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Just two of the many ways you can add impact to your
messages with Word's Desictop Publishing features.

Make Big

Money from

Tiny Sea
Creatures !

Now you can turn a worldwide
labor sliortage into a real career

opportunity. Tliere are big bucks to

be made in sardine eye closing. >«>

Did you know

that there are

always openings

in the canning

industry? We
need

experienced

eye closers now!

Day and night

positions are

available.

Benefits include

all the fresh

sardines you can

eat, and a free

oil cloth apron...

Phone

1-800-EYE-SHUT
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Books that Work
Just Like Your Mac

As a Macintosh user, you enjoy unique advantages You enjoy a dynamic user environment. You

enjoy the successful integration of graphics, sound, and text. Above all, you enjoy a computer that's

fun and easy to use.

When your computer gives you all this, why accept less in your computer books?

At SYBEX, we don't believe you should That's why we've committed ourselves to publishing

the highest quality computer books for Macintosh users. Externally, our books emulate the Mac "look

and feel," with powerful, appealing illustrations and easy-to-read pages Internally, our books stress

"why" over "how," so you'll learn concepts, not sequences of steps. Philosophically, our books are

designed to help you get work done, not to teach you about computers.

In short, our books are fun and easy to use—just like the Mac We hope you find them just as

enjoyable.

o
SVBEX'

For a complete catalog of our publications:

SYBEX, Inc.

2021 Challenger Drive, Alameda, CA 94501

Tel: (510)523-8233/(800) 227-2346 Telex: 336311

Fax; (510)523-2373

© SYBEX IS committed to using natural resources wisely to preserve and improve our environment As a

leader in the computer book publishmg industry, we are aware that over 40% of America's solid waste

IS paper This is why we have been printing the text of books like this one on recycled paper since 1982.

This year our use of recycled paper will result in the saving of more than 1 5,300 trees We will lower

air pollution effluents by 54,000 pounds, save 6,300,000 gallons of water, and reduce landfill by 2,700

cubic yards.

in choosing a SYBEX book you are not only making a choice for the best in skills and information, you

are also choosing to enhance the quality of life for all of us.



This Book Is

Only the Beginning.
Introducing the SYBEX Forum on CompuServe'^

Now, thanks to CompuServe, you can have online access to the authors and

editors from SYBEX— publisher of the best computer books money can buy.

From the privacy of your own home or office, you'll be able to establish a two-

way dialog with SYBEX authors and editors.

Expert Advice at No Extra Charge.

It costs nothing to join the SYBEX Eorum. All you have to do is access

CompuServe and enter GO SYBEX. As a SYBEX Eomm member, you'll have

access to expert tips and hints about your computer and the most popular

software programs.

What's more, you can download the source code from programs covered in

SYBEX books, discover professional-quality shareware, share information with

other SYBEX Forum users, and more— for no additional charge. All you pay

for is your CompuSer\ e membership and connect time charges.

Get a Free Serving of CompuServe.

If you're not already a CompuServe member, try it for free. Call, toll-free,

800«848«8199 and ask for representative #560. You'll get a personal ID num-
ber and password, one FREE month of basic service, a FREE subscription to

CompiiSewe Magazine, and a $15 credit towards your CompuServe connect

time charges. Once you're on CompuServe, simply enter GO SYBEX and stan

to explore the SYBEX Forum.

Tune in Today.

The SYBEX Fomm can help make your computer an even more valuable tool.

So turn c;n your computer, dial up CompuServe, and tune in to the SYBEX
Forum. You'll be glad you did. ^

SYBEX. Heip Yourself. I -I

EX
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TRODUCTIONNO
I've been using Microsoft Word on a Macintosh almost since the two

products were first announced. I've looked over the shoulders of a

hundred or more people as they learned to use earlier versions ofWord.

This is the book I've often wished I had in my reference library. It is also

one I've wanted to give to Word students. Like the software it describes,

Word 5.1 for the Mac How-To Book is designed for both first time and ex-

perienced users.

Word 5.0 was a major upgrade to an already full-featured program.

The recent announcement ofWord 5.1 offers even more power and con-

venience. Thanks to Word's new features, you can create documents like

Figure I.l in minutes. Word can integrate information from non-Word

programs (spreadsheets, databases, graphics sources, etc.) and assure

that Word documents are automatically updated when those outside in-

formation sources change.

While writing this book, I imagined some of my favorite Macintosh

users. Joanne, for instance, already knows how to make Word 4 sing.

She takes "new version" books like this one home and reads them cover-

to-cover in a single night. She's heard about the new power offered in

Word 5 and 5.1, and hopes to utilize things like the much improved Print

Merge, spelling checker, background graphics and frames, the rulers and

ribbons, Word's new drawing and graph making features, the Toolbar,

voice and text annotation, the grammar checker, and the equation editor.

Joanne wants to know more about older Word features too; like page-

nimibering alternatives, glossaries, the Work menu, print merge tricks, and

so on. For instance, she's always wondered why Word's sort feature behaves

the way it does when it encounters dates. Word 5. 1 for the Mac How-To Book

will help her understand and work around peculiarities like these.

Next, there's Michael, an experienced MS-DOS user who has re-

cendy discovered the Macintosh advantage. He understands basic text

editing but wants to learn new tricks he can do with Word on a Mac.

Michael is a lawyer and a columnist, so he needs to be able to put his

finger quickly on instructions for creating footnotes, line-numbered

drafts, tables, and other advanced page-formatting features. Some of his



FIGURE 1.1

A typical Word document

includes information from

many sources.

H&p Au-Pair Finders Interoffice Memo
H. Higgins, Col. Pickering

E. Doolittle

Rain in Spain

To:

From:

Subject:

Gentleman:

As I have been telling you all along, the rain in Spain falls mainly in

the mountains , not the plains; and I have created a spreadsheet in

Microsoft Excel 3.0 on my Macintosh to prove it:

Rain in Spain ||



Finally, I had Candy in mind when I wrote this book. She's a soph-
isticated Macintosh user with more projects than time. Among other
things, Candy is in charge of her organization's Macintosh network and
computer training. She routinely looks for ways to improve office com-
munication and users' skill levels. She makes executive-level presenta-
tions, and is always in a hurry, so I expect she'll skim Part I and Part II,

then dig into Part III and Part IV.

She'll want to know if Microsoft Word 5's and System 7's Publish
and Subscribe features will benefit or confuse her network users. She'll

be curious about QuickTime too. Candy doesn't know it yet, but Word
5's new Find File... feature will help her entire company organize its serv-

er-resident Word files, parficularly now that Word 5.1 makes it easier and
quicker to use. Word 5's new drawing tools will catch her eye, as will the
new menu layouts and personalization possibilities.

Each of my friends has a delightful sense of humor—something I've

tried to keep in mind. That's why the examples and illustrations in this

book are intentionally tongue-in-cheek. Learning anything as powerful
as Word 5 takes time. I've always felt that if a book weighs more than five

pounds and you need to pick it up regularly, it had better be fun to read!

Book conventions
Most of the examples and exercises in this book are illustrated using
Apple's System 7. Except where noted, they'll all workjust fine under Sys-

tem 6.

We've tried to adhere to official Applejargon where possible. The
16 key is variously referred to as the Apple key or the Command key. We'll

just call it the Command key or use this symbol: 3i.

Moreover, Apple would prefer that you and I not use the term
Macintoshes when referring to a gaggle of Macs. Ooops, Macs is also ver-

boten. Henceforth, we'll try to use the term multiple Macintosh com-
puters, but may slip in a Mac or two just for variety. Please don't tell the
authors of the official Apple Publications Style Guide.

Since some of you will not have the newest version of Word (5.1)

when you start using this book, we've been careful to point out which
features and techniques are available only to 5.1 users. Whenever a 5.1

feature can make life easier, the text and illustrations show 5.1 in use.



About the examples and exercises

The book contains a number of exercises and lists of steps that you may
want to try as you read along. Whenever you need to hold down one key

then press another, you'll see the keys separated by hyphens. For in-

stance, 3€-S means hold down the Apple key while pressing the S key.

Boldface text usually indicates things you are expected to type. So, if you

are being asked to type Mark Twain's name in an exercise, you'll read

something like "Type Mark Twain then press the Return key."

Tips, warnings, and 5.1 notes

Throughout the book you'll find tips, warnings, and notes specifically for

users of Word 5.1. They are designed to catch your eye. Even if you are

an experienced Word user it might be a good idea to skim each chapter

looking for these easy-to-spot items.

Mac tracks

Mac Tracks summarize the important steps, keystrokes, and menu com-

mands for major Word features. You'll find Mac Tracks at the beginning

of each chapter. Think of them as bite-sized "how-to 's" that can often

save you a trip through the entire chapter.

Where to go from here

The book's organization is fairly straightforward, except for a detour to

Appendix A if you need to install Microsoft Word. Here's an overview of

each section.

Part I: getting started

Part I helps you dive right in. Sit at a Mac (sorry)— sit at a Macintosh

when you read it. You'll soon be creating, saving, and printing impressive

documents, beginner or not. Word offers a number of different ways to

view and move through your documents. Pari I will introduce you to



these time-saving teciiniques.

Part I also covei-s Word 5's graphics features—both new and old. You'll

learn to create, import, position, and size graphic elements. The process of

flowing text around giaphics is illustrated. We'll also Uy to make some sense

out of the growing collection of giaphics and font standards (TIFF, PICT,

EPS, TrueType, etc.) and show how they relate to Microsoft Word 5.

You'll explore printing issues and see how your choice of printers

and printing options affects the final look of your documents.

Word's unique Find File command and Summary Info features are

demonstrated in Part I. You'll see how they work together to help you or-

ganize your hard disk and find misplaced files.

Near the end of Part I, you'll find information meant for users of

earlier Word versions. Here you'll learn what's different and the same.

You'll also see how Word 5 and 5.1 treat non-Word documents and files

created under earlier versions of Word.

Part lU formatting FUNDAmNTALS
Part II shows you how to look great in print. It is organized to help you

quickly find illustrated answers to specific questions. You'll learn the fun-

damentals of formatting characters, lines, paragraphs, and sections.

Tabs, tables, styles, style sheets, headers, footers, hyphenation, and page

numbering are also covered here. Those of you who need to create foot-

notes will find out how in Part II.

There are numerous step-by-step "recipes" for getting the results

you desire. And you'll see plenty of illustrations of the techniques at work.

Part iii: time savers

As you might expect, Part III is filled with tips and techniques. Here you

will learn how Word 5.1 makes envelope prindng a snap, and learn to

find and replace text or styles. We'll also de-mystify Word's new Glossary

features, and show how to create stationery for repetitive tasks. Then,

you'll learn how improve your documents' contents with Word's built-in

thesaurus, spelling and grammar checkers. If you write or work on long,

complex documents, be sure to read about Word's outlining features in

Part III, as well.



Part iv: desktop publishing

Here's where it all conies together. In Part IV you'll see real-world ex-

amples of documents you can create with the skills you've learned ear-

lier. You'll see just what it takes to make:

Awards

Brochures

" Business cards

Calendars

Directories and lists

Forms

Invitations

Letterheads and envelopes

Manuals

Memos

Menus and wine lists

Multi-column newsletters

Newspaper and magazine ads

Overhead slides

Postcards

Posters

Reports and proposals

" Signs

Three-fold mailers

The illustrations in this part of the book are accompanied by detailed

descriptions of the design decisions, measurements, and techniques used

to create them so you can do it yourself.

Since some desktop publishing projects can be quite complex,

you'll see how to work with large documents. Word's table-of-contents



and indexing features are explored here as well. If you and others col-

laborate on bigjobs, Part IV will show you how to give documents a

uniform look and feel, even when they have multiple authors.

Part V: power tools

Finally, Part V deals with topics of interest to advanced users of Word.
Few other programs offer as much opportunity for customization. Word
lets you rearrange menus, change default settings, modify dictionaries

and grammar rules, and much, much more.

Part V also contains chapters describing Word's text and voice an-

notation features, and the print merge feature for personalized mailings

and similar documents. In Chapter 26 you'll actually set up a simple, per-

sonalized mailing project and create some mailing labels, envelopes, and
postcards.

Word 5.1 users have a new tool called Microsoft Graph. It creates

charts in a variety of formats from data in your Word documents. See it

at work in Chapter 27.

If your computer is on a network with others, read about Word's
E-Mail, and other network tools in Part V as well.

System 7 users will want to check-out Chapter 28. It details ways to

use your Mac's Publish and Subscribe features. They automatically up
date documents when things change elsewhere.

If you've been bitten by the multimedia bug, don't miss Chapter 30.

It describes Word 5.1 's QuickTime stipport.

System requirements

Your Macintosh can run Word 5.0 in as litde as 1 Mb of RAM under Sys-

tem 6, if you don't use MultiFinder, or a minimum of 2 Mb under Sys-

tem 7 (which always runs MultiFinder) . Microsoft recommends 2 Mb of

RAM under System 6 and 4 Mb of RAM under System 7.

While you can run a stripped-down version of Word 5 from a high-

density (1.4 Mb) floppy, you cannot run either Word 5.0 or 5.1 from flop-

pies on a machine with only 800K disk drives. The uncompressed
program is too big to fit on an 800K diskette.



For all practical purposes, you'll want to run Word 5 from a hard

disk. Plan to have at least 5 Mb of hard-disk space available before install-

ing Word. (Word 5.1 offers an installation option for PowerBook users

that .saves disk space by installing a reduced number of features.) Read

about it in Appendix A. You'll also need at least one properly installed

printer.

If you plan to use Word's QuickTime features, you'll need the

Apple QuickTime extension installed in your System 6.07 System folder

or your System 7 Extension folder. You can get a copy of this file from an

Apple dealer or find it on many bulletin boards.

What you need for practice^ exercises

If you haven't already installed Word 5 on your Macintosh, either follow

Microsoft's instructions or read Appendix A of this book. If this is your

first Macintosh adventure, you might want to prevail upon your Apple

dealer or a friend to help with the installation.

This book assumes that you have used your Mac at least briefly and

that you know how to click, drag, select text, and make menu choices.

The first part of the book reviews these concepts, but you might want to

keep your Apple manuals within reach if you are just getting started.

If you want to practice saving work to floppies, find a spare diskette

before you settle down to work.
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Tump right in on the next page ifyou are a newcomer. If

you've used other Macintosh word processors, at least

speed read this section. Part I gives you an opportunity to

create, save, and print a sample Word document. You 'II

learn about graphics in Word and tricksfor mana^ng

your collection of Word documents. Since Word has some

unique tools (like Frames and Find File) that you won't

find in other word processors, don 't miss Part I.
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TRACKS

To start Word 8

double-click on the Word icon, or double-click on a document

created with Word. System 7 users can also double-click on

aliases of the Word program or document icons; or drag a Word
document icon onto the Word icon or alias.

To find out whith version you iiave 9

choose About Microsoft Word. . . on the Apple menu.

To type text 12

type normally, but press Return only at the end of paragraphs,

not at the end of each line. If you spot mistakes while typing,

erase them with the Delete key.

To sele<t tilings 13

drag with your mouse to highlight text or graphics. To select

an entire document use the Edit menu's Select All command
(3€-A). Read about selection shortcuts (like double-clicking

and Shift-clicking) throughout this book.

To delete things 17

select them fust. The Delete key and the Edit menu's Clear

command remove selected items completely. The Edit menu's

Cut command (3€-X) deletes selected items from the screen

and places them on the Clipboard. The scissors Toolbar button

also cuts.



lb undo mistakes 17

use the Edit menu's Undo command (3€-Z) which can often

reverse the last action you've taken. The exact name of the

Undo command changes in the Edit menu to tell you what can

currently be undone. The button on the Toolbar button that

looks like a pencil eraser will also undo.

To format text 22

first select the text, then use the ribbon, ruler, or version 5.1 's

Toolbar to change its appearance. The Format and Font

menus' commands also change the appearance of text. Many
formatting commands have keyboard shortcuts which are listed

next to their command names in menus.

To quit Word 31

choose Quit from Word's File menu, or use the S§-Q keyboard

shortcut. Word will prompt you to save or discard recent

changes.



Starting and quitting Word

Typing and editing documents

Ways to recoverfrom mistakes

How to Drag-and-Drop

Tfxe ribbon ruler and Toolbar

Savingyour work

Getting help

Keyboard tips and techniques

I N THIS CHAPTER we'll explore Word's

basic text-editing features using Word's

default settings and a Mark Twain quote. You'll type, edit, save, and

reload your first Word project.

Document setup

Althcjugh we'll use Word's standard settings for this first exercise, it is

worth noting here that many experienced users start each new project by

thinking about the document's overall design and final appearance.

Word gives you on-screen clues about how your document will look on

paper. It can show you line endings, page endings, the relative size and

placement of text, graphics, margins, and so on. In order to do this.

Word needs to know a few things from you—like the paper size you plan

to print on, and the kind of printer you will be using. And, you may have

strong feelings about how much white space you want arotmd the edges

of your pages. Once you tell Word these things, it changes the on-screen

appearance of margins, ruler, and other settings to accommodate and

reflect your design.

Thus, it is always a good idea to inpm (at least preliminary) printer,

paper, margin, and other document-design decisions before you start



TYPING HABITS TO BREAK

typing. In Part II, yoii will learn how to do this by using the Chooser,

Page Setup, the Document menu, and other tools.

If you are lucky enough to have a simple life with only one printer,

one paper size, and similar projects, you may be able to make your setup

decisions once and forget about them or even use Microsoft's default fac-

tory settings for every project. If you do complex tasks or are a perfec-

tionist, you'll frequently change specialized printer and document

settings.

D I P

Get in the habit of thinking about which printer and

paper size you plan to use, the orientation of pages, and

other design elements right when you start a new project.

Visit Page Setup and the Dociunent conunands in the

Format menu before you start typing.

Typing habits to break

If you learned to type on a typewriter or even an old word processor,

chances are you have established habits that will be counterproductive in

yoiu- use of Word 5. Here are a few habits you should try to break:

Do not use the Tab key or the Spacebar to indent para-

graphs. Instead, use the indent control in Word's ruler (the

top half of the split triangle at the left side of the ruler).

You'll learn more about this in Chapter 9.

Never use the Spacebar to center text. Use the center-align-

ment button on the ruler instead.

Don't use the Spacebar to make columns. Instead use tabs,

Word's multi-coliunn features, or make a table. See Chap-

ter 10.
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Do not manually space paragraphs with carriage returns.

Use Word's paragraph spacing instead, as explained in

Chapter 9.

Do not hit the Return key repeatedly to start a new page. In-

stead, use Word's hisert Page Break feature.

Your first word project

With those seemingly endless preliminaries out of the way, let's use

Word's default settings for this first example in order to simplify things

and get you rolling.

To get started, turn on your Macintosh and locate the Word 5 icon,

as shown in Figure 1.1. (Look in the Word folder on the hard disk if you

have used Word's installer.) If you can't find the icon, use the Find File

desk accessory under System 6 or the Find... command in the File menu
under System 7. Once you've located the icon, point to it using your

mouse (or trackball), then click on it twice quickly (double-click) to

launch the program.

You will see a new document window similar to the one in Fig-

ure 1.2. The exact size and shape of your window may be different,

depending on yoiu- monitor and system configuration. If you are a Sys-

tem 6 user or have a black-and-white display, you will not see the shades

of gray depicted in many of the illustrations in this book.

The parts of a word window
If you are using MultiFinder or System 7 with a large screen, you may see

part of your Macintosh desktop in addition to the Word window. This is

normal. An active Word 5 window has standard Macintosh scroll bars, a

title bar, zoom boxes, a menu bar, and so on. (If vou are unfamiliar with

FIGURE 1.1

To start Word 5, doubk- ^1^^
click the Word 5 icon. Microsoft Vord
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FIGURE 1.2

A new document window

appears each time you

start Word.

Version 5.1 Toolbar

Menu bar

Edit Uipuj Insert Format^ Font Tools lilindoui Utork
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"""Paragraph mark

\ Insertion point

End

'Mouse pointer (I-beam shape)

Page 1 INormal

Status area

:m:

Scroll—
barsj

_MSI

Size box

these terms and concepts, take a moment to review your Apple Macin-

tosh manuals.)

In addition to the usual Macintosh tools, you should see a Word 5

ruler, ribbon, a flashing insertion point, and possibly a Toolbar if you are

using version 5.1 (choose About Microsoft Word...from the Apple menu
if you are unsure which version you are using). Let's look at a few of

Word's window parts in a little more detail.

Menu Bar and Commands
When running Word, the top of your screen contains traditional Macin-

tosh-style menus in a menu ban Pointing to a menu title with the mouse
pointer, and holding down the mouse button reveals menu choices

—

often referred to as menu commands. You choose commands by sliding

the mouse pointer down the list of commands until the one you desire is

highlighted (turns black). Releasing the mouse button executes the high-

lighted command. Commands with ellipses (...) after their names will

ask you for additional information before they can execute.
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If you highlight a command then change your mind

before releasing the mouse button, simply slide the

mouse pointer to highlight a different command, or slide

the pointer off of the menu entirely to make the command
list disappear.

Some commands can be executed by holding down specific key

combinations. These keyboard shortcuts are usually listed next to com-

mand names in menus. You'll learn more about this later.

Mouse Pointer
Your mouse pointer should look like an I-beam and move freely about

the screen. The pointer will change shapes when it passes over certain

parts of the screen. For instance, it turns into a large arrow at the edges

of Word windows. You'll soon learn how these changes in the pointers ap-

pearance tell you what you can do next.

Insertion Point

The insertion point or cursor denotes where text, graphics and other

things will be placed when you type or insert them. The insertion point

is a tall, skinny, blinking vertical stick. Don't confuse it with the mouse
pointer. The I-beam mouse pointer and insertion point are two very dif-

ferent devices. Take a moment to locate them both in Figure 1.2 and on

your own screen.

Ribbon
The ribbon contains buttons and drop<lo\\ii menus that help you quickly

alter the appearance and arrangement of text and graphics. To display

or hide the ribbon, use the ruler choice on the View inenu or its key-

board shortcut (§€-()ption-R)

.

You can use the ribbon's font menus to pick a font, and specify it's

size. Point to the buttons containing triangles (next to the font and type
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size menus) to see drop down lists of choices. You can also type font

names or sizes directly into the font and size boxes.

Those four buttons next to the font and size menus let yoti em-
bolden, italicize, imderscore, super and subscript text. The button on
the Ruler containing a rectangle, circle, and triangle brings up Word's

Draw window where you can create your own graphics. The process is

described later in this chapter.

The button containing the paragraph mark alternately shows and
hides paragraph marks, the litde dots used to represent spaces, and
other non-printing items.

m
Word 5.1 users will see additional buttons for quick table

creation and graphing. Tables are explored in Chapter 10. See

Chapter 27 for information about creating graphs.

The remaining buttons on the right end of the ruler in both ver-

sions 5.1 and 5.0 are used for specifying from one to three columns of

text. They look Hke single (sometimes called "no columns"), double

columns and triple cokuTins. Column features are described in Chap-

ter 21.

Ruler
The ruler lets you quickly change text alignment, spacing, tabs, margins,

and indents. It serves additional roles when working in columns and
tables. The ruler shows you what's going on, and lets you alter the ap-

pearance of selected paragraphs, or the paragraph containing the inser-

tion point. You'll learn more about the ruler later in this chapter.

To display or hide the ruler, use the Ruler choice on the View menu
or its keyboard shortcut (3€-R).
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The Version 5.1 Toolbar
If you arc using 5.1 you may also see a collection of buttons called the

Toolbar. If you don't see the Toolbar, you can display it with the Toolbar

command on the View menu. This same command hides the Toolbar.

The Toolbar contains buttons. Clicking on them with your mouse issues

commands.
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It is worth noting that Word offers many formatting

capabilities not found on the ribbon, ruler, and Toolbar. For

instance, while there are only three column choice buttons

on the ribbon, you can specify more than three columns of

text using menu commands. Think of ribbon, ruler, and

Toolbar devices as mini-formatting features. Get to know

the more robust menu commands as well.

Status Area
The lower-left corner of your Word window gives additional information

about your work. Get in the habit of watching it while you work. (As

you'll read later, there are occasions when you might be asked to t\pe

things in the status area as well.)

Typing text

Type the following quotation (intentionally type The the rather than

simply The^t the beginning). Don't worry if you also make unintentional

typing mistakes, you'll learn how to fix them in a moment. Watch the

screen as you type. Notice that Word 5 automatically moves text down to

the next line when it runs out of room near the right edge of the screen.
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This is called automatic word wrap, a common and useful word process-

ing feature. For this exercise, do not press the Return key until you've

typed the period after the word bug.

The the difference between the right word and the almost
right word is the difference between lightning and the
lightning bug.

Finish by pressing Return, typing Mark Twain's name, and then press the

Return key again. When you are done, your screen should look some-

thing like Figure 1.3.

FIGURE 1.3

Type in Mark Twain's

unembeiiished qvote.

4 File Edit Vieuf Insert Format Font Tools lilindoui lUork g) »
rePlHJallJHillllMglMaigjiiqiWIMTloa^^

The the difference between the right word and the almost right

word IS the difference between lightning and the hghtning bug,
Mark TwainT

Page 1 INormal" :ee ""Rib

Selecting text

Word lets you do a lot with text after you've typed it. You can change its

appearance, move it around, delete it, and copy it. The first step is to

tell Word which text you want to work with. This is done by selecting it.

Word has many, many ways to select text. For instance, you can drag

your mouse pointer over the text while holding down the mouse button.

There are shortcuts for selecting indi\idua] words, lines, sentences, and
paragraphs, which you will read about in a moment.

Depending on your system configuration, selected text will either

change color, or be surrounded by a gray or black background. That's

how you know what you have selected, as you can see in Figure 1.4.

If you are new to the Mac, practice selecting other words, sentences,

and single characters with the mouse. It might be frustrating at first, but
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FIGURE 1.4

Doubleclick on a word to

The llBJldifference between the right vi/ord and the almost right

word IS the difference between Ughtning and the hghtning bug. fl

Mark Tvi/aini

you'll soon find yourself reaching for the mouse even when using a com-

puter that doesn't have one!
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If you have selected text and changed your mmd, click

anywhere outside of the selected area, or press an arrow key

to cancel the selection.

Selecting specific units of text with a mouse

Here is a summary of text selection shortcuts for specific units of text

like words, sentences and graphics. Practice them all until they become

second nature.

Selecting Entire Words vs^ith a Mouse
Double-click anywhere on a word to select the entire word and the space

that follows it. To select adjacent words, drag after double-clicking on the

first word of interest. Entire words will be selected when you drag this way.

Selecting Entire Lines Avith a Mouse

1. Move the mouse pointer to the selection bar (an in\isible

strip running down the extreme left edge of the document

window). The pointer will become an arrow.



SELECTING TEXT

2. Click only once.

X The entire line to the right of where you've clicked will be
selected.

Selecting Entire Sentences with a Mouse
Hold down the 5€ key while yon click anywhere in the sentence of inter-

est. This also selects the punctuation mark (period, question mark, etc.),

and the space following the sentence, if there is one. Dragging after you
click this way selects additional sentences.

Selecting Entire Paragraphs with a Mouse
The quickest way to select a paragraph with your mouse is to triple-click

anywhere in a paragraph. That is to say, point anywhere in the paragraph
and quickly press and release the mouse button three times in succes-

sion. You can also select paragraphs using the selection bar.

1. Move the mouse pointer to the selection bar (the invisible

strip running down the extreme left edge of the document
window). The pointer will become an arrow.

2. Double-click.

3. The adjacent paragraph will be selected.

Selecting Your Entire

Document >vith a Mouse

1. Move the mouse pointer to the selection bar and the

pointer will become an arrow.

2. Hold down the §€ key and click.

3. The entire document will be selected.

Selecting Graphics, Movies,
and Other Objects with a Mouse
Click anywhere within the graphic or other object. You'll see a border

—

usually with handles (small black boxes) surrounding the selected object.



THE WORD FOR THE MAC HOW-TO BOOK Chapter 1

Selecting variable units of text with a mouse
Sometimes you'll want to just select a single character, or parts of a text

string. Here are some techniques to use.

Dragging to Select

1. Point to the place where you want selection to begin.

2. Hold down the mouse button and drag in any direction.

3. When the pointer hits a screen boundary (top, bottom or

side) the document will scroll as highlighting continues.

4b Release the mouse button when you've selected the

desired area.

Shift-Clicking to Select Large Areas

1. Point to the place where you want selection to begin.

2. Click to place the insertion point there.

3. Point to the end of the desired area (scroll if necessary)

and hold down the Shift key while you click.

4b Release the mouse button.

Selecting Rectangular Areas
To select rectangular areas (like columns in a tabbed list), hold down the

Option key while you drag.

Selecting in Tables
There are many specific tools for selecting things in Word tables. See

Chapter 10 for details.



UNDO AND REPEAT

Deleting text

There are several ways to delete unwanted text like that extra the you
typed in the sample Twain quote. If you had spotted your mistake right

after typing it, pressing the backspace key four times would have

removed the unwanted characters and space.

Even though you did not make the correction earlier, it is easy to

go back now, select the undesired text and remove it. Once the text is

selected, simply press the Delete key once to eliminate the unwanted
word and unnecessary space. Try it.

Later, you will learn other ways to delete text, and numerous
strategies to reuse deleted text (move it) elsewhere. If you haven't al-

ready done so, delete that unwanted tfie.

Undo and repeat

Do you know what a damnosecond is? It's that fleeting instant when you
realize you've done something really stupid on your computer—like ac-

cidentally deleting or reformatting twenty pages of text.

Everyone makes choices they wish they could undo. Like few other
things in life, Word often lets you.

And, when doing tasks that are repetitive and complex, it is nice to

have your computer handle some of the drudgery. That's where Word's
Repeat features can help. Let's begin by looking at Undo.

Undo
Word watches as you work. With suiprising attention to detail, it remem-
bers which steps you last took. When asked, it can frequently undo your
errors. You undo things by choosing Undo from the Edit menu or by

using the 9§-Z keyboard shortcut. The exact name of the Undo choice on
the Edit menu changes as you work. Sometimes it says Undo T)ping.

Other times it says Undo Formatting or Undo Sort.
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The Toolbar button that looks like a pencil eraser will

undo your last step.

Here are some examples of things Word can undo if you ask soon

after you discover a problem:

" Editing clianges (typing, cutting, pasting, etc.)

" Most formatting actions (styles, fonts, etc.)

Most tasks done with tools (replacing, etc.)

" Most drawing actions (dragging, filling, etc.)

Suppose you have a large docimient with dozens of different paragraph

styles. There are bold headings, indentations, several different fonts,

various line- and paragraph-spacing schemes, and so on. You select all of

the text and accidentally reformat it as Normal. Poof. A week's work

looks like guacamole. Indentations are gone, headings look like body

text—what a mess! A quick trip to the Edit menu would reveal the choice

Undo Formatting, as shown in Figure 1.5.

Choosing Undo Formatting (or pressing the 3€-Z shortcut) would re-

store evervthing to the wav it was.

ARMING

Frequently, you need to catch your mistakes imme-

diately after you make them. For instance, if you type even a

single character after accidentally reformatting your pride

and joy, the Undo choice will change to Undo Typing and

you will not be able to restore the formatting. And, occasion-

ally, you wUl see a message like the one in Fig;ure 1.6. Word

can't always undo your mistakes.



UNDO AND REPEAT

FIGURE 1.5

ffie Undo menu choke

changes based on what

you've last done.

Ujm Uieui Inset
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The best approach is to stop and think immediately after you notice

a big, potentially time<onsuming mistake. Get help. Sometimes more ex-

perienced Word users or Microsoft's telephone support staff can talk you

through time-saving repair techniques. The less you fiddle after noticing

a big mistake, the better your chances of salvation. If you are a new user,

don't be embarrassed to ask for help right when you notice a problem!

By the way, it is possible to undo an Undo. Immediately after you

undo, the Undo command changes to Redo, letting you flip back and

forth.

a I p

Word often modifies Undo and some of its other menu
command names based on what you've last done. And, Word
dims commands in menus when they can't be used at the

moment. Examine command names to see what Word can

and cannot do next.

Repeat

This feature was called Again in Word 4, and it had a different keyboard

shortcut. Repeat is located on the Edit menu and the Word 5 shortcut

is §€-Y. Repeat watches you work, and attempts to remember and recreate

your actions on demand. Suppose, for instance, you change the width

of a paragraph. If you have several other paragraphs scattered around

your document that also need to be reformatted the same way, you can

select each paragraph and use the Repeat feature.

Like Undo, Repeat's name changes based on what you have last

done, and it works with most Word actions immediately after you take

them. Repeat works with taping and many other actions. Experiment.
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Inserting text

m

Word offers several ways to insert new text into an existing document.

The most straightforward approach is to move the insertion pointer to

the desired location, then start typing. Word accommodates the new text

by pushing the existing text to the right and down as necessary.

Suppose you wanted to add the word obviously between the and right

in the first line of Mark Twain's quote. You would start by placing the

mouse pointer (the I-beam) where you want to begin inserting text

—

between the space and the rin right ior this example. Next, press and
release the mouse button to move the insertion point to the desired

position.

A R N I N G

Beginners sometimes foi^et to press the mouse button

after pointing with the I-beam. Don't confuse the I-beam

with the insertion point. First you use the I-beam to point to

where you want the insertion point placed. Then you must
press and release the mouse button to actually move the

insertion point.

Place the insertion point properly and type the word obviously, in-

cluding the space that follows it. Your screen should look something like

Figure 1.7.

FIGURE 1.7

You must position the

I-beam and then insert

the text.

The real difference between the obviously
right word is the difference between lightr^mj

Mark Twain i

right word and the almost

g and the lightning bug.i

Point and click to position

ttie insertion point

before inserting
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Replacing text

Word also makes it easy to replace text. It combines the steps of deleting

unwanted text, positioning the insertion point and inserting replace-

ment text. Simply highlight the unwanted text and start typing. The old

text disappears and the new text snakes across the screen as yon type it.

For example, watch the screen while yon highlight the word almost

(double-click on it) and type nearly. See how easily you can turn great

prose into drivel? Since we'll be using this text for some future exercises,

take a moment now to restore Mark Twain's actual words using the text

editing tricks you've learned so far

Simple formatting tricks

Let's take a quick look at a few of Word's most often used style options.

Word 4 users are accustomed to going to the menu bar to make st)'le

changes. You'll still need to do that occasionally, but Word 5 contains

something new called the ribbon, shown in Figure 1.8.

FIGURE 1.8

The ribbon makes your

life easier by providing

foster access lo some of

Word's more commonly

used features.

Superscript

ICouner

Drop-dov/n point size menu

I

^^

Drop-down font menu

Show/hide

non-printing

characters

1

Tm RIBBON

Among other things, the ribbon lets you make style changes by clicking

buttons or pulling down single level menus, rather than going to the

more crowded menu bar.
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As always you must select text before working with it. For this exer-

cise, select all the text either by dragging, choosing Select All from the

Edit menu, or by using the keyboard shortcut §§-A.

D I P

Get in the habit of using the 3€-A shortcut when you
want to select your entire document. It can save you lots of

scrolling in large documents.

Let's start by increasing all of the type from 12 to 24 points. The
second triangle in the upper-left corner of the ribbon reveals a list of

type sizes, shown in Figure 1.9.

To reveal them, point at the triangle and press and hold the mouse
button. Slide the pointer down to highlight 24 and release the mouse but-

ton. Your screen should look something like Figure 1.10.

»
You can also type font names or sizes directly into their

respective ribbon boxes. Simply click in the box and start

typing. When you're finished typing, press the Return key to

enter your selection.

Regardless of which technique you use to change the size of text,

you can change as much or as little as you like. Highlightjust the first let-

ter Tin the quote and make it 48 point type. Your text will look like Fig-

ure 1.11.
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FIGURE 1.9

You can quickly change

the type size with the

ribbon.

Version 5.1 users can

also change font sizes

with these buttons

# File Edit llieui Insert Format Font To ols M'^dfw g) »
wmwmmmmxa

gUii:T««iic
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FIGURE 1.10

The type size has been

enlarged to 24 points.

The difference between the right

word and the almost right word is

the difference between lightning

and the lightning bug. i

Mark Twainl*

FIGURE 1.11

Single characters can be

changed for emphasis or

decoration.

ihe difference between the right

word and the almost right word is

the difference between lightning

and the lightning bug. ^

Mark Twain i
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If you are using version 5.1 the two Toolbar buttons

with the big and small "A"s can be used to increase and

decrease the size of selected text.

Notice the wider space between the first and second lines now. The
space between the Tand the /?glook unnatural too. That's because dif-

ferent type sizes and fonts have different inter-character (kerning) and
inter-line (leading) space specifications. These can be overridden as

you'll see later.

m
If you are using Word version 5.1 you can accomplish

this and other intriguing effects with the new Drop Caps

feature. Read about it in Chapter 8.

Let's make Mark Twain's name appear in boldface. Start by select-

ing his first and last names by double-clicking or dragging. Then press

the bold button on the ribbon (the uppercase B).

The button to the right of the bold button italicizes text. The under-

score button is next to the italic button and the next two buttons are for

super- and subscripting text.

The remaining buttons on the top row access the drawing tools,

toggle the display of symbols, and create multi-column layouts.

The ruler

The ruler is used to control margin settings, line spacing, tab settings,

and more. Word 4 users will spot some changes here too. Let's use one of

the ruler buttons now and postpone a complete ruler tour until later.
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Notice the group of four buttons on the left ol the ruler containing

horizontal lines (see Figure 1.12). These let you specify left-aligned,

centered, right-aligned, or fully^ustified text.

With Mark Twain highlighted, press the right align button and

watch what happens. Your screen should look like Figure 1.13.

There's much more to learn about the ribbon and the ruler, as

you'll see in Part II. You are probably itching to print by now, and you

will in a moment, but it would be a good idea to save your work first.

That way if you have a printer or system problem, you won't need to

redo the entire exercise.

FIGURE 1.12

Clicking here right-aligns

Mark Twain's name.

Use to specify alignment
1

I I

ra W^TSH R^THI fR^ mtUlrlil fTTf^lT]

1 F

^
-4 15—1-

Click to right align Mark Twain

FIGURE 1.13

The finished Twain quote.

iNcirmal

T

Tuiain Quote

la gj RRH] f^^ [TBIEDi iMi"i I-
-43 -4*

he difference between the right

word and the almost right word is

the difference between lightning

and the lightning bug.

Mark Twain?
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SAVING DOCUMENTS INITIALLY

Saving documents initially

The words that you have typed and styHzed so far exist only on your screen

and in your computer's volatile RAM (random-access memory). That is

to say, if you were to switch off the computer, or experienced a power

failure or other malfunction, your work would be forever lost. By saving

your work to disk as you go, you can pick up where you have left off.

D I P

Many experienced computer users save every fifteen

minutes or whenever they are interrupted by phone calls or

visitors. That's a good habit to establish.

Once you are happy with the appearance of the Mark Twain

quote, select Save from the File menu. You will see the Save dialog box,

illustrated in Figure 1.14.

FIGURE 1.14

You see the Save dialog

box the first time you

save a file.

The folder where
the document will be saved

leiLllord 5~^

D D)i«»^rs!<!n ir!l(!!rr(<il!(tf!

D Glossaries

CD Sample Documents
D Settings Files

Saue Current Document as:

Twain Quote <

Saue File as Typis

Normal

s^

o

o

c3 Ron's llcH

3684K auailable

I
Saue ])

Cancel [Desktop]

(
Neui Q

]

G Make Dackup

EJn !)j^rf>fiU for R!«

Type the document name here
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The §€-S keyboard shortcut is a convenient way to save

without visiting the File menu. Some folks use it exclusively.

The Save dialog box tells you where Word plans to store your work

and requests a name for the file. It also gives you many other save op-

tions, which are discussed in Chapter 6.

m

im

Version 5. 1's Toolbar has a button that looks like a

floppy disk. It will also start the Save process.

Let's keep things simple for now and use Word's default save op-

tions. Start by noticing where Word is proposing to put your document.

This is a very important habit to establish.

A R N I N G

If you do not get in the habit of thinking about where

you and Word save documents, you will misplace them.

When saving to a floppy disk or your own small, uncluttered

hard disk, this can be a minor annoyance. If you work on a

far-flung network with multiple servers and gigabytes of

storage space, it can take hours or days to locate lost files.
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In Figure 1.14, Word is proposing to store our new document in a

folder called Word 5. You can tell this from the picture of a folder next

to its name (Word 5) near the top of the dialog box.

Look at your screen. Take a moment to see where Word plans to

save your work. Chances are you will see something slightly different

from the folder location shown in Figure 1.14.

Telling word where to save your document
Like any good Macintosh program. Word lets you specify save locations.

You do this by picking the desired location from the drop-down list lo-

catedjust above the scrollable file list shown in Figure 1.14. (For more
information about this. See Chapter 6, Managing Your Files.)

Naming word documents
Type a name for your document in the Save Current Document as: box,

then simply click the Save button. Names can be up to 31 characters. Do
not include colons (:) in your file names.

a I p

Instead of clicking on the Save button, tap the Return
key. This will have the same effect as clicking Save. With
Microsoft Word 5, like most Macintosh programs, pressing

the Return or Enter key will execute the button with the bold

border in the active dialog box.

One way or the other, Word will save your document and, assuming

you are using Word's default settings, you will see a Summary Info

dialog box similar to the one shown in Figure 1.15, but with blanks in

many places.



THK WORD FOR THE MAC HOW-TO BOOK Chapter I

FIGURE 1.15

The Summary Info dialog

box helps Word's find

File... feature round up

documents meeting

specific criteria.



QUITTING AND RESTARTING WORD
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To prevent the Summary Info dialog box from

appearing when you initially save a new document, turn it

off via the Open and Save category of the Preferences

command as described in Chapter 31.

Saving as you work
Once you've named a document and specified a place to save it, you'll

not see the Save As... or Summary dialog boxes when you save unless

you request them. A quick trip to the Save command in the File menu,

or better still the key combination 16-S will save your work whenever you

desire. So will clicking the Save button on version .^.I's Toolbar. Save

early, often, and always before you print or make major changes.

Quitting and restarting word
There are several ways to completely quit Word. You can choose Quit

from the File menu or use the §€-Q keyboard shortcut, as shown in Fig-

ure 1.16. Try one or the other method now.

If you have made any changes since the last time you saved. Word

will ask if you want them saved. Select Yes to save changes. No to ignore

the most recent changes, or Cancel to abort your quit request and return

to word processing.

After you have satisfied Word that you have saved everything of

value, Word will quit and you'll be returned to your Macintosh desktop.
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Word needs to do some housekeeping when you quit.

For instance, Word updates its settings files, and asks if you
want to save last minute changes to your documents. When
you use Word's Quit command, or even the Finder's Shut

Down command, this housekeeping will proceed smoothly.

But if you use the power switch on the back of your Mac (or

simply unplug it) without first executing a Word Quit or

Finder Shut Down command, you may damage a document

file or loose valuable changes to your Word settings

(described in Chapter 31).

FIGURE 1.16

Quif by visiting the File

menu or using theK-Q

shortcut.

Edit UJeiiP Insert

Neuj
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Launching word by
- double-clicking on a document

Now that you've quit Word, you will need to restart the program before

you can use it again. You could double-click on the Word 5 program icon

as you did before, then tell Word to load the document that you want to

revise. But there is a shortctu. It is possible to load Word by double-

clicking on a Word document icon. Try this by double-clicking on your

Twain Quote document icon. It will look like Figure 1.17 if you are

viewing by Icon.

1. Find yoiu- Twain document (hopefully in your Word 5

folder).

Z Double-click on the Twain Quote document icon.

3. After a moment. Word 5 should be on your screen, along

with the Twain document, ready for yoti to edit.

It is even possible to launch Word 5 by double-clicking on documents

created with Word 4 and earlier versions. It's a good idea to make sure

Word 5 is the only Word version on your hard disk.

FIGURE 1.17

You can double-click a

Word 5 document icon to

start Word Tvain Quote

Using system rs alias feature

One of the most useful new features of System 7 are its aliases, which you

can use to launch Word 5. For example, you might keep the actual Word
5 icon tucked away in the Word folder and make an alias of the Word
icon for your desktop. System 7 will remember where you've stored Word
and will find and launch it when you double-click on the alias icon.

Here's how to make an alias for Word.
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1. Start bv locatinj^ and highlighting the Word 5 icon.

2. (-hoose Make Alias from the File menu, as shown in Fig-

ure 1.18.

3. A new icon will appear in the folder with the Word icon.

This is the alias icon. Notice that the file name is italicized

and contains the word alias, as shown in Figure 1.19.

FIGURE 1.18

Making an alias in

System 7 can make it

easier to launch programs.

First click to select

the Word program icon

Then make an alios

of the selected icon

and drag it to a

convenient location

like your desktop

FIGURE 1.19

You can place an alias

anywhere for easy

access—like along the

bottom of your screen.

Double-clicking on
this program alias

will run Word

Double-clicking on
this document icon

will run Word and
load the document

/

£\vt?/ Wof-d S.! /i^[fiy^fl<?ffiv Trash
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QUICK ACCESS TOYOUR LAST FOUR PROJECTS

4b Drag the icon to a convenient location. Many people place

them out on their Macintosh desktop.

5. Rename the alias if you like (shorten it, for instance) by

clicking once on the name to select it and then edit.

6. Test it. Close the Word folder and double-click on the alias.

It should launch Word without your needing to open up

any folders.

It is also possible to make System 7 alias icons for Word
documents. Using this approach, you could have an alias for

your letterhead, another for proposals, etc. Also, you can

open any document by dragging its icon or alias on top of

the Word 5 icon or its alias.

Quick access to your last
— four projects

Once you have saved some Word 5 documents, Word facilitates quick ac-

cess to the last four of them you've used. Word remembers the names

and locations of the last four documents you have worked with and lists

them at the bottom ofyour File menu as shown in Figure 1.20.

Choose the file of interest and Word will attempt to locate and load

it. If you have changed the document's name or moved it since your last

Word session, Word may ask for help locating it.
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FIGURE 1.20

Word lists your last four

projects at the bottom of

the File menu—pick one

to load it.

Edit Liieiu Insert

Neui



CUT, COPY, AND PASTE

m
With Word 5. 1 you can also open a new, untitled

window by clicking on the dog-eared document icon located

on the Toolbar.

Copying and moving
Word 5 supports all of the usual Macintosh techniques for copying and

relocating things. It also provides two unique move commands that leave

your Macintosh Clipboard undisturbed. One is called Move Text. The

newest addition, not available in versions before Word 5, is called Drag-

and-Drop. It's a handy one-step, mouse-assisted mover

Cut, copy, and paste

The traditional way to move or duplicate things on a Macintosh is to

select the items of interest, cut or copy them to the Clipboard, move the

insertion point to the new position, and paste them in. For example, sup-

pose you wanted to move the word almost so that it came before the first

right in the Twain quotation.

1. Start by selecting the desired text (you could simply double-

click on almost as shown in Figure 1.21).

FIGURE 1.21

Firsf, select the ifem(s) [ ^e difference between the right
you wish to move.

word and the almost right word is

the difference between lightning

and the lightning bug. ^

Mark Twairii
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2. Use the Cut command foimd imder the Edit menu or the

3€-X shortcut. (If you have an extended keyboard, F2 will

work, too.)

3L The selected text will disappear from the screen and be

placed on the Clipboard.

4i, Now place the insertion point at the desired location (point

and click). In this example, place it to the left of the first

occurrence of the word right dt.s illustrated in Figure 1.22.

5. Paste, using either the Paste command on the Edit menu,

the §€-V shortcut, or the paste key (F4) on your extended

keyboard. Text will flow to the right and down as the

Clipboard's contents move into place. In our example, the

resulting move would look like Figure 1.23.

FIGURE 1.22

You must position ibe

insertion point before

pasting.

"F
right1 he difference between the

word and the right word is the

difference between hghtning and
the lightning bug.

Mark Twain i

FIGURE 1.23

Tbe pasted (inserted)

material forces tbe otber

material to tbe right

and down.

1 he difference between the

almost right word and the right

word is the difference between
lightning and the lightning bug. -

Mark Twain^
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If you are using version 5.1, you can use the Toolbar's

Cut and Paste buttons Instead. They look like a scissors and
a clipboard respectively.

Copying from one
word document to another

Since you can open and work on multiple Word documents at the same
time, it is easy to move things from one document to another. For ex-

ample there are two contracts open in Figrue 1.24.

With a large screen, it is easy to size and position muUiple windows

in plain sight and quickly move back and forth, simply by clicking in the

window of interest. You can arrange your desktop by clicking and drag-

ging the size boxes in the lower-right corners of windows to adjust their

size and shape. You can move windows around as usual, bv pointing to

their title bars and dragging them.

Remember, while it is possible to have many windows in view at the

same time, you can have only one active window. You can tell the active

window by the lines in its title bar. In Figure 1.24, the bottom window is

the active one. There are several ways to activate a window. The easiest is

to simply click in it.

Activating Windo>vs by Pointing
Even if only a small portion of an inactive window is showing, clicking on
it will activate it and bring it forward.

1. Locate any portion of the desired window.

2. Click in it.

3i Resize and/or move windows if necessary to make it easier

to work.
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FIGURE 1.24

You can open several

documents simultaneously.
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WORD'S WINDOW MENU
Sometimes your screen may not be big enough to display multiple Word
documents in useful sizes. Word provides the Window menu for these in-

stances. As you can see in Figure 1.25, the Window menu lists the open

documents and lets you switch between theiri. A checkmark denotes the

active window. Using this menu, you can activate one window to copy in-

formation, go back to the Window menu to activate and display another

window, and then paste.



CUT, COPY, AND PASTE

FIGURE 1.25

The Window menu allows

you to switch between

documents.

lilindoiu

Help...

lilork

Show Clipboard

Neiu IDIndoiu OF5

Nem hire letter

s/Org chart

Some reminders about the cupboard
It is important to remember that when you cut or copy to the Clipboard,

you replace whatever is stored there. If you do this by accident and spot

your error immediately, the Edit menu's Undo command will restore the

Clipboard's contents.

The Clipboard can store text, graphics, even sound and animation.

While you normally don't need to see the Clipboard to use it, you can

view the Clipboard by choosing Show Clipboard from the Window menu
as shown in Figure 1.26.

Remember alSo that the contents of the Clipboard disappear when
you turn off your Macintosh. If you want to save something permanendy,

consider pasting it to the Scrapbook, which saves items to disk.

FIGURE 1.26

The Show Clipboard

command lets you see

what's on the Clipboard.

Edit View Insert Format Font Tools ^^^^^niliork
Help...

Clipboard

almost fl

M. M

o Shoui Clipboard,
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The contents of your Clipboard usually stay the same when you

switch from program to program, as long you do not turn off or restart

your computer. Thus, you can copy items from a spreadsheet, quit the

spreadsheet program, launch Word, and paste the spreadsheet informa-

tion into yoiuWord docimient.

MultiFinder users and System 7 users with enough RAM to run

more than one program at once often use the Clipboard to pass infor-

mation back and forth without quitting any of the programs. Here's an

example.

Suppose that you have created invoices using a spreadsheet, and

you want to copy a customer's mailing information from the spreadsheet

to a letter you are writing. Assuming you have enough RAM to run both

programs, you might open the custcjmer's invoice spreadsheet and a new

Word document, as shown in Figure 1.27.

You could copy the customer's address from the spreadsheet onto

the Clipboard, then paste it into the Word document. The results might

look something like Figine 1 .28.

O I P

System 7 users will also want to explore other pasting

options including Publish and Subscribe (described in

Chapter 28). These advanced techniques make it possible

to keep multiple documents up-to-date when things change.

The move text command
Wliile cutting and pasting is the traditional Macintt)sh way to move items.

Word has an additional tool which does not affect the Clipboard's con-

tents. It lets you move information from place to place within the same

document. It's called the Move Text command.
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FIGURE 1.27

The spreadsheet program

and Word are running

together.

A Word document

J
latjles Hauen letfprlipafl

iNgwCenturg Schl- |[^ |24 |F1 Hjyl U | HE] Bm
iNormal ja mmsm \^w\^ bhi b ^

i
^t

i h i
i mni ^

°,
. 1 .

. .
1'

.

.

. 1 .
.

. F _|4 , 15 ^_

Eagles' Haven Soaring School
12 Cactus Road Las Vegas, NV 71112 (703)555-1111

t
i

M

INVOICE

Invoice 12345-678

C»*y, Clwatum and Howe

Atttfneys at Uw
1875 Csnhiry Park East

LreAn^s.CA 91023 „, „

Payments, n Any:

$50000

:m
\

An Excel worksheet



THK WORD FOR THE MAC HOW-TO BOOK Chapter I

FIGURE 1.28

It's easy to paste

information from a

spreadslieet into a Word

document.
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Although you'd never guess from its name, Move Text

will also move graphics, sounds, QuickTime movies and more.

Unfortunately, Move Text is not one of the default choices on the

Edit menu. However, you can access it by using a keyboard shortcut. If,

after you've tried the command, you like it, you can use Word's Com-

mands... command to add Move Text to the Edit or other menu. Adding

commands to menus is described in Chapter 31.

To use the Move Text command via the keyboard shortcut:

1. Highlight some text or a graphic to be moved.

2. Hold down three keys at once—the 3€, Option, and X keys.

The lower-left corner of the active window will display the

message Move to.

3i Place the insertion point at the desired location and press

the Return or Enter key. The text or graphic will move
without affecting the Clipboard's contents. Undo works

here if you need it.

The process can work in reverse, if you like. Start by moving the insertion

point to the desired location then press §§-Option-X and select the item

to be moved. Pressing Enter or Return will move the selection to the

insertion point.

You can use Move Text to move things from one Word window to

another, but it cannot exchange information with other programs.

Drag-and-drop
Word 5's new Drag-and-Drop move feature lets you highlight text or

other movable objects and drag them to a new location. For instance, in

Figure 1.29 the word almost has been highlighted with Drag-and-Drop

enabled. With the mouse button depressed, the mouse pointer changes

appearance slightly. Notice the small rectangle near the arrow. Notice
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FIGURE 1.29

The pointer and insertion

point change when

Drag-and-Drop is enabled.

Drag the selected item

to the new location

1 he difference between the right

word and the almost right word is

o

also the long pointer. The arrow, box, and pointer move as one when

you move the mouse with the button held down. Once you release the

mouse button, the selected items will be moved to the Drag-and-Drop in-

sertion point. In Figme 1.29, the word almost would be inserted between

the and right. 11 you Drag-and-Drop while holding §€, you will move a copy

of the highlighted text.

I P

If you've held down your mouse button while selecting

things (while dragging or double-clicking, for instance),

you'll need to release the mouse button and press it again

before you'll see the Drag-and Drop-pointer. Practice will

make this second nature. Start by dragging and dropping the

word almost to restore the Twain quote.

Steps for Moving with Drag-and-Drop

1. Select the desired text or other item(s).

2. Release the mouse button, if necessary, then point to the

selected item(s), press and hold down the mouse button.

Watch the mouse pointer.

3. When you see the pointer change to its Drag-and-Drop

shape, drag the pointer while holding down the mouse but-

ton until the insertion point part of the pointer is at the

desired new location.
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4k Release the mouse button.

5. The selected ilem(s) sht)uld move.

6. Undo immediately (9€-Z) if things didn't go right.

Steps for Copying vs^ith Drag and Drop
Drag-and-Drop copying works just like Drag-and-Drop moving with one

exception. You hold down the 3€ key while you work.

1. Select the desired text or other item(s).

7. Press and hold down the 3€ biuton.

3. Release the mouse button, if necessary, then, (while still

holding down the §€ key), point to the selected iteni(s) and

press and hold down the mouse button. Watch the mouse

pointer.

4. When you see the Drag-and-Drop pointer, drag the pointer

while holding down the mouse button until the insertion

point is at the desired new location.

5. Release the mouse button and the 3§ key.

6. The selected item(s) should be copied.

7. Undo immediately (5§-Z) if you had a problem copying.

D I P

From tinie-to-time, you might accidentally drag-

and-drop something when you intend to simply select by

dragging. An immediate Undo (§€-Z) will make things right.

If you really hate Drag-and-Drop (a few people do), shut it

off from the General category in the Preferences dialog

box. Chapter 31 has details.
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Keyboard differences and word
The first Macs were like Ford's Model T—simple and utilitarian. You had

no choice of keyboards. Today, Apple manufactures extended (as shown

in Figure 1 .30) and standard keyboards with different layouts and fea-

tures. There are also international keyboards labeled with accent marks

and configured with special characters for a variety of languages, hi addi-

tion, Apple's original portables and new PowerBook notebook com-

puters have unique keyboard layouts and keys. Recently, third-party

vendors have started selling non-Apple keyboards with additional

features. Fortunately, Word accommodates most of these differences.

FIGURE 1.30

The Macintosh Extended

keyboard contains

function keys, a numeric

pad, and navigation keys.

Escape key Function keys NavigaHon keys

l]]i«».IJld X fDa »iji;i»,,.ij»om I] 1^

Command, or Apple key (X)

Option key

Arrow keys

Numeric keys

Keyboard shortcuts

Touch-typists often dislike taking their hands off of the keyboard for

anything, so Word offers a variety of keyboard shortcuts, like §€-X for

Cut. These make it unnecessarv to reach for the mouse. Shortcuts are
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mentioned throughout this book, and many are shown on Word's

menus. The Commands dialog box (Commands... from the Tools

menu) will help you explore all of Word's keyboard shortcuts. It is

possible to change or delete shortcuts or add your own new ones, as

you will learn in Chapter 31.

Keyboard shortcut symbols

Wlien you see keyboard shortcuts listed in menus and in the Commands
dialog box, peculiar-looking symbols are used to represent various keys

on your keyboard. Here's what the symbols mean:

Key
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Key combinations for special characters

Your Mac and Word 5 can work together to display and print special

characters that aren't shown on your keycaps. Examples include the

copyright symbol and accented international characters (umlauted let-

ters, for instance). In general, you specify these characters by using key

combinations. For instance, you can create bulleLs by holding down the

Option key and pressing the 8 key found on the top row of your keyboard.

The available special characters and the procedures used to create

them vary depending upon which fonts and system version you are

using. There is also a Symbol... command on Word's Insert menu that

can help.

There are subtle but important differences in the way System 6 and

System 7 users create a few special characters. Chapter 8 shows you

what's available and how to get the characters you need.

Numeric keypads and word
Most tiewer Macintosh keyboards have numeric keypads and screen edit-

ing keys (Home, Page Up, and so on) . Word uses many of these keys if

you have them.

Ninneric keypads serve two functions in Word. With the Num Loc

feature enabled, you can use the pad to enter numbers. With Num Loc off

(the default) you use the mmieric pad to navigate. Pressing 9 on the

numeric pad scrolls the screen up, 3 scrolls down, and so on.

The key in the upper-left corner of the numeric keypad toggles

Nimi Lock on and off. Newer keyboards contain both the word clear and

the abbre\iation num lock. On some keypads it is labeledjust clear or

Clear.

Some Mac keyboards have a light that tells you when Nimi Lock is

enabled, others do not. The status area at the bottom left corner of your

active Word window will also often indicate Num Lock status.



KEYBOARD DIFFERENCES AND WORD

m A R N I N G

The fact that Word defaults to Num Loc off is

particularly confusing to people in the habit of using the

numeric pad with spreadsheet and database programs. Many
of those programs defaidt to Num Loc on. New Word users

often try to enter numbers from the numeric pad and find

themselves bouncing around their Word document instead.

A fewW''ord keyboard shortcuts are unavailable to users without

numeric keypads. For instance, many of the move commands (move

down one text area, move to start of line, etc.) are available only from

the numeric pad. The Unassign Keystroke command shortcut is also un-

available without a numeric keypad. If you don't have a numeric keypad,

and you want to assign your own keyboard shortcuts to replace the ones

you are missing, that is possible. Appendix B lists all ofWord's standard

shortcuts and numeric-keypad shortcuts.

Extended keyboards and word
Extended keyboards cost more and take up extra desk space, but in

return you get 105 keys instead of 85 or fewer. Fifteen of the extra keys

are special fimction keys, which are fully exploited by Word 5. You also

get a collection of screen-editing keys (Home, End, etc.) and a Help key

that Word supports.

Many people prefer Macintosh Extended keyboards containing

special function keys. Word 5 uses them to help you be a more efficient

user. Unfortimately, PowerBooks and very early Macs do not have these

features, making a few Word functions slightly less convenient.

The top row of keys on extended keyboards contains fifteen func-

tion keys. Word has implemented Apple's standard definitions for the

first four keys: Fl is Undo, F2 cuts, F3 copies and F4 pastes. In addition.

Word's designers have assigned a number of additional function-key

shortcuts. Generally, these are shortcuts that can be accomplished with

other key combinations as well. So those of you without fimction keys

have alternatives. For instance, you can apply bold character formatting
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by pressing the FIO function l<.ey. The i<.ey combination §€-B does the

same thing. So does 36-Shift-B.

A few commands like the shortcut for the Document... and

Section... menu choices are available only if you have an extended

keyboard. Obviously, if you don't have function keys and you want to

assign your own keyboard shortcuts, that is possible. Appendix B shows

how Word's designers have utilized function keys.

Repeating keys

Most of the character keys, and many of the navigational keys (like ar-

rows) will repeat if you hold them down. This is an easy way to type a

series of keystrokes. You can change the speed of this feature from your

Keyboard control panel, located under the Apple menu. Figure T31

shows the dialog box.

The speed with which identical keystrokes are issued is called the

Key Repeat Rate. There are five choices, ranging from Slow to Fast. The
length of time your Mac waits between your first key depression and

the rapid-fire insertion of identical keystrokes is called the Delay Until

Repeat setting. As you can see in Figure T31 it's possible to specify the

delay time by clicking the appropriate button. You can shut off the delay

feature entirely by clicking the Off button in this dialog box. If you use in-

ternational keyboard layouts, this is also where you pick them. See your

Apple manuals for details.

FIGURE 1.31

Change the behavior of

repeating keys with the

Keyboard features in your

Mac's Control Panel

Keyboard

Key Repeat Rate

oooo®
Slow Fast

Delay Until Repeat

O 0(5)00
Off Long Short

Keyboard Layout



KEYBOARD DIFFERENCES AND WORD

Using word's menus without a mouse
Beginners may want to skip this topic and re\'isit it at a later time. If you

really hate to reach for your mouse when taping, or if your mouse dies in

the middle of a project, you can use Word 5's Keyboard Menus feature. It

lets you use the right- and left-arrow keys to flip from menu to menu and

the up- and down-arrow keys to make menu choices. Generally, using the

mouse is faster. Beginners—give yourself a week or two to get your eyes,

hands, and brain working together before abandoning the mouse or

trackball. If you must work sans mouse, here's how:

1. Activate the feature by pressing the period on your numeric

keypad (if you have one) or by holding down §€ and press-

ing the Tab key.

2. The Word menu bar will turn black for about five seconds,

during this time, you can press the first letter of the desired

menu (V for View, W for Window, etc.) or you can use the

left- and right-arrow keys to display the desired menu.

3. Menus drop down and stay down as you pick them.

4b Since three of Word's menu choices start with the letter F

(File, Format, and Font), you will need to hold down the

Shift key when you press F to move from File to Format and

from Format to Font. When you get to Font the next F will

take you back to File.

5. With the desired menu displayed, (Insert, for example),

either use up- and down-arrow keys to highlight an Insert

menu choice, or type the first letter of a choice (S for Sym-

bol..., T for Table..., etc.). Here, you need not hold down
the Shift key to move among choices with the same first let-

ters. Pressing S the first time in the Insert menu gets you to

the Section Break choice. Pressing S a second time takes

you to Symbol...

6. Pressing the Return or Enter key is equivalent to releasing

the mouse button. Your choice will be carried out. To can-

cel the Keyboard Menu feature without taking any action,

press the Esc (escape) key, or press the §§-. (period)

shortcut.
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Keyboard tricks in dialog boxes

Word supports the usual Apple keyboard tricks iu dialog

boxes. For instance, in dialog boxes where you are asked to

type text or dimensions, you can tab from box to box. Hold-

ing down the Shift key will move you backwards when you

press Tab.

" Anytime you see a button with a dark border, pressing

Return or Enter will work in place of clicking on the button.

" If you are unfamiliar with tricks like these, consult your

Macintosh manuals or try the tutorial programs that came

with your Mac.

HOTSPOTS
Even experienced users are sometimes unaware that you can bring up

dialog boxes, windows and other tools of interest by double-clicking at ap-

propriate areas (called hotspot.s) in Word windows. There may even be

some undocumented ones you can discover on your own.

Beginners may want to just skim this topic for now, but at least tuck

the concept away in the back of your mind; and revisit the subject later.

As you gain experience with Word, try some of these hotspot tricks and

explore to find others.

Charatter Dialog Box Hotspot To bring up the Character dialog

box, double-click on any part of the ribbon backgroimd (the space next

to the font list, for instance). Clicking on the arrows for font and t)pe

size lists works too. Obviously you'll want to have the text you plan to

modify selected before doing this.

Do€Ument Dialog Box Hotspot it you click on the Ruler's Mar-

gin indicators (they look like square brackets: [ and ] ), you'll see the

Docimient dialog box used for precisely controlling margins, specifying

footnote locations, and so on.

When in Page Layout view, if you double-click in the margins at the

(orners of yoin- docimient you will also see the Docimient dialog box.
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footnote Window HotspotS To reveal a footnote window, simply

double-click on a footnote reference mark.

The Go To Dialog Box Hotspof To bring up the Go To dialog

box used for navigating in big documents, double-click on a page or sec-

tion number in the status area at the lower left portion of the document

window.

Patograph Hotspot To bring up the Paragraph dialog box, place

the insertion pcjint in the paragraph of interest (or select multiple para-

graphs) , then double-click anywhere on the top part of the ruler scale

(above the tick marks) or on the right or left indent markers.

You can also bring up the Paragraph dialog box by double-clicking

on any of the ribbon buttons affecting paragraph alignment or spacing

(the center or double space buttons, for instance) . Unfortunately,

double-clicking this way also executes the button command. Thus double-

clicking on the Center button will center the selected paragraph (s) as it

brings tip the paragraph dialog box.

5e<tl0n Hotspot Double-click on section break marks to reveal the

Section dialog box. (Section break marks look like page breaks only with

double lines.)

Styles Dialog Box Double-click on a style name in the status area

near the bottom left ofyour Word window to bring up the Style dialog box.

Tab HotspotS Double-click on existing tabstops or the ruler's

tabstop buttons to bring up the tab dialog box. Double-clicking on the

bottom part of the ruler will add a tabstop where you've clicked, and

then open the Tab dialog box.

Getting help with word
Word has three kinds of on-line help—topic-specific help, screen-

element help, and (for System 7 users) balloon help, hi addition,

Microsoft offers product support over the telephone, via fax, and
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through C>ompuServe and other bulletin board services (BBS). There is

also TTY assistance lor the hearing impaired.

Topic-specific on-line help

It's a little ironic that Word has so many on-line help features it takes

several pages of a book to describe them, don't you think? Topic-specific

help displays a list of help topics like the one shown in Figure 1 .32. You

can scroll through the list, then double<lick on a topic and read all

about it. Pressing the Esc key or clicking in the Help window's close box

quits Help.

1. Choose the Help... command from the Window menu. (Sys-

tem 7 users can also pick Microsoft Word Help... from the

balloon help menu).

i. Scroll to the topic of interest.

3. Double-click on the topic name to read the help informa-

tion. Scroll, if necessary, to see the entire text.

4b Press Esc to quit Help. (Clicking on the close box in the

upper-left corner of the Help window also quits help.)

FIGURE 1.32

Use this Help window to

select topics and read

about them.

Help

Double-click the topic you want:

Usi ng Hel p

Microsoft Product Support

Aligning and justifying text

Ldntelirnj dfnj undoing commands
Clipboard

Columns
Copyi ng and movi ng text and graphics

Counting text

Customizing menus and key assignments

Customizing your work environment
Defaults

Deleting text and graphics

Documents: Creating

Opening

Viewing

Saving

Closing

?

II ""p I

[ Cancel
]

[PreuiOLisJ

[ NCKt ]
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When browsing topics in the help window, typing the

first letter of a desired topic will scroll the topic list to the

general area of interest. For instance, typing P will scroll the

topic list to P words like Page numbering, printing, etc.

Switching help topics

Click the Topics button in the Help menu to take you to the Help topics

list and scroll to the topic of interest. Typing the first letter of a desired

topic will take you to that general area of the topic list. The Previous and

Next buttons in the Help window will take you to the prior or next help

topic.

Pointing to get on-line help

You can often use your mouse to point to things on your screen and get

help. For instance, pointing to the ruler can reveal both the Help win-

dow and the ruler topic. Here's how:

1. Press the Help key on your keyboard or use the 5€-? key com-

bination. Your mouse pointer will become a giant question

mark. (Press Esc if this happens by mistake.)

2. Using your mouse, point to the item of interest. (The Style

menu on the ruler for instance.)

X Click on the desired item.

4. Hopefully, the topic of interest will appear in the Help window.

5. Read the help text or click the Topics button to narrow-in

on the information of interest. Scroll, if necessary, to read

the entire text.
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6. (Hick the Topics button or press return to see the topics list

again, or press Esc to quit help.

To GET ON-LINE HELP IN OPEN DIALOG BOXES

Whenever you have an open dialog box on the screen (the Print dialog

box for instance), asking for help using the techniques just outlined will

get you help for the open dialog box. For example, if you have the Print

Dialog box in view when you press the Help key or §€-? key combination,

you will see printing help.

System / balloon help

Word Balloon help is available if you are a System 7 user. With Balloon

Help enabled you'll see brief descriptions of items and their functions as

you point to them with your mouse pointer. Figure 1.33 illustrates this.

1. Choose Show Balloons from the Balloon Help menu at the

right edge of the Word menu, or turn on Balloon Help in

the Finder. (This Help menu name looks like a cartoon

balloon.)

2i Point to items of interest on the screen with your mouse.

Help-filled balloons will appear.

3. Choose Hide Balloons from the Balloon Help menu.

D I P

If your Macintosh has a 9-iiich (small) screen, you may
need to return to the Macintosh Finder to turn Balloon Help

on and off. Do this by revealing the menu at the extreme

right of your screen and choosing Finder.
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FIGURE 1.33

System 7 Balloon Help in

acfion.

Balloon help can be

controlled from either

Word or the Finder

mork

Page 1

Point to items of interest

Aligns t*xt of

selected

paragraphs flush

with left indent.

Kl
o
Q

Quitting on-line help

Pressing the Escape key closes the Help window. So does clicking in the

Help window's close box at the upper-left corner of the window.

If word asks you to locate the help file

If you'vejust installed Word, or if you've accidentally moved or deleted

the Word Help file, you may see a dialog box asking you to locate the

Help file. The desired file is called Word 5 Help, and is usually kept in

the Word Commands folder.
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Microsoft product support— services

When yon really get stuck, Microsoft's huge technical support staff can

be a big help. They provide technical note downloading services, Compu-
Serve forums, pre-recorded voice support messages and even real, live

people to answer your questions.

The first step, as they say in tech support circles, is to "Read Yoiu^

Friggin Manuals." People that don't read them are referred to as RYFMs.

If you can't find the answers you need in Word's on-line help, or your

manuals, or books like this one, it is time to call out the big guns.

Voice and fax-based support service

Since many people have the same questions, Microsoft has established

a 24-hour voice maze (called Fast Tips) which can be reached by dialing

206-635-7201 from a touch tone phone. This number will also give you

information about fax-based technical support services.

Have paper and pen in hand—these Microids talk faster than most

people can hear. Use your phone's Asterisk (*) button to skip ahead.

The Pound button (#) returns to the Fast Tips menu. To repeat some-

thing, press 7. To end, press zero.

Humans to the rescue

When all else fails, try the wonderful, and often overworked Microsoft

technical support staff. Phone them at 206-635-7200 between 6:00 AM
and 6:00 PM PST weekdays, excluding holidays. Hey, even technicians

need time off. Wlien else would they play with their home computers?

International telephone support

Microsoft provides worldwide support for Word and other products. To

inquire about local phone numbers for international support, contact

Microsoft in the United States at 206-936-8661.
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Downloading technical notes

Ifyou have a modem and communications software, you can download

technical notes for free from Microsoft. Call 206-936-6735 with your

modem set for 9600 (V.32 or V.42), 2400, or 1200 BPS (BAUD). Your

communications settings should include no parity, 1 stop bit, and 8 data

bits. You will be asked for your name and city. The first time you call you

will also be asked for details about your communications software (do

you need line feeds, etc.). If you use the same name and location each

time you call, you will not need to answer the set up questions each time.

Type Help for help.

COMPUSERVE FORUMS

Microsoft hosts a number of Microsoft forums on CompuServe, many

of them Word-related. It is even possible to rub elbows with Microsoft

programmers and product managers on CompuServe. Type GO
MICROSOFT at any "!" prompt.

Free introductory CompuServe membership kits are available with

most modems or commtmications software packages, or by dialing 800-

848-8199.

Ttd support for the hearing impaired

TTD support is available weekdays from 6am to 6pm Pacific time,

excluding holidays. Dial 206-635-4948 from your TTD terminal.
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TRACKS

To a<tivafe a window 67

point with your mouse and click in the window. The active

window's title bar will contain solid bars and the active window

will be on top of any overlapping windows. You can also pick

the desired Word document window from Word's Window menu.

To resize a window 70

use your mouse to drag on the size box, located in the lower-

right corner of the window. Drag in any direction. You'll see an

outline of the proposed new window size and shape as you drag.

Release the mouse button and the window will change size.

Clicking the Zoom box in the upper right corner alternately

expands and reduces the size of a window.

To move a window 70

point to the title bar and drag the window while holding down
the mouse button. Release the mouse button.

To dose a window 71

click in the close box in the window's upper-left corner, use the

File Menu's Close command, or the 9€-W keyboard shortcut.

You will be prompted to save or discard recent unsaved

changes, if you've made any.



To stroll in a window 71

click on the up, down, right, and left arrows in the scroll bars;

or drag the scroll boxes. If your keyboard has page up, page

down, home, and end keys, they can be used for scrolling, as

can the arrow keys. Read about additional techniques in this

chapter.

To swiUh views from the menu bar 84

choose Normal, Outline, or Page Layout from the View menu.

Print Preview is reached from the File menu.

To switth views with keyboard shortwts 84

press 9€-Option-N to switch to Normal view. Page Layout view's

shortcut is 3€-Option-P. Press 3€-Option-0 for Outline view. Use

3€-Option-I for Print Preview.

To switth views with Toolbar buttons 85

while running version 5.1 on a computer with a 13-inch or

larger screen; you'll see Normal, Page Layout View, and Print

Preview Toolbar buttons near the extreme right of your screen

(in positions 23, 24, and 25 of the possible 26 buttons). Click

on the appropriate button.

To split and unsplit windows 88

drag the thick black split bar found at the top right of a Word
Window to split the window into two panes. Double<lick on the

split bar to remove the split.



Manipulating document windows

Word'sfive ways to view documents

Keyboard shortcutsfor vieuring attd

navigating

Showing and hidingformatting characters

Version 5. / Toolbar buttonsfor viewing

Working in split utindows

Speeding screen updates

I OU WORK IN Word document windows

^m that you can position and resize for your

convenience. Word offers na\igational tools that let you quickly move to

the desired part of even huge documents. Several views make it easy to

see what your document will look like without printing it. Other views

are available to speed the creation of rough drafts and outlines. In addi-

tion, you can tiun on and off things like paragraph marks and the little

dots between words that denote spaces. (These are often referred to as

non-printing characters.)

This chapter explores window manipulation, navigation techniques,

Word's five screen views, and controlling the display of non-printing

characters.

Manipulating word's document— WINDOWS
Word's document windows work like those in any other well-behaved

Macintosli program. You can have a maximum of 23 open Word docu-

ment windows at any one time. Thus, you can open as many as 23 Word
documents simultaneously, and cut and paste between them. Only one
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can be the active window. There are several ways to activate a window.

The alternatives are described momentarily.

As you can see in Figure 2.1, most of a Word document window's

components have familiar names and functions. Here's a quick review of

window management techniques.

FIGURE 2.1

Word document windows

will remind you of those

in other Macintosh

programs.

Close box

Lines indica^e

active windov/

Tirie bar (drag here

to move winaow] Zoom box

-^

-pr-

'age 1

Untitled?

B
n^^aiH-

-4- -P 4- -4?

Horizontal scroll arrov/ (1 of 2)

Horizontal scroll bar

Horizontal scroll^\
^-^0

n

o
Q

Page up and Page dovm
(Page Layout view only)

- Split bar

-r Vertical scroll

arrow (1 of 2)

- Scroll box

-Vertical scroll bar

i Outline of new
i
window size

V
~\ Size box (drag

; to resize winaow)

Drag size box to resize windows

Activating a window
You can either activate a Word document wdndow by pointing to it with

your mouse, or by choosing it from the Word Window menu. The active

window's title bar will contain solid bars and the active window will be on

top of any overlapping windows. Once a window is active you may want to

resize it to make it easier to work in it.
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Activating Word
Document Windovs^s by Pointing

Here are the steps for activating a window by pointing. Figure 2.2 shows

how you can arrange window sizes and shapes to faciHtate pointing at

them.

1. Place your mouse pointer anywhere in the desired window.

2. Click once.

3l The window will become the active window (and move to

the top of the pile if there are overlapping windows)

.

4k Resize the window, if you wish (by clicking in the Zoom
box, for instance).

5. Work in the window.

FIGURE 2.2

An arrangement of

window sizes and shapes

thai have been resized for

easier access.

Zoom box

Erotic uses of chocolate syrup

My first day of work at the sardine factory

|was a nightmare. The stench was undeniable

-

a cross between a septic system overflow and

the lockers where literary critics hang out

Page 1 K
•Pr

<m
Size box

Click anywhere on a window
to activate it, then resize it
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You can activate a non-word window this way as well,

making it possible to switch from one program to another by

simply clicking. For instance, if you are simultaneously

running Word and Excel under System 7 or MultiFinder,

when you click in an Excel window while working in Word,

you will see Excel's menu bar as the spreadsheet becomes

the active window. This will enable you to work on the

spreadsheet without quitting Word. (To return to Word,

simply activate a Word document window.)

Activating Windo>vs
v^ith Word's Windo>v Menu
Here are the steps for activating a Word document window by pointing.

Figure 2.3 shows a typical window list.

1. Point to Word's Window menu to reveal the choices.

Z The bottom of the menu will list the window names of all

open Word document windows. (Open windows from other

applications like Excel will not be listed.)

3. Choose the menu choice corresponding to the Word docu-

ment window of interest.

FIGURE 2.3

Choose the desired

window from the

Window menu.

1
liijndoui
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4. The window will become the active window and move to the

top ot the pile if there are overlapping windows.

5. Resize the window if you wish.

b. Work in the window.

Dragging to resize a window
You can resize a Word document window by dragging the size box in the

lower-right corner of the window. Here are the steps:

1. Place the mouse pointer on the size box, located in the

lower-right corner of the window.

2. Hold down the mouse button and drag in any direction.

3L Watch the outline of the proposed new window size and

shape as you drag.

4k Release the mouse button and the window will change size.

(Undo won't work here.)

Using the zoom box to resize a window
Clicking the Zoom box in the upper right corner alternately expands and

reduces the size of a window. The window size toggles between nearly a

full screen and the last size that you defined by dragging the window.

Moving a window
Take these steps to move a window:

1. Point to the title bar.

2i Wliile holding down the mouse button drag the window.

3. Watch the outline as you drag. It is showing the proposed

new position of the window.
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4, Release the mouse button when you are satisfied.

5. The window will take its new position.

Closing a window
There are foiu' ways to close a document window:

Click in the close box in the window's upper-left corner.

Use the File Menu's Close command.

Use the 9€-W keyboard shortcut.

Quit Word.

Regardless of which method you use, you will be prompted to save or

discard recent unsaved changes, if you've made any.

Scrolling in a window
Most documents are too big to be completely displayed in their entirety

on your screen. You reveal unseen portions of yoiu^ document by scroll-

ing to bring parts of the document into view while temporaiily hiding

other parts. Usually, you'll scroll up and down to see long docimients,

but you will sometimes need to scroll left and right to see different parts

of wide documents. There are many ways to scroll.

Scrolling with the scroll arrows
When you click on a scroll arrow you will see a different part of your

docimient. For instance, suppose you are looking at page 2 of a three-

page document. If you click on the up scroll arrow (located near the top-

right of the active window), you will move a little nearer to the beginning

of the document. Clicking on the down-pointing arrow will take you

closer to the end of the document. (Typically, one click moves you up or

down about one line.) The right- and left-pointing arrows let you see cor-

responding portions of wide documents.
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If you click and hold down the mouse button while

pointing to any of the four scrolling arrows, your document

will scroll continuously untU you reach the end of the

document or release the mouse button. But there are better

ways to scroll long distances. Read on.

Scrolling by clicking in the scroll bars

Clicking in the shaded areas of scroll bars (as opposed to clicking on the

scroll arrows themselves) scrolls approximately one screen's worth. The

exact scroll distance will vary with your screen and document window

size. Experiment.

Scrolling with the scroll boxes

The white boxes in the horizontal and vertical scroll bars can be used to

quickly move great distances. For instance, if you are looking at page 1

of a 100-page document, the scroll box will be at the top of the vertical

scroll bar. Dragging it with your mouse to the exact middle of the scroll

bar will bring page 50 into view. Dragging it 3/4 of the way down the

scroll bar will take you to page 75, and so forth. Horizontal scroll boxes

can be used the same way to quickly scroll wide documents.

Obviously it is difficult to drag to the exact middle or 3/4 position

on the scroll bar. Use the scroll boxes to get you in the neighborhood,

then use other scrolling tools to fine-tune.
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It's easy to forget to move the insertion point wiien you
bounce from piace-to-place in a document by scrolling or

using the navigational tricks discussed in this chapter. Get in

the habit of looking for the insertion point before you type,

paste, or do other potentially destructive things!

Navigating with your keyboard
Word offers many, many keyboard shortcuts for navigating. You can just

scroll using keyboard commands, or you can scroll and move the inser-

tion point at the same time. Be sure you understand the difference!

Moreover, frequently if you hold the Shift key down while using key-

board shortcuts, you will select text in addition to scrolling and moving

the insertion point. For example, pressing the 9€-right arrow key combina-
tion moves the insertion point to the beginning of the next word; while

3€-Shift-right arrow selects the next word and the space following it.

There should be a keyboard shortcut that lists all of Word's key-

board-navigation shortcuts, but there isn't. Table 2.1 is the next-best

thing.

TABLE 2.1 Keyboard Shortcuts: Moving, Scrolling, and Editing

SCROLLING
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TABLE 2.1 Keyboard Shortcufs: Moving, Scrolling, and Editing (continued)

SCROLLING TO MOVE TO. PRESS.

Next Word

Beginning of line

End of line

Previous sentence

Next sentence

Next page

Previous page

Beginning of

cinrent paragraph

Beginning of next

paragraph

Top of window

Bottom of window

Start of dociunent

End of document

Scroll up one

screen

Scroll down one

screen

Scroll up one line

Scroll down one line

9€-right arrow or l€-6

(keypad)

7 (keypad)

1 (keypad)

§€-7 (keypad)

3€-l (keypad)

3€-Page Down

§€-Page Up

S§-up arrow or 9€-8 (keypad)

3€-down arrow or 9€-2

(keypad)

Home or3€-5 (keypad)

End

§€-Home or 3€-9 (keypad)

S€-End or §€-3 (keypad)

Page Up or 9 (keypad)

Page Down or 3 (keypad)

or * (asterisk on keypad)

+ (plus sign on keypad)
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TABLE 2.1 Keyboard Shorlcuts: Moving, Scrolling, and Editing (continued)

IN TABLES

OR PAGE

LAYOUT VIEW TO MOVE TO. PRESS..

First table cell or

page element

End of table or last

page element

Next cell in table

Previous cell in

table

Next page element

Previous page

element

Cell or page

element above

Cell or page

element below

Cell or page

element to the left

Cell or page

element to the right

§€-Option-7

3€-Option-l

Tab or 9€-Option-3

Shift-Tab or 3§-Option-9

36-Option-3

3§-Option-9

3€-Option-8

3€-Option-2

3§-Option-4

9S-Option-6

EDITING TO. PRESS.

Select the entire

document

Delete character

before cursor or

selected text

§€-A

Delete (Backspace)
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TABLE 2.1 Keyboard Shorlcuts: Moving, Scrolling, and Editing (conlinued)

EDITING TO... PRESS.

Delete character

after cursor or

selected text

Delete previous

word

Delete next word

Insert formula

character

Copy text

Move text

Insert glossary

entry

Copy formats

Insert special

character (symbol)

Copy as picture

9€-Option-F or Del

8€-Option-Delete

(Backspace)

9€-Option-G

§€-Option-\ (backslash)

§€-Option-C

§€-Option-X

§€-Delete

§§-Option-V

5€-Option-Q

96-Option-D

Use the nimibers on the numeric keypad (with Num Lock off) for the

tasks listed in Table 2.1. Home, End, Page Up, Page, and Page Down keys

are not available on all Apple keyboards. If you ever memorize all of

Word's keyboard shortcuts, you are spending too much time with Word.

Take a very long vacation.
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m A R N I N G

Be careful when using the Numeric keypad to navigate.

For instance, if you select some text, then press the Clear

key by accident when you meant to hit the 7 key on the key-

pad, your text will disappear! Or, if Num Lock is accident-

ally turned on, when you press the 8 (or other number keys)

in an attempt to move, selected text will be replaced with the

number corresponding to the key you've pressed. Undo
works if you spot your mistake soon enough. Many users

avoid the numeric pad navigation shortcuts for these

reasons.

The go to feature

When editing big documents, and particularly when you have a marked-

up paper copy in your hand, it is useful to be able to scoot quickly to a

particular page or to a specific page within a certain section. If you know
page (and section) numbers, Word makes this easy.

Press 3€-G or select GoTo. . . from the Edit menu. You'll see a dialog

box like the one in Figure 2.4.

The entry area is already highlighted and waiting for you to type. In

single section documents, or documents where page numbers do not re-

start in each section, just type the desired page number and press Enter

or Return. (Clicking OK works here too, but it will take you longer to

reach the mouse than it will to hit Enter or Return.) Quicker than you

can say amen. Word will take you to the requested page, and place the

insertion point at the beginning of the first line on the page. Here are

the steps:

1. Press §§-G or select GoTo... from the Edit menu.

2. Type the desired page number when you see the dialog box.

3> Press Return.
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FIGURE 2.4

Type page, optional

section numbers, or even

relative page counts here,

and away you'll go.

Type page

numbers

Type page and

section numbers

Type relative

page positions

(this one goes back 5 pages)

Section numbers and the go to command
If your document is broken into sections with page numbers that restart

in new sections, you must specify section numbers in the Go To dialog

box. (See Chapter 12 for more about sections.) To specify a section num-

ber in the Go To dialog box, type an S. For instance, typing S4 would

take you to the beginning of Section 4, (assuming your document has a

Section 4).

To specify a particular page and section, type P, the page number,

S, and the section number. Thus, P3S5 would take you to the third page

in the fifth section. Curiously, S5P3 will not do the same thing. Go figure!

Many ways to use the go to command
You can also use the Go To command to move forward or backward a

specific number of pages. And you can use it to go to the end of a

document, even if you don't know the last page number. Here's a list of



GO BACK

things yon can do with the Go To dialog box and samples of typical

entries:

Move to the beginning of the document (0 zero)

Move to the next page (p or leave blank)

" Move to last page (enter any number greater than the num-

ber of pages in the document)

Move to a specific page number (4 or P4)

Move to a specific page within a specific section (P4S3)

Move to the first page of a specific section (S3)

Move forward a specified number of pages—3 for

example (+3)

Move back a specific number of pages—5 for instance (-5)

»
If the page number displayed in the status area

near the bottom-left of your window is dimmed, use the

Repaginate Now command on Word's Tools menu before

using the Go To command.

Go BACK
Here's a handy but often confusing gizmo. When you edit, it is some-

times necessary to bounce from one part of a document to another part

of the same document. Or, if you have two different documents open,

you may find yourself repeatedly moving from one document to the

other.

Word remembers the last three places you have done editing

plus the current insertion point location. The Go Back feature lets you

quickly return to those edit points.
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There are two keyboard shortcuts. Numeric keypad owners will find

the zero key the most convenient go back button, assuming that you

leave Num Lock off. The other keyboard shortcut is 3€-Option-Z. The Go
Back command is not on Word 5's standard menus, but you can add it

from the Commands dialog box.

Incidentally, simply moving the insertion point somewhere in a

document does not necessarily add that point to the places in the Go
Back list. Generally, you need to edit something there.

Using find to navigate

Word's Find... command is a great way to move to an area needing work.

For instance, if you are looking at a printout containing a typo you want

to fix, use the Find... command to get to the corresponding spot on your

screen. Here are just the basics (Chapter 19 has the details):

1. Press 3€-F or pick Find. . . from Word's Edit menu to bring

up the Find dialog box.

2l Enter the text you wish to find, then press Return or Enter.

3. Word will search (usually down from the insertion point),

and show you the first occurrence of the specified text.

4. Click on Next or press Return to move to the next

occurrence, if that's not the occurrence you want.

5. If necessary, answer Yes (press Retiun) when Word asks if it

should search from the beginning of the document.

6. WTien you find what you need, close the Find dialog box or

click in the Word Document window to activate it.

7. Edit away.

There is much, much more to know about Find... and its companion,

the Replace... command. Be sine to read Chapter 19.
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Views

Word can show you your document with varying levels of detail to make
things easier to visualize or quicker to work with. These different display

options are called views. Word 5 provides five different views:

Normal view

Page Layout view

Outline view

Print Preview

Split screen

Normal view
Unless you are very patient, or have a fast Macintosh with a large screen,

use Normal view for most of your heavy-duty text entry and editing.

Word's other views respond noticeably slower to typing, editing, and
scrolling.

Normal view (illustrated in Figure 2.5) keeps repagination and
screen redraw delays to a minimum. It shows your text as you have typed

it, and displays graphics at the points in the text where you've inserted

them (which is not necessarily where they will print).

In earlier versions of Word, Normal view was called Galley view, a

sometimes inaccurate homage to the phototypesetting profession. It was

the default view. Normal view depicts things like type sizes, line spacing,

indents, and so on with reasonable accuracy. It does not show side-by-

side column positioning, footers, headers, nor the printing position of

framed items. Columns are shown at their actual width, but not side-by-

side. Automatic page breaks are shown as dotted lines. Manual page

breaks, if you've defined any, are shown as darker lines.

Editing in normal view

You can create and edit text, columns, and graphics as usual in Normal
view. To work on headers or footers, though, you must open Header or
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FIGURE 2.5

Normal view is the besi

for ordinary editing and

text entry.
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I recently Stoned learning hov to fly gliders, a long-tmie ambition of mine In the process,
I've learned somethir^ that is very relevant to the art of small tmsiness computing

While Hal, my flight instructor and I valked to the plaiie last veek the talX tumed to

emei^ency procedures "What's the first thing to do if you are soto and discover a

rattlesnake m your glider at 2000 feet?" He a^ked

I blurted out something ahout avoidii^ quick leg movements and making a radio
request for a precautionajfy ambulance Hal ticked-off three or four more nightmares that

had occurred at or near our desert airport "VThat if you hear a loud clunk m the tail section?
What if the rearcanopy blovsofP" And so-on

Each time I had a different opinion-a reaction, I suppose . to the stated pnDblem Each
time 1 vas vrong "

"You should do the same thing immediately and continuously m each situation ", Hal
said more firmly than I'd ever heard him before

"Fly the plane. Ron j^Fthe plane "-TI

The ansver sounds too obvious at first, smce "flying the plaone" is something that you
vouJd expect pilots to do automatically But, consider this There have been several

disastfotis commercial jet crashes apparently because entire crevs have focused on
relatiyity small distractions vhile their jiMjit\-^f]eT/ fifeui'vAry^traight mto the grourid

In one case . three seasoned pilots appear to have simultaneously vrestled vith the same
burned-out indicator lamp They vere all completely obb/ious to audible bv altitude

vamings from their cockpit instruments, and ignored inquiries from puzzled air traffic

controllers. Investigators believe that none of the fl^ht crev members even looked out a
vindovl '-

We do the same tlung m business Just today I got a call from the CEO of a nine-month
old , multl-million dollar stortup manufacrunng company We talked for ten mmutes about
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Footer windows from the View menu. To add date, time, and page num-
bering to headers and footers, use glossary entries. (See Chapter 16 for

information about glossary entries.)

Line Numbers Do Not Show in Normal Wtev/
If you have instructed Word to number lines, the numbers will not ap-

pear in this view. Use Print Prexiew to see line numbers.

Multi-column Text in Normal View
It is possible to prepare multiple-column text lor piinting while in Nor-

mal view, as shown in Figure 2.6.
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FIGURE 2.6

In Normal view,

multi-column text is

shown at the correct

width, but not side-by-side.

r
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Here the previously rough text has been justified, hyphenated, and

so on, all in Normal view. Even the column margins and indents have

been defined. To get a true sense of how this document will look without

printing it, though, you must switch to Page Layout view or use Print

Preview.

Switching views

Word 5 has a View menu (shown in Figure 2.7) that you can use to select

Normal, Outline, or Page Layout views.

The keyboard shortcut for Normal view is 9€-Option-N (for nor-

mal). The shortcut for Page Layout view is §€-Option-P (for Page). You

can probably guess the keyboard shortcut for Outline—3€-Option-0.

Switching to Print Preview either requires a trip to the File menu or

use of a not-so-intuitive keyboard shortcut. Press 3€-Option-I to enter

Print Preview mode from the keyboard.

FIGURE 2.7

Pick the desired view

from the View menu or

use keyboard shortcuts

shown on the menu.

Insert Format

Normal
Outline

• Page Layout r M'^'P
"^ 1
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m
If you have a large enough display, and if you are

running Word version 5.1, the three buttons near the right

edge of the Toolbar select views. See Figure 2.8 to see which

buttons do what. (If you use a small screen you can replace

other Toolbar buttons with the view buttons. Follow the

instructions in Chapter 31.)

FIGURE 2.8

Use these Toolbar butlons Normal view |[I]|llDj E }- Print Preview

to switch views in

version 5. 1.

Page layout view

Figure 2.9 shows what happens to the text from Figure 2.6 when it is dis-

played in Page Layout view. The ruler and ribbon have been hidden for

this example. You can make this the default view in the Preferences

dialog box.

In Page Layout view, the screen resembles a white sheet of paper, or

at least a portion of a sheet. Look closely at the top, bottom, left, and

right edges of the screen in Figure 2.9. You will see a dark background

that Word places behind the "paper." On a large enough screen, you will

see the whole page. On smaller screens or when using a large paper set-

ting in Page Setup, you may need to scroll to see these representations of

the paper's edges.

Editing in page layout view

Generally, you edit as usual in Page Layout view. Text and graphics are

positioned where they will print. Headers and footers can be both seen
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FIGURE 2.9

In Page Layout view, you

can see text as it will print.
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and edited. Click in a header, footer, or body text to position the inser-

tion point. Page breaks, be they automatic or forced, are represented by

new pages on the screen rather than by dashed lines in the text.

You can scroll only one page at a time. That is to say, you cannot see

the bottom of one page and the top of the next at die same time in this

\iew. Two small arrows at the bottom of the window—called the Page

Forward and Page Backward arrows—let you scroll up or down one page
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at a time. Wlien you move to a new page you nuist click somewhere in

the new page to move the insertion point before typing. If you have been
typing, the insertion point will move automatically.

Hidden Text in Page Layout View
If you have hidden text in your document and you reveal it. Page Layout
view will display line and page endings adjusted to include the hidden
text. This may not correspond to pages that you print if the Print dialog
box's Print Hidden Text box is unchecked. In order to see what your
pages will look like without the hidden text, you must hide the text by un-
checking the Show Hidden Text box in the Preferences dialog box. (See
Chapters 8 and 25 for information about hidden text.)

Headers and Footers in Page Layout View
You can see and edit headers and footers in Page Layout view. To add
date, dme, and page numbering to headers and footers, use glossary

entries. (See Chapter 16 for information about glossary entries.)

Line Numbers
Do Not Show in Page Layout View
If you have instructed Word to number lines, the numbers will not
appear in this view. Use Print Preview to see line numbers.

Repagination in Page Layout View
It is wise to enable automadc background repagination when working in

Page Layout view. (This is the default condidon.) Otherwise, Word will

not always display correct page and line endings. If you have turned
background repagination off, you can use the General category of the

Preferences dialog box to re-enable it. You can use Repaginate Now on
the Tools menu to update line and page endings whenever you want,

even if you have turned off background repagination.
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Split screen view

Regardless of which view you prefer, you can profit from using Word's

split-screen feature. With it, you can keep two widely separated portions

of a document in view at the same time. To split the screen, simply point

to the small black rectangle in the upper-right corner of your Word docu-

ment window. The pointer will change to the Split-bar pointer shape as

shown in Figme 2.10. Drag the Split-bar pointer down to divide the

screen.

When you release the mouse button, your screen will split into two

independent windows, each with its own scroll bar. To return to a single

screen, double-click the Split-bar or drag it to just below the title bar.

This takes some practice.

FIGURE 2.10

Splitting the screen can

be liandy when you want

to see different portions

of the same document

BJij
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FIGURE 2.11

You can arrange the

document with Normal

view in the top pane and

Page Layout view in the

bottom.
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Print preview

As you learned in Chapter 1, Print Preview is more than just another way

to view dotumenLs. Choose Print Preview from the File menu or with the

3€-Option-I keyboard shortcut.

Depending on your screen size and settings, you will see either an

unreadable birds-eye view of a page or two (with greeked text), or you

will see a full, readable page like the one in Figure 2.12.

In any case, you will be able to reposition margins in Print Preview.

It is also possible to force page munbering in this view. Notice that line

numbers are displayed in Print Preview but not in any other view type.

You cannot edit text or headers or footers in Print Preview. You will not

be able to see certain Page Setup printer tricks like image flips in Print

Preview.

Outline view

A complete description of Word's Outline feature can be found in Chap-

ter 20. For now it is enough to know that if your document is properly

formatted, switching to Outline view lets you quickly navigate and reor-

ganize even large, complex docimients. Outline view allows you to see

the entire contents of the document, just chapter headings, orjust sec-

tion headings, and so on. For instance. Figure 2.13 shows a book outline

down to paragraph headings, but does not include the text of the book

itself

If you wanted to move all of Part 4 so that it came before Part 3, you

might ordinarily use Normal or Page Layout view to scroll through and

select the complete text of all chapters contained in Part 4; then you

would cut and paste it ahead of Part 3. But by using Outline view, you

could simply "collapse" the view, as shown in Figure 2.14.

With the document thus collapsed, you could use Word's Outline

tools to move the entire contents of Part 4 by simply dragging the line

+Parl 4 Time Stivers above Part 3.

You need not begin projects by creating an in-depth outline, as you

will see later when you read about styles and outlines. By creating and ap)-

plying appropriate styles for various heading levels, you can quickly cre-

ate, a document that can be expanded or compressed for viewing and

editing with Outline tools.
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FIGURE 2.12

Print Preview gives you a

birds-eye view of one or

two pages at once.
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FIGURE 2.13

A book outline viewed at

paragraph heading level.
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View defaults

Normal view is the default lor new documents unless you change the

default to Page View by using the View category of the Preferences dialog

box (see Chapter 31). In Word 5, unlike earlier versions, Word remem-

bers the view you were using when you last saved a document and opens

the document in that view. If you have opened a new document in Nor-

mal view, done some work, switched to Page Layout view, saved, and quit,

the next time you open the document it will appear in Page Layout \iew.



FIGURE 2.14

A collapsed Outline view

allows you to move large

sections of a document.
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Hiding paragraph marks,
— spaces, etc.

Word can display helpful non-printing characters to let yon see what's

going on. Examples include:

Paragraph marks

Dots denoting spaces

Arrows denoting tab characters

Dashed lines for page breaks
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" Text and graphic boundaries

Most other guidelines

You'll generally waiu to leave these on, although turning them off can

sometimes help you better visualize the final appearance of a document.
To toggle the display of these items use the Show f command on the

View menu, or its keyboard shortcut 3S-J. If the ribbon is in view, you can

use the button that looks like a paragraph mark. (It's 4th from the right.)

Speeding up the screen

If you find scrolling and other screen actions somewhat sluggish, here

are some suggestions.

" Work in Normal view whenever possible.

Close unwanted windows and applications that you are not

using.

Version 5.1 users should consider tinning off 3-D ribbon

and ruler effects (See Chapter 31).

Version 5.1 users should consider turning off the Toolbar

(See Chapter 31).

Use the Monitor portion of your Macintosh Control Panel

to switch to Black and Wliite (instead of colors or shades of

gray).

Consider breaking one very large document into several

smaller ones (books into chapters, for instance).

Practice navigating with a
— microsoft sample document

If you are new to Word's navigation and selection tricks, why not take a

moment now to load one or two of the sample documents from Word's

Sample Documents folder (usually found in your Word 5 folder). Prac-

tice navigating, selecting, and mo\ing text until vou feel comfortable.
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TRACKS

To <hoose a printer 100

use the Apple menu to open the Chooser dialog box then click

on the appropriate printer icon (LaserWriter, ImageWriter,

etc.). Scroll, if necessary, to bring the desired icon into view.

Select the appropriate printer from the list on the right side of

the dialog box, again scrolling if necessary.

To print single <opies 1 13

bring up the Print dialog box with the Print... command on

Word's File menu or use the preferred 31-P keyboard shortcut.

Press Return or click on the Print button. Version 5.1 users can

use the button on their Toolbars that looks like a printer to

bring up the Print dialog box.

To print multiple topics 1 13

enter the desired number of copies in the Copies section of the

Print dialog box.



To print only seletfed pages 1 13

enter the starting page number in the From section of the Print

dialog box, and the last desired page number in the To box. If

your document contains sections with restarting page numbers,

you must include section information. For instance, p3s2

specifies page 3 in section 2.

To preview before printing 119

use the Print Preview... command on Word's File menu or

the 3€-Option-I keyboard shortcut. Version 5.1 users with wide

screens can use the second from the last button on their

Toolbars.

To enable batliground printing 121

you must be running System 7 or System 6 with MultiFinder.

Background printing software must be properly installed. From

the Chooser, select the icon of a printer supported by the back-

ground printing feature (LaserWriters, for instance). Choose

the On button when the Background Printing option appears

in the Chooser dialog box.



Printing your document

Using Print Preview

Background printing

Printing a document on someone else's system

r RINTING CAN BE quite simple or

^m relatively involved. Be certain that your

printer is turned on and full of supplies. Most laserprinters need to warm

up, so if you are using one and have just turned it on, wait for the ready

light before attempting to print.

O I P

It is always a good idea to save before you print!

Occasionally printing problems can lock up your computer,

and you might lose any unsaved changes if you are forced to

reboot or power-down.

Simple printing

If you only have one printer, and if it is properly installed and ready to

go; and if you just want to print a single copy of the document on your

screen, printing can be accomplished with two simple steps. Try them

with your Twain quote on the screen:

1. Press 3€-P (or choose the Print command from Word's File

menu). This takes you to the Print dialog box.



PRINTING AS AN INTERACTIVE PROCESS

2. Press Return (or click on the Print button) to dismiss the

Print dialog box and begin printing.

m
The Toolbar contains a print icon that will take you to

the Print dialog box. It is near the left end of the Toolbar

and looks like a printer.

Aborting printing

To prematurely stop printing, press the 3€-period key combination and

hold it until the printing status information disappears from your screen.

Even after the print status information disappears, your printer may

print a few pages that were sent prior to print cancellation.

O I P

If you are using your Mac's Background printing

feature, you may need to use PrintMonitor to cancel

printing. The process is described near the end of this

chapter.

Printing as an interactive
- PROCESS

While printing can be as simple as previously described, it is a good idea

to get into the habit of visiting the Chooser, Page Setup dialog box, and
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possibly the Print dialog box whenever yon begin to create a new docu-

ment, particularly if you work with a variety of printers or paper sizes. If

you wait until you have finished working on your document to choose a

printer, yoiu" page and line endings may change considerably from those

you initially saw on your screen. This can mean a minor annoyance or a

major disaster

As an example, if you write a long document, create a table of con-

tents, then change printer models or choose different printing featines,

you will find that line and page endings may change. This will require you

to redo the table of contents. Otherwise it will not agree with the printed

pages. The following printer-related decisions affect pagination and

should be selected or determined when you begin a project:

Printer model

Paper size

Reduction/enlargement

" Page orientation

" Fractional widths

" PostScript over text

" No gaps between pages

" Larger print area

Printing/not printing hidden text

Other changes affect the appearance of printed pages, but have little

impact on pagination.

If you have only one printer and it works properly, you can skip

ahead to the section on Page Setup Options and Formatting later in this

chapter.

Choosing a printer

As you may already know, the Chooser is located in your Apple menu. It

will look something like the one in Figure 3.1. Your Chooser may have

different icons than the ones illustrated here. Since the Chooser is used

to select things in addition to printers, you might see non-printer choices



CHOOSING A PRINTER

FIGURE 3.1

Click on a printer's icon

to select it.

First click on the appropriate printer icon

m

here. For instance, in Figure 3.1 the AppleShare and MS Mail 2.0 icons

are not printers. The printers drivers shown in Figure 3.1 include an

AppleTalk-connected ImageWriter, a StyleWriter and several Apple
laserprinters.

A R N I N G

Sometimes you will see printer driver icons for printers

that are not connected to your computer. The Chooser icons

represent printer-driver software that is instaUed in your

computer's system folder, not the actual hardware. (You can

remove unwanted icons by drawing the unnecessary drivers

out of your System Folder.)

You choose an available printer driver by clicking on the desired

icon, and possibly on the name of the specific printer in the box to the

right of the icons.
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Choosing printers on a network
If you have a complex network, your Chooser dialog box may ask you for

additional choices like zones. You many need to scroll to see the desired

printer icon. If you have questions about using printers on your network,

contact your Systems Manager.

Printer port selection

Some printers, like the Personal LaserWriter LS, require serial connec-

tions rather than LocalTalk connections. Usually, these printers are dedi-

cated to one computer, and not easily shared. In these cases, when you

choose a serial printer, you are given a choice of serial connections or

ports to use.

Page setup options and
— formatting

Different printer types offer different capabilities. Some let you piint

at a range of reduction and enlargement percentages, for instance, while

others do not. Programs like Word take this into consideration when
they represent documents on screen.

D I P

When you choose a different printer type, your

Macintosh will remind you to open the Page Setup dialog

box as shown in Figure 3.2. It's a good idea to check your

page setup choices even if you do not make any changes.
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FIGURE 3.2

A typical laserprinter

Page Setup dialog box.

LdserlDritet Page Setup

Paper: (», US Letter O fl-» Letter

O US Legal O B5 Letter

Reduce or
Enlarge:

100

Orientation

|
Tabloid [ [ Cancel ]

fopti

Document.

Printer Effects:

EIFont Substitution?

HTeKt Smoothing?

^ Graptiics Smoothing?

H Faster Bitmap Printing?

M Fractional Widths D Print PostScript Ouer Tewt

nuse Hs Default

ons

Page setup choices

Many companies besides Apple make printers. Some have unique fea-

tures and come with their own drivers. They are usually compatible with

Word, but your Print or Page Setup dialog boxes may look different. If

so, check your printer manuals for details.

The Word 5 Document Button
Clicking on this button brings up Word's Document dialog box which is

discussed in Chapter 7. It lets you modify margins, hidden-text printing,

and more.

The Use As Default Check Box
Normally, changes you make in a Page Setup dialog box are saved only

with the document you are working on. New documents are usually

opened using Word's standard, default settings.

It is possible, however, to define a non-standard collection of Page

Setup choices as the default for all new Word projects. Clicking to place

an X in the Use As Default box will use the current Page Setup informa-

tion for all subsequent new Word projects. This will not affect documents

created earlier with different settings, nor will it affect printer settings

used by other programs like Excel or Quicken, even if you are running

them along with Word 3 imder MultiFinder or System 7.
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Page Orientation
Most printers offer a choice of portrait or landscape printing. Clicking

on one or the other of the pictures beneath the word Orientation in most

Page Setup dialog boxes tells Word whether yon want to use the tall

narrow (portrait) or wide, short (landscape) paper setting. Portrait is

the default. For everyday correspondence like letters and memos, you'll

want to use portrait orientation. Landscape orientation is handy for wide

tables, spreadsheets and envelope printing, among other things. You

cannot mix page orientations in a single Word document.
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One way to place an occasional landscape page in a

portrait-style document is to create a separate document in

landscape mode and link it using Word's File Series features.

See Chapter 24 for more information.

Reducing and Enlarging
The Page Setup boxes for most printer types offer at least some way to

reduce the size of the printed image. Other printers let you both enlarge

and reduce.

Be aware that changes you make to the reduction/enlargement con-

trols in your Page Setup box affect the available work area on the docu-

ment screen. For instance, if you plan to reduce a document 50% when

you print it, it stands to reason that if the image on your screen is eight

inches long, it will print four inches long. This has some practical applica-

tion, so you may find it worth taking the time to overcome what might be

some initial confusion.

Suppose, for instance, that you wanted to print inserts for audio

cassette boxes. The inserts can be no wider than foin- inches, the inside

dimension of a cassette box. You could set up a document with a four-

inch text area and type tiny characters into the four-inch screen repre-

sentation of the cassette insert. But it would be better to set the Print
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dialog box to a 50% reduction, then type in eight inches of space on
the screen. This way you can work with large, easy-to-read characters

onscreen, and the text will print out at four inches. Figure 3.3 shows an

example.

Obviously, enlargements, when available, work the opposite way.

Small items on the screen print bigger. Ifyou do a lot of this work, pur-

chase a reduction/enlargement calculation wheel from a graphic arts

store to help you choose the correct ratios. There are also some public

domain programs that will help you compute reduction and enlarge-

ment settings.

FIGURE 3.3

It's often easier to work

large on-screen and then

print reduced copies.
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[ Cancel ]
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[PocumenlTT] S Fractional tUidths Q Print PostScript Ouer Tent

0Use Rs Default

Too Many Drivers • Rob Rjo«
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Tcfcacco Read • Junior Wells*
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Ruler margin markers and page-ending markers do

respond to changes in the reduce/ enlarge box. Page Layout

view and Print Preview features reflect size changes, but do

not display images in their exact dimensions. You need to

actually print and measure to determine the results of your

changes.

Paper
Many of Apple's LaserWriter's offer nine or more paper size and position-

ing options, as shown in Table 3.1 and in Figine 3.4. In this example, a

drop-down menu reveals five of the nine choices.

TABLE 3.1 Common Paper Sizes

CHOICE SIZE IN INCHES SIZE—METRIC (mm)

us Letter

US Legal

A4 Letter

B5 Letter

Tabloid

llx8'/2

14x81/2

81/4x112/3

6.9x10.8

11x17

216x279

216x356

210x297

176x250

279x432

FIGURE 3.4

You oflen have a wide

seledion ol paper sizes

and paper positioning

options to choose from.

s/Tabloid

R3 Tabloid

Enuelope - Center Fed

Enuelope - Edge Fed

Laser lilriter II B5
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Printer Effects

Most laserprinter Page Setup dialog boxes also have choices called

Printer Effects. Here are examples of common Apple LaserWriter Effects.

Font Substitution Laserprinters often have built-in fonts. Different

printers have different built-in font collections. If your document calls

for only the fonts built-in to your printer, font substitution will have

no effect.

However, when you ask Word to print using a font that is not in

your printer's collection, the font substitution effect will choose a similar

laser font. For instance, if your printer does not have New York (most

don't), the printer will use Times instead. The lack of printer-resident

Geneva will often result in Helvetica printing, and so on. Word and your
Mac do a pretty goodjob of maintaining line and page endings in these

instances, but you may cringe at the resulting appearance of your output

as you can see in Figure 3.5.

If you turn off font substitution, jaggy bitmap characters might
print, particularly under System 6. Printing can be considerably slower,

and you may not like the final appearance of the characters. Ifyou are

planning to use a laserprinter, it is best to stick with printer-resident,

TrueType, or downloadable laser fonts, thereby avoiding font substitu-

tion. You will learn more about font technologies in Chapter 8.

Text SntOOtlling Text smoothing removes the "jaggies" from bit-

mapped fonts. As you can see in Figure 3.6 there are times when this

improves the appearance of non-laser (bitmapped) fonts.

You may want to disable this effect if you use only laser fonts, since

text smoothing can sometimes blur characters and slow printing.

FIGURE 3.5

Font substitution will

replace bitmapped fonts

(top) with your laser

printer's built-in fonts

(bottom).

Font Subst i tut i on

Font Substitution
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FIGURE 3.6

Text smoothing (botlom) 16X1 SFTlOOthiriQ Off
removes "joggles" from

bitmapped fonts (top).

Text Smoothing On

GtophttS Smoothing Graphics smoothing removes the sharp

edges from bitmapped graphics, as you can see in Figure 3.7.

There may be times when you will want to turn off this effect. It

sometimes distorts or degrades graphics, and slows printing. Experiment.

foster Bitmap Printing This effect assigns more built-in printer

memory for bitmap-graphic printing, thereby speeding up the printing

of pictures on some older printers. Memory is taken from other printing

tasks. Sometimes this causes the printer to malfunction. It's a good idea

to leave this effect disabled.

FIGURE 3.7

Graphics smoothing

(right) makes bitmapped

graphics (kit) look nicer
&& (Qg

Apple LaserWriter options

In addition to printer effects, many printers have printing options.

(If there is a reason to call some printing features effects and others

options, it is not obvious.) Like effects, options change the way your

printer prints.

In die case of most Apple laserprinters, the options are contained in

a dialog box reached by pressing the Options button in the Page Setup

box. Figure 3.8 is the Options dialog box for an .^pple LaserWriter NTX.
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FIGURE 3.8

A typicol Options

dialog box—for more

fine-tuning!

LaserUlrJter Options

n Flip Horizontal

DFlip Uertical

n Inuert Image

n Precision Bitmap Rljgnment (4% reduction)

[ Cancel ]

I Larger Print Area (Feiuer Domnloadable Fonts)

^Unlimited Domnloadable Fonts in a Document

Flips

The first two options on the LaserWriter hst are Flip Horizontal and Flip

Vertical. They can be used alone or in combination to change the orien-

tation of entire documents. Except for making signs for the front of am-

bulances (like the one in Figure 3.9), it is difficult to imagine a use for

these features.

FIGURE 3.9

Horizontal and vertical

flips are useful in making

signs for Australian

ambulances. aOMAJUaMA
Invert Image
The Invert Image feature makes black areas (including text) print white

and white areas print black. Gray shades are reversed, as well. That is to

say, the lighter a shade is the darker it prints.

Precision Bitmap Alignment
Your screen displays 72 dots-per-inch. Most laserprinters print 300 dots-

per-inch. This disparity can distort the printed appearance of bitmap

graphics that have been created on-screen. Use of the Precision Bitmap

Alignment feature reduces the printed size of bitmap images by 4%,

making them less distorted. Neither Page Layout view nor Print Preview

accurately displays this size reduction.
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Larger Print Area
Many laserprinters require a Vf area of white space around the edges of

an SV'^l 1" printed page. This is pardy because the printers do not have

enough memory to image the entire sheet. The Larger Print Area...

option frees up internal printer memory that is normally reserved for

downloaded fonts, making it possible to print to within approximately
I/4" of the edge of the sheet. It is very helpful when you want to place

page numbers and other header or footer information near the edge of

the paper.

Turning this option on and off does affect screen representations

and the pagination of your document. The changes in available print-

able space are reflected in screen views of document margins, headers,

footers, line endings, and so on. So toggle this option when you begin

your project.

You will be able to use few, if any, downloadable fonts with this

feature enabled.

Unlimited Dovs^nloadable Fonts
This option makes available as much memory as necessary for down-
loadable fonts. The printer will purge and reload fonts as necessary at

the expense of printing speed. Consider adding printer memory or an

external disk drive for your printer if you use this feature regularly. It has

no effect on how documents are displayed.

Fractional Widths
During printing, this feature improves the appearance of propordonally

spaced fonts. It also provides better inter-character spacing. (See Chapter

8 for more on this topic.) Because of display limitations, the Fracdonal

Widths feature sometimes adversely affects the on-screen appearance of

fonts. It also affects line endings, and thus pagination.
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Many experienced users turn Fractional Widths

off while drafting, then turn it back on while performing

hyphenation, or creating the table of contents, index,

and before paginating final drafts.

Print PostScript Over Text
This choice determines whether embedded PostScript (EPS) images will

print on top of or beneath text and other graphics. See Cliapter 4 for

more information about embedded PostScript. Figure 3. 10 shows a file

with EPS information.

IMAGEWRIUR AND STYLEWRITER OPTIONS

ImageWriters, StyleWriters, and other printers often have their own
unique options. Here are several of the commonly seen ones.

Quality
This choice on many dot matrix printers like the ImageWriter increases

speed by degrading image quahty. If you don't mind nasty-looking type

and placeholders instead of graphics, using the ImageWriter's Draft op
tion can sometimes put a draft document into your hands quicker than a

laserprinter! Try it.

50% Reduction
This prints half-size pages which often look better than their full-size

versions. Try it with 24-point type.

Tall Adjusted
This option eHminates the "stretched-out" look of bitmapped graphics. If

your circles look like ovals and your squares look like rectangles, try this

option.
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FIGURE 3.10

Embedded PostScript

images printed over or Mansfield and Associates Clients & Publishers
under other items can

have a startlina effect
AMERICAN BROADCASTING CORPORATION (ABC)

^ AMERICAN INDUSTRIAL REAL ESTATE ASSOCL^TION
ASK MR. FOSTER./FIRSTOURS (CARLSON CORP.)

BEAR STERNS
BERGER & NORTON

CABLE NEWS NETWORK (CNN)
CHILDRENS HOSPITAL OF LOS ANGELES

COLDWELL BANKER
CONSUMER GUIDE COMPUTER BUYING GUIDES

EPSON AMERICA
FADEM & DOUGLAS
FOX TELEVISION

GILLETTE/PAPERMATE
GRUBB & ELUS
HORVITZ & LEVY

INDUSTRIAL ELECTRONIC ENGINEERS
LASER MEDIA

LOS ANGELES COUNTY COURTS
LOS ANGELES DODGERS

LOS ANGELES OLYMPIC ORGANIZING COMMITTEE
LOVE CONNECTION (ERIC LIEBER PRODUCTIONS)

NORTHROP
OCCIDENTAL PETROLEUM CORPORATION

PARTY PLANNERS WEST
PETER NORTON COMPUTING
PRUDENTLVL STEVENSON

QUE PUBLISHING
QUICK TALLY

ROGERS & COWAN PUBLIC RELATIONS
SCIENCE RESEARCH ASSOCL^TES (SRA)

SYBEX PUBLISHING, INC.

WARNER COMMUNICATIONS
XEROX

Print dialog box differences

The Print dialog box is the one you see whenever you choose Print from

the File menu or click on the printer icon in Print Preview. Don't con-

fuse it with the Page Setup dialog box. Here too, dialog-box appearance

changes with printer model. Word 5 adds some of its own features to



PRINT DIALOG BOX DIFFERENCES

Print Dialog boxes. Sometimes non-Apple printer manufacturers make
their own modifications.

The print dialog box
A typical Print Dialog box is shown in Figure 3. 1 1 . We'll examine some of

its more popular features in detail.

FIGURE 3.11

A typical Print dialog

box—note the additional

instructions provided

by Word.
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Section Ranges
Spt-cityiiig priiiliiiir ranges, while normally quite easy, can be confusing if

you've broken a document into sections and asked Word to restart page

numbering in each section. In this case, to print the entire document,

simply check the All button. This is the default condition.

To print selected parts of a docimient y<ju'll need to take some

extra steps. For instance, to print only section three in a four-section

document, leave the Pages choice set to All, then place a 3 in the From

section range and a 3 in the To section range.

Or, to print the entire contents of sections three and four, leave the

Pages choice set to All, then place a 3 in the From section range and a 4

in the To section range.

To print only pages 6 through 10 in section three, place a 6 in the

Pages From box and a 10 in the Pages To box. You must also place a 3 in

the section Range From and another 3 in the To sections range boxes.

Cover Pages
Lasei'printer dialog boxes often offer you the choice of printing a cover

page. Cover pages help separate jobs as they pile up in the printer's out-

put tray. You can choose to have cover pages print at the beginning or

end ofjobs. This makes it easy to spot the beginnings and ends ofjobs

when they are piled together. It also helps people know where to deliver

finished jobs in work groups with shared printers. If you don't need help

like this, save a tree—turn off the cover-page feature.

Paper Source
Mtjst Print dialog bo.ves let vou select a method of feeding paper. The

default is usually cassette or tray feeding for la.serprinters and automatic

or continuous feeding for dot-matrix printers. Some non-Apple printer

makers and sheet-feeder manufacturers' drivers modify this area t)f Print

Dialog boxes. Check your manuals for explanations.

Black and White vs. Color/Grayscale
Many, but by no means all Macintosh computers and printers can repre-

sent color and shades of gray. If your system is color or grayscale capable,

you may want to use these features to improve the appearance of vour
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documents. An in-depth look at color and grayscale issues is beyond the

scope of this book. But the information presented here should be

enough to help you imderstand Word 5's color and grayscale capabilities.

Even if your computer cannot display color or grays, your printer

may be able to print them. Thus, Word 5 lets you define text colors even

on black-and-white computers. See Chapter 8 for more information

about this feature. Moreover, you can paste color and gray graphics into

your Word documents. (Word supports up to eight colors or shades of

gray in graphics.)

Printing colors and shades of gray is usually slower, and some would

say less reliable than printing black and white only. Thus you will have

the ability in most printer dialog boxes to turn color printing on or off.

If you are getting frequent crashes or printer hangs when printing com-

plex documents, try turning off this option.

Printing Selected Items
If you have selected text or graphics in a document, the Print Selection

Only choice will be available in the Print dialog box. An X in this check-

box instructs Word to print only the selected text.

PostScript File Printing

The LaserWriter Print dialog box has a Destination button that lets you

send your document to a disk file, which can be used by phototypesetting

machines and other PostScript-compatible devices.

Print Hidden Text
This checkbox toggles the printing of hidden index-entry codes, Post-

Script instructions, notes to yourself, and so on. With this box X'ed the

hidden text will be printed along with visible text and graphics. Pagina-

tion is affected.

Print Next File

This choice is used when you have created a series of connected docti-

ments and want to print them all. For instance, some authors create

separate doctiment files for each chapter of a book, then use this feature

to print the entire manuscript. See Chapter 24 for details.
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Two-sided printing

Besides saving paper and reducing mailing costs, two-sided printing can

add a professional look to your documents, particularly if you use Word's

odd/even headers and other formatting tricks. You do two-sided printing

by running paper through the printer twice. Be sure to use premium
copier or laser printer paper that doesn't curl too much on the first pass.

m
Unless your printer has an automatic two-sided printing

feature like the one on Hewlett-Packard's LaserJet IIID,

you'll want to use version S.l's new Odd/Even page printing

feature described later in this chapter

It is possible to do two-sided printing without version 5.1, but it

takes extra forethought and more manual intervention. A number of

things affect the actual steps you'll take when you do two-sided printing.

They include:

How your printer delivers printed pages (face-up or

face-down).

The order in which pages from multi-page docviments are

stacked as they are printed (first page on the top or bottom

of the pile).

" Whether your document has an odd or even number of

pages.

Whether or not your printer has a paper cassette or is

hand-fed a single sheet at a time.

WTiether yoiu^ printer prints on the top or bottom of paper

placed in your paper tray.
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Whether pages must be placed in your paper tray head-first

or tail-first for the second pass.

The number of copies you need.

There are several approaches to manually printing two-sided jobs. The
brute force method (which is particularly useful if you need many copies

of the same document) is to print all of the page Is, then place them

back in the printer properly and print all of the pages 2s on the back.

Then print pages 3, and so on.

Another possibiHty is to use your printer's manual feed feature.

(Feed in a plain sheet of paper for page 1, when it comes out flip it over

and reinsert it for page 2, and so on.)

O I P

Experiment on a short (5-page) document first to

get the hang of paper handling and orientation. It will be

different for different printer models. It's very easy to get

confused and place the paper in your printer upside down
or backwards. It's also easy to pick the wrong printer options

for the second pass. Once you determine the recipe for your

printer, consider placing a set of instructions on or near it to

remind you of the steps and page orientations for two-sided

printing.

Odd/even page printing

If you are a version 5.1 user, you will find an additional option in your

Print dialog box. It enables you to print just odd numbered pages orjust

even numbered pages. This makes it somewhat easier to do two-sided

printing on printers that are not equipped for automatic two-pass

printing.

Typically, you start by printing odd numbered pages (1, 3, 5, 7,

etc.), then put the paper back through your printer to print page 2 on
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the back of page 1 , page 4 on the back of page 3, and so on. The trick is

to get the right even numbered pages on the back of the appropriate

odd numbered pages...

Here are the general steps for printing two-sided pages on the

Apple LaserWriter II family of printers which deliver pages face down, in

the correct order (page 1, first, then page 2, and so on). Steps for other

printers may differ, so experiment.

1. Set up the printer so that pages will come out face-down in

the top tray (close the bypass chute).

2. Choose Print from the File menu or use the §€-P shortcut.

3. Make sure the Print Front to Back option box is not checked.

4 Select Odd Pages Only from the Print dialog box.

5. Click on the Print button or press Return to print the odd

pages.

6. Odd numbered pages will arrive face-down in the receiving

tray with page 1 on the bottom of the pile.

7. Inspect the printed pages (they should all have odd page

numbers), then fan and jog them so that their edges all line

up and the pages don't stick together.

8. Place them back in the printer tray with the imprinted side

facing up. Make sure the top of the pages are facing the

end of the paper tray that disappears inside the printer. If

yourjob contains an odd number of pages, do not put the

last page in the tray.

9. Bring up the Print dialog box again and choose Even Pages

Only.

10. (Choose the Print Back To Front option in the Print dialog box.

11. Print.

12. Place the last page back in your finished document if you

set it aside in step 8.
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After using this 1 2-step two-sided printing technique,

check to see that the Print Back to Front option is turned off

the next time you print something.

Print preview

You can bypass the Print Preview and print immediately to hardcopy, but

previewing is advised. It lets you see a screen representation of one or

more entire pages before you print them, often saving paper and time.

If you didn't try Print Preview on the Twain quote when you read

about it in Chapter 2, this would be a good time to experiment. Pull

down the File menu and choose Print Preview (or use the keyboard

shortcut 3§-Option-I).

This will give you an excellent idea of where the text will print on

the paper. You will be able to see margins as well. If your document

contains headers, footers, line numbers, and other embellishments you

will see them represented here.

Notice the icons along the left of your screen. They are actually

buttons, as explained in Table 3.2.

TABLE 3.2

ICON

Print Preview Acfion Icons

FUNCTION

Magnifies part of a page

Adds page numbers

Displays or hides margins

Displays one or two pages

Prints the document
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The top button lets you zoom in and out to better read a portion

of a page. The second button is used for simple page numbering. The
third button turns margin lines on and off. The fourth button switches

between a one- or two-page view. The final button is an icon for your

chosen printer. Pressing it will print the document. Click on it if you

must, but there is more to learn about Print Preview.

If you spot a problei^ in your work, click on either the Page Layout

or Close buttons near the top right of the screen to quit previewing.

Then you can fix the errors and preview again.

Moving margins in print preview

Wliile a complete explanation of margins will have to wait until Chapter

7, here is a quick trick you can try in Print Preview. Notice the margin

lines and square black handle in Figure 3.12.

There are small blocks called handles at the left and bottom ends of

the margin lines. You can move the margins by dragging these handles

with your mouse when the pointer is shaped like a crosshair.

If you are still working with the Twain quote, try centering your text

by pulling the top margin down. If you like, switch to one-page view first by

pressing the fourth button. After you've moved the margin, turn off the

margin lines and see what the printed page should look like.

FIGURE 3.12

Drag the margin handle

to adjust the margins.

Drag margin handles when
the pointer becomes o crosshair

hed

Printing from print preview

Simply click on the Printer icon at the left edge of the Print Preview

screen to bring up the Print dialog box.
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Printing on other systems

If you plan to print finished documents on other computer and printer

combinations, be sure you use fonts that are available on both systems.

Realize too that different printer models have different capabilities. Not
all laser printers can print in the outer half-inch of margins.

Printing labels and envelopes

See Chapters 14 and 26 for envelope and label printing tricks. If you use

version 5.1, be sure to check out the new envelope printing Toolbar but-

ton discussed in Chapter 14!

Background printing

If you use a LaserWriter, StyleWriter or other printer that is compatible

with Apple's background printing feature, you can do other things while

your printer prints. Since some printingjobs can take minutes or even

hours, background printing can be a real productivity booster. Moreover,

you can use the PrintMonitor application to check and control the status

of multiple printjobs.

Your system does all of this by quickly sending printjobs to a file on
your hard disk rather than directly to the printer. It then spools the work
to your printer in the background.

You'll need to be running System 7 or System 6 with MultiFinder

enabled. Check your Apple documentation if necessary.

Enabling background printing

Turn on background printing from the Chooser (reached from the

Apple menu).

1. Open the Chooser from the Apple menu.

2. Click on the icon of a compatible printer.
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3. Check the Background Printing On button.

4. Close the ("hooscr and print as usual.

Your screen should look something like Figure 3.13.

If the Background printing choice does not appear, or if the On
button is dimmed, be sure that the background printing software has

been properly installed in your System folder, and that the printer is

compatible with the version of the background printing software

you are using. Check your Macintosh manuals.

FIGURE 3.13

Control background

printing from the Chooser

ID! Chooser

O

AppteJhs AppleTalk geVriter

LaswVriter

First click on a PrintMonitor-

compatible printer icon

rH.

Select a LaserWriter-

LaserWriter H NTX

Then turn background
printing on or off

O

Background Printing: (SOnQOff

AppleTail<
d) Active

O inactive

Checking the status of a print job

With background printing at work, you can use PrintMonitor to check

and change the status of multiple printjobs. If you are using System 6, to

open the PrintMonitor window, click the MultiFinder icon on the right

end of the menu bar as many times as necessary to reveal the Print-

Monitor dialog box. Under System 7, pull down the Application menu at

the right end of the menu bar and pick PrintMonitor In either case,

you'll see something like Figure 3.14.

You'll see a list ofjobs waiting to be printed (if an)), the status of

the job currently being printed, and buttons for canceling or postponing



BACKGROUND PRINTING

printing. When you are done looking at the PrintMonitor window, you

can close it with the close box, or leave it open and set it aside while you

work in a different window.

D I P

If you always want to have the PrintMonitor window on

your desktop when the Backgrounder is printing, select the

Show the PrintMonitor Window when Printing option from

the PrintMonitor Preferences dialog box. You also have a

choice of how and when PrintMonitor tells you about

printing problems. Reach the Preference settings from

PrintMonitor's File menu. See your Macintosh documen-

tation for details.

FIGURE 3.14

The PrintMonitor lets you

see the status of printing

jobs and cancel or

postpone them.

The job being printed

'

A waiting job

The status of the cunrent

and its source

job-r
irce

PrintMonitor

Printinc

LUaitin qM Rain in Spain Memo @ LaserWriter II NTX O-

O

Cancel Printing
] [ Set Print Time...

J

Printin g Status: LUord 5.1 Rll

Pages To Print; 45

user; Ron Mansfield, document; Word 5.1 All, status:

preparing data
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Canceling background printing

To cancel ajob that is being printed in the background:

1. Open or activate the PrintMonitor window.

2. Highlight the name of the job to be killed (click on its

name in the list).

3. Click the Cancel Printing button.

If there is a printer problem (no paper tray, out of paper, and so on), you

may need to correct the problem before you can cancel printing.

Print monitor error messages

The PrintMonitor can alert you to printing problems as illustrated in

Figure 3.15.

The PrintMonitor icon (depending on how your PrintMonitor

preferences are set) will flash on your menu bar or display a dialog box.

Bring the PrintMonitor window to the foreground to read about and
resolve the problem. You might also get on-screen alerts from time to

time. It is a good idea to resolve printing problems promptly.

FIGURE 3.15

The Print Monilor can

describe specific printing

problems.

Printing Status: lUord 5.1 fill

Pages To Print: 39

user: Ron Mansfield, document: Word 5.1 All, status:

Printer is out of paper

Postponing background printing

To postpone ajob:

1. Open or activate the PrintMonitor window.
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2. Highlight the name of thejob to be postponed (cHck on its

name in the PrintMonitor dialog box).

3. Click on the Set Print Time... button.

4» You'll see a dialog box like the one in Figure 3.16.

5. Either click on the Postpone Indefinitely radio button, or

click in the time and date windows to set a new printing

date and time.

6. Click OK.

7. Close or set-aside the PrintMonitor dialog box.

FIGURE 3.16

The PrintMonifor lefs

you postpone selected

printing jobs.

PrintMonitor

Printing

m Word 5.1 All @ LaserWriter II NIX

(i

Docu
1 page

Spoolf

Uiaitin g

Rain In Spain Mimo @ LaserWriter li

Set Print Time:

® 9:40:26 AM

10/15/92

O Postpone Indefinitely

[ Cancel J

0-





I

\

Working with

Graphics



TRACKS

To draw in the Pitture Window 132

position the insertion point where you want the new drawing to

appear in your Word document. Choose the Picture. . . command
on the Insert menu or click on the ribbon's drawing button (it

contains a circle, square and triangle). The Picture... command
will open a dialog box. Click on the New picture button. (To

avoid this dialog box, click on the ribbon's drawing button.)

The Picture Window will appear. Click on the drawing tools as

needed and draw with the mouse. Closing the Picture Window
inserts your drawing at the insertion point. Frame the resulting

drawing if necessary for proper positioning. (See Chapter 5 to

learn about Frames.)

To resize or s<ale drawings 133

select the drawing in your Word document by clicking on it.

Hold down the Shift key while you drag on the Size handles

(small black squares in the corners and on the edges of selected

pictures). Shift-dragging on corner handles maintains propor-

tions as you increase or decrease the picture's size. Dragging on

bottom and edge handles distorts the shape of the image as you

resize it.

To trap or trim drawings 135

select the drawing in your Word document by clicking on it.

Drag on the Size handles (small black squares in the corners of

selected pictures) without holding down the Shift key to hide

parts of the drawing.



To rotate text 144

position the insertion point where you want the rotated text to

appear in your Word document. Open the Picture Window. Use

the Picture Window's text tool to enter text. Use the rotate tool

and your mouse to rotate the text. (The rotate tool looks like a

circular line with an arrowhead.) Close the Picture Window to

insert the rotated text. Frame the resulting text if necessary for

proper positioning.

To import graphUs 148

position the insertion point where you want the imported draw-

ing to appear in your Word document. Choose the Picture. .

.

command on the Insert menu. Use the file and file type lists to

locate the desired graphic file. Click the Insert button to insert

the file. You can also import graphics by pasting them into

Word from the Clipboard.

To position grophits 155

use paragraph formatting techniques to position graphics (cen-

ter, align right, etc.) , or see Chapter 5 for information about

framing graphics.

To flow text around graphi<s 155

insert graphics in frames as described in Chapter 5 and position

the framed graphic in the text. Use Page Layout view or Print

Preview to see the graphics in position.



Drawing in Word's Picture Window

Using the Picture Window to rotate text

Resizing and repositioning graphics

Importing graphics

W ORD V'ERSIONS 5.0 and 5.1 let you do

^H more with graphics than any preceding

versions. The Picture Window is one example of that added power. You

can use it to draw diagrams, create forms, design logos, and more. For

example. Figure 4.1 shows an organizational chart created entirely in the

Word 5 Picture Window.

There are many, many other sources of graphics. For instance, you

can include Excel graphs in your Word documents. It is possible to place

single frames from QuickTime movies into Word documents. This chap-

ter shows you how to use the Picture Window's drawing tools, and how to

import graphics created by other sources.

FIGURE 4.1

This organizational chart

is a typical Picture

Window creation.

k J^

O
^^

Insert Picture

President

VT Ssles VT Ad niin
VT Baked

Goods

lol-l \<-



OPENING THE PICTURE WINDOW

Drawing in word
In general, the process works like this. With a Word document window

open and active, you open the Picture Window and draw. The graphic

will appear at the insertion point in your Word document when you close

the Picture Window. In order to save a picture thus drawn, you must save

the Word document itself.

Opening the picture window
Open the window either by clicking on the picture icon in the ribbon or

choose Picture... from the Insert menu. If you use the Picture... com-

mand, you will also need to click the New Picture button in the resulting

dialog box, as shown in Figure 4.2.

m A R N I N G

If you use Word's Easy Install option, the Picture. .

.

conunand is automatically installed for you. If you did a

custom installation and failed to include the Picture. .

.

command, rerun the Installer and add the command.

FIGURE 4.2

Click the picture icon or

choose Picture. . . from

the Insert menu to get the

New Picture dialog box.
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The tool palette

The Picture Window contains a collection of tools in something called

the Tool Palette. You click on these tools to activate them, then use your

mouse to draw, fill, and so on.

m
Version 5.1 has one more tool than version 5.0.

Figure 4.3 shows version 5.rs palette.

FIGURE 4.3

The Picture Window tool

palette lets you draw

objects, add text, and

restyle drawn elements.

Selection tool

Line tool

Rectangle tool

Ellipse tool

Rotation tool

Front/back tool

Text alignment tool

Arrowhead tool

Line color tool

Fill color palette

Sample box »

t^



DRAWING IN THE PICTURE WINDOW

rectangle. Then you could duplicate the rectangle several times, connect

the boxes with lines, and add text and shading effects.

D I P

When using the Picture Window, start your drawings

as close to the upper-left corner of the picture Window as

possible to minimize the amount of white space that will

accompany the drawing when it is pasted into your Word
document.

Here are the steps for creating the sample org chart with added in-

formation about the tools.

The rectangle tool

Click on the rectangle tool button. It will darken. This is how you know
which tool you are using. Next, click and drag with your mouse to form a

box of the desired size and shape, as shown in Figure 4.4.

D I P

To draw a square, hold down the Shift key while you drag.

Notice the status area in the lower portion of the window. It dis-

plays the height and width of the box as you drag. When you let go of the

mouse button the box will be selected, with handles in the corners and

in the center of all four sides. These can be used to resize the rectangle.

Hold down Shift when you drag a handle to maintain the object's

proportions.
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FIGURE 4.4

Draw a rectangle about

the same size as the one

in the figure.

k



DRAWING IN THE PICTURE WINDOW

Duplicating objects

To recreate the sample organizational chart, you could attempt to draw

three more boxes exactly the same size and shape as the first. But there's

an easier way.

If the object you wish to duplicate (the rectangle in this example) is not al-

ready selected, select it. Tlien click on the duplicate tool, which looks like three

st^gered rectangles. Each time you click on the duplicate tool, it creates a copy

of tlie selected objects. Click this button three times. Notice how the tool stag-

gers or cascades the copies. Move the duplicates to their proper locations.

Moving objects

To move an object, first select it, then drag it with your mouse. Do not

point to the selection handles when yovi are attempting to move an ob-

ject (see Figure 4.5). This will resize or crop it (you crop an image by

dragging its corner handles without pressing Shift). Undo can restore an

object's original size and shape if you act immediately.

D I P

Once selected, objects can be "nudged" a pixel at a

time by using the four arrow keys on your keyboard.

FIGURE 4.5

Select graphic elements

and drag them, but don't

point to the resizing handles

wAen moving things.
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Drawing and sizing straight lines

Use the line tool to draw straight lines. It is located under the selection

tool in the palette. You can draw horizontal, vertical, or angled lines.

O I P

If you hold down the Shift key while dragging, Word
wiU help you draw straight horizontal or vertical lines, as

illustrated in Figure 4.6.

As you drag a line, the status box shows its length. Once you have

drawn a line, you can make it longer. First select the line. Handles will ap-

pear at each end. Use them to drag the line to the desired length.

FIGURE 4.6

To draw straight

horizontal or vertical

lines, hold down the Shift

key while dragging.

P v:5= ^ Insert Picture = llj



TYPING TEXT IN THE PICTURE WINDOW

Typing text in the picture window
Word permits text in the Picture Window with a few style and formatting

restrictions. By the same token, it is possible to do things with text in the

Picture Window that you can't do in a document window. For instance,

you can rotate text in the Picture Window, then insert it into a Word
document.

When working in the Picture Window, you create text in text blocks

or boxes. These are rectangles with invisible sides and exaggerated han-

dles. The word President in Figure 4.7 is an example.

To create text in the Picture Window:

1. Click on the text tool (the letter A in the palette).

2. Click in the Picture Window.

3. Change the font, size, and other character formatting

choices using Word's menu bar (not the ribbon or Toolbar).

4 Start typing and Word automatically creates a text block.

5. You can resize text blocks by dragging their handles, and

the text will wrap and flow to fit the new block size or shape.

6. To edit or change the appearance of text after you've typed

it, select it first.

FIGURE 4.7

t'resident
"

Text is typed in blocks. ' k

Moving text in the picture window
Text blocks can be moved like any other picture element. In Figure 4.8,

the President block has been dragged on top of a chart box, then resized

to the length of the box. Dragging the text block to the length of the
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FIGURE 4.8

This text block has been

moved and resized.

IS
1^



GROUPS OF OBJECTS

titles in the sample organizational chart were centered by dragging the

text blocks to make them the length of the boxes, then selecting the text

blocks and picking Align Center from the drop-down text alignment
button menu.

Groups of objects

While version 5.0 does not have a group objects feature, it is possible to act

upon multiple picture elements if you first select them simultaneously.

For instance, if you wanted to move the entire organizational chart you
could do that by choosing Select AJl (3€-A) from the Edit menu, then
drag all the elements at once. Or, if you just wanted to move someone's
box and their name at the same time, you could Shift-click to select both
the name and the box, then move them together.

m
Version 5. 1 has a specific tool you can use to group and

ungroup objects. Read more about it next.

Version s.rs GROUP TOOL

Wliile you can still shift-click to select and work with multiple picture ele-

ments in version 5.1, the Picture Window's new Group tool provides a

better alternative. Among other things, it has the advantage of saving

grouping information with your drawings. It lets you easily create com-
plex objects from collections of smaller pieces. Figure 4.9 shows it at work.

In Figure 4.9 there are three graphic elements (a box, a horizontal

and a vertical line). Choosing Group all from the tool's drop-down menu
will turn all three elements into a single one.
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FIGURE 4.9

Version 5. / 's Croup loot

lets you create complex

graphic elements from

collections of simple ones.

=1 1^^
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2. Click on the Group tool in the Picture Window.

3. Chose the Ungroup Selection option.

4b All selected graphic elements will become one.

O I P

You can create large groups by grouping smaller

groups. For Instance, you could create small groups each

consisting of an organizational chart box and the text within

the box, then create a large group by grouping all of the org

chart boxes and connecting lines together.

Line, fill colors, and patterns

The Picture Window offers a variety of fill patterns and colors if your

Mac is equipped to support them. Simply select the desired object, then

use the appropriate line and fill color palettes or pattern tool to apply

your choice to selected items.

If you have a color display you'll see the chosen colors on-screen. If

you have a color-capable printer the colors will print. If your system dis-

plays and prints shades of gray, colors will be represented in grays.

Drawing polygons
Figure 4.10 shows examples of most of the Picture Window's shape draw-

ing tools at work. The head was drawn using the polygon tool. The
eyeglasses were drawn with the rounded rectangle and line tools. The eye

was drawn with the ellipse tool, the smile with the curve tool. Our
friend's hair was created with the arc tool, then filled.
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FIGURE 4.10

You can create a variety

of shapes with the

drawing buttons and tools.

To create polygons:

1. Choose the polygon tool in the Picture Window.

2. Click once to create the first anchor point.

X Drag in the direction of the next desired polygon corner.

4i Click to establish the corner.

5. Repeat steps 3 and 4 until the shape is complete.

6ii Either double-click to complete the polygon or finish by

clicking on the initial point a second time.

Line width, length, and
- arrowheads

Word 5 offers a choice of nine line widths (thicknesses) and three types

of arrowheads. They are specified by choosing from pop-up menus,

which are reached from the arrowhead and line-width buttons on the

palette shown in Figure 4.1 1.

You can either specify line width and arrowheads before lines are

drawn or you can draw lines, then change their width and arrowheads.
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FIGURE 4.11

You can specify line

thickness and arrowhead

appearance either

before or after you've

drawn lines.

k
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X Click and drag in the appropriate direction to make lines.

4k Release the mouse button.

Changing line thickness or arrowheads
To change the appearance of lines, select them by clicking (or shift-click-

ing) then use the line thickness and arrowhead tools to change their

style. In Figure 4. 11 we've selected a horizontal line with a left arrowhead

and are about to select a new line thickness.

Changing line length and position

To change the position of a line, select it and drag. To change a line's

length, select it and drag on either end.

Bringing layers forward or
— sending them back

You've already seen items stacked on top of each other. The text blocks

were placed on top of the organizational chart boxes, for instance. These

graphic elements are said to be in layers. Generally, the last thing you

draw ends up on top. Sometimes this is not what you want. Suppose, for

example, that after creating an information sign (as in Figure 4.10), you

decide to draw a box to enclose it like the one in Figure 4.12.

After drawing the box over the sign you could use the Send to Back

choice on the front/back tool to place the box behind the sign. The

finished picture would look like Figure 4.10.

Rotating and flipping

The Picture Window lets you rotate and flip objects as you can see in Fig-

ure 4.13. Here we've typed the words You will flip over Word 5.0, dupli-

cated them once, flipped them vertically, and changed the flipped words

to a lighter color to create a reflection effect. We've also pasted a flv from
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FIGURE 4.12

An opaque box covers

the information drawing.

=1 l^=
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Using clip art and imported
— graphics

Word's built-in drawing capabilities make it easy for yon to draw your own il-

lustrations, logos, and the like. But what if you want to use commercially

prepared clip art, or scanned copies of your company logo, or photos

from a video-capture device? In general, if you can get a graphic image

to your Mac's Clipboard, you can usually get it into a Word document.

Word also offers features that let you import graphic images directly

from disk files. And, if you are rimning System 7, or MultiFinder under

System 6, you can create or edit graphics in one program and move them

into Word via your Clipboard. System 7's Publish and Subscribe features

can also be used with graphics as long as both applications support this

feature.

Word 5 will accommodate images created in many different formats

including:

" PICT and PICT2 (drawing programs)

Bitmap files (paint programs and scanners)

" EPS (Encapsulated PostScript) files

TIFF files (graphics programs, scanners, video boards, etc.)

You can either paste images directly using your Clipboard, or use

Word's Pictiue... command to import the graphics. We'll explore both

techniques, but let's start with an overview of graphic technologies.

Types of graphics

Whole books have been written about the various graphic standards now

supported by computer makers. The nice thing about standards is that

there are so many of them. With apologies to the technically inclined,

here is a brief overview of the kinds of graphics files Word 5 can import.

The general advice is to try inserting any graphic file that interests you.

Word will tell von if it cannot handle it.
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Bitmap

m

The original Mac standard—bitmap images—are found everywhere.

Paint programs like MacPaint create them. Programs like SuperPaint

create bitmap images in their paint layers. Bitmap pictures are made
up of tiny dots.

Scanners can create bitmap images. Shareware companies and

users groups distribute disks containing all manner of bitmap graphics

from pictures of farm animals to things that would make a sailor blush.

Mail-order catalogs runneth over with them. Word supports 8-bit images

and will convert others (24-bit, 32-bit, etc.) to 8-bit.

A R N I N G
T

Word's Picture window is aii 8-bit window. If you open

and then edit 24 or 32-bit images with the Picture Window,

they will be converted to degraded 8-bit images. If you don't

want your beautiful 32-bit color images converted to raggedy

8-bit images, don't edit them with the Picture Window. If you

do this accidentally, a quick Undo will restore them.

PiCT

PICT and PICT2 files are Apple-standard files created by drawing pro-

grams like MacDraw and in the draw layers of programs like SuperPaint.

Tirr

There are many variations on the TIFF format. Word supports many but

not all of the growing number of TIFF variants. Screen-capture programs

and video boards often create TIFF files. So do many scanners. Some
TIFF formats include file compression techniques that may not be com-

patible with Word. Word converts these to the PICT format.
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Postscript (eps)

PostScript graphic files are created by programs like Adobe Illustrator

and Aldus FreeHand. Most of these images consist of two parts—the

PICT file you see on-screen and the embedded PostScript file sent to

your printer. Word can use both. There is even a PostScript style choice

in Word, useful for inserting PostScript printing files into your Word

documents. Be aware, though, that PostScript files can get pretty big.

Many programs like Adobe Illustrator let you copy both PICT and

embedded PostScript to the Clipboard simultaneously. Generally, this is

done by holding down the Option key when copying. See the manuals

that came with your graphics programs for details.

Wlien you insert files like these, you get both screen and printer ver-

sions (PICT and EPS).

a I p

It is a good idea to save your woric before experimenting

with graphics, since memory problems and other gremlins

can occasionally lock up your machine when graphic files are

encountered!

Importing with picture

Start by positioning the insertion point where you want to place the

graphic. The Picture... command (located on the Insert menu) reveals

a dialog box like the one in Figure 4.14. Use it to locate and insert

graphics files.

Scroll if necessary to select the graphic of interest, then double-

click on the file name or click once on it, and then click on the Insert

button. You may see an alert box like the one in Figure 4.15 telling you

that Word is converting the graphic.
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FIGURE 4.14

The Picture. . . command

lets you load graphic files

from disk artd place them

at the insertion point in

your document.

Select a Graphics File or Create a Neui Picture:

iQBrt !
3050 Business EPS Art

Q 3051 EPS Maps
O SSmnt CaiR8ra.eps

;

D 3947 Color Backgrounds u.1

CD 3949 Color Space Photos
a 4003 Rnimals u.l

D 4015 Clip Rrt u.4

List Files of Type:
|
Graphics Files

O

o

1=3 21 0MB EHternal

781 9K auailable

[Qnsertj]

[Cancel
j

[Desktop]

Find File...

[ Nem Picture ]

FIGURE 4.15

Word automatically

converts most graphics to

compatible formats.

Conuerting EPS file.

29%
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Importing graphics with
- your clipboard

If you can get a graphic to your Clipboard, Word 5 can probably display

and print it. This is a great way to move things. Here are the general

steps:

1. Start the graphics program, then load or create a graphic

using the program.

2. Select the graphic and copy it to your Clipboard with the

graphic program's Copy command. (Remember, this will

replace whatever is currently on the Clipboard, even if you

put something important there with Word!)

3. Switch to Word and open the document needing the

graphic. (If you have System 7 or MiiltiFinder and enough

RAM, you can run Word and your graphic program simul-

taneously and flip back and forth without quitting

programs.)

4i Move the insertion point to the place in the Word docu-

ment where you want to place the graphic.

5. Use Word's Paste command on the File menu or use the 3€

or F4 function key shortcuts.

Using your scrapbook with
— word graphics

Your Scrapbook can be used to store frequently-used graphics. Here an

the steps for storing and using graphics with your Scrapbook.

Storing graphics in your scrapbook

1. Select the desired graphic (from your Word document, the

Word Picture Window, or some other graphics program).
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2. Copy the selected graphic to the Clipboard with the Edit

menu's Copy command or appropriate keyboard shortcut

(usually 3§-C or F3).

X Open the Scrapbook with the Scrapbook command on your

Apple Menu.

4. Paste the graphic with the Edit Menu's Paste command or

appropriate keyboard shortcut (usually 3€-V or F4).

5. The pasted graphic will appear in the Scrapbook.

6. Close the Scrapbook by using its close box.

Inserting graphics from the scrapbook

Once you've placed graphics in your Scrapbook, you can copy them to

your Clipboard, then paste them into Word documents. You scroll

through yoiu" Scrapbook's contents as illustrated in Figure 4.16.

The general steps for copying things from your Scrapbook to a

Word document are:

1. Position the insertion point in your Word document.

FIGURE 4.16

Open the Scrapbook

from the Apple menu,

scroll to the desired item,

and then copy and paste it

into your document.

=i 1 = Scrapbook ^^^^^^=^^^^^^
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2. Open the Scrapbook from the Apple Menu.

3. Scroll to the desired item in your Scrapbook.

4* C'opy the selected graphic to the Clipboard with the Scrap-

book Edit menu's C.opy command or appropriate keyboard

shortcut (3€-(:orF3).

5. Close the Scrapbook with its close box, or click in your

Word document window to set-aside the Scrapbook.

6. Paste the graphic with the Word Edit Menu's Paste com-

mand or appropriate keyboard shortcut (9§-V or F4).

Graphics as glossary entries

As you can see in Figure 4. 17, it is also possible to store graphics as glos-

sary entries, and then insert them as you would any other glossary entry.

This is a great way to quickly insert signatures, logos and other

design elements that you use regularly. Chapter 16 is important reading

since it goes into the details of Glossaries, but the following information

might let you postpone a trip to that chapter.

FIGURE 4.17

You can save graphic

elements as Glossary

entries then quickly insert

them in Word documents.

Glossary

•print time mith seconds
•print year long

• print year short

Recycled Paper lu/Logo
• section

Stiortcut

•subject

O

O

[Qnsertj)

Define
J

[Delete]

( Close
]

Shom:

Name:

Standard Entries M User Entries

ler lu/Ll

D



EDITING GRAPHICS IN YOUR WORD DOCUMENTS

Creating glossary entries for graphics

To save a graphic as a Glossary entry:

1. Create or insert the desired graphic in a Word document.

X Select the graphic in your Word document.

3. Choose the Glossary... command from the Edit menu or

use the 3€-K keyboard shortcut.

4b Type a name for the Glossary Entry in the Glossary

window's Name box.

5. Click on the Define button.

6. Close the Glossary Window (with its close box).

Using glossary entries with graphics

1. Position the insertion point where you want to place the

graphic.

2i Open the Glossary either from the Edit menu or via the S€-K

keyboard shortcut.

3L Either double-click on the name of the desired glossary

entry, or select the entry name by pointing to it, then click

on the Insert Button.

Editing graphics in your
- word documents

To use the Picture Window to edit graphics in your Word documents:

1. Double-click on the graphic. This will open the Picture Win-

dow and place a copy of the graphic in the window.

Z Make the desired changes and close the Picture Window.

3b The updated graphic will replace the old one.
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Remember that the Picture Window converts 24- and 32-bit

graphics to 8-bit graphics when you do this. Another way to edit

Word graphics is to copy them to your Clipboard, paste them into a

graphics program so you can make the changes, and then paste the

changed graphic back into your Word document.

Linking graphics to keep
- them current

It is possible to place linked copies of graphics in Word documents that

will be automatically updated when changes are made to the original

graphics. See Chapter 28 for details.

Placing QuickTime stills
— in word documents

If your Mac is equipped to play QuickTime movies (see Chapter 30 for

details)
, you can copy single QuickTime frames and Paste them into

Word documents as still pictures. It's a great way to illustrate text, create

storyboards, and so-on. Figure 4.18 illustrates this.

Here are the General steps, (see Chapter 30 to learn more about

QuickTime):

1. Play the QuickTime movie and click on the Pause control to

freeze the movie at the desired point. Use the forward and

Rewind controls if necessary to reveal the desired frame.

2. Copy (or cut) the still image to the Clipboard.

3b Position the insertion point in your Word document.

4» Paste the resulting PICT image into your document.
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FIGURE 4.18

You can paste QuickTime

stills like these into Word

documents.

IDI Storyboard

iNormal

j=^
2B nmm mEm b^ T71TTT1 gfTTrfl

1 . P 1 -^

Opening shot: Street scene,

we hear cablecar bell

Cablecar oomes into view
vdoe-over begns

[Logo shows on back of

cable car

Page I INormal :m: is

Positioning graphics in word— documents
There are a number of techniques for positioning graphics in Word
documents. Perhaps the easiest is to treat graphics Hke paragraphs and
use Word's paragraph ahgnment tools. For instance, in Figure 4.19, a

graphic has been selected, then centered with the ribbon's center button.

For more precise control over the position of graphics (and other

objects), and to force Word to flow text around graphics and other ob-

jects, insert them in frames—the topic of our next chapter.
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FIGURE 4.19

You can position graphics

using most paragraph

alignment tools.
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To frame fixed-width objetts 164

select the text or other object(s) you wish to frame. Use the

Frame... command on Word's Insert menu (not the one on the

Format menu). Word frames the selection in a frame that is

the width of the space between the margins or column in a

multicolumn document, and switches to Print Preview. Drag the

framed item to the desired position.

To see where framed ifems wiil print 164

switch to Print Preview (i€-Option-I), or Page Layout view

(9€-Option-P).

To frame objetts and adiust their widths 165

select the text or other object you wish to frame. Use the

Frame... command on Word's Format menu (not the one on

the Insert menu). Word opens the Frame dialog box. Specify

frame width, distance from text, and other parameters, then

click on the position button. Word switches to Print Preview.

Drag the framed object to the desired position.

To position frames predsely 165

from the Frame... command on the Format menu specify the

desired position of the frame (Center between margins, for

instance).



To move framed items 165

to move framed items to a new position on the same page,

switch to Print Preview (3S-Option-I) and drag the frame. To

move a framed item to a different page, cut and paste in

Normal or Page Layout view, then switch to Print Preview to

fine time.

To flow text around framed items 166

drag framed items into text. There must be room for at least 1"

of text all around the frame.

To unframe framed items 171

select the framed item and choose the Unframe option in the

Frame dialog box reached with the Frame... command on

the Format menu (not the one on the Insert menu).



Ways to position graphics, text, and other

objects

Word 5's replacementfor the Position

command

w ORD MAKES IT easy to position

^^m graphics and text just about anywhere

in your documents. A device called a frame gives you impressive control

over where objects are placed and how much white space surrounds

them. Think of frames as devices that reserve space for specific things in

your documenLs.

You can drag framed items with your mouse in Print Preview to

place them in a new posidon by eyeball, or you can tell Word to position

frames in specific locadons on pages relative to other items like columns,

margins, and so on.

Many types of objects can be positioned with the techniques

described here, including paragraphs, single characters, graphics, equa-

tions from the Equadon Editor, tables, spreadsheets, and charts from

spreadsheet packages, or Word B.l's new Graph feature.

Since frames can contain text, they are ideal tools for placing words

in unusual places like the margins of your documents or in the middle of

other text to create things called outquotes.

Figure 5.1 shows frames used to create dropcaps, rotated text in the

right margin, outquote text and graphics spanning two columns, another

outquote in the left margin, and a framed graphic with text flowing

around it.

Users of earlier Word versions may remember the Position command.

Frame... is the '90s replacement for that sometimes awkward feature.

It is worth noting that the command Frame... appears on two

Word 5 menus. Insert and Format. The two choices do slightly different

things, and those differences are important, as you will soon see.
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FIGURE 5.1

Use frames to position

text and graphics.

Frames can be used -

to create drop caps

Framed text and graphics -

can span multiple columns

Use frames to place^*- Fiy me piano, Ron
u . , II • • Fly the plane-

outquotes in margins

Text will flow around -

framed objects

Rotated text and graphics

can be positioned with frames

A Business Lesson at 2,000 Feet
Ron Manstield

]I recently started learning

J how to fly gliders, a long-

I time ambition of mine. In

the process. I've learned something

that is very relevant to the art of

small business computing.

While Hal. my flight instructor

and I walked to the plane last week
the talk turned to emergency proce-

dures. "What's the fir^t thing to do if

you are solo and discover a rat-

tlesnake in your glider at 2000
feef" He asked.

I blurted out something about

avoiding quick leg movements and

making a radio request for a precau-

tionary ambulance. Hal tickcd-off

three or four more nightmares thai

had occurred at or near our desen

In one case, three seasoned

pilots appear to have simultaneously

wrestled with the same bumcd-out
indicator lamp. They were all

completely oblivious lo audible low

altitude warnings from their cockpit

instruments; and ignored inquiries

from puzzled air traffic controllers.

Investigators believe that none of

the flight crew members even
looked out a window!

We do the same thing in busi-

ness. Just today I got a call from the

CEO of a nine-month old. mulD-mil-

lion dollar startup manufacturing

company. We talked for ten minutes

about the rapid growth of his busi-

ness, the challenges of managing
far-flung offices, and so on. Then he

That busy CEO had no business spending three

hours, much less three days writing a computer

program, but that's exactly what he had done ^
airpon, "What if you hear a loud

clunk in the tail section? What if the

rear canopy blows off?" And so-on

Each lime 1 had a different opinion-

a reaction. I suppose, to the stated

problem. Each time 1 was wrong.

"You should do the same thing im-

mediately and continuously in each

situation ". Hal said more firmly

than I'd ever heard him before. "Ry
the plane. Ron . . Fly the plane

'

The answer
sounds too obvious

at first, since ,^„
"flying the plane" is

something that you
would expect pilots

to do automatically

But^

mere have been

several disastrous

commercial jet crashes apparently

because entire crews have focused

on relativity small distractions while

thciT planes flew themselves straight

into the ground.

got to the real purpose of the call-

what he thought was the rattlesnake

in his cockpit He had personally

spent three days trying to integrate

an order entry program from one
software vendor with a general

ledger program from another maker.

It would save his company about

$3,000 since they could avoid buy-

ing the complete set of accounting

modules that included his favorite

order entry program. He wanted to

know if he should

keep trying to force

the two dissimilar

^ products to work
» together He also

talked about using a

complex database

management
package to

personally program

a new order entry program from
scratch. He never once mentioned
spending the extra $3000 for a com-
plete set of compatible accounting

modules, or hinng someone else to

do the programming

Framing items

You frame things by selecting them and using the Frame... commands

on the Insert and Format menus. It is possible to frame a single item like
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a graphic, a word, paragraph, or single character. You can also fratne mul-

tiple items as long as they are contiguous. For instance, you could frame

a graphic and its caption. You can only see the true printing position of

framed items in Page Layout view or Print Preview.

The frame position that you specify becomes a part of the selected

paragraph's formatting, and is stored with the paragraph's paragraph mark.

There are several ways to spot framed items in Word documents.

You can tell an item is framed by the way your mouse pointer behaves

when it passes over the item in Print Preview. Framed items cause the

pointer to become a crosshair—the indication that you can move them.

When you select framed items in other views, they are surrounded

by outlines and handles. In Normal view, framed items also have small,

black, non-printing boxes at their left edges. You may also see these black

boxes next to things that are not framed. They indicate paragraphs that

contain formatting features that won't become evident until you switch

views or print. (In this case, Word is telling you the paragraph contains

frame positioning information.)

D I P

When you insert some items (like pictures from the

Picture Window), the items appear to be framed in Normal

and Page Layout views. You will find, however that when you

switch to Page Layout, you will not be able to move these

items until you have really framed them with Frame. .

.

commands on either the Insert or Format menus as

described next.

Frame... on the insert menu

The Frame... command on the Insert menu is easy, and often the best

choice for ihings that ha\'i' fixed widths which you don't want to change
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—tables, giaphics, and charts, for instance. The general steps for fram-

ing with this command are:

1. Select the item or items to be framed.

2. Choose Frame... from Word's Insert menu (not the Format

menu).

3. Word will create a frame that is the width of the current

paragraph or column, insert the selected item(s) into the

frame, and switch to Print Preview.

4b Point to the frame (the mouse pointer becomes a crosshair).

5. Drag the outline of the frame to the desired position.

6. Wait for Word to redraw the page with the frame and its

contents in their new position. (See the tip that follows.)

7. Repeat steps 4 to 6 if necessary.

D I P

To hasten the starting of page redraw in Print Preview,

click outside of the page itself (in the button or dark gray

areas, for instance).

Frame... on the format menu

The Frame... command on the Format menu is best when you need to

change frame widths. For example, if you want to place an outquote in a

margin, and if the outquote text you want to frame is wider than the mar-

gin, you can specify a frame width that will fit within the margin and

cause text to wrap within the frame. Use the Frame... command on the

Format menu to do this. Here are the general steps:

1. Select the item or items to be framed.
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2, Choose Frame... from Word's Format menu (not the Insert

menu).

X Word will display the Frame dialog box.

4. Specify the desired width for the frame by typing in the

Frame Width box. Enter dimensions in inches (in or "), cen-

timeters (cm), or picas (pi)— 1.5 in, for instance.

5. Use the drop-down lists to specify a location for the frame

(as described in a moment), or click the Position... button.

6. Word will switch to Print Preview.

7. Change the position of the frame if you wish, by pointing to

the framed item (the mouse pointer becomes a crosshair),

and dragging.

Framing fixed-width items

Perhaps the easiest way to frame is to select something and use the

Frame... command on the Insert menu. In Figure 5.2, a graphic has

been selected by clicking on it with the mouse.

With the item selected, the Frame... command from the Insert

menu is issued. Word automatically switches to Print Preview, making it

possible to drag the graphic just about anywhere, including into the mar-

gins. In Figure 5.3 the frame is being dragged into the text area which

will cause the text to flow around the graphic.

FIGURE 5.2

Begin the framing

proceis by selecting the

item(s) you wish to frame.
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I spend lots of time looking over people's shoulders Its amazing how
much computer power goes untapped Many users learn the basic

features of one or two popular programs, then put away their

manuals forever When more advanced projects come along these

users (often painfully) apply their basic skills rather than cracking

the books to learn about advanced features that could make Uiem

•u-

^^gr^ -
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FIGURE 5.3

Drag the outline in Print

Preview to reposition your

framed object.

n fnd
lojs of time looking over people's shoulders. It's amazinghcw|

k conaputer power goes untapped. Many users learn the basic

ires of one or two popular programs, then put away their

ualsjDiever. When more advanced projects come along these

iUserrTolron painfully) apply their basic skills rather than cracking

ithe books to learn about advanced features that could make them
much more efficient. This is narticularlv true of soreadsheet and

When you release the mouse button, Word will move text as re-

quired, then recompute all of the line and page endings necessary to ac-

commodate the new graphic position. Eventually, it will redraw the page

with your giaphic in place. Be patient. This is no small task.

D I P

While you drag, the top of your screen will display

statistics indicating the distance of the left edge of your

frame from the left edge of the page. A similar statistic is

provided for the top of the frame and page. Watch these as

you drag to help reach the desired position.

The frame dialog box at work
While the dragging process just described is fine for most uses, it is pos-

sible to be much more precise by using the Frame dialog box, reached

with the Frame... command on the Format menu (not the Insert menu).

This command has the added advantage of letting you specify the width

of the frame.

The example in Figure 5.4 was created by selecting the graphic,

choosing Frame... from the Format menu, and then using the horizontal

and vertical positioning menus to center the graphic on the page. (It is

also possible to type specific measurements into these boxes, instead.)
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FIGURE 5.4

The Frame dialog box

(from Frame. . . on the

Format menu) lets you

specify precise positions,

frame widths, and

white space.
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Microsolfs Kxcel spreadsheet ol -

fer a hundred or more functions

Some programs like Wingz, the

Informix spreadsheet pack-
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Let's use Microsoft Works
as an example to learn

more about the gej S

It IS a much better (and as you'll

soon see, safer) way to add -up
columns of numbers than

specifying each cell that

needs to be included in the

total Suppose, for instance

that you wanted to add the

contents of the ten cells A

1

through and including A 10

Frame

pHonzontal
1



REPEATING FRAMED OBJECTS ON MULTIPLE PAGES

Repeating framed objects
— on multiple pages

If you wanted a logo or other framed object to appear on every page of

your document (or within a section), place the frame in a header or

footer, then position the object either by dragging in Print Preview or by

using the Frame dialog box, reached by choosing Frame... from the For-

mat menu. Figure 5.5 shows an example of this.

FIGURE 5.5

Place the frame in a

header or footer then

position the object

anywhere you want. It will

print on all pages.

Current about M f> fl 2 page
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in 1982 by Ron Mansfield
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To position objects properly on mirrored pages, use the Frame

dialog box (reached from the Format menu) to specify the object's

horizontal position as Outside or Inside relative to the Page.

To FRAME OBJECTS IN VIEWS

When you work in Normal view you see framed items where they were ini-

tially created, not where they will actually appear on the printed page.

Switch to either Page L.ayout view or Print Preview to see where framed

items will print. Figure 5.6 illustrates this.

Framing text

The two different Frame. . . commands react differently to the way you

select text. If you select a few words or a character, then use the Frame...

command on the Insert menu. Word automatically inserts a paragraph

mark, and frames only the selected text.

The Frame... command on the Format menu, however, will frame

the entire paragraph containing the selected text and any other text

in the paragraph containing the insertion point.

D I P

It is often a good idea to remove or adjust indents

when framing text, since they can sometimes cause Word to

display and print text in long vertical strings if the indents

are too wide or the frame too narrow for the text. Figure 5.7

shows an example of the problem.



FR,\MING TEXT

FIGURE 5.6

Normal view shows

framed Hems where they

were created while Print

Preview or Page Layout

view shows them in their

printing positions.
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FIGURE 5.7

Remove indents and

make frames wide

enough so text doesn't

display and print in long

vertical character strings.

Editing and formatting
- framed text

Within reason, yon can embellish framed text just as you would any other

text. Use the ribbon, ruler, and menu commands on selected text.

Frame positions as styles

The positioning information you create when you position frames is

stored with the paragraph mark following the graphic. Positioning infor-

mation like this can be defined as a style and used over and over with dif-

ferent graphics!

For instance, you could select the graphic in Figure 5.4 and define a

new style called Center Frame in Page or whatever. Then the next time you

wanted to center a graphic in a page, all you would have to do would be

to select the graphic and apply the style. Quicker than you could say "Bill

Gates has a nice house," Word would position the graphic in the center

of the page. See Chapter 13 for more about styles.



TABLES: AN ALTERNATIVE TO FRAMING

Deleting or unframing framed objects

To delete a framed object, select then cut, clear, or use the delete key

to remove the frame itself and the paragraph mark after the frame.

Tojust unframe something without deleting it, select all of the

framed elements, then choose Unframe from the Frame dialog box

reached with the Frame... command on the Format menu. DeleUngjust

the paragraph mark after a framed object will also unframe it.

Tables: an alternative to framing

Somedmes you may find it easier to use tables as positioning devices, par-

ticularly if you want to create multiple columns with text and graphics

next to each other like those in the storyboard example in the preceding

chapter. Read more about tables in Chapter 10.





Managing

Your Files
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To open Word files 177

double-click on Word document icons in the Finder to launch

Word and load the document. From within Word, use the Open. .

.

command on Word's File menu or its keyboard shortcut §€-0.

System 7 users visit the drop-down list above the scrollable list to

open the appropriate disk and folder System 6 users change

disks with the Drive button. Double<lick on the desired file

name in the scrollable list to load the document. Version 5.1

users can click on the Toolbar button that looks like a file

folder (2nd from the left on the Toolbar).

To open non-Word files 179

start Word by double-clicking on the Word icon in the Finder.

From within Word, use the Open... command on Word's File

menu or its keyboard shortcut 3€-0. Version 5.1 users can click

on the Toolbar button that looks like a file folder (2nd from

the left on the Toolbar). Use the List Files of Type drop-down

list to specify the kind of files vou wish to view and open (Mac-

Write, text, graphics, etc.) Use the drop-down list above the

scrollable file name list to open the appropriate disk and folder

(or the Drive button in System 6). Double<lick on the desired

file name to load the document. Word will convert the file if

necessary or tell you that it can't.



To find lost files 182

use Word's Find File... command on the File menu. Specify a

drive using the Drop-down Drive list (or a Drive and a folder

using version S.l's Location list). Enter search criteria includ-

ing file names or portions thereof, information contained in

the file's Summary Info (author, subject, etc.), and date ranges

if they will help you narrow the search. Click OK and view the

resulting list. Click on file names to view their contents. Click

the Open button to open the desired file.

To save normally 189

use Word's Save command. The first time you save an untitled

file you will be asked to name it and specify a location for tlie file.

If you have the Summary Info feature turned on you will be

prompted for Summary information (author's name, subject,

etc.).

To save to different disk drives 190

system 7 users should visit the drop-down list in the Save As. .

.

dialog box (just above the scrollable file list) to select and open

the appropriate disk. Or use the Drive button in System 6. If

you plan to save to a floppy disk, insert it first.



A review ofpaths (folders)

Ways to locate lostfiles

Word's Find File. . . Summary Info commands

Important information about backups

Working with Non-Word documents

I OUR HARD DISK can contain hundreds

^H or even thousands of files. If you work in

a large, networked organization, you may have access to ten times this

many documents. If you've ever misplaced a file you know how frustrat-

ing and time-consuming trying to find it can be.

Word 5 provides two features to help you organize and locate files.

They are called Find File... and Summary Info..., both found on the File

menu. For those of you new to the Mac, we'll start with a quick review of

the concept of files and folders, and something related called a path.

Files, folders, and paths

Your Macintosh lets you arrange your files in a hierarchical structure.

Files (Word docimients, for instance) can be stored in folders. Folders

can be also be stored within folders. Figure 6.1 shows an example of this.

In the example, there is a folder called *Client Files. It contains all

of the client-related folders and files for this computer. Within the

*Client folder there are three client folders, one for each client (CNN,

Berger Norton, and Xerox). Each of these client folders contains addi-

tional folders and files relating to the particular client. For instance, the

Berger Norton folder contains the B &: N Tasks and progress folder, in

which project-related memos, lists, and reports are stored. The Berger

Norton folder also contains tjther folders with billing and contract infor-

mation, hardware information, etc. If you were to open the Xerox folder,

you might find a similar arrangement of Xerox-specific files.



OPENING PREVIOUSLY SA\'ED DOCUMENTS

1 FIGURE 6.1
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riGURE 6.2

From the Open dialog

box, use the dropdown

menu to open to the

folder containing the

document you need.
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Find File...

[Desktop]

J
DRead Only

list Files of Type:
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Uiord Documents S

be opened. In cases where vou have folders within folders, you will need

to visit the drop-down list more than once.

If you open one folder too many, re-visit the list and choose the

folder above the one you last opened.

WTien you see the file (the document) that you want to work with,

double-click on the document name or just click on it and press Return.

If you click Read Only, you will not be able to make any changes to the

file; yovi will be asked to save any edits to a new file.

Notice that Word's Open dialog box has two devices you may not

have seen in the Open dialog boxes of other Macintosh programs. The

first is a drop-down menu titled List Files of Type. This menu lets you

restrict the types of files that you will see in the scrollable list. For in-

stance, you can ask to see only stationery files, or only Word documents,

or only MacWiite documents, and so on.

The second new choice in the Open dialog box is a button labeled

Find File.... This takes you to a Word feature that helps find lost files and

round up collections of files meeting specific criteria.



OPENING PREVIOUSLY SAVED DOCUMENTS

D i P

Double-clicking on Word document icons in the Finder

will launch Word, if necessary, and load the document.

Here are the general steps for opening Word documents with Word
running:

1. From within Word, use the Open... command on Word's

File menu or its keyboard shortcut §€-0.

2i Use the drop-down Hst above the scrollable list to open the

appropriate disk and folder.

3. Double-click on the desired file name to load the document.

m
Version 5. 1 users can click on the Toolbar button that

looks like an open file folder (2nd from the left on the

Toolbar), to reach the Open dialog box.

Opening non-word documents

Each different word processing program (MacWrite, WordPerfect, etc.),

creates document files containing unique control codes for things like

character attributes, margins and so forth. Frequently, if you use one

word processing program to open a document created by a different pro-

gram, you will see these codes which look like unintelligible gibberish in-

termixed with the document's text. Margins may be different. Fonts and

line spacing will often change.
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There are third-party file conversion programs that can minimize

these problems (like Apple File Exchange, and Word for Word).

Microsoft Word also has some file conversion capabilities of its own. It

uses converters stored in your Word Commands folder. Many of the con-

verters are automatically placed in your Word Commands folder during

the standard Easy Installation procedure. A few others must be dragged

there manually. With all of the converters in place, Word can open and

save the following file types:

Earlier Macintosh Word versions (1.0, 3.0 and 4.0)

Word for DOS versions 1 .0 through 5.5

All Word for Windows versions

All Microsoft Works for the Macintosh versions

MacWrite II and MacWrite 4.5 and 5.0

WordPerfect for DOS versions 5.0 and 5.1

Documents saved in Rich Text Format (also called Inter-

change or RTF)

" Documents saved as text only

- A variety of graphics files (EPS, TIFF, PICTl and PICT2)

m
Version 5. 1 users will also be able to use Word directly

with Macintosh WordPerfect version 2.0 files and Microsoft

Excel files. Word 5.1 also has improved MacWrite 11,

WordPerfect DOS, and Windows MetaFile converters.

Don't expect exact parity when moving documents from one pro-

gram or computer to another. You will probably need to make some
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formatting changes, deal with line ending differences and so on. Here

are the general steps for loading Non-Word documents:

1. From within Word, use the Open... command on Word's

File menu or its keyboard shortcut §€-0.

2. Point to the List Files of Type drop-down list to pick the

kind of files you wish to view and open (MacWrite, text,

graphics, etc.).

3. Use the drop-down list above the scrollable list to open the

appropriate disk and folder.

4b Double-click on the desired file name.

5. Word will convert and load the document or alert you to

the fact that it cannot do the necessary conversion.

6. Inspect and clean up the document.

7. Save it as a Word document if you plan to use it with Word
in the future, or use the Save As... command to save it in

the originating program's format if that's where you will be

working on the document in the fiUure.

O I P

If you find yourself dealing with DOS or Windows
documents on diskettes, purchase a program like AccessPC

for yoiu- Superdrive-equipped Mac. Programs like these let

you read and write MS-DOS diskettes on your Mac.

Opening documents as read only

If you wish to open a document as read only to prevent yourself from ac-

cidentally making changes to the disk file, click on the Read Only option

box on the Open menu.
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Moreover, Stationery documents are always opened as read only.

When you open a stationery document then make changes and save

tlieni, yon will be automatically prompted for a different file name.

Stationery is discussed in more detail in Chapter 15.

Find file

Don't confuse Word 5's Find File... feature with the Find File desk acces-

sory found on some Apple menus. Word's Find File... (reached by choos-

ing Find File... from the File menu) is a powerful tool that helps you

locate, list, sort, examine, open, and print documents based on simple or

complex search criteria. You can examine your Mac's hard disk(s) or

even search a server or shared drive over a network. Both Word and non-

Word files can be located using this feature.

Suppose, for instance, that you recall creating a list of projects for

a client, but you don't remember where you saved the list. Find File...

can help.

Start by choosing Find File... from the File menu or by clicking the

Find File... button in Word's Open dialog box. You will see a Search

dialog box that looks something like Figure 6.3.

FIGURE 6.3

Word's Find File... does

much more than Apple's

desk accessory of the

same name, like

displaying this Search

dialog box.

Search

File Name:

Title:

Rny TeKt:

Subject:

Ruthor:

Uersion:

Keyujords:

projects

Finder Comments:

Created
(S) On Hny Day O From: ' /^ '

ED
Cancel

OriLies:
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It gives you a number of places to type restrictive search criteria, an

area to specify restrictive date and time ranges, plus three drop-down

menus.

m
If you are usingWord version 5.1, the Drives drop-down

list will be tided Location. You will also see file folders listed

in addition to disk drives. Open folders to restrict the search.

As you may have gathered from Figure 6.3, Find File... lets you

make very specific requests. Lets look at several examples.

Searching BY FILE NAMES
Continuing with the case of the missing project list, let's say you remem-

ber that the file name contained the word projects. Typing that word

alone in the File Name entry area of the Search dialog box and clicking

OK or pressing Return will cause a rapid search of the disk specified in

the Drives drop-down menu (a drive called 210MB External in Fig-

ure 6.3).

Soon you will see a new dialog box titled Find File, listing all of the

files containing the word projects in their filenames. As you can see from

Figure 6.4, it's possible to learn a lot from this box.

In our example, three files have been found. By clicking on the name
of a found file you can examine it more closely. The View drop-down

menu lets you see the contents of the file or review its statistics (creator,

creation date, size, etc.). The window then displays available info. If you

have entered summary information or added comments using your

Mac's Get Info feature, you can read that information here as well.

Clicking the Open button at the bottom of the dialog box will open

the document like usual. Clicking Search... will take you back to the

Search dialog box. Print... opens the document and presents the Print

dialog box. If you click on the folder name above the list of files, you can



THE WORD FOR THE MAC HOW-TO BOOK Chapter 6

FIGURE 6.4

Find File creates a list of

files meeting your search

criteria.

View Statistics

Author Ron Mansfield

Version Final

Type Word Document

Created Ron Mansfield

Mon, Apr 1, 1991 2 06 PM
Last Saved Ron Mansfield

Fri,Dec 27, 1991 12 17 PM
Characters 5439
Size : 1 OK

Title

B & N Projects

Subject

consulting projects

Author

Ron Mansfield

Version

Final

Keywords
projects, Berqer,

Norton, client

Contents

^Content*
statistics ^
Comments

• Summary Info

Q75 last 4 projects

A Projects

-O

o

Organization

Pick & Announce In-house Lead

Person & Alternates For

Vord Processing

Lit Support Databases

Admin &. Other Databases

Making DAT Tapes Off-site

Storage

Telecom Tasks : Liaison,

Vestlaw, Dialog, etc.

Database Design Reviews o
rSearch TcHt

1GD0

[[
Open

]]
[search...]

[
Sort...

] (
Print...

]

use the path menu to view additional files. The Sort... button is one of

several devices designed to help you deal wdth long lists of documents

meeting your criteria.

Dealing with large lists

Suppose we had found a hundred files containing the word projects in

their names, rather than just three? You could click on each name in the
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scrollable list and manually examine the files. But there are quicker alter-

natives such as the Sort. . . button in the Find File dialog box. It brings up

another dialog box like the one shown in Figure 6.5.

If you know the approximate time frame of a project, date sorts

will help you narrow down the list to examine. If you knew this was a big

document, a sort by file size might help, and so on. The sort feature also

lets you place lists in ascending or descending order. Click the appro-

priate radio button. When you are satisfied with your criteria, click OK
or press Return.

Another alternadve is to redo the search with more specific criteria.

Clicking the Search... button will take you back to the Search dialog box

where you can add further restrictions using the File Types drop-down

menu. For instance, you can list only files that contain specific words or

phrases; or you can listjust files of a specific type. If you've entered sum-

mary information, you can use it to restrict searches. Here's how:

FIGURE 6.5

find File's Sort... button

lets you arrange long file

lists by name, size, type,

creation date, or last

saved date.

Date Created ^
File Name
File Size

File Type

•/Date Created ^
Date Last Saued

Sort By:

Sort Order: (g) Ascending
[ cancel 1

O Descending

Searching inside documents

Searches on file names alone are the quickest, and are recommended as

the starting point for searches of any but the smallest disk drives. But if

you cannot find a file with a file-name search, or if you find too many
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flics contaiiiiiisr the search word, it is possible to ask Word to look inside

each file on the disk being searched and list only those files containing

the word or words meeting your criteria. Find File... searches enure

Word documents including headers, footers, and hidden text.

The criteria it uses is called search text. You enter it in the j\ny Text

box in the Search dialog box. You need to use the same care when speci-

fying search text that you use with Word's Find... and Replace... com-

mands. If you are too specific, you may miss the file you are looking for.

Use too vague a search string, and you will get excessively long file lists.

Suppose, for instance, you want to round up everything you've writ-

ten about DAT (Digital Audio Tape). If you use DAT as your search text,

Word will also list files containing the words database, date, and Datsun.

This example illustrates a subtle point about search text: casing is irrele-

vant. Placing a space after DAT in the search string solves that problem.

Several wildcards work here. You will type them from the keyboard.

For example, Sm?th will find both Smith and Smyth. The wild card ^W
searches for white space. See chapter 19 for more about Find and

Replace wild cards that can be used here too.

Once you've entered search criteria in the .Any Text section of the

Search dialog box and started the search by clicking OK or pressing

Return, Word will start examining the contents of your disk. This can

take a while.

D I P

To cancel a long, needless search use the 3§-. (period)

shortcut.

Eventually a Find File window will appear. Select the file of interest.

Then, use the Search Text arrow buttons shown in Figure 6.4. Word will

display and highlight each occurrence of the specified text in the view area.

Incidentally, the Search Text arrow buttons work regardless of how
you find files. You need not first specifv text in the Any Text portion of

the Search dialog box. Simply type in any text string you want to search

for and press the searching arrows.
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fiND FILE... AND SUMMARY INFO.

Ifyou and your colleagues have been religious about entering consistent

summary information, you can use the Find File... feature to search for

those entries. That's the purpose of the Tide, Subject, Author, Version,

and Keywords entries in the Search dialog box.

Just remember that if youVe created documents and failed to put
your name in the author box when creadng summary-info, or if you
somedmes type your whole name and other dmes use your initials, you
run the risk of missing documents when your Find File... search criteria

include summary info search restrictions.

Naturally, documents created with other programs (like Word 4)

that do not collect summary info will be ignored as well.

n
Written policies and procedures regarding file naming

and summary information entries can be a big help in law

firms and for publishers, and other organizations with

networks and thousands of files.

Try it you'll like it

If you haven't already done so, search for your Twain Quote using some
of the summary info you entered when you initially saved the document.

Multiple searches

There are times when you will want to do multiple searches. For in-

stance, in our earlier example, you may discover that sometimes you
referred to DAT in documents by the complete name and not the
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acronym. You'd need to search once for DAT and a second time for Digi-

tal Audio Tape to find each relevant document. If you use multiple disk

drives you will need to perform multiple searches.

Combining Searches
The classic combined search works like this. Search for the first criteria

of interest (Any Text: = DAT for instance). Review the list in the Find File

window.

Then click Search... to return to the Search dialog box. Pull down
the Search Options menu near the lower-right corner of the dialog box.

Choose Add Matches to List. Change the search criteria (to Digital

Audio Tape, for example) . Then run the new search. The resulting list

will contain documents meeting either criteria.

You can combine the results of different types of searches. For ex-

ample, you can search first by file name, then by author, and so on.

Searching Multiple Disks
If you have more than one disk drive on your computer, or if you want to

search both your computer's disk and other drives on a network, you

must do multiple searches. The results of the searches can be combined

using the techniques previously discussed to give you one list for all

drives. Here's how that works.

Search your first drive. Re-visit the Search dialog box and pick a

new drive from the Drives list. Be sure to change the Search Options

choice to Add Matches to List. Rim a new search on the second drive.

Repeat as needed until all drives have been searched.

Using Multiple Searches to Restrict Lists

So far, you've seen multiple searches used to make lists longer. It is pos-

sible to use the Search Only In List on the Search Options menu to make

lists shorter. Do your search, then click Search... to return to the Search

dialog box. Pick Search Only In List from the Search Options menu.

The next time you search. Word will only examine files listed in the

previous search list. It is a way to narrow down your search without time

consuming trips through irrelevant files and folders.
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Deleting files in word
Here's a worthwhile addition to your Word menu. Add the Delete...

command by visiting the Commands... command in the Tools menu
(3€-Shift-Option-C) . (See Chapter 31 to learn how to add menu items.)

The Delete... command lets you delete imwanted documents

without returning to the Finder, as shown in Figure 6.6.

FIGURE 6.6

Delete... is o useful tool

you can add to Word's

File menu with the

Commands. . . command.

Delete Document:

IQ B & N Tasks & progress

D Month 1 Status report

D Ron's Projects

D Task assignments

D Task tist Memo

^3 2IDMB EKternal

82995K auailable

^3
Cancel [Desktop]

IDK to be deleted

Saving initially—a review

You've already learned the basic steps for saving in Chapter 1. Here's a

review and some additional information about saving.

Until you save your document for the first time, it resides

only in RAM and will be lost if there is a power failure or

other malfunction.

Save about every fifteen minutes or whenever you are

interrupted.

Turn on Word's automatic save reminder if you have

trouble remembering to save. (Use the Open and Save

category in the Preferences dialog box to enable

reminders.)

Always save before printing.
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Save before you do complex tasks that might drastically

alter your document, like using the Replace... command or

hyphenating.

To save initially, select Save from the File menu or use the 3€-

S keyboard shortcut. (Version S.l's Toolbar has a button

that looks like a floppy disk. It will also start the Save process.)

Pay attention to the part of the Save dialog box that tells

you where Word plans to store your work.

To specify a different save location, use the drop-down list

located just above the scrollable file (or the Drive button in

System 6).

Type a name for your document in the Save Current Docu-

ment as box, then simply click the Save button or press

Return. Names can be up to 31 characters. Do not include

colons (:) in your file names.

You needn't type anything in the Summary Info dialog box,

and you can prevent it from even appearing. But if you plan

to keep many documents on your hard disk, and particularly

if you will be storing things on a crowded network server, it

is a good idea to use this new Word 5 feature.

Saving as you work
Once you've named a document and specified a place to save it, vou'll

not see the Save As... or Summary dialog boxes when you save unless you

request them. A quick trip to the Save command in the File menu, or bet-

ter still the key combination 3€-S will save your work whenever you desire.

So will clicking the Save button on version S.l's Toolbar. Save early,

often, and always before you print or make major changes.

The Save As dialog box shown in Figure 6.7 is the System 7 dialog

box. System 6 users won't see the Desktop and new Folder buttons. Nor

will they see the down-pointing arrow next to the current folder.

Here is a list of the options vou'll see in the Save As dialog box and

some information about their use; followed by examples of typical save
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FIGURE 6.7

Ffie Save As dialog box

lets you name files and

control a variety of save

options.

Drop-down list (System 7 only)

Current folder or drive name / Current drive and space indicator

) Ron's llcH '^\

a *Entrepreneur

D 2001 Quotes
— » (i

ACCOUNTING CHECKBOOKS
ACCOUNTING INllOICES

-G-

O

en Ron's IICK

558K auailable

Saue Current Document as:

[[
Open

i|
. f s:jpi:1 ]

[cancel] [oesktopj

( Neuj CH ]

D Make Backup

Saue Eile as Type-

Normal "[^ n»»?fn"» for nte

— Scrolling document and folder list Command buttons

operations. Remember that System 6 users will see a dialog box that looks

slightly different from the one shown in Figure 6.7. Refer to the figure

for help locating various parts of the dialog box as you read about them.

Current folder or drive name
This box shows the current drive or folder name. Unless you tell Word to

do otherwise, this is where it plans to save your work. In System 7 you can

point to this box to see a drop-down list of the folders and disk drives.

The document and folder list

This scrollable list shows the contents of the current folder (or drive).

The list might include Word documents, folders, and non-Word files and

folders. You can use this list to open different folders (or drives) thereby

causing Word to save your work in a location you specify.
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Current drive

This area shows the current drive and the amount of free space on that

drive (558K in the Figure 6.7 example). Unless you tell Word otherwise,

this is the drive where your work will be saved.

Save current document as box

This is where you type and edit document file names that should not ex-

ceed 31 characters. Don't use colons (:) in file names. You cannot use

the same name for two files in the same folder.

The command buttons

The actual buttons you see here will change depending upon which ver-

sion you are using and what you are doing. For instance, if you have a

floppy disk inserted in your floppy drive, and if you make that floppy the

current disk, the Eject button will no longer be dim. System 6 users will

see a Drive button in place of the System 7 Desktop button shown here.

The Open Button changes to a Save button when you can save.

In Figure 6.7 the button reads Open since a folder has been

selected in the scrolling list. Clicking the button (or double-clicking on

the Folder name) will open the folder and display the Save button.

Make backup option box

Beware the Make Backup Option box! When you choose this option,

Word copies the most recent disk-resident version of your file before

saving your current changes to the original file. This is not a true backup

for several reasons described elsewhere in this chapter.

Fast save option

The Fast Saves option causes Word to save just your changes most of the

time rather than making you wait while it rewrites your endre document

to disk each time you save. While this option can let you get back to
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typing and editing more quickly, it consumes extra RAM, and can create

real recovery problems if you have trouble with your disk while working

on a big project. If you do want to use the feature, it must also be

enabled in the Save and Open preferences. See Chapter 31 for details.

O I P

Many experienced Word users leave Fast Save off.

Save FILE AS TYPE LIST

This drop-down list lets you specify non-Word file formats when you save.

Compatibility with other programs will vary based on which Word features

you use and which other programs you plan to exchange data with.

Default FOR FILE

An X in this box tells Word that you want to use the specified non-Word

format whenever issuing the Save command. Remove the X and change

the file Type to Normal to save Word documents as Word documents.

Saving under a different
- file name

Normally, once you've named a document, Word will keep saving the

document under the same name. Use the Save As... command to save

a document under a different file name.

1. If necessary, make the document you wish to save the active

document, then choose Save As... from Word's File menu

or use the Shift-F7 shortcut.
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2. Type a new file name in the Save Current Document as area

of the dialog box. Since this area is already highlighted, you

can just start typing.

X Specify a new folder and disk location if you wish, then click

the Save button or simply press Return.

4 FiUure Saves will use this new name and location.

Saving to floppy and other
- disk drives

Normally, once you've saved a document. Word will keep saving the docu-

ment to the same disk and into the same folder you initially specified.

Use the Save As... command (Shift-F7) to save a document to a different

disk or to a different folder.

1. If you plan to save to a floppy, insert it into your Mac's floppy

drive. If you plan to save to a different hard drive, be sure it

is turned on and moimted. If you plan to save on a server, be

sure your network connection has been established, and that

the desired server drive is moimted. (See your Macintosh

manuals or contact your network manager for assistance.)

Z If necessary, make the document you wish to save the active

document, then choose Save As... from Word's File menu
or use the Shift-F7 shortcut.

3. Specify the desired disk drive in the Save dialog box by click-

ing the Drive button repeatedly in System 6 until you see

the drive that you want, or by clicking the Desktop biUton

in System 7. The Desktop button in System 7 displays the

available disks in the scrollable list. When you've chosen

the appropriate disk (or a folder on that disk), click the

Save button or simply press Return.

4k Future Saves will use this new name and location.
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Creating new folders while saving

System 7 users can create new folders without leaving Word by clicking

the New Folder button in the Save dialog box, then specifying a location

for the new folder and gi\ing the folder a name. System 6 users will need

to return to the Finder to create new folders.

Saving in non-word formats

Just as you can open non-Word files with Word, you can save your work in

Non-Word formats. Use the drop-down Save File as Type list in Word's

Save As. . . dialog box to specify the desired file format.

Dos AND WINDOWS FORMATS

When saving files that will be used on DOS and Windows computers,

restrict document file names to eight characters (no spaces), plus a three

character extension. Letter to Bob is not an acceptable DOS or Windows
file name for instance, while BOBLTR or BOB.LTR are acceptable. Some
word processing programs expect specific file extensions. Check with the

documentation that came with your DOS or Windows programs for

details about file naming rules and conventions.

When your disk gets full

Occasionally, when you attempt to save. Word will tell you that there is

not enough room for your project on the current disk. You may even get

an insufficient disk space message seemingly out of the blue. This is be-

cause Word sometimes creates temporary files that need disk space of

their own. There are several things you can do in this situation.

Use the Save As command to sa\'e to a different hard drive on

your Mac or perhaps to a different hard drive elsewhere

on your network.
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Use the Save As command to save to a floppy disk.

Swiic li lo the Finder (requires System 7 or System 6 under

MultiFinder), and delete old unwanted files, empty the

trash (an important step), then switch back to Word and

attempt to save again.

Use Word's optional Delete... command which is unfor-

tunately not automatically displayed on Word's File Menu.

On the theory that some people reading this paragraph may be in a

panic since the first three options aren't available, here's a way to use the

Delete... command even if it is not installed on your Word File menu:

1. Choose Commands... from Word's Tools menu (or press

§€-Option-Shift-C if some tiukey removed the Commands...

choice from your Tools Menu).

2. Scroll to the Delete... choice in the list of commands that

will appear. (Don't confuse this with the many other Word

commands containing the word delete. You want Delete...)

3. Click the Add button to add the Delete... command to your

File menu.

4b Close the Commands dialog box by using the Close button.

5. Use the new Delete command on your Word File menu to

free-up some disk space by choosing and deleting unwanted

files.

6. Try to save your Word document again.

7. Delete still more old files if necessary.

After you've saved successfully, use the Finder to clean up that cluttered

disk of yours or buy a bigger one. To learn more about adding com-

mands to your Word menus read Chapter 31.
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Getting a save reminder

If you want Word to remind you to save regularly, you can turn on the

Save reminder by following these steps:

1. Choose tlie Preferences. . . command from Word's Tools menu.

2i Click on the Save and Open Disk icon as shown in Figtne 6.8.

3. A list of Save options appears like the ones shown in Figure 6.8.

4b Click on the Save Reminder option box to place an x in it.

5. Enter the number of minutes between reminders (15 is the

default).

Once you've turned on the reminder, Word will bug you any time you've

gone longer than the designated period without saving. You may lose a

few characters if you are typing when this alert pops up. Check your

work. See Chapter 31 for more about the Preferences command.

FIGURE 6.8

Enable save reminders

and specify the time

between reminders with

the Open and Save

category in the

preferences dialog box.

Preferences

7t^

Op«n And Sav«

Default Font

Spe-lling

^ Hliuays Interpret RTF

D Rlii>ays Make Backup

D RlloiD Fast Saues

n Prompt for Summary Info

Saue Reminder Euery Minutes
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Making file backups— for safekeeping

Its a fact of life. Hard disks fail. Floppy disks are easily damaged. Fires,

floods, winds, and earthquakes destroy computers and the files stored on

their disks. Pimks walk off with them. Nice people like you and I acciden-

tally delete important files. Computers and software have a mean-spirited

habit of trashing your important work-in-progress, usually when you are

in a big hurry.

You need to make regular backup copies of your important Word
documents, and you need to store those files far enough away from your

computer so that they will siuvive a neighborhood disaster.

The easy way to save small, simple files is to copy them to floppies.

Use Word's Save As... (Shift-F7) to place copies of important documents

on separate disks which should be stored away from your computer. Or
you can save entire folders to floppies using your Mac's Finder. (Consult

your Apple documentation if you need help with this.)

For big Word files and large collections of documents, consider

backing up to removable portable hard disks, or look into tape backup

systems.

Whatever you do, don't rely upon Word's automatic Backup feature

as your only backup method! Backup files created with this automatic fea-

ture will almost never contain the most recent changes you've made.

Many experienced users leave this automatic backup feature turned off

and take active responsibility for backups themselves. (Turn it off in the

Open and Save category of the preferences dialog box. See Chapter 31

for details.) If your organization has a computer support person or net-

work manager ask about backup policies and procedures.

Recovering damaged files

If, while working in Word, there is a power failure or other gremlin that

causes your computer to lock up or otherwise misbehave, you may find

yourself with a damaged document that will either refuse to load, or be

missing information. If you have taken the advice earlier in this chapter,

and turned off the Fast Save featiue, you may be able to recover most of



RECOVERING DAMAGED FILES

m

your recent work by loading the appropriate temporary file that Word

has probably placed in your System folder. Here are the general steps:

1. Quit Word, then from the Finder (with Word not running),

open your System folder and look for files with the word

Temporary and a number following them (Temporary-3,

for instance).

2. Move these temporary files out of the system folder.

3. Check their dates and times. Chances are one or more of

them will have dates and times approximating the crash

time. These are the ones you are after.

4. When you find likely candidates, name them some-

thing else.

5. Launch Word.

6. Use the Open command with the All Files choice in the List

Files of Type box.

7. Attempt to open the renamed temp file(s).

8. Cut or copy the salvageable stuff into a new or existing

Word document.

A R N I N G
T

Never delete or rename temporary files when Word is

running. Quit Word first.
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polloitnng Word's oum organization. Part II logically

explores most ofthe tools used to control the overall

appearance ofyour document. You 'II learn about setting

margins and indents, changing characterformatting, ad-

justing line spacing, setting tabs, creating tables, headers,

footers, sections, styles, and much more.

"Jliis is where the rubber meets the road. The tricks you 11

learn in Part II can turn any beginner into an ac-

complished wordsmith. Read itfrom start tofinish. Later

it'll make a good reference tool.

.4
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To thange margins 208

use the Document. . . command on Word's Format menu or the

3€-F14 keyboard shortcut. Type desired top, bottom, left, and

right margins in the margins boxes. Or you can switch to Print

Preview and drag margin handles.

To treate mirrored margins for fadng pages 212

choose the Mirror Odd/Even option in the Margins section of

the Document dialog box. Reach it with the Document... com-

mand (§€-F14) on Word's Format menu.

To <ontrol repagination 216

turn automatic repagination off or on. Clear the Background

Repagination check box in the General Preferences dialog box

reached with the Preferences... command on Word's Tools

menu. To force repagination use the Repaginate Now com-

mand on the Tools menu. Version 5.1 users with wide enough

screens can use the Toolbar's Repaginate button.

To forte manual page breaks 217

position the insertion point where you want the new page to

begin. Press Shift-Enter or use the Page Break command on

Word's Insert menu. Version 5.1 users with wide enough screens

can use the Toolbar's Page Break button.



To remove manual page breaks 218

select the manual page break mark (a thick dotted line) and

delete as you would any other character—with the Delete key,

for instance.

To keep things together on a page 218

select the items you want to keep together, then choose the

Format menu's Paragraph command (3§-M). Choose the Keep

Lines Together or Keep Paragraphs Together options. Click OK.

To <ontrol willows and orphans 221

turn this feature off or on from the Document dialog box

reached from the Format menu. Click in the Widow Control

check box to remove the X and allow widows and orphans.



Ways to adjust the white space around pages

Tipsfor documents that will be bound

Tipsfor two-sided printing

How headers andfooters affect margins

Ways to control page breaks and pagituition

Ways to keep things on the same page

Controlling widows and orphans

I HE WHITE SPACES around the four

edges of a Word 5 page are determined

primarily by margin and optional gutter settings. (Gutters add extra

white space for bound documents.) One set of margin and gutter set-

tings is used for an entire document. Your choice of paper size, paper

orientation (portrait vs. landscape), and margin, and gutter settings work

together to determine the size and shape of the text area of the pages in

your document.

Larger margins and gutter settings decrease the available text area

while increasing the surrounding white space on each page. Figure 7.1

shows the Word 5 default margin and text-area dimensions for both

portrait and landscape orientations when creating U. S. letter-size docu-

ments without gutters.

Get off to a good start

Since margin settings (and Page Setup information) all affect pagina-

tion, it is a good idea to define these dimensions right when you begin a

new project. This will give you a better grasp of the page covmt and over-

all look ol the docimienl as you work. You can always fine-time margin

settings just before final printing.



GET OFF TO A GOOD START

FIGURE 7.1

Margin settings, paper

size, and orientation are

three of the many factors

that affect the available

text area.

Default top & bottom margins

1-inch wide

Lett margin

1 25-inches
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any book!) If you plan to have different left and right margins in a two-

sided document (a wide left and narrow right, for instance), it is useful

to think of these as inside and outside margins rather than left and right

margins, since the wide margin will be on the left of odd-numbered

pages and the wide part on the right side of even-numbered pages.

You'll learn how in this chapter.

If you use headers and footers, you will want to know how they inter-

act with margin settings. Word makes this all fairly painless.

Remember, some printers cannot print at the extreme edges of a

page. This can be a consideration when setting margins.

Document margins vs. indents

Don't confuse Word's margin settings with its paragraph indentation fea-

ture. A Word document can have only one user-specified left margin set-

ting and only one user-specified right margin setting, but each

paragraph can have a different left and right indentadon setting.

Indents are added to margin setdngs. That is to say, if you specify a

1.0" left margin and a V2" left indent, your text will print 1 V2" from the

left margin. If you set a 1.0" right margin and indent the right edge of a

paragraph 1.0", the text will stop 2.0" from the right edge of the page.

See Chapter 9 to learn more about indenting.

Changing document margins
There are three ways to set margins. The most straightforward method is

to use the Document dialog box reached from the Format menu. (If you

have an Extended keyboard you can use the 36-F14 keyboard shortcut to

bring up the box.)

It is also possible to drag margins using the margin handles in Print

Preview. This lets you see the results of margin changes after a slight

repagination delay.

Finally, you can drag margin brackets in Normal and Page Layout

views. The margin brackets are located on Word 5's ruler. Let's look at all

three techniques, starting with the dialog box.



CHANGING DOCUMENT MARGINS

D I P

Document margins are affected by your printer choice,

page orientation, and other decisions made in the Page

Setup dialog box. Choose your printer, if you have more
than one, then use the Page Setup command on the File

menu to make any necessary changes before adjusting

margins.

The document dialog box margin settings

Figure 7.2 shows the Document dialog box. You are invited to enter new

Left, Right, Top, Bottom, and Gutter margins. After you type in each

new setting, press Tab to move to the next box. As with other Word

dialog boxes, enter fractions as decimals (V4" would be 0.25, and so on).

Here are the general steps for changing margins from within the

Document dialog box:

1. Choose the Format menu's Document... command or use

the §€-F14 shortcut on extended keyboards.

i. Type the dimensions you desire in the Top, Bottom, Left,

and Right boxes.

1 Click OK.

FIGURE 7.2

You have complete

control over margins in

the Document dialog

box, found under the

Formal menu.

_ _



THE WORD FOR THE MAC HOW-TO BOOK Chapter 7

Dragging margins in print preview

It's easy to change a document's margins while in Print Preview. Drag any

of the margin handles, as shown in Figure 7.3, then wait a moment for

your Mac to redisplay the page with your new margin settings.

D I P

If you don't see the margin handles in Print Preview,

click the third icon from the top of the Print Preview icon

stack as shown in Figure 7.4. This will display the margin

boundaries and handles.

FIGURE 7.3

Drag margin handles in

Print Preview to change

your margins.

FIGURE 7.4

Click here if necessary to

reveal margin guidelines

and handles.

iJ<-
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Wlien displaying two side-by-side pages in Print Preview, you will

need to click in one page or the other before adjusting margins. The

handles and guidelines will move to the page where you click. This lets

you work with different left and right (inside/ouLside) margin combina-

tions. The general steps for changing margins in Print Preview are:

1. Switch to Print Preview from Word's File menu or with the

31-Option-I keyboard shortcut.

2. If the margin boundaries and handles are not visible, click

on the third icon from the top to turn on the boundary

lines and handles.

3. Point to a margin handle. The pointer will change to a

cross hair.

A. Drag the margin handle. Watch the margin dimension dis-

played near the top of your screen as you drag.

5. Release the mouse button and click anywhere off the page

to see the effect of the margin changes.

6. Repeat steps 3 through 5 to fine tune, if necessary.

O I P

If you've chosen Mirror Odd/Even margins in the

Document dialog box, be stu-e to display two pages in Print

Preview to see the effect on facing margins as you drag. Odd
pages (pages 1, 3, etc.), are always displayed on the right.

Dragging margin brackets on the ruler

The bottom edge of the Word 5 ruler normally displays left and right

paragraph-indent markers. You can display document-margin markers

instead, then move them.
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1. If the Ruler is not displayed, use the Ruler command on the

View menu or the §€-R shortcut.

2. Click on the margin-marker button (the middle one), high-

lighting it as shown in Figure 7.5.

3. With the margin markers (the square brackets) displayed

on the ruler, simply drag them to the desired position with

your mouse. Watch the lower left of your screen for the mar-

gin dimension as you drag.

FIGURE 7.5

Click on the middle ruler

marker button to reveal

margin markers, then

drag margin markers to

change document margins.

Bii^



GUTTERS FACILITATE BINDING

FIGURE 7.6

Mirror Even/Odd

margins compensates for

two-sided documents

with dissimilar left and

right margins.

Inside Margins Same

4 5

Outside Margins Same

Wlien adjusting margins in Print Preview, ifyou've chosen tiie Mir-

ror Odd/Even feature, be sure you display two pages in Print Preview.

Otherwise you won't know if you're working with an odd or even page.

Gutters facilitate binding

Here's one of those features that apparently exists simply because other

products have it. Gutter margins compensate for the paper tucked away

in the binding of a two-sided book that would be unreadable. Gutters are

additional white space in the inside margins. The gutter width, which

you specify in the Document dialog box, reduces the text area, as shown

in Figure 7.7.

In Print Preview, you can see the effect of gutter margins, but you

cannot adjust them. To adjust the gutter, leave Print Preview and visit the

Document dialog box.
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FIGURE 7.7

Cutler space

compensates for paper

used in the binding

process by adding space

to inside margins in

two-sided documents.

D

HK Default top & bottom margins

remain 1 inch wide

Gutters reduce text area

For instance, a 0.5' gutter reduces

the default text area to

5 5" wide by 9' high

(sheet size less margins, less gutter)

Default nght margin

remains 1 25 inches

wide

Lett margin

remains i 25 inches

Instead of using gutters, simply increase the size of the

inside margins to accommodate binding.

Printing in margins
As you can see from Figure 7.8, it is possible to place text, graphics, and

page numbers in margins by using indent markers. You can drag indent

markers into margins, and text or graphics will follow. You can also use

Word's Frame command to place things in margins, as described in Chap-

ter 5. Page numbers can also be positioned in margins, as you will learn

in Chapter 11.



PAGE BREAKS

FIGURE 7.8

It's easy to print in the

margins.

ii File Edit View Insert Format Font Tools lUindoiv

I

Page 1

Printing in margins Si

mzjMi \m^\ ^1 a
^gTJB) BFT^ B^ HFTTHTn mn]

-p 41

he difference between the

P^^ord and the almost right W'
*u ^.(•f

l^jj)^ Normal
'•^ ** '^ *-^ '^ -~* Mj^.t.xs.j: ^iT^-x^jta.

,
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How HEADERS AND FOOTERS
— AFFECT MARGINS

Headers and footers print in the top and bottom margins. The inclusion

of headers and footers causes Word to automatically adjust top and bot-

tom margins when necessary. For instance, if you use the Document

dialog box to specify a minimum top margin of V'l', then create a header

that is 1.0" high, word will increase the top margin size to make room for

the big header. You can override this feature by specifying exact top or

bottom margins in the Document dialog box. This will force Word to

limit top and bottom margins, headers and footers be damned! This can

create some interesting effects, desired and otherwise. Read about

headers and footers in Chapter 1 1

.

Page breaks

Page breaks are the places in your document where one page ends and

a new page begins. Many things affect where page breaks will occur.
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Factors include the size of your paper, margin settings, paragraph for-

mats, and section breaks. Word automatically computes and displays page

breaks as you add and delete information. You can visualize page breaks

in all xaews prior to printing. Breaks appear as dotted lines in Normal

and Outline views. Since both Page Layout view and Print Preview simu-

late sheets of paper, page breaks are easy to visualize in those views as well.

You can force your own page breaks. For instance, if you always

want new chapters to start on a new page you can force this by inserting

manual page breaks at the beginning of each chapter.

Repagination

In order to display and print page breaks properly Word must recalculate

page endings after you've made changes. Normally this is done automat-

ically in the background whenever Word can steal some otherwise un-

used compiUer time. This process is called automatic repagination. Since

page endings affect certain other features, Word always repaginates when:

You ask it to print

" You switch to Print Preview or Page Layout view

You compile a Table of Contents or Index

To turn off automatic repagination (and speed up slower Macs when

working on large documents), do the following:

1. Choose Preferences... from Word's Tools Menu.

Z Display the General category if it is not already in view by

clicking on the General icon.

X Clear the X from the Background Repagination check box.

4. Close the Preferences dialog box.

5. Remember to use the Repaginate Now command when you

desire repagination.

You can also force repagination whenever you like by issuing the

Repaginate Now command found on the Tools menu.



REPAGINATION

m
If you have a large enough screen and are using Word

version 5.1, the Repaginate tool is available in button

position 21 on the Toolbar when counting from left to ri^t.

It looks like four sheets of paper.

Forcing page breaks

When you want to force a page break, you can insert manual page

breaks. In Normal and Outline views they look thicker than Word's auto-

matic page breaks.

O I P

Generally speaking, forcing a p^e break is not a great

idea. If you must do it, wait until you have done all of your

other formatting.

To insert a manual page break:

1. Move the insertion point to where you want to place the

break.

2. Either select Page Break from the Insert menu or use

the Shift-Enter shortcut. Be sure you hit Shift-Enter and

not Shift-Return. (PowerBook owners will need to hunt

for their tiny Enter keys.)

3. You'll see a thick manual page break line on your screen.

4. Text or graphics below the manual page break will appear

on the next page of your document.
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im
If you have a large enough screen and are using Word

version 5.1, the Page Break tool is available in Toolbar

button position 20 when counting from left to right. It looks

like text with a Ught line dividing it.

Moving and deleting page breaks

Manual breaks can be dragged up or down in Print Preview. They look

heavier than Word's margin lines. In other views yon can either drag and

drop, or cut and paste manual breaks.

Manual breaks can be highlighted and deleted like text in Normal,

Page Layout, and Outline views. (You cannot delete automatic breaks

placed by Word.) Select a manual break line and press Delete.

The Replace... command will also let you search for and delete

manual breaks. You do this by searching for manual breaks and replac-

ing them with nothing. See Chapter 19 to learn more about replacing.

Keeping things together
— ON A PAGE

Sometimes automatic page breaks occur where they shouldn't like just

after paragraph headings or in the middle of lists or tables. Word offers

several ways to keep things together.

Keeping lines together

To keep lines together and prevent a page break from separating them,

do the following:

1. Select the lines you wish to keep together.



KEEPING THINGS TOGETHER ON A PAGE

2. Choose Paragraph... from Word's Format menu, or use the

3€-M keyboard shortcut.

X Enable the Keep Lines Together option by clicking to place

an X in the appropriate box.

4 Click OK.

5w Small black, non-printing blocks will appear next to the

paragraphs indicating that they have special formatting that

may not be obvious in some views.

6. The lines will stay together on the same page with each

other (sometimes causing very early page breaks)

.

Keeping paragraphs
or graphics and labels together

To keep paragraphs together, or to keep graphics and related text

together on the same page, do the following:

1. Select the paragraphs (possibly including graphics) you

wish to keep together.

2. Choose Paragraph... from Word's Format menu or use the

li-M keyboard shortcut.

3. Enable the Keep With Next option by clicking to place an X
in the appropriate box.

4. Click OK.

5. Small black, non-printing blocks will appear next to the

lines indicating that these lines have special formatting that

may not be obvious in some views.

6. The designated items will stay together on the same page

with each other (sometimes causing very early page breaks).
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Keeping parts of tables together

As you will learn when you read more about tables in Chapter 10, Word

treats each row in a table as a separate paragraph. Select all the rows of a

table and use the Keep with Next paragraph option to keep a table intact.

Forcing paragraphs to start
- on a new page

To force paragraphs to start a new page (chapter headings, for instance),

do the following:

1. Select the paragraph you want to place at the top of a new

page.

2. Choose the Paragraph command from the Format menu or

use the S€-M keyboard shortcut.

3. Select the Page Break Before option.

4 Click OK.

Removing keep with and similar
— paragraph options

To remove special paragraph and line options like Keep With Next, Keep

Lines Together, and Page Break Before:

1. Select the paragraph (s) you want to change.

2. Choose the Paragraph command from the Format menu or

use the 3€-M keyboard shortcut.

3. Click to remove Xs from unwanted options.

4 Click OK.



CONTROLLING WIDOWS AND ORPHANS

Controlling widows and
- ORPHANS

Widows are short lines (typically a single word) at the end of paragraphs.

Orphans are the first lines of paragraphs that print by themselves at the

bottom of a page. While both can be distracting to readers, some editors

will tell you to eliminate orphans and live with widows (pim intended).

The choice is yours, tmless you work somewhere with policies about such

style issues.

Word automatically eliminates both widows and orphans imless you

tell it to do otherwise. You may find it helpful to turn off this feature if you

are having trouble making things fit, particularly in multi-column docu-

ments. Here's how to turn off automated widow and orphan suppression:

1. Choose the Document... command from Word's Format

menu or use the 3€-F14 shortcut on extended keyboards.

7. Remove the X from the Widow Control option box.

3. Click OK.

4b Widows and orphans may occur, and you must deal with

them manually, or choose to ignore them.





\x

Characters

and Fonts



TRACKS

To speafy <hara<ter appearame before typing 231

choose a font, font size, character formatting options, and

other embellishments. Use the Format menu, Character dialog

box. Font menu, ribbon, keyboard shortcuts, and version S.l's

Toolbar to make your choices. The characters that you type will

take on the specified appearance.

To ihange (haroKter appearante after typing 232

select the text you wish to alter, then choose a font, font size,

character formatting options, and other embellishments. Use

the Format menu. Character dialog box. Font menu, ribbon,

keyboard shortcuts, and version 5.1 's Toolbar to make your

choices. The characters that you type will take on the specified

appearance.

To <liange your default font 253

use the Default Font... command on Word's Font menu to

open the Default Font category in the Preferences dialog box.

You'll see two dropxlown lists—one for font and the other for

size. Make your choices and close the Preferences dialog box.

Changes affect the current document and all new documents.



To type speiial <hara<ters and symbols 253

either type appropriate key combinations (like Option-8 for bul-

lets) or use the Symbol... command on Word's Insert menu to

display the symbol dialog box. Click on desired symbols to place

them at the insertion point. Switch fonts before and after insert-

ing when it is necessary to include characters or symbols not

found in the current font. Version 5.1 users with wide screens

can use the Symbol button. You can also use the Key Caps com-

mand on your Apple menu to view and insert special symbols

and characters.

To treate drop taps 259

select the text, symbol, or graphic you wish to drop, then use

version B.l's Drop Cap... command foiuid on the Insert menu.

Ifyou are not using version 5.1, frame the desired elements

with the appropriate Frame... command (on the Insert and For-

mat menus) , then position the frame so that text will flow

aroimd it. Adjust line spacing, frame width and subscripting to

tighten up white space around drop caps.

To type non-breaking spates 267

hold down the Option key when you press the space bar to

create non-breaking spaces. These will keep words together on

the same line. Non-breaking spaces can be spotted in text by

looking for their non-printing tildes.



Characterformatting

Understanding, picking, and usingfont

technologies

Controlling typesetter's, or smart, quotes

Typing symbols and special characters

Hyphenation

Formula commandsfor technical typing and

math formulas

J PECIALISTS CALLED TYPOGRAPHERS
^ spend their whole hves studying and

improxing the appearance of printed words. It is a complex profession

steeped in tradition and romance. Computers have added to the trivia

and mysdque surrounding tspography. Word 5 provides considerable

typographic prowess. For instance, you can:

Specify fonts (type designs)

Specify character size

Embellish text (embolden, italicize, and underline it)

Adjust inter-character spacing (kerning)

Specify colors for characters

Change the case of text (e.g., lowercase to uppercase)

™ Super- or subscript characters

Copy and repeat character formatting

Include international accent marks and special symbols

" Hide and reveal text selectively (annotations)

Use Word's typeset commands for equation and technical

typing
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For many, it may be enough to know how to print desired characters

in appropriate sizes and styles. Other readers will want to know how to

get just the right look. Some will need to know about various font tech-

nologies. You may need to be aware of compatibility issues when moving

documents from one computer or printer to another.

This chapter progresses from simple, non-technical techniques to

fairly complex issues. Feel free tojump from topic to topic as the need

arises.
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If you always use the same computer, and a single

printer; and if you are happy with your choice of fonts and

effects, you may be able to completely ignore the technology

and typeset command information found near the end of

this chapter.

Terminology
People often use the terms font and typeface synonymously. The terms

are not really synonyms, but since the world seems to be treating them

that way these days, we will too. With apologies to professional typo-

graphers, let's start with some slightly over simplified definitions.

Characters, fonts, and typefaces

Characters are the letters, numbers, punctuation marks and special sym-

bols that you type from the keyboard. For our purposes, we'll define a

font or typeface as a collection of characters and symbols with a common
appearance, or design. Courier is an example of a Font. It will remind

you of old electric typewriters. Times is a different font (or typeface) that

will remind you of newspaper and magazine copy.
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Different fonts contain different collections of characters and sym-

bols. Some fonts are designed to be used for specific purposes like head-

ings or drop caps. These sometimes have only upper case letters, and

may not even contain pimctuation. There are scientific and math fonts

that contain the necessary Cireek and other symbols for technical typing.

Others fonts are used for adding decorations to your document. Zapf

Dingbats is an example. Instead of numbers and letters it contains tiny

pictures of airplanes, boxes, check marks and so on.

Font families

A collection of all of the variations of a font is called a family. For in-

stance, you can purchase a font family from Adobe called Lucida. This

family includes Lucida Roman, Lucida Italic, Lucida Bold, and Lucida

Bold Italic.

One way to add emphasis to a document is to use different fonts for

headlines, paragraph headings, and body copy. Sometimes you'll decide

to pick different fonts from the same family, other times you'll mix fonts

from different families. The headings and body type used in this book

illustrate both techniques.

Character formatting

When you use Word 5, you need not purchase entire font families to use

effects like bold and italics. Word has features that can often embellish

the appearance of single plain fonts to create bold, italic, shadow, and

other effects. The techniques used to do this are usually referred to as

character formatting. Figure 8.1 shows many of the character formatting

variations possible when using Word 5's character format tricks on the

New Century Schlbk (schoolbook) font.

Don't confuse the character formatting tricks shown in Figure 8.1

with true bold, italic, and other fonts. Purists often prefer the real thing,

and these character formatting effects can sometimes look downright

awful when applied to certain fonts—including many of the low cost

shareware typefaces in common use.

Incidentally, not all font vendors provide identical looking fonts,

even when the font names are the same. The Courier installed in Apple's
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enhance a font in many

ways.

FIGURE 8.1

Normal (a.k.a. Plain text), Bold, Italic
With Word 5's formatting Standard underline Word Underline
capahiiit,es,yoam

double underline Dotted underline

Strike-thru

all caps off, ALL CAPS ON
Small Caps Off, Small Caps On

SuperNormalsubscript

Condensed character spacing Off

Condensed character Spacing On
Expanded character spacing Off

Expanded character spacing On
Black Blue Cyan Gix^en Magenta Red

Bold + Italic + OmSEums + ^^©(^©33? + €(Dmd(smQ(S(^

LaserWriters looks quite different from the Courier in Pacific Data's Post-

Script products, for instance. Occasionally (but rarely) this can cause dif-

ferences in line endings. And, once in a while you'll find different special

characters in fonts from various manufacttuers. (You won't always find the

little apple character in some non-Apple-provided fonts, for instance.)

Monospaced vs. proportionally spaced

Some fonts are said to be monospaced or fixed-pitch; others proportion-

ally spaced or variable-pitch. Monospaced fonts like Courier use the

same amount of horizontal space on a line for each character, regardless

of the width of a character. With a monospaced font like Courier the

letter i takes the same amount of horizontal space as the letter W. Thus,

if you can fit seventy W's on a line in Courier, you can only fit seventy i's

in the same space. Obviously this is an inefficient use of space and some-

times causes sloppy looking words. Since people like lawyers, art direc-

tors, and publishers usually want to fit as many words as possible on a

page, they turn to proportionally spaced fonts that tuck narrow letters in

closer to their neighbors.

In Figure 8.2 the same word is printed first in 72-point Courier, a

monospaced font, and then in 72-point Times and Helvetica, both
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FIGURE 8.2

Noike that Courier (lop)

is much less elegant than

Times (middle) or

Helvetica (bottom).

Wimp
Wimp
Wimp

proportionally spaced fonts. Notice the ocean of white space on either

side of the letter i in the Courier example. A long base has been added

to the bottom of the i in an attempt to distract you from this untidiness.

Compare the white space on either side of all three i's in Figure 8.2.

Ironically, the monospaced Courier font uses less horizontal space

on the line than either of the proportionally spaced fonts, due mainly to

the much wider W's and m's in the proportional faces.

Point sizes

The various sizes of type (9-point, 10-point, 12-point, etc.) are referred to

as point sizes. You should know that 9-point type is smaller than 10-poinl

type, and that there are 72 points to an inch. Thus, 72-point type will

take 1 vertical inch of space, 36-point type will require V2" of vertical

space, and so on.

Point size is measined from baseline to baseline. For instance, in

Figine 8.2 you would measiue from the bottom of the W on one line to
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the bottom of the W above or below it. Sometimes different fonts of the

same point size appear to be taller or shorter than each other, due to

the amount of space the designer has allowed for ascenders, descenders

(the parts of characters that go below the baseline and above the tops

of caps); and for white space above and below the characters (leachng).

Notice how the 72-point Courier looks shorter than the 72-point Hel-

vetica in Figure 8.2.

Your choice of point size affects the amount of space between lines

(called leading), as well as the height of the characters. You can have

more than one point size on a line, but Word will adjust the line spacing

to accommodate the largest character on the line. You can override this

feature as you will see in the next chapter.

Serifs vs, sans serifs

The horizontal cross lines on the W, i, and p in Figine 8.2's Cornier and
Times examples are called serifs. (The fonts themselves are called serif

fonts.) Popular Macintosh fonts with serifs include Courier, New York,

Palatino, and Times. Fonts without these embellishments are said to be
sans serifs. Avant Garde, Chicago, Geneva, and Helvetica are examples.

Character formatting tools—
- an overview

There are many ways to tell Word to make characters bold, italicized, big-

ger, or smaller. This process is called character formatting. Tools for char-

acter formatting include the ribbon, menu choices, dialog boxes, and
keyboard shortcuts. You can change the formatting of single characters,

entire words, or whole documents. Let's start with an overview of the

tools Word provides for character formatting, then look at typical ex-

amples of the tools in use.
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You can either specify the desired appearance of char-

acters before you type them, or you can type first, then select

text and change its appearance. Virtually all of the character

formatting techniques described in this chapter can be

accompUshed either before or after you keyboard text.

Character formatting
choices on word's menus

Word's Font and Format menus both contain character formatting

choices. Here's an overview:

The Font Menu
Word 5's Font menu on the menu bar lists all of the fonts installed on

your Macintosh and their standard sizes, as illustrated in Figure 8.3.

(Yours may have different fonts.) Don't confuse this with the smaller font

menu on the ribbon.

Check marks indicate the current font and size. The Up and Down
commands (and their keyboard shortcuts) increase or decrease the cur-

rent font size by one point each time you issue the command. This is one

way to specify non-standard font sizes not listed in the menu.

The Other... command on the Font menu opens the Character

dialog box, and the Default command lets you change the font and size

used for your everyday work. Both of these options are described later in

this chapter.

The Format Menu
The bottom of Word's Format menu (shown in Figure 8.4) contains

several character-related choices including Bold, Italic, Underline (single
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FIGURE 8.3

The Font menu lists all

fonfs installed on

your Mac.

BEP. Tools lUJndoiLP

9 Point

10 Point

• t]g PEQmG
14 Point

18 Point

24 Point

881

Up

Doiun

Other...

Default Font...

>/Chicago

Courier

Geneua
Heluetica

Monaco
Times

continuous), and Condensed 1.5. Plain Text removes some kinds of char-

acter formatting including bold, italic, and underlining. The Revert To

Style... command is a more powerful way to remove character formatting

The Format menu also has the choice Character... which will bring

up the Character dialog box. Finally, notice Change Case... which is

described later in this chapter. Some Format menu choices have key-

board shortcuts.

Character formatting with the ribbon

The most immediately visible way to modify character appearance is to

use the buttons and font menu on the ribbon as illustrated in Figure 8.5.
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FIGURE 8.4

The Format menu

contains character

choices too.

1 Formats
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If the ribbon is not in view, choose the Ribbon

command from Word's View menu or use the §§-Option-R

keyboard shortcut.

From the ribbon you can pick a font, change to a different point

size, toggle bold, italic, and underline effects. You can also superscript or
subscript characters. Simply click on the appropriate ribbon button or
pick the desired menu item from the ribbon's drop-down lists. Clicking a

second time on a ribbon btitton removes or toggles the effect.

m
The Toolbar in Word version 5. 1 also has several

character formatting buttons. These are discussed next.

Character formatting
with version 5.rs toolbar

The Word 5.1 Toolbar (shown in Figure 8.6) has several character format-

ting buttons including the Font Up, Font Down, and Change Case tools.

Other buttons help you create bulleted lists, insert symbols, and interna-

tional accent marks.

FIGURE 8.6

The version 5. 1 Toolbar

contains a number of

character-related

formatting choices.

m^MaiiT^M^m^i^mip^^^^mTimmmmmmm^^
t

Bulleted list Change case

Increase font size

Decrease font size

t

Insert symbols
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Character formatting
with the character... command

Tin- Character dialog box contains the most comprehensive collection of

character formatting options. Reach it from the Format menu, or with

the §€-D keyboard shortcut. It can also be reached by using the Other...

choice on the Font menu.

fl
There's a hotspot for the Character dialog box. Simply

double-click in any blank part of the ribbon. See Chapter 1

for more information on hotspots.

The Character dialog box lets you specify and combine a potentially

gaudy array of character effects. It also presents yet another way to pick

fonts; and it lets you fiddle with inter-character spacing. Drop-down

menus provide you with underline and color choices. You can even enter

non-standard font sizes from here. This is one busy box! Take a good

look at Figure 8.7.

Using the Character Dialog Box
Notice the Style section of the Character dialog box. It contains eight

choices, from Bold to Hidden. You can apply one or more of these choices

to selected characters and to subsequently typed text. Simply click to

place Xs in the boxes next to the desired effects. You can remove effects

by clicking to clear the box. The dialog box also shows which character

formatting options have been enabled from the ribbon, menu, and key-

board shortcuts.

Effects can often be combined. For instance, it is usually possible to

ha\e text that is bold, italicized, and underscored. (Not all fonts accept

all formatting options though, and occasionally you will sec combina-

tions on screen that will not print.) Click OK when you have selected the

desired effects.
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FIGURE 8.7

The Character dialog box

gives considerable control

over character formatting

options.

Character

Font:

Courier 3
Size:

12 ^^O]a
[cancel

]

Double [! [Green [! [ Apply
]

Underline: Color:

Style



THE WORD FOR THK MAC HOWrO BOOK Chapter 8

About Grayed Character Option Boxes
If you select text, then open tlie CHiaracter dialog box and see gray boxes

next to the formatting options (like those in Figure 8.8), it simply means

that you have selected text with an inconsistent variety of character for-

matting options. For instance, some of your selected text may be bold,

other parts plain, part luiderlined, and so on.

This is an important concept as you will learn when you work with

the Replace command in Chapter 19. An X in a character format box

means all the selected text exhibit.s that particular attribute (like the X in

the bold box back in Figure 8.7). A completely clear box (no X and not

gray) means that the selected text definitely does not exhibit the specific

attribute anywhere within it. A gray box means that some of the text may
or may not exhibit some or all of the character formatting options. (This

third condition must have been invented by a politician.)

FIGURE 8.8

Gray option boxes mean

that different parts of tiie

selected text have

dissimilar character

formatting.

Style

HBold
U Italic

H Outline

[D ShadoiLi

UStrikethru

m Small Caps

Hflll Caps

B Hidden

Keyboard shortcuts
for character formatting

Many of Word's character formatting tools have keyboard shortcuts.

They are mentioned throughout this chapter, and summarized in

Table B.5 in Appendix B.
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How TO SPECIFY EVERYDAY
— CHARACTER FORMATTING

Now that you've seen an overview of the formatting tools let's look at

some specific everyday tasks.

Choosing fonts and sizes

Word can use any font installed in your system. Theoretically at least, you

can print any font in any size from 4 points to a whopping 16,383 points.

This corresponds to character heights ranging from approximately '/I8th

of an inch to about 19 feet! In reality, you'll probably work with type sizes

ranging from about 7 to 72 points most of the time, since they are easy to

read and look good on traditional page sizes.

m A R N I N G

The type of printer you use, the system version you are

running, the fonts you've chosen, and other factors affect

the final printed appearance of fonts at various sizes. There

is more information about this at the end of the chapter.

Word offers almost too many ways to pick fonts and sizes. Here's a

summary of the various techniques:

" Pick the desired font and size from the Font Menu on

Word's menu bar.

Use the drop-down font and size lists on the ribbon.

Type the name and size of the desired font directly into the

font name and size boxes on the ribbon, then press Enter

or Return. For instance, click in the font name on the rib-

bon, then type all or part of a font name like NewY for

New York. (You need only type enough to differentiate the
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desired font from other installed fonts.) Next ciici< in

the size box, if necessary, and type a new point size from 4

to 16,383. Press Enter or Return.

Select fonts from witliin the Character dialog box reached

with the Character... command on Word's Format menu (i€-

D). Double-flicking in an unused part of the ribbon is the

hotspot for the character dialog box.

The keyboard shortcut §€-Shift-E places the word Font in

the status area at the lower left corner of the document win-

dow. Type enough of a font's name to differentiate it from

others (like New Y for New York) then press Enter or

Return. This will change to the specified font.

To increase or decrease a font size one point at a time

(from 10 to 11, for instance) use the Up or Down com-

mands on the Font menu or their shortcuts 3€-] and S§-[.

Version 5.1 users can use the big and small letter A buttons

on the Toolbar to increase and decrease font sizes a point at

a time.

To Increase or decrease font sizes by the increments listed

in the Font menu (10 point, 12 point, 14 point, etc.), use

the keyboard shortcuts l§-Shift-> and 9€-Shift-< respectively.

Assign fonts and sizes as part of styles. (See Chapter 13 for

details.)

Here's a quick way to tell which is the current font

and size. Keep the ribbon displayed, and get in the habit of

checking the font name and size listed there. That's the

current font and its size.
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Creating bold characters

There are a number of ways to add Bold character formatting to charac-

ters you've selected or to characters you are about to type. Here are four

choices:

Click the Bold button on the ribbon. It looks like a bold B.

(A white B in a black button indicates that bold character

formatting is enabled.)

Use either of the two keyboard shortcuts for bold character

formatting—3€-B or 3€-Shift-B.

Enable the Bold option in the character dialog box. (Use

3€-D or the Character... command on Word's Format menu

to display the Character dialog box.) Click in the Bold option

box. An X indicates bold character formatting is enabled.

- Assign bold formatting as part of styles, (see Chapter 13 for

details.)

Creating italicized characters

Create italicized characters in much the same way you create bold ones:

Click the Italic button on the ribbon. It looks like an

italicized letter I. (A white I in a black button indicates that

italic character formatting is enabled.)

Use either of the two keyboard shortcuts for italic character

formatting—3€-I or §€-Shift-I.

Enable the Italic style in the character dialog box. (Use S-D

or the Character... command on Word's Format menu to

display the Character dialog box.) Click in the Italic option

box. An X indicates italic character formatting is enabled.

Assign italic formatting as part of styles, (see Chapter 13 for

details.)
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Underlining

Yoii can apply simple, single, continuous underlining with the ribbon.

Underline command on the Format menu, or with the §§-U keyboard

shortcut. If you want different underline formats, you'll need to use the

Character dialog box.

There are five underline choices on the drop-down menu il-

lustrated in Figure 8.9. They include Single, Word, Double, Dotted, and

None. The effect of these choices are self explanatory, and illustrated

back, in Figure 8.1. Unfortimately, underline choices cannot be coin-

bined; it is not possible to choose double word underline, for instance.

FIGURE 8.9

There are five underline

options.

None

v/None

Single

Word
Doubl

Dotte

1

D
If you routinely use different imderline styles like

Double or Word, you can add commands for them to your

Word menus. See Chapter 3 1 to learn how. There are

keyboard shortcuts for various underline styles. They are

listed in Appendix B, Table B.5.

Strikethru

If you write contract drafts or work with other important documents, you

may wish to use Word's Strikethru feature. It is a way to indicate text that

will be deleted in the final copy. (Choose the Strikethru option in the

Character dialog box to overlay text with a horizontal line.
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Use the Strikethru feature to format both the text and

the spaces that you plan to delete in the final copy. When it

conies time to delete, you can use Word's Replace. .

.

command to find text containing Strikethru text and replace

it with nothing, thereby deleting the text. See Chapter 19 for

more about the Replace. . . command.

Expanding and condensing character spacing

Word lets you override the standard spacing between characters (the

kerning) defined by font designers. You can either move characters

closer together with the Condensed character formatting option, or

move characters farther apart with the Expanded option. The default for

expansion is 3 points. The condensing default is 1.5 points.

Condensing can help you fit extra words on a line while Expanding

can create interesting effects for headlines and other desktop publishing

tasks. You'll see many examples of this later in Chapter 22. The changes

can be dramatic as illustrated in Figure 8.10.

You can condense characters a maximum of 1.75 points and ex-

pand them a maximum of 14 points. Word will remind you of this if you

try to exceed the limits.

FIGURE 8.10

Ihis IS fhe same line or Condensing and expanding makes a difference

New Century Schoolbook Condensing and expanding makes a difference

shown normally, then
Condensing and expanding makes a difference

condensed and expanded

the default amounts.
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Kerning characters

You can use the Condensed option to tuck pairs of letters closer to each

other to tighten them up and improve the appearance of some awkward-

looking combinations ofwide and narrow letters. Simply select the letters

you want to cozy-up, then use the Condensed option on the Character

dialog box.

O I P

Advanced users may also want to consider using the

Displace formula typesetting command for more precise

kerning. (Read about formula typesetring commands later

in this chapter before trying this tip.) Place Displace

commands with ba (displace back) options between letters

you wish to tighten up. For instance to Kern the pair WA,

you'd enter the arcane string \V3€-Option- \d§€-Option-

\ba4()A in normal view with Show \ turned on. When you

print or switch to Page Layout view with Show 5 turned off,

you'll see kerned pairs. Changing the number after ba

adjusts the distance between the letters. The computer for

the rest of us. Right!

Creating super and subscripts

Normally, any characters that you type are placed on an invisible line

called the baseline. Superscripted characters are moved above the

baseline; subscripted characters are placed below the baseline. While the

obvious use for this is in equations and chemical formulas (H^jO, for in-

stance), there are many other ways to use super- and subscripting. For ex-

ample, if you abbreviate numbers like 2nd, superscripting the letters and

reducing them a point size or two (like this: 2"'
) gives them a typeset look.
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You can also use super- and subscripting to line up odd-sized bullets

with adjacent text. As you'll soon see, it's possible to tweak the appearance

of drop caps by super- or subscripting them.

There are several ways to super- and subscript characters. You can

use the new ribbon buttons with the up and down pointing triangles, or

you can use the Superscript and Subscript radio buttons in the Character

dialog box. Both of these techniques retain the ciurent font size, but

reposition the characters above or below the baseline. The Character

dialog box lets you type in changes to the defaults of 3 points above and

2 points below in the By box.

O I P

There is a better way to make supers and subs, which

uses keyboard shortcuts. l§-Shift-h is the superscript shortcut

(you cannot use the plus on the numeric keypad). ^Shift-

is the subscript shortcut. Rather than just repositioning text

in relation to the baseline, both shortcuts decrease the

selected type to the next smaUer font size. This is very handy

for exponents and molecular notation.

Character color choices

Even if you cannot display or print color. Word 5 lets you specify six char-

acter colors plus black or white. You can then take copies of yoiu" disk

files to color-capable hardware for display and printing. To specify a color:

1. Start by selecting text, or positioning the insertion point

where you want to type colored text.

2. Choose the desired color from the drop-down Color menu
in the Character dialog box.

X With the selected text in view, click Apply to see colors or

grays. If your monitor supports color, you will see color
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characters on screen. If your monitor supports shades of

gray, colors will be converted to grays.

4. Click OK to close the character dialog box.

5. Wlien you print, enable your printer's color or gray scale

features if it has them. For instance, install a color ribbon in

your ImageWriter or choose the Color/ Grayscale option in

many laserprinter Print dialog boxes.

D I P

You may need to visit the Monitor portion of yoiir

Mac's control panel to enable shades of gray. Some people

turn off gray-display features to save memory and speed-up

video performance. See your Macintosh manuals for details.

The actual appearance of your Monitor control panel dialog

box may differ from the example in Figure 8. 11—a portrait

monitor on a Macintosh Ilex.

Remember, not all Macintosh computers can display gray or colors,

but you need not display color to print it. To see which color you've as-

signed to text when using a black and white only monitor, select the text

and visit the Character dialog box to read the name of the assigned color.

Using the change case command
The Change Case... choice is available on the Format menu only when
you have selected (highlighted) text. Figure 8.12 shows the resulting

dialog box which offers five choices.

Look closely at the dialog box. It demonstrates the results of the

five choices in use. For instance, UPPERCASE changes all selected char-

acters to uppercase letters, and the choice UPPERCASE itself appears all

uppercase in the dialog box. Title Case changes the first letter of each

selected word to uppercase as illustrated in the dialog box.
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FIGURE 8.11

You may need to visit

your Monitor control

paneho show grayscales.

ID Monitors

Characteristics of selected monitor : 7

(•) Grags:

O Colors

:

Drag monitors and menu bar to rearrange them.

Jk^US^i^

Identify
]

FIGURE 8.12

ffie Change Case. .

.

dialog box gives you a

choice of five case formats.

Change Case

(*) UPPERCASE

O loiuercase

O Title Case

O Sentence case.

OtOGGLE cflSE

[Cancel]

Alas, the Title Case feature is not context-sensitive, so it capitalizes

prepositions and articles, including of, the, and so on. To change case

with this feature:

1. Select the text you wish to change.

2. Choose Change Case... from the Format menu.

3. Choose the desired case option.

4 Click OK.
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When you change case by using this dialog box, the characters themselves

change to the specified case. It is just as if you had retyped them using

the new capitalization scheme. Undo works here if you act immediately.

Using the all caps option

The All Caps feature is foimd in the Character dialog box. It changes

only the appearance of letters without actually changing the letters them-

selves. Unlike the Format menu's Change Case... command, the All Caps

option lets you type in lowercase and see uppercase letters as you work.

1. Select the text you wish to change, or position the insertion

point for typing.

2i Choose Change Case... from the Format menu.

3. Choose the desired case option.

4. Click OK.

5. Selected and/or subsequendy typed case will appear in upper

case, but the underlying text will retain its actual capitalization.

Using the small caps option

The Small Caps option in the Character Dialog Box can create some very

interesting effects. Figure 8.13 shows some examples of Small Caps at work.

D I P

Remember that applying the Small Caps fonnatting option

to text containing dingbats like those shown in Figiire 8.13, wiU

usually "capitalize" the dingbats, thereby changing the character

that spears and prints. Select dingbats and remove Small Caf>s

formatting. Use Word's Replace. . . command (described in

Chapter 19) to do this if you have many changes to make.
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FIGURE 8.13

ffiese four samples of

Small Caps character

formatting show how easy

it is to add punch and

visual interest.
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fbimatting include:

Toggling ribbon buttons, menu commands, and keyboard

shortcuts

Using the Plain Text Command

Using the Revert To Style command

Using the Character dialog box

" Using the Replace command to automate removal

Changing to a different style

Unfortimately, not all approaches work under all circuinstances, and

there are some landmines, particularly when styles are involved. Remov-

ing character formatting is easiest if you are not using Word styles other

than Normal. See Chapter 13 to learn about Styles.

Toggling to remove character formatting

Obviously, you can use the Undo command (§€-Z) to undo tormatting im-

mediately after you've changed it. And, you can remove inost character

formatting by applying it a second time. This process is called toggling.

For instance, if you select a bold word and click on the Bold ribbon but-

ton; or choose the Bold command on the Format menu, the selected

text will no longer be bold.

The plain text command
The Plain Text command on the Format menu or its keyboard shortcut

3€-Shift-Z will also remove most character formatting. Simply select the

text then execute the command.

Limitations of toggling and plain text

The toggling and Plain Text techniques just described will remove for-

mats and many combinations like bold or bold with underlines. In fact,
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toggling and the Plain Text command should work with the following

character formatting features in any combination:

- Bold

Italic

Underline

Double underline

Word underline

" Dotted underline

Strikethru

Outline effect

Shadow

Small caps

" All caps

Hidden text

Colors

However, the toggling and Plain Text tricks will not tighten up characters

that have been expanded, nor will it spread out characters that have

been condensed. You cannot change fonts or their sizes this way either.

You'll need to either visit the Character dialog box or use the Revert To

Style command to change these formatting effects.

Revert to style

The Revert To Style command on the Format menu removes all manually-

applied character formatting (including expansion, font changes, etc.).

The resulting text takes on the characteristics of the underlying style for

the paragraph containing the text. The key phrase here is "manually-

applied," a concept you'll understand after you've read Chapter 13.



THE WORD FOR THE MAC HOW-TO BOOK Chapter 8
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As you'll see when you explore styles in Chapter 13, if a

style calls for bold text and you manually underscore that bold

text, when you use Revert To Style, the underUning you've

manually applied disappears, but the bold usually stays.

When you try to unformat text and bizarre things happen

(everything becomes bold when you expect it to be plain for

instance), chances are you're experiencing the interaction of

Word's styles layer and the manual formatting layer. Read

about them in Chapter 1 3.

Copying and repeating character
- FORMATS

To copy character formatting, do this:

1. Select only the characters of interest (but not the para-

graph marker at the end of the paragraph).

1 Press 3«-Option-V.

3. The words Format To appear in the lower-left comer of the

screen.

4i Position the insertion pointer to begin typing or select the

text you want to format.

5. Press Enter (not Return).
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Once you've copied a text format, it is easy to reapply

it elsewhere with the Repeat command foimd on the Edit

menu or its keyboard shortcut (3€-Y).

Changing your default font
- AND SIZE

Use the Default Font... command on Word's Font Menu to change the

default font for the current and new documents. Word installs the bit-

mapped font New York. If you have a PostScript printer you'll probably

want to change to something else like Times. This changes the font and

size used for the Normal style and for styles based upon Normal. (Chap-

ter 13 explores styles.)

To change the default font:

1. Choose Default Font... from Word's Font Menu.

2. The Preferences dialog box will appear with the Default

Font category in view.

X Use the drop-down lists to pick a new default font and size.

4 Click in the close box to change the preference.

5. The appearance of your current document will change.

New documents will also use the new default font and size.

Typing special characters

Special characters, like the copyright symbol (©), ligatures, and foreign

accents have always been fairly easy to type and print with the Key Caps

choice on your Apple menu. Word 5 makes it even easier Let's look at

the new Symbol... feature and review the old reliable keyboard shortcuts.
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The symbol command
A dialog box appears whenever you choose Symbol... from the Insert

menu. 3€-()ption-Q is the keyboard shortcut. It shows you all available

characters in the current font. Clicking on a symbol does two things. First,

it inserts the character at the insertion point in your doctmient. Then it

shows you the decimal code and keyboard shortcut, if there is one.

To see which symbols are available in different fonts, simply choose

a font from the Font menu and use the Symbol... command to view the

choices.

The characters are displayed in the ciurent font size. If they are too

small to distinguish, visit the Font menu and pick a bigger size to have a

look. Change back to the correct size before you insert.

O I P

If you own a recent version of Norton Utilities, check

out Norton's KeyFinder utility. You may prefer it over both

Apple's Key Caps and Word's Insert Symbol command.

Typing symbols from the keyboard

If you know the appropriate key combinations you can enter tliem direcdy

from the keyboard without using the Symbol... feature. For instance, to

type the bullet character (•), hold down the Option key and press the

8 key (not the one on your niuneric key pad). Different fonts sometimes

have different key combinations, so you will need to consult the docu-

mentation that comes with yoiu" fonts or use Word's Symbol... command,

the Key Caps desk accessory, or a more powerful third-party accessory

like KeyFinder, to show you the combinations. Also, a few key combina-

tions differ in System 6 and 7. Figure 8.14 shows commonly-used special

characters and tluir keyboard shortcuts.



TYPING SPECIAL CHARACTERS

FIGURE 8.14

Some of Word's

commonly used special

characters and their

keyboard shortcuts.

Name
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International and accented characters

To type accented international characters (lii<.e the n in La Canada) you

use three keys. First you hold down the Option i<.ey phis a key to tell your

Mac which accent to apply, then you press the character key for the char-

acter you wish to accent. For example, to umlaut an o, do the following:

1. Hold down the option key while pressing the U key.

2. Release both keys.

X Press the O (or Shift-O) key to get a small or capitalized,

iimlauled o.

Incidentally, you can't accentjust any old characters. Figiue 8.15 shows

you the possibilities and their key combinations.

O I P

Remember—those keystroke combinations listed in

Figure 8.15 are shortcuts. If you forget them, you can always

locate and insert accented characters with Word's Symbol. .

.

command on the Insert menu, or with the Apple menu's Key

Caps or similar utilities.



VERSION 5. IS BULLETED LIST COMMAND

Dingbats

Add some spice to your life. Use the dingbats found in the Zapf Chan-

cery and Zapf Dingbats fonts instead of plain old bullets. Dingbats are

also great as list separators, and as border decorations. You've already

seen examples back in Figure 8.13 and you'll see others in later chapters.

Consider purchasing and installing other dingbat fonts like Bills-

Dingbats, DavysDingbats, and International (a nifty symbol font). All of

these can be found in shareware packages at very low cost. Use Word's

Symbol... command to see and insert them.

Effi
Version 5. 1 has a new automated bulleted list makii^

feature. Read the following to learn how to use it.

Version s.rs bulleted list
— COMMAND

Version 5.1 contains a bullet command on the Insert menu and a cor-

responding Bulleted List button on the Toolbar. These gizmos place

plain old bullets in front of selected paragraphs and create hanging in-

dents (read about hanging indents in Chapter 9.) The feature uses the

current font.

To BULLET EXISTING PARAGRAPHS

1. Select the paragraph or paragraphs you wish to format.

2. Click the Bulleted List tool (it looks like three lines with

boxes to their left) or use the Bullet command on the

Insert menu.
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3. Word will create hanging indents and insert bullets in front

of each selected paragraph.

4i Undo works if you act immediately.

To TYPE NEW BULLETED LISTS

1. Click the button or choose the command.

2. Type an entry and press Return.

3L Click the button or choose the command again.

As you can see, it's easier to first type multiple paragraphs then select

and bulletize them all at once.

Hidden text

I hate when authors do this, so with apologies, here goes. Even though

hidden text is technically a character formatting topic, it's not covered in

this chapter. To find out about hidden text, see Chapter 25. Sorry...

Smart or typographer's quotes

Word can automatically place curly quotes in documents when you type

straight quotes. This gives your work a typeset look. Turn the option on

before t)'ping since Word will not automatically change quote marks

you've already typed.

1. Use the Preferences command on the Tools menu to dis-

play the Preferences dialog box.

2. The General category slujuld be in view. If it is not, click on

the General icon to display the general options.

3. Enable the Smart Quotes by clicking to place an X in the

Smart Quotes option box.
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4, Subsequently when you type quotes. Word will convert them

to curly opening and closing quotes (assuming that your

chosen font has these characters).

D
If you are creating a document that you plan to export

(for use with different word processing software, perhaps);

turn off the Smart Quotes feature before creating docu-

ments containing quotes. Otherwise you'U risk confusing the

other guys with strange codes instead of quotation marks.

Large initial caps, drop caps,
- and dropped words

Large initial caps are just what their name implies—big letters at the

beginning of paragraphs. They are used as decorative flourishes. Drop caps

are large initial caps that are dropped into a paragraph or into the mar-

gin next to a paragraph. They are often placed at the beginning of chap-

ters and major topic transitions to catch your reader's eye. Dropped words

are a variation on this technique. You create drop caps or dropped words

by placing large initial caps or words in frames and positioning them to

get the desired effect. Graphics can also be used as drop caps.

m
You can use version 5. 1's Drop Cap. . . command to

automate the process of creating ch-op caps and dropped

words. Read about it in the following section.
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Figure 8.16 shows a few examples. Read the text in each example to

get an overview of how the effect was accomplished.

The process almost always looks easier than it is. It is very easy to frit-

ter away the hetter part of a day lining up drop caps and the text they sit

in. You'll often need to fiddle with paragraph formatting (line height

and spacing settings), superscripts, subscripts, frame sizes, and font sizes.

The version 5.1 Drop Cap feature does a pretty goodjob of minimizing

this, but there will be times when you'll still tear your hair out.

Using version s.rs drop cap feature

You control version 5.\'s drop cap feature from the dialog box shown

in Figure 8.17. Reach it with the Drop Caps... command on Word's

Insert menu.

Drop Cap... is designed to work with single spaced text only. It

won't work in tables, headers, or footers. You won't be able to see the

position of drop caps nor create them in Outline view. You can't place

drop caps in the margins of multicolumn documents, but you can

place them within text in multicolumn documents. That said, here are

the general steps:

1. Format the body text the way you like it. Be sure you are

happy with things like margins, fonts, and so on. Single

space the text.

2. Place the insertion point in the paragraph needing a drop

cap, and choose the Drop Cap... command from the

Insert menu.

3. You'll see the Drop Cap dialog box illustrated in Figure 8.17.

4k If you want to use a different font for the drop, choose it

from the drop-down font menu.

5. The Height box proposes the number of lines the cap will

drop. For instance, 3 li means that the drop cap will be

three lines tall and drop alongside the first three lines of

text. Pick the desired number of lines from the drop down

line list, or alternately, type in an exact point size for the

drop cap (36 pt, for instance).
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FIGURE 8.16

large initial caps and

dropped words created

using Frames, character,

and paragraph formatting

with the first example

created by 5. / 's new Drop

Cap command.

w ord version 5.1's new Drop Cap feature

automatically creates frames, increases the

size of the initial text and switches to Print

Preview. It will place drop caps in the text

or in the margin as shown here.

Drop caps can be created in a number of

ways. This one was made by selecting

just the letter D in 12 point New Century
Schoolbook text and increasing it to 25
points. The D was framed with the Format
menu's Frame... command. The Frame
width was adjusted in the Frame dialog

box. The D was then superscripted 6 points.

J-iarge initial caps

Create these by choosing a larger type size

for the first character. Minimize the

resulting extra white space between the

first and second lines by setting the first

line's Space After option to points and
superscripting the first line. You can use
Frames to create similar effects.

' Graphics can be used as drop caps

/too. This butterfly was pasted from
the scrapbook, reduced in size,

fi-amed, then dragged into place fi-om Print

Preview. The From Text option was set to

in the Frame dialog box to tighten things.

Entire words can be dropped.

This example was created

with the Frame command on Word's Insert

menu. First the word Entire was selected.

hen you can't resist the urge to be
decorative, consider using specialty

fonts like Ann-Stone shown here. It is

designed to simulate old wood cuts, contains

only upper case letters, and is perfect for

drop caps. You can find Ann-Stone and fonts

like it in many shareware font collections.
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FIGURE 8.17

Version 5.1 's new

drop cop options are

specified here.

Drop Cap

Font:

Courier B
""g"'-

|( OK
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rPosition

[ Cancel
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Drop caps without the drop cap... command
Figure 8.18 shows a sample drop cap exercise you can easily try. Even if

you have version 5.1 and plan to use the Drop Cap... command, try this

exercise. The techniciiies you'll learn can be used to improve the ap-

pearance of automated drop caps too.

Here are the steps for creating something that looks like the ex-

ample in Figure 8.18 without using version B.l's Drop Cap... command:

1. Work in Page Layout view so you can see your progress.

Type 5 or more lines of 12 point Courier body text with

Word's Automatic (default) line spacing.

2 Select just the first letter (the Yin our example), then open

the Character dialog box, perhaps with the 3€-D shortcut.

2. Make the selected character 48 point Courier as shown in

Figure 8.19.

4. Frame the single 48 point character using the Frame... com-

mand on the Insert menu. (This command automatically

sets the frame width to match the character width. If you

use the other Frame command, you'll need to specify a

frame width corresponding to the character width.)

5. Word will frame the Y, make it a separate paragraph and take

vou to Print Pre\iew. You'll see something like Figure 8.20.

6. Ugh! This creates too much white space at the bottom and

right side of the Y. That's because Word's automatic line

spacing feature has increased the white space to accom-

modate the big letter. And, Word initially places the frame

0.13 inches to the left of the text.

FIGURE 8.18

You may need to play with line height in the Paragraph
dialog box, frame width in the Frame dialog box, the
From Text setting in the Frame dialog box, and character

that created this sample to formatting options like Superscript to adjust the white
, , J space below and to the right of drops. The exact combination

see how to make drops depends upon which font and other choices you make. Try to

and imorove their
recreate this example. The steps are described in the text.

appearance.
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FIGURE 8.19

Select the cap and specify

48 point Courier.

FIGURE 8.20

For ntosl tastes, there's

too much white space

beneath and to the right

of this drop character

Select riie character to drop

ou may
^^/^ dialog

chajrac
adjust the v

exact combir
you make . Ti

described ir

7. Switch back to Page Layout view. (Click Close in Print

Preview.

)

8. Select just the Y and open the Paragraph dialog box (3€-M).

This is where you can force narrower line spacing by turn-

ing off the auto feature and telling Word the exact amount

of space you need.

9. Pull down the Spacing Drop-down list and choose Exactly.

Then type 34 and optionallv pt for M points in the box to

the right of the drop down list, fhis forces negative line

spacing (line spacing smaller than the text point size.)

Figure H.2\ shows the proper settings.



LARGE INITIAL CAPS, DROP CAPS, AND DROPPED WORDS

10. Click OK to execute the new settings. By now your screen

should look like Figure 8.22. Notice that the bottom white

space is gone but the top of the Y is cropped. That's be-

cause the line spacing is so small that the Y almost can't fit.

Subscripting will help.

11. Now, with the Y still selected, click on the ribbon's Subscript

button (the one with the down-pointing arrow). Wlien

FIGURE 8.21

Proper line spacing for

the drop cap example.

First pick Exactly from the list

Next type 34 or 34 pt

Then click OK

Untitle 12

ja i43^a [1M5

Idrop
ou mo
dial

:((;chara

radius
sTrKe

other choi
setepsa re

ja ^^NNI BEB
Spacing-

Before:
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working with larger drop raps you may need to visit the

Character dialog box to specify greater subscripting settings.

12. Finally, use the Frame... command on the Format menu as

shown in Figure 8.23 to open the Frame diiUog box and set the

From Text dimension to 0. Click OK and admire your work.

riGURE 8.23

Set the From Texf

dimension to 0.0 in.

UntJtled2 |
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Deleting drop caps

If you've just created a drop cap with version 5A's Drop Cap... com-

mand, Undo will delete it. Otherwise you'll need to take the following

general steps:

1. In Normal view with paragraph marks displayed, delete the

unnecessary paragiaph mark just to the right of the drop

cap. This will imframe the letter and place it back with the

rest of its partners.

2. Change the letter's size, font, and other characteristics to

match the rest of the text.

O I P

After you've removed the paragraph mark that follows

the drop cap, Word's Revert To Style command on the

Format menu (5€-Shift-Space) can often handle the rest of

the details.

Typing non-breaking spaces

In order to keep multiple words on the same line (someone's tide, first

and last name for instance) , you can use special spaces called non-break-

ing spaces. To do this, simply hold down the Option key when you press

the Spacebar.

Typing hyphens and dashes

To type hyphens, simply use the minus key (to the right of the zero key at

the top of yoiu- keyboard) . Hyphens typed this way will always print.
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Typing non-breaking hyphens

Non-breaking hyphens keep hyphenated words together on the same

line. Never press the minus key (-) to enter a non-breaking hyphen! In-

stead, liold down the 3€ kev and press the tilde key (~).

D I P

Since non-breaking spaces are typed by holding down
the Option key when you press the Spacebar, you may be

tempted to type non-breaking hyphens by holding down the

Option key and pressing the minus key. Big mistake! As

you'll see next, the Option-minus key combination is used

for en dashes (a littie brother of the em dash).

Typing em and en dashes

Em dashes are used to indicate an abrupt change of thought—or did you

know diat already? Hyphens and dashes are often confused. Type tlie longer

em dashes by holding down Option, Shift, and the minus key (-). In some

fonts em dashes are very long and obvious. That's not always the case.

Incidentally, em dashes get their name from their width. In most

fonts an em dash is the length of a letter m. That's an easy way to remem-

ber what it's called.

D I P

While dashes should normally be longer than hyphens,

in a few fonts (including Chicago) they are not. You are not

losing your mind after all. It's a bug.
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Typing optional hyphens

An optional hyphen will always be displayed whenever you have the Show

Paragraph feature enabled, but it will print only if the word it is in sits on

the right margin. Most people use Word's automatic hyphenation feature

to enter optional hyphens, but you can enter them from the keyboard.

Hold down the % key and press the minus key (-). If all this talk of

dashes and hyphens is sounding like Morse code, take a moment to

peruse Table 8.1.

TABLE 8.1 Word's Hyphens and Dashes

HYPHEN KEY COMBINATION APPEARANCE^

Normal

En dash

Em dash

Non-breaking

Optional

*W/>/i Show on.

Option- -

Option-Shift-

Automatic optional hyphenation

Word 5 has an automatic feature that will work with you to place optional

hyphens in words based on certain built-in rules and a hyphenation dic-

tionary. You can supervise the process or let Word take things into its

own hands. If you use it, there are some things you will want to do first.
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m A R N I N G

Optional hyphenation is one of the last things you want

to do when preparing a document. Finish everything else

that affects line endings first. Otherwise, you will may need

to rehyphenate repeatedly.

Preparing to hyphenate

Bf sure ihal your document is complete and properly organized. Do the

spelling check. Polish the appearance ot your text (fonts, sizes, character

expansion, etc.) Apply justification, if that's part of your plan. Break the

document into sections if you need them. Set up columns. Have some-

one else proofread your work one last time. You may, however, want to

hold off on final page-break decisions until after hyphenation.

Check out Figure 8.24. Judging from all of the white space between

words, it could profit from some hyphenation.

FIGURE 8.24

This raggedy text needs

hyphenation—especially

the third line from the

bottom!

Those priceless few moments
before the sun sets always
remind him of fine brandy or

New England in the fall.

Everything and everyone
around the two of them was
bathed in orange and red and
hues without names.
Photographers call it magic

light.
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Entering optional hyphens

Word will hyphenate an entire document orjust selected text. When you

choose Hyphenation. . . from the Tools menu, Word will open a small dialog

box like the one in Figure 8.25. Click the Start Hyphenation button.

Working from the insertion point, Word will move through your

document (or selected text) looking for a possible word to hyphenate. In

Figure 8.2.5 it has found the word remind.

The dialog box offers several alternatives. The Change button will

place an optional h)phen between the e and m. The No Change button

tells Word to not hvphenate this word and to continue. Cancel quits the

hyphenation.

Optionally, you can move the hyphenation point yourself Use your

mouse to point to where you want to place the hyphen. Press the mouse

button once. A non-blinking pointer will appear between the characters

you've chosen. Click on the Change button to place the optional hyphen

and continue the automatic search.

As you can see from Figure 8.26, Word suggested only one hyphena-

tion point in our example. It left the rest of the unsightly white holes (be-

tween Everything and everyone and hues without names, etc.). It didn't solve

the widow problem, either Big help.

FIGURE 8.25

Wordis suggesting that

remind be hyphenated

between the e and the m.

-iFii'R?—IR mZJMi ElB
[Normal

^
ja \^\^Mm B^^ B^ BT^ tm Btn\

41 -4?

These priceless few moments
before the sun sets always

r^ind him of fine brandy os

New England in the fall:

Everything and everyon^

around the two of them was
bathed in orange and red and

hues without names;

Photographers call it //ij?i"

/'>^if-

ID^ Hyphenation

Hyphenate:
|

rejmind

n Hyphenate CapitaHzed UJords

\[ No Change
]]

[
Change ^] [

Hyphenate Selection Cancel
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FIGURE 8.26

Word's automatic

hyphenation may not

solve all your problems.

Those priceless few moments
before the sun sets always re-

mind him of fine brandy or

New England in the fall.

Everything and everyone
around the two of them was
bathed in orange and red and
hues without names.
Photographers call it magic

light.

Moreover, some editors and style manuals will tell you not to

hyphenate words in ways that leave only one syllable on a line, yet Word

has done just that. There are few hard-and-fast hyphenation rules.

Manually breaking the one-syllable rule twice more creates a much
nicer looking paragraph, as you can see in Figure 8.27. The combination

of manual and automatic hyphenation even found a home for the widow.

D I P

If you like tight copy, you may want to run the auto-

hyphenation feature and then fine-tune a bit by hand.

Removing automatic hyphens

The Undo Hyphenation command (located on the Edit menu) will be

available to remove optional hyphens if you use Undo (3§-Z) immediately

after you run the auto-hyphenation feature.
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FIGURE 8.27

Adding two hyphens

manually really improves

the final appearance of

the paragraph.

Those priceless few moments
before the sun sets always re-

mind him of fine brandy or

New England in the fall. Every-

thing and everyone around the

two of them was bathed in

orange and red and hues with-

out names. Photographers call

it magic light.

You can delete hyphens like any other character. Select them and

cut or delete. Word's Find and Replace features will also help you delete

hyphens of all sorts. See Chapter 19 for details.

Formula typesetting commands
If you need to type complex formulas, Word now gives you the choice

of using its built-in formula typesetting commands or the more fully

featured Equation Editor. In this chapter we'll explore the ten built-in

commands that let you construct complex equations. Some of these com-

mands, like Box and Fraction may be of interest e\en if you don't create

complex formulas.

Syntax for formula commands
You type formula typesetting commands directly into your documents.

They all begin with a special character created by holding down the 3€,

Opdon, and backslash (\) keys simultaneously. This special character tells

Word that the text that follows contains special formatting instructions.

For instance the command string \X(Let Me Out) tells Word to draw a

box around the words Let Me Out. The command .\F(1,2) tells Word you

want to create the fracdon '/2. A command string consists of several

parts. For instance, in the string .\F(1,2) the .\ tells Word that a formula-

typesetting command follows. The letter F is the Word 5 command for
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Fraction, and ( 1 ,2) are the arguments used bv the command. Many com-

mands have opticjns. There are rules about which argviments and options

can be used together, and in what order. Sometimes there are command
limitations. For instance, Word's arrays can have no more than 39 argu-

ments. Collectively, the rules and guidelines described above are called

the command .syntax.

To type and view a command string, place Word in Normal view

with Show H turned on. To see how the command string will print, choose

the Hide ^ command either using the ribbon, the View menu, or the §€-]

shortcut. Switching to Page Layout view will also show you how command
strings will print. When you get proficient with the commands you may
find yoiuselfWorking in Page Layout \'iew for instant gratification.

Microsofi recommends that you type these commands at the begin-

ning of new lines (paragraphs), but you may find that they'll work in the

middle of lines too.

Figure 8.28 shows examples of all ten commands and the results

they produce. The first column contains the command name and the

basic command code. The second colimm shows a typical command
string—examples of things you might type. Cohmin three shows the

results of the command when printed or displayed in Page Layout view

or in Normal view with Show K off.

You may want to refer back to Figure 8.28 as you read more about

each command and its options and syntax. Commands are shown in up-

perca.se, but lowercase will work as well.

Array (AA)
Use this command to create one- or two-dimensional arrays (usually

columns of numbers). An array command can contain a maximum of 39

arguments. There are array options that let ycui specify the number of

columns, the alignment of numbers (left, right, or center), and options

for specifying vertical and horizontal spacing of the numbers.

Option Notes

.\AlL Aligns left

.\AR Aligns right

.\AC Aligns center



FORMULA TYPESETTING COMMANDS

Option Notes

\COn Sets the number of columns to n

SVSn Vertical spacing between lines in n points

.\HSn Horizontal spacing between columns in n points

Box (AX)
Use this command to draw a box around whatever you type in paren-

theses (the argument). The default command draws all four box sides.

You can have word draw only specified sides (like just the top orjust the

FIGURE 8.28

Word provides ten

builf-in formula

commands for use in

scientific and other

applications.

Command
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left and right sides) by specifying the desired sides as options. As you can

see in Figure 8.28, it is possible to embellish text in the argument. Word
will accommodate for large type sizes, bold characters, etc. Here are the

options for the box command.

Option Notes

.\BO Draws the bottom line

.\LE Draws the left line

.\RI Draws the right line

.\TO Draws the top line

Bracket (AB)
This command places brackets alongside your arguments. You can

specify the character to use for bracketing (usually {), [], or <>). If you

don't specify a character, Word will use parentheses. As you can see in

Figure 8.28, it's possible to specify brackets on both sides of arguments

by using the .\BC option with a left bracketing character like | or [ or (.

If you use other characters with the .\BC option, they will repeat on both

the left and right side.

Option Notes

.\LC.V Puts the character c on the left of an argument

.\RC.V Puts the character c on the right of an argument

.\BC.V Puts the character con both sides of an argument

Displace (AD)
Use this command to move the next character horizontally relative to the

preceding character. You saw an example of this earlier in the chapter.

The empty parens are required, as shown in Figure 8.28.

Option Notes

.\FOh Spaces forward m points
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.\BAw Spaces backward n points

.\LI Draws line from preceding to next characters

Fraction (AF)

Here's an easy way to create good looking fractions. The command syn-

tax is .\F(numerator,denominator). Remember to place the numerator

first in your argument. Arguments can be numbers, text, other equa-

tions, or combinations thereof. Figure 8.28 shows some examples.

Integral (Al)

This command creates an integral containing three arguments in the

order (lower limit, upper limit, integrand). Integrals of simple radical

equations like square roots, align with the equation centered vertically.

Complex equations center on the radical value.

Option Notes

.\SU Creates a capital sigma (Z)

.\PR Creates a capital pi (IT)

.\IN Specifies in-line format with limits to the right

.\FC.V Specifies fixed-height character (c) as operator

.WC.V Specifies variable-height character (c) as operator

List (AL)

Since Word uses commas to separate items in an argument, there needs

to be a way to create commas that display and print without confusing

the typesetting feature. This is it.

Overstrike (AO)
This command draws arguments on top of each other. You can adjust the

character alignment using three options.
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Option Notes

.\AL Aligns the left edges of character areas

.\AR Aligns the right edges of character areas

.\AC Centers alignment

Radical (AR)
This draws one- and two-argument radicals. Figure 8.28 has examples

of each.

Super or Subscript (./S)

This command places things a specified number of points above or

below the baseline. If you don't specify options, Word uses a 3-point

default. You cannot use these commands in conjunction.

Option Notes

.\UPn Places arguments n points above the baseline

SDOn Places arguments n points below the baseline

.\AIn Alters the space allowed above the baseline n points

SDln Alters the space allowed below the baseline n points

Creating Complex Formulas
As you can see in the Fraction example in Figure 8.28, it is possible to

combine commands and formulas to create complex notations. You may
need to surround some formulas and commands with parentheses.

Formula Glossary
Microsoft may have provided a formula glossary with your copy of Word.

Look for it in the Glossary folder within the Commands folder wherever

you installed your Word program. If you find a formula glossary, you can

use it to explore sample equations and to simplif)' formula creation. For

more on glossaries, see Chapter 16.
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Printing Problems
A formula must be able to fit within the specified margins, indents, or

table-cell width where you ask Word to place it. Otherwise it will not dis-

play or print. If you have problems, adjust margins, indents, or cell

widths as necessary, or break up the formula.

About font technologies

As computers evolve, new font technologies emerge. These changes

often improve the way characters look on your screen and print on

paper. Unfortunately, advances also add to the confusion, and create new

compatibility problems. Plus, there are differences in the way System 6

and System 7 interact with various font technologies. Word works with vir-

tually all existing Mac fonts. We'll leave in-depth discussion of the topic

to other books specifically devoted to the subject and your Macintosh

manuals, but an overview is in order.

Bitmapped fonts

Bitmapped fonts (sometimes called screen fonts, or fixed-size fonts) were

the first to be used on Macintosh computers. They are still very popular

with good reason. They look great on your screen and they display quick-

ly. Moreover, they work on non-PostScript printers (like the Image-

Writer).

When your Macintosh System was installed, a number of standard

bitmapped fonts like New York, Monaco, Chicago, and Geneva were auto-

matically included. You or someone else may have added others.

Bitmapped fonts create a character by turning on and off the ap-

propriate pixels on your screen, and the "dots" on your printer. When
you install bitmapped fonts on your Macintosh, you'll want to install all

of the sizes of a bitmapped font you plan to use (unless you are using

TrueType, PostScript fonts, or ATM described in a moment).

When you select a bitmapped font. Word's Font menu shows you

which sizes are installed. Installed font sizes are listed in larger outlined

characters. For instance, you can tell from Figure 8.29 that only 12 Point

Courier is installed on this Mac.
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FIGURE 8.29

Only Courier's J2 point

font is installed.

.Dip Tools [DJndoiD

9 Point

10 Point

v/t]g PsDmQ
14 Point

18 Point

24 Point

It's possible to display and print characters in uninstalled sizes, but

Word and your Mac will attempt to scale an available point size to fulfill

your request. This sometimes results in jagged, nasty-looking characters.

Since obtaining the best quality from bitmapped fonts requires in-

stalling many different versions of the same font, (particularly with non-

PostScript printers like the hnageWriter); and since bitmapped fonts

must record every single dot that makes up a character, a font collection

can quickly use up a lot of disk space. That's one of the reasons that scale-

able TrueType and PostScript fonts are now so popular. It's also one of

the reasons that Adobe's Type Manager was invented.

TRUETYPE FONTS

TrueType fonts are scaleable. That is to say, instead of being collections

of dots, they are mathematical representations of character shapes that

your Mac uses to draw characters. They can easily scale up or down to

represent different sizes. TrueType support is built-into System 7, and

can be added to System 6.07 with an installer available from your Apple

dealer. TrueType fonts print on all laserprinters (PostScript or not), and

they often look much better than bitmaps on Inkjet printers and when

used with fax modems. Moreover, if you share files with Windows users,

you can somewhat minimize font compatibility problems by installing

similar TrueType fonts on Windows machines and Macs.
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Postscript fonts

PostScript is actually a programming language developed by Adobe. It

makes it possible for a wide variety of programs like Word, PageMaker,

MacDraw, and others to print complex images on a wide variety of devices

including laserprinters, typesetting equipment, 35mm slide imagers, etc.

PostScript fonts are actually collections of character descriptions created

in the PostScript language. PostScript's universality makes it theoretically

possible for you to create a document on your Mac and reproduce it ex-

actly on a typesetter or other PostScript-sawy device. (That's the purpose

of the PostScript File option in Word's Print dialog box.)

There are many, many PostScript fonts available. Most popular laser

printers (including the entire Apple line) are PostScript compatible and

have built-in PostScript font families in their ROMs. The usual collection

includes:

" Avant Garde

Bookman

Courier

Helvetica

New Century Schoolbook

Palatino

Symbol

Times

Zapf Chancery

Zapf Dingbats

When you want to print a font that is not resident in your printer's ROM,
the font needs to be downloaded to the printer's built-in RAM. Word and

your Mac can take care of this for you automatically. The process can

cause a noticeable delay in printing however.

Because (at this writing) Macs cannot directly display the scaleable

PostScript characters on-screen, when you install PostScript fonts you

also install bit mapped versions of these fonts. The bitmaps are often

referred to as the screen fonts and the scaleable fonts are often called

printer fonts.
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Occasionally you'll be able to create effects on screen with Post-

Script screen fonts that won't print with the printer fonts. For instance,

combining the shadow and outline character formats works on screen

but not on paper.

There are two commonly used variations on the PostScript theme

called Type 1 PostScript fonts and Type 3 PostScript fonts. (Don't ask

about Type 2, it's a sore subject.)

Type 1 fonts have special information called hinting -which often im-

proves the appearance of smaller type. Word will work with both Type 1

and Type 3.

Your printer must be PostScript compatible to directly print Post-

Script fonts (usually Inkjet and other dot matrix printers are not). Non-

PostScript printers can print PostScript fonts with the help of utilities like

Adobe Type Manager (ATM).

Adobe type manager or atm

ATM is a utility program that enables your Mac to display representations

of your PostScript printer fonts on your screen instead of using your bit-

map screen fonts. This lets you displayjaggie free type in just about any

size. But many people install ATM because it also noticeably improves

Inkjet printing and sharpens the appearance of documents sent via FAX
modems.

There are drawbacks. ATM can slow down your Mac display. This is

particularly noticeable on older and low cost machines like a Macintosh

Plus or a Macintosh Classic.

By the time you read this, Apple and Adobe may have already

added ATM to Apple's system software, in which case you'll not need to

purchase ATM separately.

When different

machines have dissimilar fonts

Wlien you create a document on your machine and try to print out on

someone else's, it is important to have the fonts you've used in the docu-

ment on both machines. Otherwise, fonts will be substituted, affecting

the appearance of your document.
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Occasionally you'll see truly bizarre font substitutions because of

something called font ID conflict. To learn more about problems like

these and possible work-arounds, see your Macintosh manuals or a book

specifically devoted to computer font technologies.
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TRACKS

To €reate a new paragraph 289

press the Return key. Each time you do, a new paragraph is

created, and a paragiaph mark is placed in your document. Use

the Show f command or ribbon \ button to see paragraph

marks.

To split one paragraph into two 289

move the insertion point to the place where you want the new
paragraph to begin. Press Return.

To join two paragraphs 290

delete the paragraph mark between the two paragraphs. Text

above will take on the appearance of text below if the two para-

graphs originally had different paragraph formatting.

To tenter, align, or justify text within paragraphs 302

place the insertion point in the paragraph of interest, or select

multiple paragraphs. Use the Center, Left, Right, or Justify

buttons on the ruler, or use the keyboard equivalents 3€-Shift-C,

§€-Shift-L, and 5§-Shift-R respectively.



To adjust spating between lines in tlie same paragraph 303

place the insertion point in the paragraph, or select multiple

paragraphs. Use the ruler's single, 1.5, or double space buttons;

or use the Format menu's Paragraph. . . command or 3§-M short-

cut to open the Paragraph dialog box. (Double-clicking on in-

dent markers will also open the dialog box.) Type the desired

line spacing in the box next to the Line drop-down list. Enter

specifications in inches (in), points (pt), pica (pi), lines (li), or

centimeters (cm). Use the list to pick Exactly, or At Least.

(Don't get in the habit of pressing the Return key twice to

double space.)

To adjust the spating between paragraphs 305

place the insertion point in the paragraph, or select multiple

paragraphs. Use the ruler's Blank Line Space buttons (just to

the left of the tab buttons) or use the Paragraph... command or

9€-M shortcut to open the Paragraph dialog box. (Double-click-

ing on indent markers will also open the dialog box.) Use the

Paragraph dialog box to specify spacing before, spacing after, or

combinations thereof. Type the desired paragraph spacing in

the boxes labeled Before and/or After. Enter specifications in

inches (in), points (pt), pica (pi), lines, (li) or centimeters

(cm). If you've created space between paragraphs by pressing

Return, (usually not a good idea) select the resulting paragraph

marks and change their spacing specification or font size.



Word's unique definition ofa paragraph

How toformat paragraphs

Adjusting the space between lines

and paragraphs

Creating borders and lines

Adding shading

Numberingparagraphs

Sortingparagraphs

I HIS CHAPTER EXPLORES Word 5's

1 paragraph-formatting tools used for

adjustable line spacing, indentation, and text alignment. You'll see how
to use Word's border features to create boxes and lines. Paragraph num-

bering, shading, and sorting are also discussed. You can save complex

sets of formatting decisions as styles, as you'll see in Chapter 13.

WORD'S PARAGRAPHS
Your English teachers taught you that paragraphs are collections of sen-

tences on a related topic. Word uses a somewhat more liberal definition.

A Word paragraph can be a single text character, a graphic, or even a

blank line consisting only of the paragraph mark (f) that appears in

your document when you press the Return key. Paragraph-formatting

features are an important part of Word 5's arsenal. Figure 9.1 contains

five Word paragraphs, each ending with a paragraph mark. Can you

find them all?

Each Word paragraph in your document can be uniquely for-

matted, and need not contain text. For instance, the first paragraph in

Figure 9.1 is single spaced with the first line indented about Vf. The
next paragraph contains a hanging indent, and is double spaced. The

third paragraph is right justified. The fourth paragraph is a blank line



WORDS PARAGRAPHS

FIGURE 9.1

Word paragraphs always

end with a paragraph

mark (HI.

[Normal

JO^

Paragraph samples

[FglM] BEI MM H aiTH
3a f^msmi bf^ b^ btitf^i mrrn

-^ -p-

Some Word paragraphs contain multiple sentences Some do not Wotd
paragraphs always end with a paragraph maik -

paragraph can have a unique format Blank lines can be paragraphs This example

contains five paragraphs li

Con you find than aUT^

Page 1 Normal ]SE JMa

created by pressingjust the Return key. The final paragraph is a graphic

(without text), followed by a paragraph mark. Notice that this last para-

graph (the graphic) has been centered.

Creating paragraphs

Each time you press the Return key you create a new paragraph. It's that

simple. When you open a new document. Word applies the default para-

graph settings stored as a style called Normal. It formats each new
paragraph the same way until and unless you tell it to do otherwise.

Splitting text into multiple paragraphs

If you want to split a lengthy section of text into two or more paragraphs,

do this:

1. Place the insertion point where you want the new para-

graph to begin. (Be careful not to include unwanted spaces

when splitting text.)

7. Press Return.

X The text will split, and you'll see a paragraph mark if the

Show f feature is enabled.
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4b The new paragraph will take on the characteristics of the

one above. For instance, if the original big paragraph had a

first line indent, the two little ones will too.

This concept is illustrated in Figure 9.2. Notice how the new paragraph

takes on the same indentation characteristics as the preceding one.

FIGURE 9.2

To spilt one paragraph

into two, position the

insertion point (watching

for unwanted spaces) and

press Return.

, Place insertion point

to begin new porograph

(beware unwanted spaces)

Your Englh>n teachers taught you that

paragraphs aiv^ol lections of sentences on a

Bgfo^g j
related topic. |Word uses a somev;^at more
liberail definition. A V/ond paragraph can be
a single text character, a graiphic, or ei/en a
blank line, fl

Your English teachers taught you that

paragraphs are collections of sentences on a

related topic. 1

After 1 Word uses a somewhat more liberal

definition. A Word paragraph can be a
single text character, a graphic, or even a

"" blank line. ¥ \
New paragraphs take

on characteristics of ttiose above

iO\H\HG PARAGRAPHS

It's easy to turn two paragraphs into one. Just delete the interceding para-

graph mark and add any necessary space to separate the new neighbors.

For instance, to rejoin the two short paragraphs in Figure 9.2, you'll

need a space between the period after the word line and the Y in Your.

The quick way tojoin these two paragraphs would be to select the un-

wanted paragraph mark and type a space to replace it.

1. Turn on the Show f feature (3€-J), to make things easy.

2. Delete the paragraph mark between the two paragraphs,

adding space if necessary.



DELETING PARAGRAPHS

3. Text above will take on the appearance of text below if

the two paragraphs originally had different paragraph

formatting.

Forcing new lines without using
- paragraphs

Sometimes you'll want to force a new line without creating a new para-

graph. The reasons will become more apparent as you start to use ad-

vanced Word features like paragraph numbering and styles with Next

Style options, so tuck this trivia nugget away. To force new lines without

creating new paragraphs, use the Shift-Return key combination. Instead

of a paragraph symbol, you'll see arrows like the ones in Figure 9.3.

FIGURE 9.3

Use the Shift-Return

feature to force new lines

This line is in the fi rst paragraph^

So is this one^
without starting a new and this One^
paragraph and note t

different marks at tht

of all but the last line.

paragraph and note the ^nd tHs One.'^l
dirferent marks at me end

Deleting paragraphs
Think twice when deledng paragraphs. You can delete just the contents

of a paragraph or delete the contents and the paragraph marker. If you

delete the marker, text below the old paragraph will take on the charac-

teristics of the remaining paragraph above it. This is by design, and is not

a bug. If you accidentally delete a paragraph mark, and create a prob-

lem. Undo (3§-Z) will usually return your heart rate to normal.
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Adding blank lines between
» paragraphs

You can create blank lines typewriter style byjust mashing on the Return

key all day. But hey, it's almost the year 2000. Instead, create white space

between paragraphs, rather than adding blank lines. Use tools like the

ruler's Space Before Paragraph button, or the Paragraph dialog box. As

you'll soon see, this will give you better control over spacing between

paragraphs and make it easier to keep paragraphs together. Read on.

Paragraph formatting

You modify the appearance of paragraphs using Word's ruler, Toolbar,

and the Paragraph dialog box. The ruler and version 5.1 Toolbar are

easy to use and readily available. When precise formatting is required,

consider using the Paragraph dialog box rather than the ruler. Some for-

matting features have keyboard shortcuts.

O I P

If you want to reformat only one paragraph, simply

place the insertion point anywhere within the paragraph,

then make formatting changes. There is no need to select

the text in a sin^e paragraph. To alter multiple paragraphs,

select them first. Your changes will affect all selected

paragraphs, including any partially selected paragraphs.

Double-clicking at the left edge of a paragraph will select it.

As we did in the previous chapter, let's start with a quick tour of the

paragraph formatting tools, then look at some everyday paragraph for-

matting tasks.



PARAGRAPH FORMATTING

Formatting with the ruler

The ruler contains a number of handy paragraph-formatting tools. If the

ruler is not showing, use the keyboard shortcut §€-R or choose Ruler

from the View menu.

You must tell Word which paragraph or paragraphs you wish to for-

mat before using the ruler's tools. Figure 9.4 shows you the location and

function of the ruler's paragraph-related features.

If you have only one paragraph selected, or if all of the selected

paragraphs have identical paragraph formatting options, you'll see in-

dents and tabs displayed in the ruler. Activated paragraph options (like

double spacing) will be indicated with darkened buttons.

But if you select dissimilar paragraphs, the bottom of the ruler will

be grayed-out and the ruler will indicate the indents for the first para-

graph only.

Effi
Version 5. 1 has several paragraph formattii^ features

on the Toolbar. Read about them next.

FIGURE 9.4

The ruler places

paragraph formatting

tools at your fingertips

and also shows many

paragraph setting options.

Left align Right align

Center \ Justify

1 2 points of extra space

between paragraphs

Tab stops

see Chapter 1 0)

Line-and-a-half spocing

First line indent marker Shows indent markers

Left indent marker Right indent marker
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Formatting with the toolbar

Standard paragraph buttons on version S.l's Toolbar include BuUeted

List, Nest, and Unnest. You must tell Word which paragraph or para-

graphs you wish to format before using these tools. Figure 9.5 shows the

buttons. All three of them change indents on specified paragraphs. The

Bulleted List button also precedes selected paragraphs with bullets.

You'll see examples of all three features at work later in this chapter.

FIGURE 9.5

Paragraph formatting

buttons on the Toolbar

Formatting with the paragraph dialog box

The Paragraph dialog box shown in Figine 9.6 is reached with the Para-

graph... choice on the Format menu or with the §§-M keyboard shortcut.

FIGURE 9.6

Reach the Paragraph

dialog box from the

Format menu, with the

li-M shortcut, or via

botspots.

Paragraph

rSpating-



PARAGRAPH FORMATTING

D I P

m

Double-clicking on any paragraph formatting button in

the ruler, or on any indent marker will bring up the Para-

graph dialog box.

Besides being the launching pad for several other formatting

features (Tabs, Borders, and Frames), it lets you precisely specify inter-

line and inter-paragraph spacing. You can dictate exact indentation and

line spacing measurements here. This is also where you turn offline

numbering for specific paragraphs and specify pagination guidelines.

Wlien you enter measurements in the Paragraph dialog box you

can often use different units of measure for the same specification. For

instance, you can specify hue height in points (pt), lines (li), inches (in),

picas (pi) , or centimeters (cm) . Each possible numeric entry in the Para-

graph dialog box has a default unit of measure which is shown in each

entry box.

In United States Word versions, the default for horizontal measure-

ments like indents is inches. The default unit of measure for line and

paragiaph spacing is points. (You may recall, diere are 72 points per inch.)

A R N I N G

It is possible to make entries in the Paragraph dialog

box without specifying units of measure if you know the

default unit of measure for each type of entry. For instance,

the default for line spacing is points. Here's the rub. If you

enter 2, Word will assume you mean 2 points, not double

spacing. To specify double spacing you'd need to enter 2 li.

When you are uncertain about the default unit of measure

for a paragraph specification to play it safe, always enter the

unit of measure's abbreviation.
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Keyboard formatting shortcuts

There are numerous keyboard shortcuts for paragraph formatting. They

are mentioned throughout this chapter and summarized in Appendix B,

Table B.5.

A few keyboard shortcuts are additive. That is to say, instead of tog-

gling, when you press them more than once, they increase their effect.

For example, pressing 3€-Shift-N indents a paragraph one-half inch.

Pressing it twice consecutively indents the paragraph one inch.

Specifying paragraph formats

As promised, here are the steps for applying paragraph formats and

everyday examples. Don't forget that it is possible to store and quickly

recreate complex paragraph formats using Styles, as described in

Chapter 13.

Indenting paragraphs
- automatically

There are a number of ways to indent paragraphs, hidents are added to

margins, thereby increasing the white space and decreasing the text area

for specific paragraphs. Thus, if you have a 1.0" right margin and specify

a right indent of 1.0", your text will print 2.0" from the right edge of the

paper.

The first line of each paragraph can be indented differently from

other lines in the paragraph. First lines can be shorter than the others,

creating indents, or longer than the others creating hanging indents

(sometimes called outdents). Once you change indents, each new para-

graph you start by pressing Return will maintain the same indentation

settings until you change them. Indented paragraphs can have other

paragraph formatting as well. Figure 9.7 shows several indenting

examples.
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FIGURE 9.7

Several examples of

paragraph indenting.

a I p

First line indents Indent markers

Bob fl

1 am considenng using the following quotation in the shareholders

meeting this Monday What say'!!

Advetisinq may te desalted as the science of

arresting tne human intelligence long enojgh to get

money ffcm it H
Stephen Leacodc"i_

Maiy thinks it's perfect Joan and I aren't so sure 'Ve need to nail nx

opening quote down today so 1 can work it into the sbdes !f

Page I I
Indent -ML

Paragraphs with 1 " left

and right indents

Whenever you place the insertion point in a paragraph,

the indent markers on the ruler move to show you the

setting for the current paragraph.

Indenting with the ruler

The quickest way to indent is to drag indent markers on the ruler. To ad-

just left and right paragraph indents from the ruler:

1. Place the insertion point in a paragraph or select multiple

paragraphs.

2. Point to, and then drag the appropriate triangular indent

markers to the desired locations. (Drag on the bottom part

of the left marker to set the overall left indentation.)

3. If you are interested, watch the status area at the bottom left

corner of the window as you drag. It shows the position of

the indent mark in relation to its respective margin.
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A. You will see the text move when you release the mouse button.

5. Wlierever you place the insertion point in a paragraph, the

indent markers on the ruler move as necessary to show you

the setting for the current paragraph.

Indenting with the paragraph dialog box

The Paragraph dialog box lets you type in specifications for right, left,

and first line indents. The default dimension in the U.S. is inches (in).

By including the appropriate imit of measurement with your entry, you

can specify points (pt), picas (pi), or centimeters (cm) instead. To adjust

left and right paragraph indents from the dialog box:

1. Place the insertion point in a paragraph or select multiple

paragraphs.

2. Open the Paragraph Dialog box with the Format menu's

Paragraph... command (§€-M) or click on a hotspot.

X Enter specifications for right, left, and/or first line indents.

4 To see the effect without closing the Paragraph dialog box,

use the Apply button. Click OK when you are happy with

the indentation.

5. Once you move indent markers, each new paragraph you

start by pressing Return will maintain the same indentation

settings tmtil you change them.

Indenting with keyboard shortcuts

There are keyboard shortcuts that move the left indent marker. The

keyboard shortcut §€-Shift-N moves it to the right the distance of one

standard tab stop, and §§-Shift-M moves it back the same distance. These

are additive commands, and can create nested paragraphs. Pressing

3€-Shift-R twice indents further than pressing it once. There are no short-

cuts for the right indent marker.
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m
The Toolbar contains three buttons for indenting.

Read about them next.

Indenting with the toolbar

The Nest Toolbar button moves the left indent marker to the right the

distance of one standard tab stop, and the Unnest button moves it back

the same distance. These are additive commands. Pressing Nest twice in-

dents further than pressing it once. There are no Toolbar buttons for the

right indent marker.

Indents in margins

It is possible to specify indentations that print in the right and/or left

margins. Specify negative margin settings in the paragraph dialog box

(-0.5 in, for instance), or drag indent markers into margins. Be patient.

Horizontal scrolling is required when you drag indent markers into mar-

gins, and the process can sometimes be slow.

Indenting FIRST LINES

You can indent the first line of a paragiaph with the ruler, the Paragraph

dialog box, or tabs. Tabs are generally the least efficient method.

First Line Indenting with the Ruler

1. Place the insertion point in a paragraph or select multiple

paragraphs.

2. Drag the top half of the left indent marker.

3L Text moves when you release the mouse button.
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4 Subsequently typed paragraphs will indent the same way.

First Line Indenting vs^ith the Paragraph
Dialog Box

1. Place the insertion point in a paragraph or select multiple

paragraphs.

2. Open the Paragraph dialog box from the Format menu
(5€-M), or with a hotspot.

X Specify a first line indent dimension in points (pt), inches

(in), picas (pi), or centimeters (cm).

4. Use the Apply button to see the effect without closing the

dialog box. Click OK when you are happy.

First Line Indenting >vith the Tab Key
You can create first line indents with the Tab key. But it's extra work,

since you'll need to remember to tab each time you start a new para-

graph. Use the ruler trick instead. You'll like it.

Hanging indents

Sometimes it is desirable to have the first line in each paragraph stick

out. This is particularly useful for creating bulleted lists, numbered para-

graphs, bibliographies, and so forth. Tlie first line in a hanging indent

is called (cleverly) a hanging indent. The subsequent lines beneath are

called turnover lines. Figure 9.8 shows some examples.

Hanging Indents vs^ith the Ruler

When creating hanging indents from the ruler, follow these steps:

1. Place the insertion point in the paragraph you need to for-

mat, or select multiple paragraphs, or place the insertion

point where you plan to begin typing hanging indented

paragraphs.
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FIGURE 9.8

Some examples of

hanging indents.

Hanging indents

|New i>ntyr^ S.^flTlR [T? >Q SIZIl] ^EHj BSBI
iNormal 3^

mnm
im HE

^ -4i- -1^ -P- -44

Llllin KTiI^

X
DeTank. P 1987 Adi/antaga ofHead-to-Tail Sardine

Packing San Franda^o, CA, Doc's Oceanographic
Press ¥

Hanging Indents usually start flush left with their

ttimo\«r lines indented This example was created

with a kejfboard shortcut'?

• Many people use hanging indents like thisone for

bulleted lists Version 5 1 will create then
automatically with a toolbar button as illustrated

here/i

1, Numbered lists also look betterwhen formatted with
hanging indents '-U

2 This usually is easiest with the ruler or tabs ,^

Page I INormal^ m:

Z Set the position of the left edge of the turnover Unes. With

the Ribbon in view (3§-Option-R) , drag the bottom half

of the left indent marker to the right.

3. If you plan to indent the right edge of your paragraph (s)

drag the right indent marker either now or later.

4. To create the hanging indent, drag the top half of the left

indent marker to the left, past the turnover indent, and

release the mouse button when you reach the desired

point. The ruler will scroll to show you the hanging indent's

position with relation to the rest of the paragiaph.

Keyboard Shortcuts for Hanging Indents

There are keyboard shortcuts for moving the left indent. Use 5§-Shift-N

to move the left tab marker to the right. Pressing 3§-Shift-M moves the

marker to the left. Movements are in the increments used for default tab

settings (usually W). This is a great way to create nested indents! (Note

that l§-Shift-M will not go past the left margin.)
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Aligning and justifying text

The four buttons near the left end of the ruler let you quicklyjustify, cen-

ter, and right- and left-align text. The lines in the buttons demonstrate

the expected results. As always, you must first either select multiple para-

graphs or place the insertion point in the paragraph you want to align.

Left alignment

Left alignment is Word's default. Text sits right up against the para-

graph's left indent position. If you have specified a first line indent, the

left alignment feature does not override it. Instead, it uses the specified

first line setting, then left-aligns the remaining text.

Centering

Clicking the Center button places the text or graphics smack dab be-

tween the indent markers for the paragraph being centered. If you want

to center things between document margins, be sure the left and right in-

dent markers are sitting on their respective document margins. Moving

the first line indent marker will effect centering.

D I P

Never use spaces to center. Always type words at the

left margin, then click the Center button.

Right alignment

Clicking on the Right alignment ruler button places selected items Hush

against the right indent position for the paragraph. Use this feature for

correspondence dates, inside addresses, and for added impact.
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If you want to right-align things with the document's right margin,

be sure the paragraph's right indent marker is sitting on the right docu-

ment margin.

The first-line indent feature works in conjunction with right-aligned

text. That is to say, text can be both right-aligned and have the first line

indented.

Justification

Clicking on the Justify button causes Word to add space between words

in the selected paragraphs. This results in what some people consider to

be a typeset look.

With the exception of the last line in a paragraph, all of the jus-

tified lines will have exactly the same length and will all be flush left and

right with the paragraph's left and right indent markers. Justified text

can also have the first line indented.

If the uneven spacing and rivers of white space caused by justifica-

tion annoy you, consider inserting hyphens to tighten up the text. See

Chapter 8 for details.

Adjusting the space between lines

The ruler provides three buttons for simple but effective control of the

space between lines under most circumstances. The buttons contain

lines that demonstrate the relative effect of single, one-and-a-half, and

double line spacing. Single spacing causes 12-point line spacing, 1 V2-line

spacing is 18 points, and double-spaced lines will be 24 points apart.

(There is little or no effect for text larger than 24 points.)

When you use these ruler buttons. Word will compensate for

graphics, superscripts, and large or small txpe sizes. To force exact line

spacing, use the line-spacing features found in the Paragraph dialog box

(described in a moment). You will find them particularly helpful when

working with very large or very small type sizes.
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To SINGLE SPACE TEXT

1. Single spacing is Word's default spacing. To reapply it to

text spaced some other way, place the insertion point in a

paragraph or select multiple paragraphs.

2. Click on the left-most line spacing button on the ruler

3. Selected text and subsequent typing will be single spaced.

To DOUBLE SPACE TEXT

1. Place the insertion point in a paragraph or select multiple

paragraphs.

2. Click on the third of the three line spacing buttons on the

ruler.

3. Selected text and subsequent typing will be double spaced.

LiNE-AND-A-HALF SPACING

1. Place the insertion point in a paragraph or select multiple

paragraphs.

2. Click on the line spacing button between the single and

double spacing buttons on the ruler.

3. Selected text and subsequent typing will be space-and-a-half.

To SPECIFY EXACT LINE HEIGHTS

Word automatically sets the appropriate amount of white space between

lines for you unless you tell it to do otherwise. It even compensates for

different size characters on the same line by setting line spacing to the

largest character

But sometimes, you'll want to specify exact line spacing for one or

more paragraphs. Increasing the spacing by a non-standard amount can
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help you fill unused space when your copy runs a little short. Or, specify-

ing slightly less than normal space between lines can help keep that last

lonesome line from printing on its own page.

It's the Paragraph dialog box you need to visit. Here you tell Word

you want at least a specified amount of space.

1. Place the insertion point in a paragraph or select multiple

paragraphs.

2. Open the Paragraph dialog box (§§-M)

.

3. Choose Exactly or At least from the drop-down list.

4b Enter a specification, and unit of measure (2.5 li, 26 pt,

1.5 in, 22 cm, etc.).

5. Use the Apply button to preview, if you so desire.

6. Click OK to make the specified spacing change.

Spacing before and after
- paragraphs

Many people place white space between paragraphs by pressing the

Return or Enter key several times—typewriter style. While this worksjust

fine, there is a preferred method.

The Paragraph dialog box (Paragraph... from the Format menu)

has an area called Spacing. It lets you define the amount of white space

Word places before and after paragraphs. You can enter spacing setdngs

in points (pt), inches (in), cendmeters (cm), or lines (li). Thus, 12

points would be entered as I2pt, 25 cendmeters would be entered as

25cm, and so on.

Each paragraph can have unique before and after spacing if you

wish. One advantage to adding space this way is that the spacing before

and after paragraphs does not change when you change the point size of

your text. Another advantage is that you can use different spacing com-

binations for different pinposes.

Headings often have different spacing requirements from body

text, for instance. You may wish to create different before and after spac-

ing designs for figures and figure captions as well.
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As you will learn in Chapter 13, you can save unique spacing

specifications as part of a style, making it easy to keep the look of your

documents consistent.

D I P

When adding space, remember that if a paragraph has

space added after it, and the paragraph beneath it has space

added before, the white space between them will be the combi-

nation of the two settings. For example, if one paragraph

has 12 points of spacing after it and its successor has 6

points of spacing before, the white space between the two

paragraphs will be 18 points.

To ADD WHITE SPACE BEFORE PARAGRAPHS

1. Place the insertion point in a paragraph or select multiple

paragraphs.

2. Click on the Space Before button on Word's ruler.

X Selected paragraphs and subsequent ones will have 12 addi-

tional points of white space at their tops.

To REMOVE EXTRA WHITE SPACE BEFORE
PARAGRAPHS

1. Place the insertion point in a paragraph or select multiple

paragraphs containing extra space at their tops.

2. Click on the No Space Before biuton on Word's ruler.

3. Selected paragraphs and subsequent ones will now have

only normal line spacing between them.
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Fine-tuning paragraph spacing

Wliile the ruler buttons are fine for most occasions, you may need to visit

the Paragraph dialog box occasionally to getjust the right look. Enter ap-

propriate specifications in the Spacing Before and After boxes to fine

tune. Use the Apply button to preview the results.

Space before and page tops

When you print, Word ignores the Space Before setting in paragraphs

that land at the top of a page because of automatic pagination. If you

force a page or section break, however, Word retains this extra space. It

will also retain the additional space if you check the Page Break Before

option in the Pagination section of the Paragraph dialog box.

Borders and shading

Word 5 bristles with paragraph border and shading features. You can

apply various border treatments and shading to single paragraphs or

groups of paragraphs. For instance, all of the paragraphs in Figure 9.9

are surrounded by a common double-line border, while the last para-

graph has a single line top border and shading.

FIGURE 9.9

You can apply borders

and shading to one

paragraph or multiple

paragraphs.

Page 1

:£

You can have it fast, i

You can have it cheap.

«

You can have it done right.

Pick any 2 of the above

INormal* :m: j^ a
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Creating lines with the border command
Don't be fooled by the boxy-sounding name of this command. Border...

can be used to create Hues as well. Check-out the samples in Figure 9.10.

You adjust the horizontal length of borders or lines by adjusting a

paragraph's width with indent markers or the Paragraph dialog box. It's

also easy to control the distance between text and border lines. You can

use borders to surround paragraphs, framed objects (like graphics), and

tables.

FIGURE 9.10

By leaving off parts of

borders, you can create

lines.

Borders needn't be boxes. Use
them to create lines like this one.

^
Lines above attract attention

Make thick lines from thin, shaded paragraphs.

Lines below set things off

Consider leaving off left & right sides

1 Tables often look better with borders too.
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Standard and shadow borders

Word has two predefined border types that are just a few mouse clicks

away. Here are the general steps for using them:

1. Place the insertion point in the paragraph of interest, or

select elements to be formatted—multiple paragraphs,

graphics, etc.

7. Open the Border dialog box (shown in Figure 9.11) with

the Border... command on Word's Format menu or the Bor-

der button found in the Paragraph and Table dialog boxes.

3. With the Border dialog box open, click on either the Box

or Shadow Box icon.

4 Click OK and say "Ahh..."

FIGURE 9.11

The Border dialog box.

Border

Bord
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m
Version 5. 1 users will find a Border Toolbar button

nestled between the Change Case and Increase Font Size

buttons.) It opens the Border dialog box.

Custom borders and lines

Border and line play can be great rainy day entertainment. Just don't get

carried away on busy days or with a deadline looming. Before you can ef-

fectively create custom borders, you must understand the Border sample

part of the Border dialog box shown in Figure 9.12.

The border sample changes to represent the border you are creat-

ing. For instance, in Figure 9.12, the border specifications call for a

single line along the top of the paragraph. You specif)' lines (add and

remove them) by clicking on border guides. They look like dotted T's

and L's. Two of them are labeled in Figure 9.12. Clicking on any of the

three horizontal guides toggles horizontal lines. Clicking on vertical

guides—well, you know.

The little triangles that appear and disappear are called selection

markers. They show you which border lines will be affected when you

FIGURE 9.12

The Border sample

portion of the Border

dialog box.

Border
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click a border guide. Don't worry, this will begin to make sense when you

experiment on your own.

D I P

Double-clicking on a comer guide surrounds the entire

border sample.

Ifyou've selected multiple paragraphs (or tables) you'll be able to

place lines between the different paragraphs (or table rows) thanks to

those center border guides. And, as you've seen in the examples, it is pos-

sible to specify the line widths used for borders. It's even possible to com-

bine different line styles in the same project. Here are the general steps

for custom borders:

1. Place the insertion point in the paragraph of interest, or

select elements to be formatted—multiple paragraphs,

graphics, etc.

2. Open the Border dialog box (Shown in Figure 9.1 1) with

the Border... command on Word's Format menu, or any

of the Border buttons.

3. Click on the appropriate border guides in the sample to

turn them on or off.

4k Click on the line type(s) you wish.

5. Unfortunately, there's no Apply button here, so Click OK to

view your border, then return if necessary to change the

lines selected in the sample and the line types.

Incidentally, Undo will remove unwanted new borders if you click right

after leaving the Border dialog box. Once you've created some favorite

border combinadons, consider saving them as glossary entries or styles.

See Chapters 13 and 16 for details.
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Increasing the Space
Bet>veen Borders and Text
To add extra spate between the text contained within borders and the

borders themselves, specify a point measurement in the From Text box.

You can do this when you are designing the border, or select an existing

border and change the spacing later by visiting the Border dialog box.

Controlling Border Width
A paragraph's indents (and the document's margins) control the width

of a border. To change the border, select the paragraph (s) containing

the border formatting and change the indents.

Shading

Shading can be added to paragraphs with or without borders. Use shad-

ing to create forms orjust to add decoration. Be aware, however, that

shading can look pretty raggedy on most printers. Test print some

samples before spending hours shading your favorite form or resume.

To add paragraph shading, pick a shading percentage from the

drop-down Shading menu, or enter a percentage in the entry box. The

smaller the percentage, the lighter the shading—100% is solid black.

Here are the general steps:

1. Place the insertion point in the paragraph of interest, or

select elements to be shaded—multiple paragraphs,

graphics, etc.

i. Open the Border dialog box with the Border... command
on Word's Format menu, or any of the Border buttons.

3. Click on the drop-down Shading list or type a percentage in

the box.

4. You'll see a sample at the right of the list.

5. Click OK to view your shading, and be sure to test print it.
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Removing borders and shading

You can remove borders and shading with the Revert to Style... com-

mand on Word's Format menu. But, since this will sometimes remove

other character and paragraph formatting that you want to keep, here

are the steps for removing just borders and/or shading:

1. Select the objects with the borders you wish to remove.

2. Open the Border dialog box with the Border. . . command
on Word's Format menu, or any of the Border buttons.

3. Click on the None choice in the Preset Borders part of the

dialog box.

4i If shading has been applied, choose None from the Shad-

ing list, or type none in place of the percentage.

5. Click OK.

Numbering paragraphs
Word lets you number paragraphs in a variety of formats. You can use

Arabic numbers (1, 2, 3, etc.), Roman numerals (I, II, III or i,ii,iii), and

even letters (A, B, C or a, b, c). You can use a variety of separators to

enclose or separate paragraph numbers, including commas, colons,

hyphens, slashes, semicolons, brackets, braces, and parentheses. You

work in a dialog box like the one in Figure 9.13.

FIGURE 9.13

You can control

paragraph numbering

from this dialog box.

Renumber

Paragraphs: (•) HII O Only If (Already Numbered

Format:Start at: 1.

Numbers: Ql Ol-I-- (•) By Ewample O Remoue

[[
OK ]] [cancel]
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Word does not number empty paragraphs consisting ofjust a para-

graph mark. It will, however, number paragraphs containing things like

graphics, which you probably won't want numbered most of the time. In

that case you'll need to either number around these things by number-

ing selectively, or use Shift-Returns to keep the elements with their ap-

propriate paragraphs.

To number vanilla paragraphs under normal circumstances:

1. Be sure you have created all of your paragraphs and don't

have any unwanted paragraphs (remember, headings and

graphics are paragraphs too).

2. Save your work.

3. Select the specific paragraphs you want to number, or don't

select anything if you want Word to number everything.

4. Open the Renumber dialog box from the Tools menu or

use the 3€-F15 shortcut on Extended keyboards.

5. Specify the numbering format you desire (Arabic, Roman
numerals, etc.). Create a sample in the Format box using

any of these separators if you like: /() []|1.,:; ([1.] or A or 1

for instance).

6. Word separates numbers and their text with tabs imless you

type a space or spaces in the format sample. (1. Space, for

instance).

7. Specify a starting number.

8. Click OK to number.

9. Check your work and undo immediately if it is not perfect.

Removing paragraph numbers

The Remove option in the Renumbering dialog box removes all

or selected numbers. It also removes the tabs Word inserted while

numbering.
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Renumbering numbered paragraphs

Simply add or delete paragraphs, then take the necessary steps to specify

formats and number as before.

mARMING
T

If Word encounters a paragraph that looks like it has

been numbered (an ingredient line in a recipe like " 1 .5 lb.

of butter" or "A. Lincoln", for instance) it will think that this

is a paragraph that needs to be numbered. You might end up

with "A lb. of butter" or "in lb., of butter", for instance.

Microsoft's suggested solution is pretty frustrating. Your

best bet is to selectively niunber around these problems, or

minimize them by keeping troublesome lines like this

together in one paragraph by using the Shift-Return method

of forcing new lines without creating new paragraphs.

Restoring paragraph formats

While the Revert to Style command on the Format menu will usually

undo any of the paragraph formatting described in this chapter, it

might also remove character formatting you may have done. Frequently

changing a paragraph to a different style is an option. This will make

more sense after you've digested Chapter 13.

Sorting paragraphs
Suppose you've t)ped a list of names and want to sort diem alphabetically.

It's a good idea to save just before you sort (or do other things that may

drastically alter your document) just in case you don't get to Undo in
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time. Here are the steps for sorting paragraphs (read more about sorting

in Chapter 10):

1. Select the paragraphs yon wish to sort.

2. Use the Sort command in Word's Tools menu.

3. Paragraphs will be sorted based on the beginning char-

acter(s) in each paragraph.

4» Undo works if you act immediately.

Tabs and paragraphs
Each paragraph can have its own tab settings. Read about tabs in the

next chapter.

Tables and paragraphs
As you'll see in the next chapter, tables can contain paragraphs. Generally,

tables in paragraph cells behave like ordinary paragraphs.
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TRACKS

To set tab stops 323

show the ruler (§€-R). Click the button corresponding to the

desired tab stop type. Click on the bottom of the ruler near

the desired tab stop location.

To move tab stops 324

select the paragraph (s) containing the tab stops to be moved,

then drag the tab stops on the ruler, or open the Tabs dialog

box (by double-clicking on a tab for instance).

To remove tab stops 328

select the paragraph (s) containing the tab stops to be removed,

then drag them off the ruler, or use the Clear button in the

Tabs dialog box.

To (reate a table 33

1

choose the Insert Table... command on Word's Insert menu
or click and drag on the Table button in version 5.1's ribbon.

Specify the desired number of rows and columns (which can be

changed later). Word creates table cells, consisting of rows and

columns of identical widths and heights. Cell height changes

automatically as you insert and delete thing in cells. Column

widths can be adjusted.



To type in tables 332

position the insertion point in a table cell. A cell can have mul-

tiple paragraphs, each with different paragraph formatting.

Create multiple paragraphs in cells with the Return key. Word's

character formatting features are also available in table cells.

Tab to move from cell to cell. Shift-Tab to move backwards.

To add rows in tables 336

place the insertion point in the last cell of your table and press

tab to add a new row at the bottom of a table. To add rows in

the middle of a table, place the insertion point in the row below

where you want the new row and press 3€-Control-V.

To remove rows in tables 338

select imwanted rows and use the §€-Control-X keyboard shortcut

or the Table Layout. . . command on the Format menu.

To add tolumns in tables 340

use the Table Layout... command in the Format menu. Adjust

row width to accommodate the new column (s). See this chapter

for version 5.1 and other shortcuts.

To remove tolumns in tables 341

use the Table Layout. . . command in the Format menu. Adjust

row height and column width if necessary to use the newly avail-

able white space.



Five kinds oftab stops and when to use them

Tables and how to use them

Version 5. 1 's handy Table button

Ways to sort information in Word documents

Word's ability to add, subtract, multiply,

and divide

Word's Equation Editorfor complexformula
typing

w ORD NOVICES OFTEN either under-i or overuse tabs. Primarily a quick way to

position text or graphics, tabs have lots of competition in Word 5. Some
people use the Spacebar instead of tabs. Lovers ofWord 5's table features

often abandon tabs altogether in favor of tables. This is probably a mis-

take too. Moreover, your typing teacher may have told you to use tabs to

indent the first line of each paragraph. You may prefer Word's split left

indent marker, which is probably a better choice for that task.

This chapter also shows you how to have Word do simple math

calculations (a great way to compute and proof totals and subtotals in

tabular typing). And, you'll see how Word can sort things like phone lists.

Finally, Word 5 comes with a separate program called Equation Editor,

manufactured by Design Sciences Inc. It will be of particular interest to

scientists and academicians. Microsoft ships a customized version of the

program designed specifically for use with Word 5. This chapter intro-

duces you to the Equation Editor and tells you how to obtain additional

information or an even more robust version of the program.

Tabs

Tabs are great for creating quick, relatively simple lists, and Tabs do

some things in Word you can't do on a typewriter. For instance, they can



TABS

help you exchange Word data with spreadsheets, databases, and other

programs. Each paragraph in a Word document can have the same or dif-

ferent tab settings. So turn off that MTV and let's explore the wonderful

world of tabs and tab stops!

Word offers five specialized tab stop types. They each work with tabs

to help align text, and are particularly useful for making simple colum-

nar lists like the one in Figure 10.1.

FIGURE 10.1

Word 5 provides leh,

confer, right, decimal, and

bar tabs.

Tab characters

Right

!
2»

. 3*
4*
5»

. 6*
7.
8«
9*

*10*

Finest Lovin' Man*
Give It Up Or Let Me Go'

Woman Be Wise«
Under The Falling Sky »

Love Me Like A Man*
Love Has Wo Pride*

I Feel The Same*
Guilty*

Angel From Montgomery
What Is StKcess*

Bonni Raitt*

Give It Up*
Bonnie Raitt

Give It Up*
Give It Up*
Give It Up*
Takin'h^Time*
Takin'IvfyTime*
Streetlights*

Streetlights*

3:57.
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Center tab stops

A center tab stop centers your text around the tab stop. In Figure 10.1

the song titles (in column two) are aligned with a center tab stop.

Right tab stops

Right tab stops position whatever you type to the left of the tab. As you

can see in the first column of Figure 10.1, this is a great way to type long

lists of numbers.

Decimal tab stops

Decimal tab stops behave as you'd expect. They align columns of num-
bers on the decimal point and are perfect for simple financial reports.

Bar tabs

Don't you wish you had these in college? (On second thought, perhaps

you do.) The Bar button creates those nice, thin vertical lines you see

separating items in Figure 10.1. They aren't actual tab stops, (that is, you

cannot use them to align text) but they can be placed and moved like

stops.

Tables vs. tabs

Simple tabular columns are great if you have items that always fit one

line. But suppose, in Figure 10.1, that Bonnie had recorded a song with a

very long title

—

How Can I Miss You If You Won 't Go Away ?, for instance. If

you use tabs, the title wouldn't automatically wrap to fit the format. You

would need to redesign the tab layout, shorten the song title, or cobble

things up with a carriage return. Ugh. Long items like these give tab

typist.s fits. As you will see later in this chapter, tables make it easy to deal

with this and other problems.

Serious typists will probably choose table solutions over tabs most
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days. The price is speed and complexity. Word's table features can be

slow at times; and you may scratch your head in the beginning. Tables re-

quire an understanding of tabs too. So, for simple projects like the ex-

ample here, you might want to stick with tabs alone, at least until you've

mastered them.

Setting custom tab stops

Custom tab stop setting is easiest with the ruler showing. Use the 3€-R

shortcut to turn on the ruler or choose Ruler from the View menu, if

necessary.

It is also handy to have the Show f feature on, since that will enable

you to see tabs themselves as you type them. Use §€-J to display para-

graph markers and tab markers, which look like bold arrows.

Tab stops are stored with the paragraph mark for each paragraph,

thus all of the rules about paragraph markers apply. If, for example, you

set tab stops once and type returns at the end of each typing line, each

new paragraph (line) will use the same tab stops as the preceding one,

until you tell Word otherwise.

Setting tab stops with the ruler

1. With the ruler in view (§€-R), click the button with the pic-

ture of the desired tab-stop type. It will darken.

2. Hold down the mouse button and drag a new tab stop onto

the lower portion of the ruler as shown in Figure 10.1. If

you make a mistake, drag the stop off the ruler and try

again.

3i When you type, press the Tab key to move the insertion

point to the new tab positions. With Show f turned on,

you'll see fat arrows indicating each tab character you type.
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Moving tab stops on the ruler

To move tab stops before you've entered text, simply point to the stop of

interest and drag away. If you have already entered text that uses the tab

stops you want to move, first select all of the text before moving the tab

stop.

For instance, if you had already typed the ten lines in Figure 10.1

and wanted to move the left tab stop for all of the lines, you would need

to highlight all ten lines before moving the tab stop. Otherwise, some

lines (paragraphs) would have different stops than others. Incidentally,

you'd also want to highlight the paragraph mark beneath the tenth line

too if you plan to enter more items. Otherwise the last paragraph marker

won't know about the change and subsequent entries would be off.

If you highlight paragraphs with different tab-stop settings, the bot-

tom portion of the ruler will be dimmed. Only the stops for the top para-

graph will be displayed.

a
Watch the status area at the bottom left of your window

as you drag tabs. It will show you their position.

Setting tab stops with the tabs dialog box

While using the ruler is easy, you may want to use the Tabs dialog box

for some projects. It provides ways to precisely set tab stops and it offers

some additional tab-related options. Figure 10.2 shows the Tabs dialog

box at work.

Press the Set button in the Tab dialog box when you are happy with

your tab settings. The tab changes will be made. You will need to click

OK to close the Tabs dialog box and change the text. The advantage of

using Set first is that you can assign multiple tabs from the dialog box

without reopening it multiple times.
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FIGURE 10.2

ffie Tabs dialog box gives

you precise control and

additional tab-related

features.

The Bonnie Raitt Collection
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m A R N I N G
T

Remember to select all affected text and paragraph

markers before moving tab stops. Undo (3€-Z) will save you

when you forget.

Units of measure in the tab dialog box

Measurements in the Tabs dialog box are assumed to be in inches unless

you type another legal abbreviation (cm for centimeter, pt for point, or

pi for pica). As an example, 5 cm would position a tab stop five cen-

timeters from the left margin.

Leading characters for tabs

Were not talkingJulia Roberts or Robin Williains, here. Word 5's leading

charactei^s are dots, dashes, and solid lines. These leaders precede tabbed

entries producing the effect demonstrated in Figure 10.3. You set them

from the Tabs dialog box. They make it easy to read wide, sparsely popu-

lated lines without losing your place.

1. Select the paragraphs you want to pretty-up.

2. Double-click on the tab where you want the leaders.

3. Choose the leader style you desire from the Tabs dialog box.

4. Click OK.

You can apply this effect when defining new tab stops or double-click on

existing stops to bring up the Tabs dialog box as an afterthought.
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FIGURE 10.3
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Default tab stop positions

The Microsoft Word standard settings specify tabs every half-inch (0.5

in). You can change this by setting new stops in the Document dialog

box. (Use the Document... command on the Format menu, or press

3€-F14 on your extended keyboard. Enter dimensions in inches, cen-

timeters, picas, or points. The example shown in Figure 10.4 uses

default stops set every three-quarters of an inch (0.75 in).

You can change that default by following these steps:

1. Open the Dociunent dialog box via the Format menu or

with the §§-F14 shortcut on extended keyboards.

FIGURE 10.4

Enter new default tab

positions and click OK

to use them for the

current document or

click Use as Default to

use from now on.

-Margins

Left:

Right:

Gutter:
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2i Type the desired tab specification in the Default Tab Stops

box. Specify a unit of measure—inches (in), points (pt), or

picas (pi).

3. Click OK to set the default forjust the current document

or select the Use as Default option then click OK to change

tab defaults for the current document and all new documents.

Clearing tab stops

You can drag the occasional tab off the ruler if you don't need it. The

Tabs dialog box (see Figure 10.2) provides facilities for clearing multiple

tabs at once. If you do choose a specific tab, the Clear button in the Tabs

dialog box will still remove it.

When your tabs don't line up

Select all of the paragraphs that you want to conform and set identical

tabs, or correct the first paragraph, then select the rest and copy the para-

graph format.

You might also consider using the Clear .\11 button. It removes all

custom tabs. Defaults remain. This can make an absolute mess of yottr

pride and joy. Undo or Cancel should work if you accidentally clear all

custom tabs, but it is always a good idea to save your work before ex-

perimenting with major changes like these. Remember, these features

only work on paragraphs you have selected.

Entering and editing
- tabular data

Once yoti haye set up tab stops, simply press the Tab key to reach the

stop and begin typing. Word will position the text as you type. If you are

typing at a center or right stop, text will flow appropriately as you type.

When you type at decimal stops the insertion point sits to the left of the



TABLES

decimal position until yon hit the period key; then it hops to the right

side. To leave an entry blank, simply tab past it by pressing the Tab key.

D I P

To move the insertion point backwards one tab at a

time in tables, hold down the Shift key and press Tab.

Tabs and data exchange
Tabs and carriage returns are often used by Macintosh databases and

spreadsheets. Tabs usually separate fields in records and carriage returns

usually separate records. If you use Word 5 to type a list of tab-separated

names, addresses, and phone numbers, for instance, you might be able

to export the list to your favorite database or time-management program.

Check out the importing sections of your other Macintosh program

manuals.

Tables

Tables help you organize complex columnar information. Use them to

create such diverse documents as forms, television scripts, financial

reports, parts catalogs, and resumes. You can insert tables anywhere you

need them in Word documents. Word 5's table feature and the terminol-

ogy used to describe it will remind you of a spreadsheet.

Word tables consist of horizontal rows, and vertical columns. You

do the typing in areas called cells. Cells can contain text, numbers, or

graphics. Text in cells is edited and embellished as usual with Word's rib-

bon and ruler.
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A number of table-specific features let you control the size, shape,

and appearance of cells. Border and shading features are available, h is

also easy to insert and delete rows and columns.

Tables can be created from existing text without needless retyping.

Or, you can use the table feature to organize information and then con-

vert yt)ur table to text. You can even import and export spreadsheet data.

Figure 10.5 shows a typical Word table.

The dotted lines around each cell represent non-printing table

gridlines. You can add printing borders with the Borders... command.

The larger dots arc end-of-cell and end-of-row marks. Click the Show f

button in the ribbon or use the 9€-J shortcut if you can't see them on

your screen.

FIGURE 10.5

A typical lable consisting

of three rows, eoch

containing two columns, a

total of six cells, and

dotted cell gridlines that

will not print
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Creating a simple table

Place the insertion point where you want to insert a table. Choose the

Table... command from the Insert menu. (There is no standard key-

board shortcut, but you can assign one.) The Insert Table dialog box will

appear. Enter the desired number of columns and rows for your table.

Don't worry if you are uncertain about the exact number of columns or

rows you'll need. You can always add or delete them later. Figure 10.6

shows dialog box entries for two three-column rows.

Word computes a column width automatically, taking into con-

sideration the available text area in your document and the number of

columns you've specified. Initially, all table columns are the same width,

but you can change column widths using techniques described later in

this chapter.

FIGURE 10.6

The Insert Jable dialog

box and the resulting

three-bytwo cell table it

creates.

Insert Table

Number of Columns:
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[ Cancel]
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m
Version 5. 1 includes a table button on the ribbon.

It can help you quickly specify the number of rows and

coliunns in a new table, or, as you will see later in this

chapter, convert typed text into a table. Figure 10.7 shows it

creating a new table.

FIGURE 10.7

Version 5. Vs Table

button speeds table

creation.

Using 5.rs TABLE BUTTON

1. Place the insertion point where you want the new table.

2. With the ribbon in view (§€-Option-R) elicit the table but-

ton, then drag while holding down the mouse button to

highlight the desired number of rows and columns.

3. When the displayed grid represents the desired number of

rows and columns, release the mouse button.

4b Word will insert an empty table when you release the mouse

button.

Entering and editing text in a table

With only the few exceptions noted in this chapter, you navigate, enter,

and edit table text just as you do any other Word 5 text. Use your mouse

or arrow keys to position the insertion point, then type normally. Think

of the cell borders as margins. Word will automatically wrap text within
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the cell as you reach the right edge. Rows will automatically grow taller as

necessary to accommodate your typing.

To move from cell to cell within a table, either use your mouse or

use the Tab key to go forward and Shift Tab to go backward. The inser-

tion point will move left and down to the next row when you press Tab in

the last column on the right side of a table; and it will move right and up
one row when you Shift Tab past the last column on the left. If vou press

Tab in the last cell of the last row, you will create a new row.

D I P

Since you use the Tab key to navigate in tables, you
cannot simply press Tab to enter tab characters in cells.

Instead, you need to hold down the Option key while

pressing Tab.

You can apply the usual character formatting to all or selected

characters in a table. The familiar ribbon, ruler, and menu features all

work here.

Paragraphs in cells

First-time table users are sometimes unaware of the important role

paragraphs play in tables. A cell can contain more than one paragraph.

Create paragraphs in the usual way. While typing in a cell, press the

Return key.

You can apply all of Word's paragraph formats to paragraphs in

cells. Since cells can contain multiple paragiaphs, they can also contain

multiple paragiaph formats. Thus, within a single cell, you can have

several different indent settings, tab settings, line-spacing specifications,

styles, etc.
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Selecting in tables

You can select characters, words, and other items in table cells using

Word's usual mouse and keyboard features. In addition. Word also

provides table-specific selection tools enabling you to choose whole cells,

entire rows, coliunns, or areas, as Figure 10.8 illustrates.

FIGURE 10.8

Word provides a number

of lable-specific seledion

tools.

Employee* Hew Salary* Notes*
Geller, S* $125,000* J Plus travel ezp.

jmmisii'Mi

Cell selection ixir

;

Employee*
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Holding down the Option key while clicking anywhere in a column

will also select the entire column. Selecting the bottom or top cell in a

column and dragging up or down is somewhat tedious, but will also work.

Selecting rows
Double-clicking any cell selection bar will select the entire row. Selecting

the left-most or right-most cell in a row and dragging will also work.

Selecting adjacent groups of cells

To select groups of adjacent cells, either drag through the cells or click

in one cell and Shift-click in the others. For instance, to select all but the

employee column in Figure 10.8, you could click in the New Salary cell

then Shift-click in the cell containing the word Commission. The right-

most six of the table's nine cells would be selected.

Selecting the whole table

To properly select an entire table, hold down the Option key and double-

click anywhere in the table. Lf your document contains multiple tables

and they are not separated by paragraph marks, this technique will select

all adjacent tables.

Do not use Word's Select All command to select a table, since this

will also select paragraph marks and other things outside of the table.

Modifying table designs

While Word's default table settings may be fine for simple typing tasks,

you will eventually want to change column widths, overall table width,

cell spacing, and so on. You'll want to insert, delete, and move rows and

columns. As you can see from Figure 10.9, it is even possible to create

professional-looking forms by modifying Word's standard tables.
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FIGURE 10.9

Create

professional-looking

forms by adding borders

and adjusting row and

column sizes.

User Survey
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Adding rows in the middle of a table

To insert a single row in the middle of a table:

1. Place the insertion point in the row below where you want

the new row.

2. Use either the keyboard shortcut, 3€-Control-V, or the In-

sert Row featine, found in the Table Layout dialog box

shown in Figure 10.10. (You reach this dialog box by choos-

ing Table Layout... from the Format menu, which is avail-

able whenever your insertion point is in a table.)

3> To insert a row this way, activate the Row button, then click

on the Insert button. You can also add the Insert Rows com-

mand to the Format menu.

A, To add multiple rows, either repeat the 9€-Control-V

shortciu as many times as you need to, or try the alternate

approach in the next step.

5. Select as many existing rows as you want to insert new ones

before making the insertion. In other words, if you want to

add three rows, select the three existing rows beneath the

desired insertion point, then use l€-Control-V or visit the

Table Layout dialog box. Word v^dll insert three rows.

FIGURE 10.10

The Joble Layout. .
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Changing row heights

Normally, Word sets the height of each row automatically to accom-

modate the cell containing the tallest entry. For instance, if one cell in a

row needs 2.0" to accommodate the text or graphic it contains, all of the

cells in that row will be 2.0" high. All cells in a row must be the same

height, but different rows can have different heights.

You can overrule Word's automatic row-height (and column-width)

settings via the Table Cells... command located on the Formal menu.

This is one way to create forms with fixed-sized entry areas. (There is

no standard keyboard shortcut for the Table Cells... command, but ex-

perienced table typists often add their own. Figure 10.1 1 shows the Table

Ceils dialog box and its menus.)

Place the insertion point anywhere in the row whose height you

wish to specify. If you want multiple rows to share the same height, you

can select all of them.

Open the Table Cells dialog box and enter a row height and unit

of measure (1 in, 12 pt, etc.) in the entry box next to the Height dro]>

down menu.

Click OK to make the change and close the dialog box to see the

results of your choice without closing the dialog box. Undo Table Cells

(3€-Z) works here if you use it immediately.

The drop-down Height menu lets you specify' a minimum row

height or an exact height. If the exact height is too small to accom-

modate the biggest entry in a row, the excessive text or a portion of the

too-tall graphic will be cropped when printed.

Deleting rows
Delete rows either from the Table Layout dialog box described earlier

(and shown in Figure 10.10) or by using the §€-Control-X shortciu. Start

bv placing the insertion point in the unwanted row or by highlighting

multiple doomed rows. Undo does work here. You can add the Delete

Rows command to the Format menu.
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FIGURE 10.11

The Table Cells...

command on the Format

menu brings up the Table

Cells dialog box, where

you can specify row

heights and column widths.
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Inserting columns
at the right edge of a table

To insert a column at the right edge of a table:

1. Place the insertion point between the right edge of the

right-most column and the end-of-row mark.

Z Visit the Table Layout dialog box (Table Layout. . . in the

Format menu) and activate the column button.

3. Click Insert.

4 Word will add a new column but will not change the width

of the earlier columns to accommodate it. In order to make
the enlarged table fit on your page you will probably need

to adjust margins, column widths, or page orientation. New
columns retain the format of the old right-most columns,

but borders will not transfer.

Inserting columns in the middle of a table

To insert a single column in the middle of a table:

1. Place the insertion point in the column to the right of

where you want the new column to appear.

2. Select Table Layout from the Format menu.

3. Activate the Column option button.

4. Click Insert.

5. To insert multiple columns, either repeat the process (per-

haps using Repeat Insert... from the Edit menu—§€-Y), or

select as many existing columns as you want to insert new

ones to the right of tlie desired location of the new colimins.

In other words, if you want to add three columns, select the

three existing columns to the right of the desired insertion
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point, then visit the Table Layout dialog box. Word will in-

sert three columns. You can also add the Insert Columns
command to the Format menu. All new columns retain the

format of the column to their right.

Deleting columns
To delete columns, select the column or columns to be removed. Choose
Table Layout... from the Format menu to bring up the Table Layout

dialog box. (See Figure 10.10.) Activate the Column button if necessary

and click Delete. Like the other commands, you can add Delete Columns
to the Format menu.

m
The Table button on version 5. 1's ribbon lets you

quickly insert cells, columns, or rows. Read how next.

Inserting table elements with s.rs ribbon

\'ersion B.l's Table button lets you insert table elements. Simply select

the number of cells, rows, or columns you wish to insert, just as you
would to use the Table dialog box, then click on the Table button.

Changing column widths

You can change the widths of entire columns or selected cells within

columns. Most changes can be made by dragging column markers on the

table scale in the ruler. Or you can make precision adjustments in the

Table Cells dialog box.
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Changing Column
and Cell Widths with the Ruler
To change the width of an entire cohiinn:

1. Select all cells in the column you want to work with. This is

an important step! If you fail to select the entire column,

your changes will affect only selected cells.

2. With the column selected, display the table scale on the

ruler. To do this, click on the Table Scale button in the

upper-right corner of the ruler. It looks like a T.

3i The table-column markers will display on the ruler, ready

for dragging, as shown in Figure 10.12.

When you drag the markers in this way, markers to the right will also

move, changing the overall size of the table. To preserve the positions of

all markers, hold down the Shift key when dragging column markers.

As you can see in Figure 10.13, it is possible to change the size of

just one cell by placing the insertion point in the cell then dragging its

column marker. Here too, holding Shift while dragging will preserve the

markers' positions.

Undo Formatting is available if you need it. Visit the Edit menu or

use the (by now familiar?) 5€-Z shortcut.

FIGURE 10.12

Drag the column markers

to change column or cell

widths.
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FIGURE 10.13
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FIGURE 10.14

The Jable Cells feature

can help bring order

(bottom) to chaotic cell

and column widths (top).
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The Table Cells... command brings up the Table Cells dialog box

shown in Figure 10.14. The dropdown Apply To menu is a powerfvil

weapon in cleaning up problems. With the rows needing identical cell

widths, we've entered a column width of 1.5 in. After clicking OK, the

cells align themselves as shown in the after portion of the figure.

There's another trick worth noting. As shown in Figure 10.15, you

can type the word Auto in the Column Width box of the Table Cells

dialog box. This evens out the right edge of the table.

Aligning tables

The Table Cells dialog box has an Alignment drop-down menu that lets

you specify how you want selected rows or entire tables aligned with rela-

tion to your document's left margin. The choices are Left, Center, and

Right. C^hoices you make here do not affect the alignment of things in

table cells.
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FIGURE 10.15

Typing Auto in the

Column Width box will

make unequal rows (top)

the same width (bottom).
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FIGURE 10.16

The contents of several

cells {top) can be merged

together (bottom) with

the Jable Layout dialog

box.
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CONVERTING TABLES TO TEXT AND VICE VERSA

and other programs that expect tab- or comma-separated (delimited)

input. Word has solutions for all these contingencies.

It's fairly easy to convert back and forth from tables to text. You may

need to do some cleanup before or after conversion though. Always work

on copies of your documents when you do this!

Converting text to tables

Highlight the text in your document that you want to turn into a table.

Choose Text to Table... from the Insert menu and click the appropriate

Convert From button as described below.

Tab-Delimited Text
Click the Tab Delimited button in the Insert Table dialog box. Lines of

text separated by paragraph marks or line breaks will become rows in

your table. Tab-separated strings of text within those lines will become

cell entries in the row. Word will automatically create the necessary num-

ber of columns based on the maximum number of tabs in a line.

For instance,

Sony Corporation [Tab] 800-222-7669 [Return] SYBEX,
Inc. [Tab] 415-523-8233 [Tab] Publisher [Return]

would create two rows with three columns, even though the last cell in

the first row would be empty.

Comma-Delimited Text

Click the Comma Delimited button in the Insert Table dialog box. Lines

of text separated by paragraph marks or line breaks will become rows in

your table. Comma-separated strings of text within those lines will be-

come cell entries in the row. Word will automatically create columns

based on the maximum number of commas in a line.

For instance,

Sony Corporation [Comma] 800-222-7669 [Return]

SYBEX, Inc. [Comma] 415-523-8233 [Comma] Publisher

[Return]
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m
would create two rows with four columns, even though the last cell in the

first row will be empty.

A R N I N G
T

Ea^

Beware of commas that might create unintentional cells

like the one between SYBEX and Inc. in the last example.

Converting from Paragraphs
Click the Paragraphs button in the Insert Table dialog box. If you ask

Word to convert paragraphs to tables, it will propose a single column and

create as many rows as you have paragraphs. Changing the number of

columns will distribute paragraphs among the columns from left to right.

In a two-column layout, the first paragraph would end up in the top-left

cell of the new table, the second paragraph in the top-right cell, the third

in the left cell of row two, and so on.

When you select text, then click on version S.l's Table

button, you'll see a dialog box asking you which conversion

options you'd like to use to convert text to tables.

Converting Text Placed Side-by-Side

Word 3 users can convert text formatted as side-by-side text using this

converter. Don't trv to use it for other conversions.
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Converting tables to text

Select the table cells you wish to convert or use the Option-double-click

trick to select the whole table. Choose Table to Text... from the Insert

menu. Word will provide a Table to Text dialog box which asks if you

want the table converted to Paragraphs, Tab-delimited, or Comma-

delimited text. Pick one. If you pick the Comma or Tab options, Word

will convert each row of your table into one line (a paragraph, actually).

Cells in your old tables will become tab- or comma-separated items on

the lines.

Remember that in-text commas will confuse Word. It would treat

SYBEX, Inc. as two distinct entries. If you choose tab text you will prob-

ably need to set new tabs after the conversion.

Choosing the Paragraph option will convert each old table cell into

at least one paragraph. If cells contain multiple paragraphs, the para-

graph marks are retained during the conversion, so some cells will create

more than one new paragraph.

Table tips

Here are some tips to help make you a more productive table editor.

They cover a variety of subjects.

Rearrange rows in outline view

With a table on-screen, switch to Oudine view from the View menu.

Move the pointer to the left edge of your table. The pointer shape will

change, as shown in Figure 10.17.

You can drag rows to new positions using Word's Outline features.

See Chapter 20 for more information about Oudine view.

FIGURE 10.17
n i Proposed Salary Changes* !•

view 10 rearrange tables. „
;
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Moving cell contents

To move the contents of cells:

1. Find or create new empty destination cells in the ap-

propriate quantity and configuration to hold the items you

plan to move. For instance, if you plan to move a four row

by six column collection of cells you will need the same

number of available cells in the same configuration (4x6)

to receive the moved items.

2. Copy or cut the items of interest by highlighting them and

using Copy or Cut from the Edit menu or the keyboard

shortcuts 3€-C and 3€-X.

X Now you can either select the same cell configuration at the

destination (four rows of six columns each in our example)

or you can try a shortcut. Simply place the insertion point

in the upper-left destination cell. (If you use this shortcut,

do not select the cell.) Be sure to place the inserdon point

before the end-of-cell mark, then paste.

4. All of the cells will flow into their new destinations, bring-

ing their formatting information with them. Undo Paste

(3€-Z) works here if you spot trouble immediately.

5. Delete unused columns using the Table Layout... command
if necessary.

Styles and tables

Word will use the current style (at the insertion point) when creating a

new table. You can change the style of the whole table or apply different

styles to different portions of the table.

Consider creating muldple styles if you plan to play with table for-

matting. For instance, you might have a style for table headings, another

for standard text, another for decimal-aligned numbers, and so on. See

Chapter 13 for more detail on styles.
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Apply the new style to all appropriate paragraphs in your table by

selecting the paragraphs and using the ribbon's Style menu. From then

on, simply changing a style will change all table text formatted with the

changed style.

Memory, tables, and speed

IfWord slows to a crawl in large tables, try quitting and increasing the

amount of memory allocated to Word in the Get Info box. Sometimes

this helps. See your Macintosh manual for details. You might also con-

sider turning off Show Table Gridlines (found in the View category of

the Preferences dialog box).

Repeating headings on multipage tables

To repeat column headings on each page of a muldpage table, create a

separate section for the table. Place the table headings in the section's

header. Start by placing the inserdon point in the first row of your table.

Create a new section by inserting a Secdon Break (from the Insert

menu).

Copy the heading rows from your table and paste them into the sec-

tion header. Adjust paragraph Before and After spacing if necessary.

Page Layout view will help you see what's going on.

Place table layout choices in your menu

If you create tables frequently, you can use Word's Commands... com-

mand to place table-related commands and choices in your menus. You

can even add commands to bypass muUiple choices in the Table Layout

dialog box. For example, an Insert columns command is available. Ap-

pendix B lists all ofWord 5's commands.
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Sorting in word

m

Have you ever created something like an alphabetical list of employees

and their phone extensions, then needed a list of phone extension as-

signments sorted by extension number? Most of us have many lists like

these, and they always seem to be in the wrong order.

You could retype the old list or cut and paste, but Word's Sort...

command, found under the Tools menu, might be a better solution.

Don't throw away your database software just yet, though. The Sort fea-

ture has limitations, many of which can be overcome with a little plan-

ning.

Word can sort lines of tabular text, items you've entered in tables,

or even paragraphs in a document. The Sort command can be quite help-

ful when preparing data files for Word's Print Merge feature (discussed

in Chapter 26).

A R N I N G

As with some other Word features, Sort can make sub-

stantial changes to your document (read: ruin your bard work),

so it is best to save before you sort. Consider practicing on

copies of important files.

Simple sorting

Word 5's Sort feature will attempt to alphabedcally sort any selected text.

To sort this way:

1. Select all the lines you want to rearrange (and no others!).

Unselected lines will not sort.

7. Pick Sort... from the Tools menu.

3. The selected items will be rearranged in ascending order

for you. Undo Sort is available.



SORTING IN WORD

Look at the list of employee names, phone extensions, and birthdays in

Figure 10.18, for instance. Word has sorted them by first name, which

might not be desirable.

Notice that Word has rearranged the three highlighted lines alphabeti-

cally, using the first character in each line. If there had been two names in

the example starting with R (Robert and Robbie, for instance), Word would

have considered as many characters following as necessary to sort properly.

Sort order

Normally, Word sorts alphanumerically in ascending order based on

each character's ASCII code. That is to say, the default sort would start

with numbers 0-9, then progress from uppercase A to lowercase z.

Ifyou hold down the Shift key when visiting the Tools menu, the

choice will be Sort Descending. (You must press the Shift key before point-

ing to the Tools menu, and hold down the Shift key at least until the menu

appears.) A descending sort will progress from lowercase z to uppercase A,

then from 9 to (zero). As you will see in a moment, numbers in dates and

part numbers containing letters may require special handling.

FIGURE 10.18

Highlight the text to be

sorted, choose Sort. .

.

from the Tools menu

(top), and Word will sort

alphabetically using the

first character (bottom).

' i File Edit Uieiii Insert Format Font
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Lines beginning with punctuation marks (*, !, etc.) will appear at

the top of ascending sorts antl the bottom oi descending sorts.

Accented characters are treated like their non-accented equivalents.

Thus n and n are the same for sorting purposes.

Sorts based on portions of lines

As you can see in Figure 10.19, you need not sort on the first characters

in a line. In fact, you can base sorts on nearly anything you can select.

Just be sure you select all the text you want to sort.

You can see from the before and after portions of Figiue 10.19 that

Word sorted entire rows based on the highlighted extension numbers,

not just the highlighted text. The illustration contains tab-separated text,

but the technique works fine with items separated by spaces.

FIGURE 10.19

To 50t1 based on

extension numbers (top),

hold the Option key while

dragging to select areas,

and Word sorts entire

ram (bottom).

1

Employee*
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Sorting dates, names, and part numbers

There is no chronological sort-order option built into Word, so you

will need to use some forethought when typing dates you plan to sort.

Figure 10.20 illustrates the problem.

Since the year appears last in most American date formats, it is im-

possible to sort dates like the ones in Figure 10.20 without separating the

month, day, and year into separate columns. So the solution is to turn

the list into a table and sort by the last column.

You can have similar problems with alphanumeric part numbers.

Names are a problem, too, if you've entered first names before last

names or if you've included someone's title.

One solution is to break items like these into columns and insert

them in a table, as shown at the bottom of Figure 10.20. Word sorts en-

tire rows based on the specified sort column. So in the table shown at the

bottom of Figure 10.20, the rows containing peoples' names are sorted

by birth year column.

Multilevel sorts

When you place items in a table, it is possible to have Word automatically

do multilevel sorts, as shown in Figure 10.21. First, select the columns

you wish to sort. Then select Sort. . . from the Tools menu. In this case

Word has sorted by first name, then last name within first name.

FIGURE 10.20

Word will not properly

sorl dales entered in most

American formats.

Employee*
BiUie Holiday*

Dr^ John*
Robert Johnson*

Extension*
472*
400*
450*

Birthday!
12/10/40^
n/07/45

: 1/1/50

Employee*
Robert Johnson*
Dr. John*
Billie Holiday*

Extension*
450*
400*
472*

Birthdayll
1/1/50'iJ

11/07/45^
12/10/4C|l?



THE WORD FOR 1 HE MAC HOW-TO BOOK Chapter 10

FIGURE 10.21

Word has sorted by first

name then last name

within first name in this

example.

Employee*



ADDING, SUBTRACTING, MULTIPLYING, AND DIVIDING

FIGURE 10.22

The Calculate feature

gives Word 5 limited but

useful math capabilities.

iNormal

f:

Postal facts

ja s^ja s^
2B

USPS Postal Facts for FY 9041

Titles*

Mail Handlers'

Mail earners*
Others*

Count*

Totol

760,668 :m:

Clipboard

760,668 ^

Adding with calculate

The Calculate feature performs addition on selected columns or rows of

numbers. For simple addition, highlight the numbers you wish to add,

then choose Calculate from the Tools menu or use the §€-= shortcut.

(Press the equals sign on the main keyboard; don't use the one on the

numeric keypad unless you have Num Lock engaged.)

Word will add (sum) the selected numbers and place the answer in

the lower-left corner of your document window and on your clipboard,

ready for viewing with the Window's Show Clipboard command, or past-

ing into your document.

m A R N I N G

Since the answer is placed on yoiir Clipboard, whatever

else was previously there is gone. There is no Undo here, so

if you have your life's best work residing on the Clipboard

only, save it somewhere else before calculating.

Incidentally, nearly anything you do after issuing the Calculate com-

mand will overwrite any information in the status area at the lower-left
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corner of your screen. Even if the results of your calculation disappear

from the status area, don't panic. Your answer will remain on the clip-

board until you copy, cut, or perform some other operation that alters

the clipboard.

You need not place plus signs between numbers you wish to add.

Thus, if you were to highlight the numbers 2400 and 1000, Word would

place 3400 on your clipboard.

Word ignores most but not all selected words, symbols, and punctua-

tion, as you will see in a moment. It will attempt to include commas in

answers if commas are extant in the original numbers. Answers will be

formatted using the maximum number of decimal places in the selected

text. Thus, typing, highlighdng, and calculating 2,400 and 1000.000

would result in 3,400.000, since one of the numbers contained a comma
and the other had three decimal places.

Word treats numbers surrounded by parentheses as negative num-

bers, so if you highlight 2400 and (1000), the answer will be the sum of

the positive and negative numbers, 1400.

Multiplication, division,

percentages, and more
Word supports more complex math, within reason. If you type 2400-

1000, the answer will be 1400. Placing an asterisk between two numbers

—

like 2*2 and highlighting both numbers will effect multiplicadon, giving

the answer 4. Division works as you'd expect. The string 2400/2 would

yield 1200.

There is even a percentage funcdon of sorts. The string 80*10.0%

would result in 8.0.

These features are nowhere near as robust or predictable as a full-

blown spreadsheet, so you will need to keep an eye on them. For in-

stance, you might expect that 2400-10% would produce 2160 (the result

of 2400-240). But Word doesn't work like that.
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The Calculate command was used to create all of the results that

were then pasted into the right colimin in Figure 10.23. Creating your

own examples is a good way to understand this feature's strengths and

limitations. A table was irsed in Figiue 10.23, but you need not type your

examples in a table. Calculate will attempt to compute any group of num-
bers you highlight, whether they are in tables, tab-separated blocks, or

even in sentences.

Notice that in lines 1 through 6, Word provides the results you'd ex-

pect. Line 7 has a problem, apparently due to the parentheses used to

surround the text. Changing the parens to brackets solves the problem,

as you can see in line 8.

Notice the percentage computations in lines 13 and 14. hi order to

gel the right answer you must first have Word compute 10% of 2400 and

then have it subtract the answer from 2400. Parens work for this purpose.

Word first does the math in parens, then works outside of them. BiU

there's a potential gotcha as you can see in line 17. Since Word always

treats single numbers in parens as negative numbers, the results on line

17 are quite different from those in line 16. Use parens with care, or bet-

ter still, do the fancy work in a spreadsheet, then copy and paste it into

your Word docimient.

Chapter 28 will show you how to link Word documents and spread-

sheets and how to use System 7"s Publish and Subscribe features. These

are often better ways to place complex math results in Word documents.

FIGURE 10.23

Use care when

calculating.
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The equation editor

The Equation Editor is an elegant way to type complex looking for-

mulas. It helps you build formulas using palettes of math symbols

and templates. The feature understands formula typesetting rules and

conventions, and will do much of the formatting for you. It does not

calculate.

Starting the equation editor

The Equation Editor is a separate program that runs under Word 5's su-

pervision. The program and related help file should be installed in your

Commands folder. They are shown in Figure 10.24.

FIGURE 10.24

The Equation Editor ' ^^

and its related help file
Equation Editor

should be installed in your i—
Word 5 Commands folder. vvX

HELP

Equation Editor Help

Normally, Word's installation program will put them where they

belong. You can double-click to laimch the program under System 7 or

MultiFinder, biu it is better to use the Object... command on Word 5's In-

sert menu instead. As shown in Figine 10.25, the Insert Object dialog

box will present you with several choices.

Either double-click on Equation or highlight it and click OK, You

will see an Ecjuation Editor Window like the one in Figure 10.26.

Creating equations

You assemble equations by typing text and picking templates and .sym-

bols from the palettes. Equation Editor has a number of keyboard

shortcuts which are detailed in the program's context-sensitive help

screens.



THE EQUATION EDITOR

FIGURE 10.25

Sfart the Equation Editor

from the Insert Object

dialog box, reached from

the Object command on

the Insert menu.

Insert Object

Object Type:

Equation rv
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FIGURE 10.27

Reach the Equation

Editor's help screens from

the Apple menu or press

Help on your Mac's

keyboard.
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Footers,

Page Numbers,

and Footnotes



TRACKS

To <reate, view, and edit simple headers and footers 367

choose Header or Footer from the view menu. In Normal view

you'll see a header or footer window. In Page Layout view the

header or footer will appear in the margin. Type and edit as

usual. All pages of the document will contain idendcal headers

and/or footers.

To insert dates and times in headers and footers 368

in Normal view open the desired header or footer window and

click on the date and/or time icons. Position and format the

date and time using standard Word character and paragraph

formatting techniques in open header or footer windows. You

may need to use the Show Ribbon (3€-Option-R) and Show

Ruler (3€-R) commands to see these tools in header and footer

windows.

To treate different odd and even headers and footers 371

switch to Normal view (§€-Option-N), Choose the Document...

command on the Format menu (9C-FI4), and select the

Odd/Even headers option. Use the Odd Header, Even Header

and Odd Footer and Even Footer commands that appear on

your View menu to create different odd and even headers and

footers.



To treate different first pages in headers and footers 372

switch to Normal view (9€-Option-N), Choose the Section...

command on the Format menu (3€-F14), and select the Dif-

ferent First Page option. Use the First Header and First Footer

commands that appear on your View menu to create different

headers and footers.

To number pages 373

in Print Preview, double-click on the page number icon (second

from the top), hi Normal view open the desired header or

footer window and click on the page number icon.

To reposition and format page numbers 377

use standard Word character and paragraph formatting tech-

niques. In Print Preview, drag page numbers to new positions

with your mouse. In Normal view open the desired header or

footer window and use the header or footers, ribbon, ruler, etc.

You may need to use the Show Ribbon (3S-Option-R) and Show

Ruler (3€-R) commands to see these tools in header and footer

windows.

To suppress page numbering 378

place the insertion point in the desired section of your docu-

ment (if it has multiple sections), then open the Section dialog

box with the Section... command (Option-F14) on the Format

menu. Choose Different First Page.



Ways to create headers andfooters

Numbering pages

Formatting headers andfooters

Facingpage variations in headers

andfooters

Stepsfor spell-checking headers andfooters

Creating, editing, and stylizingfootnotes

H EADERS AND FOOTERS are places to

^M put repetitive information in a docu-

ment's top and bottom margins. (Don't confuse footers with footnotes,

they are different).

You can use headers and footers to print something simple on each

page, like your name, or something complex, like a graphic. Stylized

text, dates, and automatic page numbering can all be included in

headers or footers.

Headers and footers can be identical on all pages in your docu-

ment, or you can specify different contents for each section of the

document. Odd and even pages can have different designs if you wish.

The first page of each document or each section can be unique.

Editing takes place in special Header and Footer windows, opened
from the View menu. It is possible to apply virtually any paragraph or

character style using ribbons and rulers in these windows. Once headers

and footers have been added to a document, it is possible to see and edit

them in the Page Layout view. They are also displayed in Print Preview,

but in Normal view, you must open a separate window.

Word's footnote features are equally powerful and easy to use. You
can enter edit and view footnote numbers in a variety of formats. Word
simplifies inserting, deleting, and moving footnotes by aiUomatically

niunbering and renumbering them as necessary.
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Entering basic headers and
- FOOTERS

To enter a header that repeats on all pages in your document:

1. While in Normal view, choose Header from the View menu.

2. Since you're in Normal view, a new Header window will open.

3. Create and edit header text as you would any other. You can

paste graphics, apply styles, and otherwise format your work

normally. Figure 1 1.1 shows an example of centered text, and

a small graphic in a header. The bottom of the header con-

tains a line created with Word's paragraph Border feature.

FIGURE 11.1

A header window can

contain stylized text,

borders, and graphics.

Your Word document window

Confessions

2^
3a m^\^\m\

ja {mzm Bj] m o mnm
J3_

im B^ nrTTTrTTTi grrri-

My first day of work was a nightmare The stench was undenijt'le^a

cross bet\«

This line was creoted>

with the paragraph

border feature

The Header window

Confessions:Header :

Sdine Hs Pi ei<i oils]

Click to paste page numbers,

dates, and times

Confessions of an eye -closer in a sardine factory1

Iheader EE o

A graphic pasted into a header Text centered in a header
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A. Use the optional page number, time, and date features

described later in this chapter.

5. Either close the header with its close box, or leave it open

and click in the main document to continue working there.

Footers are entered the same way as headers, except that you work in a

Footer window. (Again, we assume you are in Normal view.)

1. Choose Footer from the View menu.

2. Since you're in Normal view, a new Footer window will open.

X Create and edit footer text as you would any other. You can

paste graphics, apply styles, and otherwise format your work

normally.

4b Use the optional page number, time, and date features

described later in this chapter.

5. Either close the footer with its close box, or leave it open
and click in the main document to continue working there.

Adding dates, times, and simple page numbers
In Figure 11.2 a page number has been inserted in a footer by clicking

on the page numbering icon at the top-left of the footer window. (The

date and time can be added by clicking the appropriate icon.) The page

number was then centered by using a footer ruler (3€-R) with the Footer

window active.

FIGURE 11.2

A page number has been

specified and centered in

this footer window

.

m 1
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Rulers and ribbons in headers and footers

You don't use your regular document ruler or ribbon when working in

header and footer windows. You display special ones by placing the

insertion point in your header or footer window and choosing Ribbon

or Ruler from the View menu. The keyboard shortcuts (3€-Option-R and

3€-R, respectively) work here too.

Headers and footers in page layout view

Ifyou are in Page Layout view when you choose the Header or Footer com-

mand from the View menu, Word will move the insertion point to the header

or footer and, if necessary, make room for you to work. (\'(:)u won't see tlie page-

numbering, date, and time icons in Page Layout view.) Tliis is a good way to \'is-

ualize the relationships between headers, footers, and the rest ofyour page.

In Figure 11.3, the header is taller than the specified top margin, so

Word has pushed the header down into the text area. You can get an

even better view of this in Print Preview, where you can also change the

margins to accommodate the tall header.

FIGURE 11.3

When you view

documents in Page Layoul

view, you gel a good idea

of where headers and

foolers will print.

Confessions lai

ja 3a mzm ^a 1^ o gnM
3Q iMi =[^ B^ HrrrTrrm mrri- -

-42

iB
Confessions of an eye-closer in a sardine factory I

M

Page I

My first day of work was a nightmare The stench was undeniable-a

cross between a septic system overflow and the lockers where

literary critics hang out n

|.g4!;t| Normal E

Headers and footers in print preview

It is a good idea to switch to Print Preview when designing headers and

footers. As you can see from Figure 11.4, the footer fits properly in the
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bottom margin, but either the top margin or the header or both need

work. You can drag the top margin handle in Print Preview to enlarge

the top margin. It is also possible to drag the entire header up and down

wilhin ihe existing margin. To do this, place the pointer in the header. It

will change into a crosshair (+). Hold down the mouse button and drag

the header up or down.

D I P

Remember that many printers cannot print at the very

edges of the paper; and that it is possible to drag a header

or footer into non-printing areas. If you have selected the

correct printer (from your Chooser), Word does a pretty

good job of showing you when a header or footer will be

cut off by your printer.

FIGURE 11.4

You can use Print

Preview to view and

fine-tune header and

fooler page relationships

by dragging margin

handles or headers and

foolers themselves.

, f^



EVEN AND ODD HEADERS AND FOOTERS

Seeing those two pages side-by-side in Figure 1 1.4, it becomes

obvious that since this document will be printed two-sided and then

boimd, it would look better with different odd and even headers.

Even and odd headers
- and footers

To create different even and odd headers or footers:

1. Place the document in Normal view.

2. Check the Even/Odd Headers choice in the Document

dialog box, reached from the Format menu, or with the

§€-F14 shortcut if you have an extended keyboard.

3. Your View menu will change to include additional header

and footer choices.

4. You now have four header and footer windows in which to

work. Use them to change text alignment for mirrored

pages or even add different graphics for odd and even

pages, as illustrated in Figure 11.5.

FIGURE 11.5

Different graphics liave

been used here for even

and odd pages.

<ii(t.iltii.r>. v>».<i>. ..•iitiHr't.y
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So far so good, but now the little face will be looking off the page

on the document's first page! Fortunately, Word offers a Different First

Page option that can be used to fix this.

Different first page headers
— and footers

The Section dialog box contains a choice called Different First Page.

(Chapter 12 goes into more detail about sections.) To create unique

headers and footers for the first page of your document:

1. Place the document in Normal view (5§-Option-N).

2. Reach the Section dialog box from the Format menu or use

the Option-F14 shortcut on an extended keyboard.

3. Choose the Different First Page option.

4. Two more choices appear on your View menu for this docu-

ment, titled First Header and First Footer.

5. It doesn't take a physics degree to know what happens next.

Use these choices to create a first page with headers or

footers that differ from the rest.

Postscript code in headers

If you are using a PostScript printer and want to send PostScript code

from Word documents, you can insert the code as hidden text in your

headers. Figure 1 1.6 shows code that will print the word CONFIDEN-
TIAL diagonally across an 8V2" sheet of paper over your Word text.

Remember to turn on Print Hidden Text in the Print dialog box if you

try this.



PAGE NUMBERING

FIGURE 11.6

PostScript code entered

as hidden text in headers

can be sent to your printer

when you print.
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simple page numbers in tlie default location, (V2 " from the top and

right sides ol the page):

1. Choose Print Preview from the File menu (l€-Option-I).

2. Double-click on the page-numbering icon, as shown in

Figine 1 1.7.

3. An automatic page number will appear quicker than a cat's

sneeze.

FIGURE 11.7

Double-click on the

page-numbering icon to

apply page numbers.

Honda Letter Rgreement



PAGE NUMBERING

The header/footer method
Word makes it easy to place page numbers in headers and footers. To

add page numbers using tiie header/footer method:

1. Open a Header or Footer window.

2. Click on the page-numbering button.

3. A number will be inserted for you in your header or footer

at the insertion point.

4i Like anything else placed in headers and footers, page

numbers can be stylized, repositioned, surrounded with bor-

ders, accompanied by text, and otherwise embellished.

Word uses the standard header or footer style to format page number
placed tlierein. You can override this by applying additional character and

paragraph formats or by changing the standard header or footer style

(see Chapter 13).

Headers and footers have tab stops, which you may find useftil for

page number positioning. Or, you can open rulers and ribbons and use

their formatting tools for headers and footers. Figure 1 1 .8 shows an auto-

matic page number centered in a footer, accompanied by the word Page

and surrounded by a paragraph border.

FIGURE 11.8

The page-numbering

button in a header or

fooler creates numbers

that are easy to format

and embellish.

iPi Honda Letter Rgreement:Footer ^s I3i==

[Sdmp fH Pieuiuiis)

|Ngw Yort ja ^T^j^ {Bjzjsi igB El O
ja mmmm b^^ b^ gEiziiE mm

± 15 6_

Page 2 !l

|footer+. jm IE
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The section method

The Section dialog box provides a third easy way to insert page numbers,

which we'll call the section method. It uses the Microsoft standard style

page number. You don't have to use the section method for numbering

documents broken into sections, but you might find it convenient to do so.

1. Start by placing the insertion point in the section you want

to number.

2. Display the Section dialog box by choosing Section . . . from

the Format menu or use the Option-F14 shortcut on ex-

tended keyboards. The center of the Section dialog box will

look something like Figure 1 1.9.

X By default, Word places section method page numbers in

the upper-light corner of your document (W from the top

and right edges of the paper) , but you can specify different

positions in the From Top and From Right entry boxes. You

will probably not want to enter dimensions that will place

page numbers within the text area of the document, al-

though this is possible. Moreover, remember that not all

printers can print at the extreme outer edges of the paper.

A, When the Restart at 1 box is checked, each new section of

your document will start with page 1.

FIGURE 11.9

The Section dialog box

contains several useful

page-numbering options.

Page Numbers

Format: 1 2 3 B
D Restart at 1

H Margin Page Numbers

From Top:

From Rigtit:

0.5 in

0.88 in



PAGE NUMBERING FORMATS AND STYLES

Page numbering formats
— and styles

a

Word supports three page-number formats. Standard Arabic numbers

(1, 2, 3...) are the default. It is also possible to number with Roman
numerals (I, II, III...) or with letters (A, B, C...). All of these formats are

available, regardless of which page-numbering technique you choose.

You can use Word's many character and paragraph embellishment

features to spruce up page numbers. Pick the font of your choice, make

numbers bold, align them, put boxes around them. Text can appear next

to the numbers (Pg. 1, for instance).

After inserting page numbers, visit the Section dialog box (Sec-

tion... in the Format menu) and use the dropv-down Format menu to

choose the one of your choice.

To choose your new default page-number format, click on the Use

As Default button in the Section dialog box. This will record the format,

position, and other page choices in a Word Settings (5) file.

I P

Documents containing multiple sections can have

different formats in each section. That's both good and bad

news. If you want all sections to have the same format, you

will want to pick a format before you break up the docu-

ment. Otherwise you must place the insertion point in each

section and pick the same format for every one. Plan ahead.

Managing starting page numbers

Usually you will want Word to place the number I on your first printed

page, but not always. For example, many people prefer their multipage

letters to be printed without a 1 on the first page. They still want the
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second page to be numbered 2, the third 3, and so on. Let's call this Jirst

page number suppressed.

Or, you may wish to start each new section in a multisection docu-

ment with 1. Let's call this restart sections with 1.

Sometimes you may want your first page to be printed without a

number (a cover page, for instance) and then you want the next page to

contain the nimiber 1. Let's call this begin second pagefrom 1.

Finally, you might want to use some other number for the first

page, like 25 or 100. This is helpful when you are combining your work

with other documents. Let's call that starting page other than 1.

Note that in all the following examples, we assume that your docu-

ment does not already have page numbers.

First Page Number Suppressed
This one's easy.

1. Place the insertion point in the desired section.

7. Check Different First Page in the Header/Footer portion of

the Section dialog box (reached from the Format menu).

No page number will print on the first page and the second

page will be numbered 2.

Restart Sections w^ith 1

1. Place the insertion point in any section. Open the Section

dialog box and check the Restart At 1 box.

7, If you want only certain sections to start this way, repeat the

steps as many times as necessary with the insertion point

placed in the pertinent sections.

X To make all sections start with 1, use the Select All (3€-A)

choice from the Edit menu. Then check the Restart at 1 box.

Begin Second Page from 1

This one's tricky, and requires an understanding of sections and pagina-

tion. You may want to review those topics first.
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D I P

Start by being certain that your first page is perfect and

requires no further editing. (You will need to repeat this

every time you change the contents of the first page.)

1. From the Tools menu choose Repaginate Now.

2. Now place a section break between the bottom of the first

page and the top of the second.

3. Place an X in the Restart at 1 check box in the Section

dialog box. Wliile still in the Section dialog box, pick New
Page from the drop-down Start menu.

4b Click OK to close the Section dialog box. Phew!

You may prefer to create a separate document for the first page and num-

ber the remaining pages normally. This is an efficient way to create

covers.

Starting Page Other Than 1

To start numbering pages with numbers other than 1:

1. Open the Doctunent dialog box from the Format menu or

press 96-F14.

Z Choose File Series.

3. A small dialog box will appear.

4. Type the starting number in the Number From entry box.

5. Click OK.

Removing page numbers

If you've created numbers using the Print Preview method, go back to

Print Preview and drag the numbers off of the page.
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To remove page numbers inserted using the header/footer

method, open the header or footer and delete numbers as you would

any other text.

Numbers inserted with the section feature are removed by un-

checkitig the Margin Page Numbers box in the Section dialog box.

Regardless of which method you've used to insert numbers in docu-

ments containing sections, you will need to place the insertion point in

each section with page numbers you wish to delete and repeat the

process.

Footnotes
Word lets you create simple footnotes, or personalize their appearance.

Here are the various techniques.

Easy automatic footnotes

Figure 11.10 shows an automatic (default) Word footnote. It should take

you less than ten seconds to add your first footnote to existing text.

1. Start by placing the insertion point where the footnote

marker is needed (after the word companies in our

example)

.

2. Choose Footnote... from the Insert menu or press the 9€-E

key combination.

3. You can dismiss the Footnote dialog box by clicking OK,

since Word's defaults are fine for this project.

A, The document window automatically splits into two panes

and a footnote reference number (1 in this case) appears

both at the insertion point and in the footnote area of the

split document window.

5. The insertion point automatically moves to the footnote

window where you can type the footnote.
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FIGURE 11.10

Standard footnotes like

these require very little

effort.

The document window

The footnote window -

p-; Footnote samples
|Ng^^^ York J\zi B EZCy] g mnm

3a M^m^ B^^ Bf^ mrmTTi mm
-14 -P 31

Take CD-ROMs for instance It is now possible to store the text of an

entire encyclopedia set on a single compact disc that looks ]ust like

the ones you put in your stereo Computers, when equipped with

appropriate drives can retrieve CD-ROM based information quite

quickly -

Many large companie^. are betting that CD-ROM technology is

about to take off, and ther^ are some signs that they may be right

Apple Commodore. IBM NEC JPhilUps, and Sony ]ust to name afev

Page I Ml

A footnote

Footnote reference marks The split box

b. To return to the main document, move the hisertion point

with the mouse, or press 3€-Option-Z. If your keyboard has

a numeric-key pad and if Ninn Lock is off, pressing zero on

the pad will also retinn you to the main document's inser-

tion point.

Viewing footnotes

Footnotes are always displayed in Page Layout view and Print Preview.

If they are not visible in Normal or Outline view, choose Footnotes

from the View menu, (not Footnote... from the Insert menu) or use the

§€-Option-Shift-S shortcut.

If you are constantly entering or referring to footnotes, you can

leave the footnote window visible while you work. Scrolling in your docu-

ment will cause corresponding scrolling in the footnote window. Use the
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footnote scroll bars if necessary to view notes. Feel free to resize the foot-

note window to suit your taste and screen size. Drag the bar separating

the two windows the same way you resize other Word split screens (point

to the Split-box and drag).

To hide the footnote window, choose Footnotes from the View

menu, or use the four-fingered, §§-Option-Shift-S "shortcut".

D I P

Double-clicking on a footnote marker in your

document will display the footnote and place the insertion

point at the end of the footnote. If necessary. Word will

open the footnote window and scroll to the appropriate

note. There may be a slight delay so be patient.

Inserting footnotes ahead of existing ones

Whenever you insert footnotes. Word renumbers the existing ones

properly, as shown in Figure 11.11.

FIGURE 11.11

Inserting a footnote

before ttie first note

automatically renumbers

all affected notes.

;D Footnote samples

3^
[footnote text 2B

a [ELyJ l:^[v:l Ijgl O
iMM Ba= I B^i rrprim 1

1 mm
#- -41 -P-

Take CD-ROMs ' for instance It is now possible to store the text of an
entire encyclopedia set on a single compact disc that looks |ust like

the ones you put in your stereo Computers, when equipped with

appropriate drives can retrieve CD-ROM based information quite

quickly, f

Many large companies2 are betting that CD-ROM technology is

about to take off, and there are some signs that they may be right

^CD-ROM stands for Compact Disc Read Only Memor^^
^Apple. Commodore. IBM. NEC. Phillips, and Sony, just to name afev^

1592 Chars Ifootnote teKt na
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Editing and personalizing
- footnotes

You can copy, move, or delete entire footnotes as easily as you would a

single character.

1. Select the footnote marker of interest in the document text.

(This might take a steady hand, particularly if you have

Drag-and-Drop enabled.)

2. Cut, copy, paste, or drag-and-drop the footnote mark.

3. Word does the rest. Ifyou have Numbering turned on. Word

will update the numbers in your text and in the correspond-

ing footnotes. If you copy and paste a mark, a corresponding

new footnote will magically appear in the right spot in your

footnotes. Deletion works as you would expect.

Editing footnote text

Visit the footnote window. Use Page Layout view or open the footnote

window itself. Cut, paste, and Drag-and-Drop away to your heart's con-

tent. (Note that you cannot cut a footnote's entire text; you must cut

the footnote mark if you wish to delete or move it.)

Personalizing footnotes

Word lets you modify' many footnote parameters via the Footnote dialog

box shown in Figure 11.12. You make other footnote-related decisions in

the Footnote section of the Document dialog box (Document... on the

Format menu), also shown in Figure 11.12.
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FIGURE 11.12

Personalize footnote

appearance using the

Footnote dialog box and

the Footnote choices in the

Document dialog box.

Use to specify footnote positions

pFootnotes \—

|
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Controlling footnote numbering

You can specify the starting number for footnotes in the Footnotes

area of the Format menu's Document dialog box. Only Arabic numbers

are permitted. Footnote numbering can restart on each page if you check

the Restart Each Page button in the Footnotes area of the Document

dialog box.

Footnote text style

You can embellish selected footnote text as you would expect. Highlight

the text of interest, then use the ruler, ribbon, or format-related menu

choices (bold, italic, and so on).

To change the size or font or other footnote style elements for all

footnotes, modify the Microsoft standard footnote text style. (Footnote

text is based on the Normal style.) To change the footnote reference

marks, modify' the footnote reference style.

Footnote position

There are four possible positions for footnotes:

At the bottom of each page (the default)

- Directly beneath the last text on a page

" At the end of a section in multisection documents

At the end of your document

Specify footnote position by using the drop-down Position list in the Foot-

notes section of the Document dialog box on the Format menu. Phew!

Incidentally, in multicolumn sections, footnotes print below each

column.

Footnote separators

The little black lines that separate document text from the footnotes

themselves are cleverly called footnote separators. Edit them by
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clicking the Separator... button in the Footnote dialog box, illustrated in

Figure 11.13.

FIGURE 11.13

Change the separator by

opening the separator

window.

IDI Footnote samples:Footnote Separator

lol fF Reset

December 19, 19?i}i:02 Pt4-

INormal 'M.

lai

IS
o
Q

When you click the Separator. . . button you will see a new window

containing a sample of the current separator. The default is a short, thin,

black line.

This is just like any other Word window. You can edit the length of

the line (it's a paragraph). Insert a graphic, if you like. You can even

use Word's drawing tools here. Double lines look nice. Use Word's Para-

graph Border feature to create them. It is possible to use a ruler and

ribbon in the separator window.

When you are happy with your creation, close the separator window

and view the results in Print Preview or Page Layout view.

fOOTNOTE REFERENCE MARKS
Footnote reference marks appear wherever you place them in your

document's text area, and at the beginning of each footnote in the foot-

note area itself.

By default. Word uses numbers for reference marks. If you turn off

the Numbering feature. Word defaults to an asterisk as the footnote refer-

ence mark. You can type any character of your choosing in the Footnote

Reference Mark portion of the Footnote dialog box. In fact, it is possible

to use as many as ten characters for a footnote reference mark.
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Footnote continuation

Continuation separators appear whenever footnotes carry over onto the

next page. These notices can be modified the same way you change

regular separators as described in the previous section on Footnote

Separators.

Footnote tips and cautions

- Word does not automatically spell-check footnotes, but you

can select footnotes and run the spellchecker.

Do not place index or table-of-contents entries in footnotes.

They will be ignored.

Word's new Find and Replace features can help you search

for and reformat footnotes. See Chapter 19.

- Save frequently used footnote entries in your glossary to

eliminate tedious retyping. See Chapter 16.
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To <reote settion breaks 392

position ilie insertion point where you want the break and use

the Insert menu's Section Break command (§€-Enter).

To treate thapters using serf/on breaks 393

start each chapter with a section break. Optionally, change

headers and footers to show new chapter numbers, titles, and

chapter-specific page numbering.

To €reate iomplex pages using se<tion breaks 393

place insertion points where you want new formatting features

(like changes in the number of columns) to occur. It is possible

to have multiple sections on the same page.



To Kontrol page numbering in se<tions 394

place the insertion point in the section whose numbering you

wish to control. Open the Section dialog box with the Section...

command on Word's Format menu. Choose the desired page

numbering options.

To print seietted settions 395

specify the desired section in the section range portion of

Word's Print dialog box.

To delete settion lirealis 396

select them and delete them as you would any other character.



Reasons to break your documents into sections

How to make section breaks

Ways to save time when creating sections

w HEN YOU THINK of sections, you

^H probably imagine traditional book sec-

tions—collections of several related chapters for instance. Word's sec-

tion features can help you organize large projects this way, of course, but

they do much more. Word sections are designed to let you change major

formatting features at places you decide in your document.

Sections need not be used only for books or reports. It is a shame

sections aren't called zones or something less specific.

You can start a new section whenever you want to change the for-

mat, position, or progression of page numbers. Sections can be used to

turn line numbering on and off. Since footnote positioning can be dif-

ferent in each section, sections are sometimes used for this purpose.

Headers and footers can also vary from section to section. Last, but by no

means least, sections can be used to change the number of cokuTins in a

document. You'll see practical applications of these tricks in a moment.

There are no hard and fast rules about when to create new sections.

Experienced Word users often create multiple sections in a one-page

document. Other times they'll use a single section for an entire 100-page

report.

Creating section breaks

1. Prepare to create a new section by placing the insertion

point where vou want the break.

2. Next, hold down the §€-Enler (not the Return) key com-

bination or pick Section Break from the Insert menu. This
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places a double-dotted, non-printing line called a section

break at the insertion point on your screen. Figure 12.1 con-

tains an example.

Sections as chapter elements

It is very common to create a new section for each chapter in a large

publishing project like a manuscript or report. This makes it possible to

change header and footer information like chapter names. If you were

creating an employee handbook, Chapter One's header might contain

the words Welcome new employees, while the headers in Chapter Two might

say Your health plan explained, and so forth.

Sections also make it possible to customize page numbers within

chapters. Your document's frontmatter might be numbered in lowercase

Roman numerals (i, ii, iii, etc.). Page numbers within chapters might

contain chapter-related numbers that restart at the beginning of each

chapter (1-1, 2-1, and so on) . As you'll recall, you can use different page-

numbering styles in each section of your document, and you can restart

page numbering at the beginning of any new section.

Sections as formatting tools

You probably know that word can produce multicolumn documents, but

did you know that you can have different numbers of columns on the

FIGURE 12.1

Sections are marked

with double-dotted,

non-printing lines and the

section number appears

next to the page number

in the status area.
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morning's first moving pencil point Is it a harmless crow circling her

breakfast, or a ballistic jet streaking through the military training route

near Edvards Air Force Base'' -

If it /sa trainer it could reach me in sixty seconds, less time than it

would take most pilots to see it, decide and react Which vas it-bird or

student Top- Gun-wannabe? What direction was it headed? Hov high? How

fast?
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same page? The trick is to breai< a single page into multiple sections. Fig-

ure 12.2 shows an example of this technique. There's a section break

separating the single- and three-column text from one another. See

Chapter 21 for more about columns.

The section dialog box

Reach the Section dialog box by double-clicking on the section break at

the end of the section you wish to change. It is also possible to place the

insertion point in the section being designed and choose Section... in

the Format menu. (You owners of big keyboards can press the Option-

F14 shortcut, if you prefer.)

Many of the choices in the Section dialog box are covered else-

where in this book, but the Start drop-down menu of the dialog box con-

tains a number of section-specific items worth exploring, h is shown in

Figure 12.3.

FIGURE 12.2

You can mix column

formats on the same page

by inserting section

breaks where you wont to

switch formats.

I spend lots of time looking over people's shoulders Ifs amazing how much
computer power goes untapped Many users learn the basic features of one or

two fxipular programs, then put aiAay their manuals forever When more
advanced projects come along these users (often painfullyl apply their basic

s^iills rather than cracking the books to learn about advanced features that could

ma>;e them much more efficient This is particularly true of spreadsheet and
database users

Take a "beginner's"

program like Microsoft

Works for the Macintosh,

Works provides over 75
"functions" that simplify

and speed development
of spreadsheets and
databases Other 'tnore

advanced" programs like

It is a much tetter (and

as you'll soon see, safer)

way to add-up columns of

numbers than specifying

each cell that needs to be

included in the total

Suppose, for instance

that lou wanted to add
the contents of the ten

Bocks are permissibe.

You can sometmes list

non-contiguous cells to

aeate a range You can
even reference multiple

ranges. Here are some
range exam pies using the

Works Sum function

FIGURE 12.3

Choose one of the

options from the Start

menu to specify how Word

should break your section.

Start:
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This is how you tell Word where you want it to start printing the

various sections of your document. You can make a different choice for

each section. Here are explanations of your options.

No Break
No Break is Word's default section printing strategy. Text from preceding

sections will occupy the same page as the designated section, if there is

enough room for the text from both sections.

Ne^v Column
In multicolumn formats. Word breaks a column when it encovmters a

section mark. It prints the subsequent text at the top, of a new column.

(See Chapter 21 for more about columns.)

Ne>v Page
Word will always start new sections on new pages when it encoimters this

choice.

Even Page
Word starts printing the new section on an even-numbered page, even if

it means leaving an odd numbered page blank.

Odd Page
Word will start the new section on an odd numbered page. This is a great

way to ensure that new secdons start on right-hand pages when designing

documents for two-sided printing.

Copying section breaks

Section-formatting information is stored with secdon breaks much the

same way paragraph formatdng is stored with paragraph marks. And you

can copy secdon informadon by copying and pasdng section breaks. It is

even possible to place section breaks as glossary items. See Chapter 16

for information about glossaries.
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Section breaks differ from paragraph marks (1), in that a section

break controls the information below it, while a paragraph mark controls

the information that precedes it.

It takes some practice to highlight section breaks. You may find it

easiest to do this in Normal view. When you move the mouse pointer to

the left edge of a section mark it turns into an arrow. Click to highlight

the mark as shown in Figure 12.4. You can then copy, cut, etc.

FIGURE 12.4

1* Ill II HM

j : :;;;;;;;;;;;;tt;;;;i;u;;;;;;;;;;;;;;;;;;;;;;:;:;;;;;;;:;:;;:

horn the kfl margin to select ^ IT

it for coping or deletion.

Deleting section breaks

Select a section break as described above. Then press the backspace or

Delete key. Text after the removed section break will take on the charac-

teristics of the preceding material.

Time-saving section tips

Documents start out as one big section and it is often best

to wait until you are nearly finished with a document before

breaking it into smaller sections. Do, however, think about

the divisions in your document early on.

Section formatting affects an entire single-section docu-

ment. For instance, header and footer choices will be ap-

plied throughout. If you want most of the document to

print in multiple columns, make that choice while the docu-

ment contains only one section. Then break the document

into sections and modify things like page numbers within

each section.

Set up stationary and glossary entries for complex section

designs. See Chapter 16.
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To define styles from the ruler 402

create a paragraph containing the style you want to immortalize

(adjust indents, set tabs, line spacing, fonts, etc.) With the inser-

tion point in that paragraph, click in the name portion of the

ruler's style list, type a new style name and press Return twice.

To apply styles 403

place the insertion point in the paragraph of interest, or select

multiple paragraphs, then select the desired style from the

ruler's drop-down list; or press §€-Shift-S (you'll see the word

Style in the status area). Then type enough of the style's name
to uniquely identify it. You can also select and apply styles from

the Style dialog box, reached with the Style... command in

Word's Format menu(3C-T).

To define styles with the Style. . . tomntand 404

create a paragraph containing the style you want to immortalize

(adjust indents, set tabs, line spacing, fonts, etc.). With the inser-

tion point in that paragraph, choose the Style... command on

the Format menu (§€-T), type a new style name, select other op-

tions (Based on. Next Style, etc.), and click OK.

To base one style on another 407

place the insertion point in the paragraph of interest, or select

multiple paragraphs. Select the desired style from the Based On
list in the Style dialog box reached with the Style... command
in Word's Format menu(9€-T). Select the style you wish to use

as the base from the Based On list.



To modify styles 410

alter the paragraph containing the style, then choose the cur-

rent paragraph's style in the ruler or Style dialog box reached

with the Style... command in Word's Format menu(96-T).

Choose the Redefine option when asked to reapply or redefine.

To rename styles 413

edit style names in the Style dialog box reached with the Style...

command in Word's Format menu(l€-T). Be sure the new

name is unique.

To <opy styles between dotuments 415

copy a paragraph (including the paragraph mark) ft'om one

document to another. The style (s) will follow. Alternately, you

can merge style sheets. Read this chapter to find out what hap-

pens when both documents have dissimilar styles with identical

style names.

To merge Style sheets 415

from the destination document, open the St)'le dialog box and

choose Open from Word's File menu. Select the source docu-

ment and open it. Word will merge the styles from the source

with the destination's styles. Read this chapter to find out what

happens when both documents have dissimilar st\'les with identi-

cal style names.



Ways to capture and reuse complexformats

(styles)

Word's standard styles explained

Style-sheet tricks and strategies

How to base new styles on existing ones

W ORD 5'S STYLE-RELATED features are

^^m responsible for much of its power and

popularity. They also confuse and initially frustrate most new users. It is

possible to plug-along in Word for the rest of your life without knowing a

whit about styles. That would be a shame. Learning about styles and style

sheets and Word's standard styles and the concepts of normal and base

styles can save you hundreds or even thousands of hours.

When you couple that know-how vfith Word's glossary and station-

ary features (covered elsewhere in this book), Word can make you a

dramatically more efficient author and typist. If you work with other

people on large, complex projects, or if your organization wants a

uniform look for all of its printed documents, styles are essential.

Consume this chapter a little at a time. Try a few style experiments

when you are not working on a rusli project. If your eyes begin to glaze

over or you find yourself pounding the desk with your fist, take a break.

It will all make sense sooner than you think.

What are styles and style sheets?

Styles are collections of paragraph and character formatting decisions

that you make and save using meaningful names. Styles make it easy for
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you to reuse complex paragraph formats without laboriously recreating

them each time. The sales letter in Figure 13.1 contains five examples of

styles. Their associated style names appear in the drop-down list at the

left edge of the ruler.

Each docimient has its own collection of styles. A document's collec-

tion of styles is called its style sheet.

Some styles in this example are very simple. For instance, the style

used for Dear Ms. Steak is called Normal. It uses Word's standard default

settings (flush left, single-spaced text in the 12-point New York font). The

letter's Body style is only slightly more complex. It looks like normal text,

except that the first line has been indented V2" and 4 points of space

have been added to the beginning of the paragraph. (Thai's why the

salutation and the body copy are slightly separated.)

The buUeted paragraphs near the bottom of the window are also

normal text, this time indented 1.0", with extra space preceding them.

You may have noticed that the name for this style is Bullets, b. The b fol-

lowing the comma in the style name is a second name for the same style.

(More about this later.)

FIGURE 13.1

The five styles in this

letter (Body; Bullets,b;

From Address; Normal;

and To Address) are

listed in the style menu

at the top.

Customer letter
\
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Normal

To Aijdresr

a Ml
mumm JflyJ.
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Fortunes RUs®

John Quickcloser, Sales Consultant-
123 Lotus Lane, Wmthree, CA 91 Oil-

1-8Q0-EAT-SOME-

Ms Amy Steak'-

Chu Sum Quick. Restaurant*

820 Broadway-
Santa Monica CA, 94123^

Dear Ms, Steak,^

Thanks for pointing out the spelling errors in that last batch of

fortune cookies 1 As we say in the fortune cookie business, "He who
laughs last sometimes chokes on cookie " And we can't have that,

now can we? Here are steps we've taken to prevent errors in the

future-

• We now use Word 5 with its new Spelling checker •-

Page I Bullets 151 Q
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The most complex collection of formatting tricks in Figure 13.1 was

used to create the From information. A style named From Address in-

cludes 14-point New Century Schoolbook rather than 12-point New York.

Characters have been expanded. The paragraph is indented 2V2" from

the left margin and sticks out '/2" past the document's right margin. The

text is centered in a shadowed paragraph border, and extra spacing

separates the text from the border.

Creating and naming styles is very easy. Developing clever style

strategies lakes more forethought. Here's how it all works.

Defining styles from the ruler

1. Display the ruler (press §€-R, or select Ruler from the View

menu if necessary)

.

2. Place the insertion point in the formatted paragraph whose

style you'd like to capture.

3. Click once on the style box (the name portion of the drop)-

down style-name list). As shown in Figure 13.2, the style box

will tiun gray, indicating that you can type a new style name.

4 Tvpe a meaningful style name and press Return twice.

5. Word will save the style information and add the new name
to both the style sheet and the drop-down style list for the

current docimient.

FIGURE 13.2

To define styles from the

ruler, i^ace the insertion

point in the pamgrofh of

interest, dkk in the style box,

and then type a new style

name and press return.

Normal

^ ir~^ +
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Applying styles from the ruler

Once you've defined styles, you can easily apply them to one or more
paragraphs.

1. Either place the insertion point in a paragraph or select

several paragraphs.

2. Scroll through the drop-down style list to pick the desired

style.

3. Your text will be reformatted using the selected style. Note

that the style name appears in the status area.

Applying styles from the keyboard

Instead of scrolling through style names on the drop-down list to apply a

style, you can apply a style by typing its name in the status area of the

document window. To do this:

1. Press the 3€-Shift-S key combination.

2. The word Style will appear in the status area at the lower-

left corner of the document window.

3. Type enough of the style's name to uniquely identify it.

4b Press Return. Your paragraphs will be reformatted.

O I P

The Repeat keyboard shortcut (§€-Y) works when
applying styles. After you apply a style once, you can move

the insertion point to other paragraphs and press 3€-Y to

apply the new style where needed.
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Style name considerations

Style names can be up to 254 characters long, but shorter is often better.

Names can contain any legal Macintosh characters including spaces (al-

though commas and semicolons have special functions in style names).

As you've seen, styles can have more than one name. For instance, you

could call the same style Bullets and b. This is particularly useful if you use

the keyboard method of applying styles. You might use a long name to ac-

ciu"ately describe the style on the drop-down menu, and a short name for

quick keyboard selection. You can assign as many names to a single style as

you wish, keeping in mind the 254 character limitation.

When you assign multiple style names to the same style, separate

them with commas (or semicolons for some non-English Macintosh

systems).

m A R N I N G

Word cares about capitalization in style names. Figure

and figure are two different names. Try to be consistent

when naming similar styles in different documents. You'll

learn why later in this chapter.

The style dialog box
As is often the case with Word, there is a dialog box for styles which con-

tains powerful features not found on the ruler. Reach the Style dialog

box by using the 3€-T keyboard shortcut, or pick Style... from the For-

mal menu. You will see something like Figiue 13.3.

This dialog box lets you define new styles and rename, explore, list,

or delete existing ones. It serves other purposes, as you will soon see.



THE STYLE DIALOG BOX

FIGURE 13.3

Reach the Style dialog

box by pressing^- 1 or

choose Style. . . from the

Format menu.

Style: Customer letter

NeiLi St yle

Body
s/ Bullets,

b

From Address

•Normal
To Address

Stioui: («) Bocument Styles O All Styles ^

Style:

1^1
[cancel

J

(
Apply

]

[Define]

Based On:

NeKt Style:

Normal a
a

Defining styles in the style dialog box

To define a style via the Style dialog box:

1. Place the insertion point in or select a paragraph contain-

ing the desired format.

2i Open the Style dialog box (3€-T).

3b Highlight New Style.

4 Type a legal style name in the box provided.

5. Click Define to record the style.

In Figure 13.3 a new style named Closure has been defined. It will be

used for the Sincerely section of the letter. Text will be positioned 4.0"
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from the left margin, there will be 4 points of space before the Sincerely

paragraph and 36 points after, leaving room for a signature. You can tell

all of this by looking at the description in the box beneath the new style

name. Word's developers call the cryptic formatting shorthand con-

tained here "banter"

Printing OUT A STYLE SHEET

It is often useful to have a printed list of styles and their descriptions.

This can help vou keep things consistent in a large organization, and it

can help you troubleshoot formatting problems in complex documents.

To print style information:

1. Display the document's Style dialog box.

7. Choose Print... from the File menu or use the §€-P key-

board shortcut.

The style list for our sample document is shown in Figme 13.4. Take a

moment to compare it to Figure 13.1. Pretty slick, eh?

FIGURE 13.4

You can print out a list of

styles as a bandy

reference.

Body
Normal + Indent: First 0.5 in, Space Before 4 pt

Bullets.b

Normal -i- Indent: Left 1 in, Space Before 4 pt

Closure
Normal + Indent: Left 4 in. Space Before 4 pt After 36 pt

From Address
Normal + Font: New Century Schlbk 14 Point, Expanded 1.5

Points, Indent: Left 2.5 in Right -0.5 in Centered Border: Top
Bottom Left Right (Single Shadowed 6 pt Spacing)

Normal
Font: New York 12 Point, Flush left

To Address
Normal -h Space After 12 pt
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When and where styles are saved

Styles are saved with your document and they are saved only when you

save the document. This is yet another good reason to get in the habit

of saving early and often. Ifyour computer crashes after you've spent

several hoius setting up a complex style sheet, or if you accidentally click

No to the Save Changes? prompt when you close a document, you will

not be happy.

Basing one style upon another
This time-saver is often a source of bewilderment for newcomers. It oc-

casionally catches old pros off-guard too. Word lets you build upon styles,

or base one upon another. You've seen examples of this in the sample

customer letter at the beginning of the chapter. The letter's style called

Body is built by starting with the Normal style and adding instructions to

indent the first line of each paragraph. In other words, the style Body is

based on the style Normal.

If you change the Normal style so that it uses Helvetica instead of

New York, any paragraphs formatted with the Body style will change to

Helvetica too. That's the good news and the bad news.

Word watches you as you develop new styles and bases new styles on

the style you modify. For instance, if you type the last paragraph of your

customer letter in Body style, and decide when you get to the end that

you want to create a Closure style, you would probably drag the left in-

dent marker for the paragraph containing the word Sincerely. Unless

you tell Word otherwise, it will base the Closure style on the Body style,

since that's the style you modified to create the Closure.

Since Body contains a V2 " first-line indent, your Sincerely will be in-

dented an extra V2 ". Later, if you change the distance that the Body style

indents first lines, the Closure paragraph will move too.

Unless you are careful, you can create quite a chain reaction this

way. Experienced users try to create one or Uvo base styles and tie most

of the rest of their styles to those base styles, rather than basing each new
style on the previous style.
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The Style dialog box lets you force specific styles to be based upon

other styles of your choosing. Pick the appropriate base style from the

drop-down Based On menu, found near the bottom of the Style dialog

box. Figure 13.5 shows the From Address style which is based on Normal.

What's the appropriate base style? That will vary with your project.

At first, you may find it less confusing to base all of your styles upon Nor-

mal. Then experiment and observe carefully. You will soon learn from ex-

perience which combinations work best for you. Newcomers, beware.

Play with copies of important documents, especially if it is ten minutes

before the Federal Express person is due to pick up your document.

Next style

Frequently, you can predict the order in which styles will be used. When
you type letters, for instance, you know that the To style will always be

used after the From style. In reports and manuals, headings are usually

followed immediately by body text, and so on.

FIGURE 13.5

Word lets you specify

which base style each new

style is based upon.

Style: Customer letter

New St yle

Body
Bullets,

b

From Rddress

O

•Normal
y To Rddress

[Cancel

[
Apply

[
Define

Shouj: (i) Document Styles O BH Styles r „ . .

Style
:

^

[ Use fls Default

O

From Rddress

Normal + Font: New Century Schlbk 1 4 Point, Expanded 1.5

Points, Indent: Left 2,5 in Right -0.5 in Centered Border: Top

Bottom Left Right (Single Shadowed 6 pt Spacing)

Based On:

NeHt Style:

Normal

To Rddress



BASING ONE STYLE UPON ANOTHER

The Style dialog box lets you specify which style Word will flip to

when you finish typing a paragraph and press Return. Often, you want a

paragraph to be in the same style as its predecessor. This is the default

condition when creating styles.

But, as shown in Figure 13.5, it is possible to specify different next

styles simply by highlighting a style in the style list and picking the

desired style from the drop-down Next Style list, hi oiu" example. Word

will switch to the To Address format when you press the Return key after

typing the From Address.

In order for this trick to work, you should hold down the Shift key

when you hit Return to terminate all but the last line in your From ad-

dress. This way, Word treats all of the lines in the From address as one

continuous paragraph and places different looking return marks at the

end of all but the last lines, as you can see in Figure 13.1.

To override the Next Style when typing, end your paragraph by

pressing 3€-Return, rather than just Return. The next paragraph you

tvpe will use the format of its predecessor.

WORD'S STANDARD STYLES

Word's designers have created 32 standard styles that are used by its foot-

note, outline, index, table-of-contents, page-numbering, header, and

footer features. These standard styles do not automadcally appear in

your style sheet until you use the associated features in a document. It is

possible, though, to force Word to place them in your style sheet by using

the All Styles button in the Style dialog box.

Try it now. Note that the standard styles show up in the Style dialog

box, but not in the menu on the ruler. The pardculars of these standard

styles are discussed in their related chapters. For instance, the oudine-

related styles (headings 1 through 9) are discussed in Chapter 20.

For now, realize that you can modify standard styles, change their

base styles and, with few exceptions, otherwise treat them like the custom

styles you create. You cannot delete standard styles. Standard styles are all

based on Normal, so changes to the Normal style (or your Word default

font) will affect all standard st\les.
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Additional formatting and styles

It is possible to override or embellish styles with additional character

formatting. But there are some caveats. Consider the From portion of

our customer letter example, for instance. It would be nice to make the

company name bigger and bold. The registered symbol (®) could be a

little smaller and subscripted. The finished product would look like Fig-

ure 13.6.

FIGURE 13.6

Character formatling can

be added to stylized

paragraphs, but they may

riot be permanent.

Fortunes R Us®-
John Quickcloser, Sales Consultant-'

123 Lotus Lane, Winthree, CA 91 OIL
1-800-EAT-SOlMEr

You already know how to make these character-based changes from

the ribbon, and obviously they work in stylized paragraphs. But they inter-

act with formatting elements in your styles. Read on.

Reapply/redefine styles

If you ask Word to apply a style to a paragraph that already uses that style

(applying Normal to an already Normal paragraph, for instance) you will

be visited by a strange and powerful dialog box. It is shown in Figure 13.7.

FIGURE 13.7

Word wants to know if

you want to modify the

paragraph or the style

itself.

1
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paragraph no longer looks like the others. By choosing the Body style

again from the ruler yon will get a chance to reapply your Body style and

repair the errant paragraph.

The second use of this dialog box is to let you quickly redefine a

style. Suppose you hate the fust line indent you've used for body text.

Change the indent in any one Body style paragraph, then pick Body

from the Style list. Click on the Redefine button and click OK. Word will

redefine the Body style using the new indent from yoiu- sample para-

graph. All of your Body paragraphs will be changed.

Strange things sometimes happen when you redefine or reapply

styles to manually-embellished paragraphs, however. Figure 13.8 shows

what happens when the embellished From paragraph has the From style

reapplied.

FIGURE 13.8

Reapplying a style to

paragraphs containing

additional character

embellishments can cause

unusual results.

Fortunes R Us®^
John Quickcloser, Sales Consultant+-

123 Lotus Lane, Winthree, CA 91011
1-800-EAT-SOMEfl

The bold attribute remains. The registered mark is still small and

subscripted, but Fortunes R Us is now the same type size as the rest of the

address.

Figtue 13.9 shows the effect of redefining the paragraph after

making the same text embellishments. This time most of the small text

gets bigger.

While the interaction of manually applied formatting and styles

may seem almost random sometimes, it is not. Read about it at the very

end of this chapter.
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FIGURE 13.9

Redefining a style in an

embellished paragraph

can cause problems loo.

[Fortunes R Us®-
John Quickcloser, Sales

Consultant'
123 Lotus Lane, Winthree, CA

91011
1-800-EAT-SOME B

The revert to style command
Suppose you have an established paragraph format, and type text in that

format. Then you apply character formatting to embellish the text. You

start underlining a few words, italicizing some others, and then before

too long, realize you've really overdone it!

Word's Revert to Style command (found on the Format menu) will

remove the character formatting (underline and italics in the example)

without changing the other style elements (margins, paragraph charac-

teristics, etc.). The keyboard shortcut is 3€- Shift-Spacebar.

Deleting styles

You cannot delete Word's standard styles, but you can remove the cus-

tom ones you've created. Unwanted styles can be deleted by selecting

them in the Style dialog box and clicking on the Delete button. You will

be asked to confirm; press GPL All paragraphs formatted with a deleted

style will revert to the document's Normal style.



RENAMING STYLES

mARMING

Undo does not restore deleted styles. Thus, you cannot

undo (re-establish) a deleted style, but you can sometimes work

around this. Save the documentjust before you attempt any

style deletion. Inspect the document immediately after deleting

styles. Do not save the document again imtil you are certain

that the deletion of styles hasn't caused problems. If there are

problems, close the document without saving (by answering No

to the Save Changes? prompt). Reopen the document and your

styles should all be intact. Or, better yet, you can experiment

on a copy of your document.

Renaming styles

Styles can be renamed in the Style dialog box:

1. Open the Style dialog box from the Format menu or with

the l§-T keyboard shortcut.

2. Click on the style name you want to change.

3. Use the Style name-text box to select and edit or replace

the name.

4. Click Define and OK to confirm the change.

The style name changes, but the style remains intact, with one possible

excepfion. If you change a style's name to one that already exists in the

document, the style that you have renamed will take on the charac-

terisdcs of the pre-existing style. For instance if you have a double spaced

style called Draft, and you change the name of a single spaced style from

Body to Draft, all of the paragraphs formatted as Body will be double-

spaced and take on any other style characterisdcs associated with the

original Draft style.



THE WORD FOR THK MAC HOW-TO BOOK Chapter 13

Finding and replacing styles

Style-changejunkies rejoice. Word 5 lets you search for and replace

styles. While Word 5's vastly improved replace feature is fully described in

Chapter 19, here's a quick style replacement how-to:

1. Open the Replace dialog box from the Edit menu or use

the 9€-H keyboard shortcut. It will look like Figure 13.10.

2. Visit the two drop-down menus that start with the word For-

mat. In both cases, pick Style... from those drop-down lists.

You will be presented with a list of possible styles.

3. In the Find What portion of the dialog box, you will be

shown all styles used in the document.

4b In the Replace With portion of the dialog box, you will also

see Word's standard styles.

5. Pick the style you want to locate, and, if appropriate, the

style you want to replace it with.

6. Use Find Next or Replace All, as appropriate. Consider

experimenting on a copy of important documents.

FIGURE 13.10

The Replace feature lets

you locate or swap styles.

Replace

Find liihat:

[Format ] -Stgle Normal

[Special [

Replace Itiith:

n

Stgle Bodg

Clear

Character..

Paragraph.

Style... ^

Drd Only Match Case

|[
Find NeKt J

c D
Replace BM~]

Cancel ]

Search:

I Doum a



TRANSFERRING STYLES TO OTHER DOCUMENTS

Transferring styles to other
- documents

After you've spent time setting up complex styles, it would be nice to

re-use them in new projects. Word provides several ways to do this. For

repetitive tasks, consider setting up stationary documents containing

styles as described in Chapter 15, and glossary entries, described in Chap-

ter 16.

If you have just a style or two you want to copy from one document

(the source) to another (the destination):

1. Select some text from a source paragraph containing the

style of interest and paste it into the destination document

needing the style.

2. Word will bring over the style with the text.

m A R N I N G

Remember that if the destination document has a style

name identical to the style being copied from the source, the

destination document will reformat the incoming text rather

than take on the new style. Moreover, if you copy more than

fifty styles at once, the source dociunent's entire style sheet

will be automatically copied to the destination document.

It is also possible to merge different style sheets, which copies

unique styles from one document to another and modifies styles with

identical names.

Here's how to merge style sheets:

1. With styles properly named and saved, work in the destina-

tion document.
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Z Open the Stvle dialog box and then choose Open... from

the Word File menu.

X Select the .source document and click. Open.

4b Word will update the destination document as described

earlier.

5. When you are sure that the desired results have been

achieved, save the destination document to record the

changes to its style sheet.

There are a few land mines, though. First, you must save any changes to

the source document before attempting a merge. This records the cur-

rent styles for the source document. Next, inspect the source and destina-

tion documents for possible style name problems. Remember that Word

styles are case sensitive—body and Body are different style names. As you

may have guessed, this can work for or against you. Consider printing

out both style sheets and comparing them before you merge.

Wlien you merge, styles on the destination style sheet with names

identical to those on the source style sheet will take on the characteristics

of the source style sheet. Styles not foimd on the destination style sheet

will be imported from the source style sheet.

O I P

Other Word commands that exchange style information

will bring over styles as necessary. For instance, Subscribe,

Link, Glossary, and Paste Special all attempt to bring styles

with them.
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A FEW STYLE TIPS

Establish organization-wide style sheets and style-naming

conventions. This will make it easy to work on projects as

a team.

Use the Space Before and Space After paragraph features

along with Shift-Returns rather than creating white space

with multiple carriage returns. See Chapter 9.

When experimenting with styles, work on document copies.

This is particularly important for new users working on com-

plex documents containing interrelated styles.

- Combine styles with the power ofWord's glossary and sta-

tionary features. See Chapters 15 and 16.

• Establish one or two base styles for complex documents.

They need not be based on Word's Normal style, particu-

larly if the look of the document is radically different from

your normal work.

Manual formatting and styles

As promised, here's an explanation of how styles and manual formatting in-

teract (aldiough, perhaps collide is a better word) . Don't feel bad if this

seems confusing, h is. First, there are some important concepts to review:

- By now, you should know the difference between character

and paragraph formatting. Paragraph formatting describes

things that happen to all of the characters in a paragraph

—

like indendng and line spacing. Character formatting can

be applied selectively to all, or to just a few characters in a

paragraph.

- And you'll probably remember that some character for-

matting opdons toggle. Specifying bold twice, for instance,

turns bold character formatdng on then off. Other charac-

ter formatung features don't toggle. Choose Helvetica

twice, for example, and nothing interesting happens.
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Now for the new stuff. Wlien you use menu choices, the ruler buttons,

ribbon buttons, or keyboard shortcuts to specify formatting options, you

arc doing something called manual formatting. When you use a style to

format text, that's called (yep) style formatting. There's a difference as

you will soon see.

'When you initally define a new style, Word looks at any paragraph

and character formatting you've done and memorizes a collection of

your manual formatting decisions. If all of the text in the sample para-

graph (s) is identical, that's a no-brainer.

But, what if you ask Word to create a style from a sample paragraph

or paragraphs containing inconsistent formatting? What should it do, for

instance, about bold if some of the text in the sample paragraph is bold

and some isn't—ignore bold formatting, make everything bold, lock up

your computer? And, what if some of the lines you've selected for the

sample are single-spaced and others double-spaced? Or, how about incon-

sistent spacing before and after selected paragraphs, or wacky indents?

(Variety has its price.)

Word needs to come to some conclusions about these inconsisten-

cies, since, when you apply styles, they can only format all of the specified

text consistently.

Sooooo, Word looks at the first 255 characters in your sample text

and decides whether or not to include a manually-applied formatting

option as part of the style. If a particular manual format (bold, for in-

stance) appears in at least half of the first 255 characters of your sample,

it becomes part of the style. Suppose, for example, you have a 600 charac-

ter paragraph and at least 128 of the first 255 characters (more than half

of the first 255) are bold. The style will include bold as one of its format-

ting features.

Any text you subsequently apply this style to will receive bold format-

ting. However, if at least 128 of the first 255 characters are not bold, the

style will not contain bold formatting even if the last 300 characters in

the text sample are bold. So far so good? Read on.

Once you've defined a style (1-inch left and right indents, plus all

bold text, for instance), selecting unformatted, plain vanilla text, and ap-

plying the new style will make the text conform to the style's formatting

definidons (indented, bold text, in our example).
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But, what if the text you apply this style to already has other manual

formatting like bold or italic—or what if you later try to apply manual for-

mats to text you've formatted with your indented bold style. "Well," as

President Clinton says, "that depends."

Let's take it one situation at a time—but first, a word or two about

formatting "layers," as Microsoft likes to call them.

Formatting layers

Suppose you use a style to format otherwise plain vanilla text. You would

be applying something Microsoft refers to as the style formatting layer.

The once plain text would take on the formatting characteristics defined

by the style (indented, bold Times let's say).

Then, suppose you manually format some of those same charac-

ters—italicize a word or two, increase the point size of the first character,

and so on. You've added something called the manual formatting layer.

Here's where it gets good. When you format, things that can toggle

do, and things that can't, don't. So if you apply bold formatting to text

that a style has set to bold, the manual formatting layer will make (only)

the manually formatted text not bold. By the same token, manually for-

matting Times as Helvetica will cause the manual formatting layer to

setjust the affected characters to Helvetica. In effect you are manually-

overriding the style formatting layer.

Paragraph-wide manual formatting works as you'd expect also.

Manually double-spacing text that a style has set to single spacing works

just fine. Only the selected paragraph or paragraphs have double spacing

instructions added to their manual formatting layer. So Ron, what's so

confusing about that?

Well, first of all, things get a little trickier if you manually format

text before you apply a style. Switching styles after you've manually for-

matted text can make your palms sweat too.

Applying styles to manual formats

Often, when you switch from one style to another, manual formatting

remains as you've defined it, since the manual formatting layer remains

when the style layer changes. But there's a catch. If the new style contains
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formatting options that toggle (lii<.e bold), Word tries to decide whether

or not to toggle the manually formatted text. Get out your decoder rings

for this one, space cadets.

If more than half of the first 2.'^5 characters of the selected text that

you are about to reformat contains a toggling attribute (bold or what-

ever) , the manual format will override the style format, and not toggle.

Otherwise, the attributes will toggle and there is no way to prevent it.

You can, however, recover, or partially recover, from unexpected

"togulation" with either the Undo or the Plain Text command. The Plain

Text command on Word's Format menu removes all character format-

ting except for font and size changes.

Format layers and the replace
- COMMAND

What's that? You wonder about Word's Replace... command and format

layers. 'Tis sad but true. Wlien you rim around globally replacing styles

and/or manually-applied formatting with the Replace... command
described in Chapter 19, you'll need to keep in mind Word's behavior

when it encounters combinations of manual formatting and styles. The

Replace command causes the same toggling and other behavior

problems as does human intervention.

Removing styles and retaining
— FORMATS

Occasionally you might want to remove all of the styles in a document

without affecting the appearance of the document. You'll want to

remove the Bold hident style you've created, for instance, biu you want

the text to remain bold and indented. Some people do this before shar-

ing Word Mac doctmients with WordPerfect DOS users, for example.

Here are the steps:

1. Save your document with the Word For MS-DOS option in

the Save As dialog box.



REMOVING STYLES AND RETAINING FORMATS

2. When asked if you want to attach a style sheet answer No.

3. The resuhing document can be used by Word for DOS,
WordPerfect for DOS, and many other DOS word process-

ing programs.

4k If you open the document with Word for the Mac, you will

find all of the formatting intact, but only a Normal style.
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Time
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Jfyou 've ever said to yourself, "There must he a better

way!" this is the sectionfor you. You'llfind examples of

Word's ability to truly automate your office, school, and

home projects. Learn how to print envelopes with afew

mouse clicks. Set up stationery to speed the creation of

everyday documents. Read about Word's thesaurus,

spelling, and grammar checker—the next best thing to

having a human editor sitting at your side. See how Find

and Replace can make quick work ofmajor revisions. Dis-

cover the power of Word's outlining tools, and how they

can make you a more productive zvriter and editor.
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TRACKS

To set version 5. 7's envelope return address 431

open the Addresses dialog box with the Insert menu's

Addresses... command. Click on the Default Return Address

Name in the scrollable list. T\pe or edit the return address in

the big box. Click the Use as Default button.

To print envelopes in version 5.1 431

select an address (if there is one) from the letter or other docu-

ment you are typing. Open the Create Envelope dialog box with

the Envelope Toolbar button or Create Envelope... command
on the Tools menu. Type or edit the address in the big box if

necessary. Click Print... then select appropriate Page Setup and

Print dialog options for your printer and envelope size. With en-

velopes loaded in the printer, click Print in the Print dialog box.

To update version S.l's address list 435

open the Addresses dialog box via the Addresses... command
on the Insert menu, then click on the name for the address you

want to change (scroll the list if necessary). The address will ap)-

pear in the big box where you edit the text. Click Define and

you'll be asked if you want to accept the changes. Click OK.



To use version 5. 1's address list 435

open the Addresses dialog box via the Addresses... command
on the Insert menu, or use the Addresses button in the Create

Envelope dialog box. Double-click on the name for the address

you want to use (scroll the list if necessary). The address will ap-

pear in the Create Envelope dialog box or be inserted into your

Word document at the insertion point, depending on how you

opened the Addresses dialog box.

To print envelopes in earlier Word versions 436

set up stationery based upon Microsoft's sample envelopes,

paying attention to envelope size, page printing orientation,

and your printer's ability to print near the edge of pages. Con-

sider adding envelope stationery to your Work menu.



Version 5.Vs new Envelopefeature

Version 5.
1

's new Mail Listfeature

Strate^esfor users ofearlier Word versions

I RONICAIXY, EXPENSIVE COMPUTERS
can make the simple task of envelope print-

ing more difficult. Many offices keep typewiiters aroundjust for envelope

and label printing. Sound familiar? Computerized envelope printing is

not so bad once you get the hang of it, and set up documents that rem-

ember the recipe for you. If you are using Word version 5.1, there's a

new envelope printing and mail list management feature that you'll find

quite useful. And if you don't have version 5.1 it's pretty easy to set up

stationery for most popular envelope sizes on most printers.

We'll look at both 5.1 and 5.0 envelope techniques in a moment,

biu first here are some general tips that apply to both Word versions:

Use window envelopes whenever possible to avoid envelope

printing altogether. Set up letterheads, invoices, and similar

documents with the inside address properly positioned for

windows.

• Ask your letterhead designer to take your computer printer

into consideration when picking paper stocks and envelope

designs.

" Pick envelopes designed for yoiu" printer. These supplies

are easier to find now, and many office supply stores and

mail order paper sellers stock them. (Try Paper Direct, for

instance —800-272-7377.) Laser-friendly envelopes have spe-

cial fiaps and flap glue that minimize jamming. Ink-jet-sawy

envelopes are made of paper stock that won't fuzz up yoin^

characters.
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" The Sample Documents folder that came with your Word
disks contains a number of stationery files for business size

envelopes with and without return addresses. There are

files for a variety of printers, as illustrated in Figure 14.1.

Personalize these to save yourself some time.

Once you find the recipe for envelope printing, place

stationery containing all the right settings on your Work

menu (see Chapter 31).

When designing new envelope dociuiients, use Print

Preview to look for things like retiun addresses that are so

close to envelope edges that they will be clipped.

Purchase an envelope tray or feeder for your envelopes if

you print a lot of them.

Version s.rs envelope feature

Version 5.1 has an envelope printing time saver. It's a Toolbar button

that looks like an envelope. Clicking on it (or choosing the corresponding

FIGURE 14.1

The Sample Documents

folder on one of your

Word disks contains

stationery you can

personalize for a variety

of envelope sizes and

printer types.

CH Envelopes

Q DeskVriter w/ RA

Ql DeskVriter w/o RA

Q] LaserWriter IISC v/' RA

Q LaserWriter IISC w/o RA

Q LaserWriter Plus w/ RA

Q\ LaserWriter Plus w/o RA

Q LW IINT/NTX w/ RA

Ql LW IINT/NTX w/oRA

Q Personal LS w/ RA

Q Personal LS w/oRA

Q Personal NT w/ RA

Q Personal NT w/o RA

Q Personal SC \// RA

Q] Personal SC w/o RA

Q StyleWriter w/ RA

Q\ StyleWriter w/oRA
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Create Envelope command on the Tools menu) opens a Create En-

velope... dialog box like the one at the top of Figure 14.2.

The bottom of Figure 14.2 showfs the Addresses dialog box, reached

with the Addresses... button in the Create Envelope dialog box.

From the Create Envelope dialog box you can:

Print envelopes containing one-time addresses that you type

into the dialog box.

Copy an address from your document for envelope printing.

Store your favorite addresses (using the Addresses

dialog box).

FIGURE 14.2

Version 5. / automates

envelope printing and

helps create address lists.

« File Edit View Insert Format Font Tools liiindoui lilork

D|Qg|Hl#lUM@l<^[siTigngg)[^Tiii^r5^^

Create Enuelope

Fortune Cookies R XJs

I2aLo1u5Laiie
Wiirthree.CAMOU

Print...

Cancel

Addresses.

SVBEX Inc.

202 1 Challenger Drive

Alameda, CA 94501

Addresses

Neil) Address

Default Return Address

Apple

-G-
[ OK

Cancel

( Uetine ]

[ Delete ]

Address Name:

[ Use As Default

SYBEX Inc.

202 1 Challenger Drive

Alameda, CA 94501
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Recall stored addresses and print envelopes.

Recall stored addresses and insert them into your letters or

other Word documents.

Setting up a return address

If your envelopes have preprinted return addresses, you can skip this

task. But if you want to tise plain envelopes and have Word print your

return address in the upper-left corner of envelopes, do this:

1. Open the Create Envelope dialog box either with the Tool-

bar button or Create Envelope... command on version B.l's

Tools menu.

7. C>lick on the Addresses... button to open the Addresses

dialog box as shown in Figure 14.2.

3. Select the Default Return Address choice from the scrolling

address list, and click the Define button (or simply double-

click on the Default Return Address choice, instead).

4. Type your return address in the large box below the smaller

Address Name box.

5. Word uses Normal style for the return address formal. With

limitations, you can embellish the return address. Fonts,

sizes, bold, underline, and italic are all changeable. You

can't insert graphics however, and most other formatting is

verboten.

6. When you are happy with the spelling and appearance of

your return address, click the Use as Default button.

7. Unless you want to type an envelope right away, close the

Addresses dialog box with the OK button.

Printing envelopes with new addresses

You can either type an envelope address directly into the Create En-

velope dialog box, or select an address in your letter or other Word docu-

ment, then open the Create Envelope dialog box. When you've selected
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an address in your Word document (or any other text, for that matter),

the text appears in the address portion of the Create Envelope dialog

box. Here are the general steps for envelope printing:

1. Select the address in your document if it has one.

1. Open the Create Envelope dialog box either with the Tool-

bar button or Create Envelope. . . command on version B.l's

Tools menu.

3. If you selected an address in step 1 you'll see it in the dialog

box; if not, type an address in the big box.

4. Click on the Print button.

5. You'll see a modified Page Setup dialog box like the one in

Figure 14.3.

6. Pick an envelope size from the Envelope Size list shown in

Figure 14.3.

7. Pick a page orientation (usually landscape for laser printers

or Portrait for StyleWriters and DeskWriters). The Portrait

orientation button shows a person standing normally. Land-

scape orientation is represented by a person rotated 90

degrees.

FIGURE 14.3

Choosing Phnl from the

Create Envelope dialog

box displays a modified

Page Setup dialog box.

LaserlDriter Page Setup

Paper: ® US tetter OH4 tetter

OUStegal O B5 tetter

tmReduce ot

Enlarge:

Orientation

Enuelope Rlignment:

Oteft ® Center O Rigtit

Printer Effects:
-» r ..t. - «:«

^^o
|

Tabloid [ [ Cancel

[Opti

C5 1162 K 229 mml
C6 I1 14 K 162 mm)
C65 (114 k 229 mml
Dt (I 10 K 220 mm)
Italian (110 k 250 mml
Monarch 15 7 8 k 7 12 ml

-/Size 10 (4 1/8 H 9 1/2 in)

Size^l 1 14 12 H 10 5/8 Inl

Size 12 14 5 4 K I I inl

Size 6 5/4 (3 5/8 k 6 1/2 inl

Size 9 (3 7/8 k 8 7/8 inl
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8. Choose an Envelope orientation to tell Word if you plan

to feed the envelope through the center of your printer's

paper path or at one edge or the other Newer laser printers

often have guides for centering envelopes in the paper

path. Adjust the guides for your envelope width if this is

necessary.

9. With the printer ready and all of the appropriate options

chosen, click OK.

10. You'll see a Print dialog box.

11. Select the envelope (paper) source—paper cassette or

manual.

12. Specify the number of envelope copies you need if more
than 1.

13. With the envelope(s) in place, click the Print or OK button

depending upon which System version you are using.

14. Wait patiently for the system to print.

15. Word will ask if you want to save this address. (Actually it

asks if you want to Save Changes to Mailing Address.) It's a

good idea to save addresses that you might need again, and
it's easy, as you'll see in a moment. Click Yes to save or No to

discard the address.

Many laser printers (including the LaserWriter II NTX)
will let you manually feed without chcking the manual feed

button in the Print dialog box. Just put the envelope in

position before printing begins.
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Storing addresses

You can t-ither add addresses to your envelope addresses list before or

after printing. In either case, it's done from the Addresses dialog box

shown back in Figiue 14.2. As you may recall, you can reach the Ad-

dresses dialog box through the Addresses... button in the Create En-

velope dialog box. But there's another way. The Addresses... command
on Word 5.1 's Insert menu will also bring up the Addresses dialog box.

1. Select an address in a document or type one in the Create

Envelope dialog box.

2. Open the Addresses dialog box with the Envelope button or

Insert menu's Addresses... command.

3. Type a imique identifying name in the small Address Name
box (Chicago Office, for instance). Word suggests a name if

you've selected an address before starting this process.

4 Type or edit the actual address in the big box, if necessary.

5. Click Define.

6. Use the Close box in the upper left of the window to close

it. OK will insert a copy of the address in your document.

Printing envelopes with stored addresses

1. Open the Create Envelope dialog box either with the Tool-

bar button or Create Envelope... command on version S.l's

Tools menu.

2. Click the Addresses... button.

3t Double-click on the desired address name in the scroll-

able list.

4 The Addresses dialog box will disappear and the address

will appear in the Create Envelope window.

5. Click on the Print button.



VERSION 5 18 ENVELOPE FEATURE

6. You'll see a modified Page Setup dialog box like the one

back in Figure 14.3.

7. Pick an envelope size from the Envelope Size list.

& Pick a page orientation (usually landscape for laser printers

or Portrait for StyleWriters, ImageWriters and DeskWriters).

9. Choose an envelope orientation to tell Word if you plan

to feed the envelope through the center of your printer's

paper path or at one edge or the other.

10. With all of the appropriate options chosen, and the printer

ready, click OK.

11. You'll see a Print dialog box.

12. Select the envelope (paper) source—paper cassette or

manual.

13. Specify the number of envelope copies you need if more

than 1.

14. With the envelope (s) in place, click the Print or OK button

(depending upon which System version you are using) and

the envelope (s) will print.

Inserting addresses in documents

To insert an address from the Addresses list into a Word document:

1. Position the insertion point where you want the address to

be inserted.

2. Open the Addresses dialog box xda the Addresses. .

.

command on the Insert menu.

3. Double-click on the desired address.

4. Word will insert it for you.

Changing addresses

You can edit stored addresses (including your return address) at any
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time in the Addresses dialog box. Here's how:

1. Open the Addresses dialog box via the Addresses...

command on the hisert menu.

2. Click on the name for the address you want to change

(scroll the list if necessary).

3. The address will appear in the big box.

4k Make changes using the usual Word text editing tricks.

5. Click Define.

6. You'll be asked if you want to accept the changes.

7. Click OK.

8b Use the close box to close the Addresses dialog box without

inserting the changed address into your document.

Deleting addresses

1. Open the Addresses dialog box via the Addresses. .

.

command on the Insert menu.

2. Click on the name for the address you want to delete (scroll

the list if necessary)

.

X The address will appear in the big box.

4 Click the Delete button.

5. You'll be asked to confirm the deledon. Click OK to delete.

6. Click OK again to close the dialog box.

Using earlier word versions

Use the Microsoft-provided envelope stationery mentioned earlier in

this chapter, or create your own. (Stationery is discussed in Chapter 15).



USING EARLIERWORD VERSIONS

When you set up your envelopes you'll need to consider the following:

Whether or not you want Word to print the return address

for you.

The size of the envelope.

The envelope orientation as it passes through the printer

(portrait or landscape).

" How close to the edge of an envelope your printer can print.

The desired appearance of the text.

Figure 14.4 shows the beginnings of a new envelope document created

with Microsoft's stationery for business size envelopes containing return

addresses. This one is pre-configured for an Apple LaserWriter NTX
which supports center-fed landscape envelope printing.

FIGURE 14.4

Microsofl-pfovided

envelope slationeiy can

speed envelope printing

set up.
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Explore the sample documents that came with Word.

Use Page Layout view and Print Preview to see the tricks

used to create them. Check out the associated dociunent and
Page Setup settings for each document as well.

As you can see from the Page Setup and Document settings for this

particular sample document (shown in Figure 14.5) the settings used in-

clude a 2-inch right margin, a 0.5 inch left margin, a 2.25 inch bottom

margin and a 2.5 inch top margin. Landscape orientation has been

selected in the Page Setup dialog box.

FIGURE 14.5

The Document (top) and

Page Setup (bottom)

settings for business

envelopes on a center-fed

laser printer.

Document

rMargins



USING EARLIERWORD VERSIONS

By adding giaphics, character, and paragraph formatting to

return addresses, you can print logos, return addresses, and recipients'

addresses in a single pass as illustrated in Figiue 14.6.

FIGURE 14.6

Add graphics and

formatting to customize

Microsoft's sample

envelope documents.

Butierilys are &4«e .Mfordable

ISIg Monarch Lane
Ne-wark Ne-w Jersey 1S34S

Addressee N.

Addressee Ai

Addressee C

Page Normal^ :m: TI Q
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TRACKS

To <reate stationery 445

create a new document including any necessary formats, styles,

page-numbering choices, section decisions, graphics, and re-

usable text, but don't type the main text. Save the incomplete

work using Word's Stationery choice foimd in the Save File as

Type menu.

To use stationery 445

double-click on a stationery icon to open an im-named copy to

work with, or use Word's Open dialog box. You'll be prompted

to enter a file name for the document when you first attempt

to save.

To modify stationery 447

double-click on a stationery icon to open an im-named copy

of the stationery or use Word's Open dialog box. Make the

changes. When you are prompted to enter a file name for the

document, enter the exact name of the stationery file and use

the Stationery choice foimd in the Save File as Type menu.

Confirm the replacement.



To add stationery to your work menu 448

create a document and save it as stationery. Use the key com-

bination 9€-Option-+ (not the keypad plus). When your cursor

becomes a giant plus sign, use it to pull down the File menu
and pick the Open... command. Open the File you want to add

to your Work menu.

To assemble one dotument from multiple files 449

place the insertion point where you want the contents of the

file to appear, then pick File... from the Insert menu. You will

see a standard Open dialog box. Find the file you want using

the usual Macintosh folder-navigation techniques and click

Open or hit Return. The contents of the chosen document

will be inserted.



Ways to save time with reusable documents

A tiew way to assetnble documentsfrom
boilerplate

Customizing Microsoft's stationery samples

W ORD 5 OFFERS two simple but powei-

^^B fill features that may forever change the

way you work. The first gives you the ability to save Word documents as

stationery. Think of this as a potential high-tech replacement for blank

forms, letterhead paper, printed envelopes, and pre-printed memo
stationery, among other things. Microsoft has even provided some

samples to get you started.

The second feature—the File... command in the Insert menu—lets

you place the entire contents of documents direcdy into tlie document you

are working on, without time-consuming cutting and pasting. It's the per-

fect way to assemble complex documents from boilerplate text.

Why stationery?

You've always been able to reuse word-processing documents by opening

them, replacing old information with new, and then saving the work

using a new file name. But as anyone that has done this will tell you, it is

easy to forget to rename the new document before you save it. Generally

this results in destroying your earlier work, since the new docimient over-

writes the content of the old file. Not a pretty picture.

Word 5's stationery feature prevents this from happening. When
you first create a letterhead, form, memo, or other file that you know you

will want to use repeatedly, save it as stationery. Wlien you open a docu-

ment thus saved, you actually work on and save to a copy of the file, not

the original file itself



WHY STATIONERY?

Word 5's drawing tools and formatting features make it easy for

you to create professional-looking letterheads, envelopes, newsletters,

proposals, reports, and more. With the stationery feature, you can design

these things once and re-use them withoiU deleting old text or having to

remember to change file names when you save.

Creating stationery

1. Start by creating a new document including any necessary

formats, styles, page-niunbering choices, section decisions,

graphics, and re-usable text.

Z Before you start typing the main text (a letter on the new

letterhead or stories in your newsletter design), save the in-

complete work using Word's Stationery choice. It's found in

the Save File as Type menu. Figure 15.1 shows how to save

files as stationery.

3. Name the file, then before clicking Save or pressing Return,

pick Stationery from the drop-down menu, available in

both the Save and Save As... dialog boxes on the File menu.

System 7 users will notice that stationery documents in Word act like Sys-

tem 7's Stationery pad items; they even have the Stationery pad box

checked when you do a Get hifo.

Using stationery

Documents saved as stationery have different icons from regular docu-

ments, making them easy to distinguish. The icons look like pads of

paper with a corner turned up. In Figure 15.2 the icon on the left is

stationery and the one the right is a letter created with the stationery.

To work with stationery, double-click on a stationery icon to open

an un-named copy to work with, or use Word's Open dialog box. To

quickly spot stationery while in the Open dialog box (Open... from the

File menu), pick Stationery from the List Files of Type drop-down list, as

shown in Figure 15.3. The scrollable file list will contain only stationery

items and folders.
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FIGURE 15.1
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D I P

It's a good idea to put regularly-used stationery

documents on your Work menu. See Chapter 31. System 7

users can create aliases of stationery, as well.



WHYSTATIONER\'?

FIGURE 15.3

The Open dialog box can

be restricted to showing

only stationery.
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5. You will be asked to confirm the replacement of the old

stationery with the new.

6. Click Replace to save your changes.

MlCROSOFrS SAMPLE STATIONERY

Many of the sample documents provided with Word 5 were saved as

stationery. (You already saw examples of this in the preceding chapter.)

Feel free to modify them for your own use and re-save them as stationery.

The documents can be found in the Sample Documents folder installed

with Word 5. Look in the folder containing the Word program itself, or

search for sample documents using the Find File... feature, described in

Chapter 6.

Adding stationery to your
— work menu

While a full-fledged discussion of the Work menu will have to wait until

Chapter 31, on the theory that no one ever reads the last chapter in a

book, here's a recipe for adding stationery to your Work menu. (If you

don't have a Work menu, these steps will even add one for you.) Once

you put stationery on a Work menu, you can start a new complex docti-

ment with just a mouse click.

1. Create a document and save it as stationery as described ear-

lier in this chapter.

2. Tell Word you want to add a Work menu entry (and a W^ork

menu if you don't already have one) by using the key com-

bination 9€-Option- +. Note that you should use the plus

key on the top row of your keyboard, not the one on the

numeric keypad!

X Your cursor will tiun into a giant plus sign.



COMBINING DOCUMENTS WITH INSERT FILE.

4b Use it to pull down the File menu and pick the Open...

command.

5. Find the file you want to add to your Work menu.

6k Double-click on its name, or click once on the name and

once on Open.

7. Your Work menu will flash as though struck by lightning as

the file name is added to it.

8L Henceforth, picking the document name from the Work
menu will open an imtitled copy of the document.

Combining documents
- with insert file

In the past, if you wanted to place the entire text of one document into

another, you needed to open both documents, select all the text in one

window, copy it to the clipboard, then switch to the other window and

paste it in.

Word's new File... feature in the Insert menu greatly simplifies this.

Here's how to use it:

1. Place the insertion point where you want the contents of

the file to appear.

2. Pick File. . . from the Insert menu. You will see a standard

Open dialog box.

3. Find the file you want using the usual Macintosh folder-

navigation techniques and click Open or hit Return.

4i The entire contents of the chosen document will be in-

serted immediately.
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m A R N I N G

The usual Word style and glossary merges occur as

well. That is to say, any necessary new styles and glossary

items will be added to the document receiving the insertion.

This could lead to problems if there are duplicate style

names. See Chapter 13 for more about styles.

The Insert File... command is perfect for attorneys and others need-

ing to assemble documents from boilerplate text. Create separate files

for each piece of boilerplate, then Insert away as needed. Word can even

sometimes insert non-Word text with the Insert File command, by con-

verting it first.

D I P

Organize files you'll insert often using short,

consistent, meaningful file names. For instance, if you

assemble proposals from boilerplate files, and need to

include different disclaimer clauses for proposals sent to

various states or countries, you might assign file names like

Disclaimer NY and Disclaimer CA and Disclaimer UK. These

names will all show up near each other in the Select a File to

Insert Ust, making it easy to quickly pick the right ones.

Sharing stationery and
- boilerplate files

Consider putting stationery and boilerplate files on your network's

server (or on a System 7 computer with file sharing enabled) so that



OTHER DOCUMENT ASSEMBLY STRATEGIES

everyone will have access to the same letterhead, proposal formats, and

so on. Then, when things change, you'll only need to update it in one

place for everyone.

If you create common stationery files for many different users in

your organization, keep the lowest common computer configuration

in mind. Try not to use fonts that some people won't have. Don't use

printer effects some printers can't accomplish (printing near edges,

or in color, for instance).

Other document assembly
•— strategies

As you'll see in Chapter 26, Word's Print Merge feature can also be used

to create document assemblies. It's a little more complicated to set up

Print Merge assembly files, but it might be worth the effort.
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TRACKS

To define a glossary entry 457

create the entry you wish to memorialize then open the Glos-

sary dialog box with the Edit menu's Glossary... command
(3€-K). Type a name for the entry and chck Define.

To insert a glossary entry 458

place the insertion point where yon want the glossary item to ap-

pear, then open the Glossary dialog box with the Edit menu's

Glossary... command. Double-click on the entry you wish to in-

sert. Read this chapter to learn other methods including several

keyboard techniques.

To assign keyboard shorttuts to glossary entries 460

open the Glossary dialog box, then press 9€-Option- + (on the

numeric keypad, not the main keyboard). The pointer will turn

into a large 3€ symbol. Click once on the name of the desired

glossary entry. Demonstrate the shortcut-key combination. Use

any previously ima.ssigned key combination, or confirm the

overwriting of an existing one.

To edit glossary entries 46

1

insert the item needing work into your docimient, edit and

highlight it. Open the Glossary dialog box. Highlight the cor-

responding entry name. Click Define to replace the old with

the new.



To delete glossary entries 46

1

open the Glossary dialog box, highlight the undesirable entry,

click Delete and confirm.

To open spetial purpose glossaries 469

first open the Glossary dialog box (3€-K) then choose New

(3€-N) from the File menu. Glick Yes to temporarily remove

the non-standard entries from the glossary list. Next locate the

desired special glossary and double-click on its name or use

the File menu's Open command.

To merge glossaries 470

open the existing glossary (§€-K) and then open the special

glossary with the File menu's Open... command without remov-

ing the non-standard choice first.

To print glossaries 470

open the Glossary dialog box (3€-K) and pick Print from the

File menu (3€-P).



Ways to save and quickly insert boilerplate

Word's standard glossary entries

Special purpose glossaries

Merging glossaries

I MAGINE PRESSING A couple of keys to

call up and insert entire paragraphs, com-

plete mailing addresses, or properly formatted letter closings, including

your signature. Those are just a few of the things Word's glossary feature

will help you do. It can also save and recall voice annotations, graphics,

memo distribution lists, tab settings, QuickTime movies, andjust about

any element of a Word document. Glossaries are also useful for boiler-

plate text. Boilerplates are standard clauses, paragraphs, or even entire

documents that you use frequently.

Creating new glossary items is quick and easy. Each saved item is

called an entry. Collections of entries are called Glossaries or Glossary

files. Glossary files are saved to disk. You can have different glossaries for

different tasks, and switch between glossaries as necessary. It is also pos-

sible to merge entries from different glossary files.

Word's default glossary comes with a number of pre-defined stan-

dard entries. These let you quickly insert dates, times, authors' names,

and other useful variable information. For example, there is one stan-

dard glossary entry that will print the cmrent date. Another automat-

ically enters the author's name from the document's Summary

Information record.

Finally, Microsoft has provided several special purpose glossaries for

things like page-layout projects or documents requiring complex math

fornuilas.



DEFINING YOUR OWN GLOSSARY ENTRIES

Defining your own glossary
» ENTRIES

To create glossary entries:

1. Select (highlight) the items in your document that you

want to define as glossary entries.

2. Call up the Glossary dialog box. Use either the Glossary...

command from the Edit menu or the §€-K shortcut. Your

screen will look something like Figure 16.1. In this ex-

ample, an entire letter closing has been selected. It contains

several different paragraph formats, a severe left indent,

and a scanned signature which has been previously pasted

from the scrapbook using Word's graphics capabilities. All

of these elements are one glossary entry that can be quickly

recalled and inserted as if they were one entity.

FIGURE 16.1

Define glossary entries

by selecting items, then

opening the Glossary

dialog box (choose
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3. Type a meaningful name in the Name box (Informal clos-

ing in the example).

A. Click on the Define button to add the entry to your glossary.

5. Click on Close to close the dialog box.

Inserting glossary entries
- in your documents

Once an item is in your glossary, there are several ways to paste it into

any document you are working on. The obvious method is to:

1. Place the insertion point where you want the glossary item

to appear.

2, Open the Glossary dialog box with the Edit menu's Glos-

sary... command or the S€-K keyboard shortcut.

3L Highlight the entry of interest (scrolling first, if necessary)

.

4. Click the Insert button.

5. The desired entry will appear at the insertion point in your

document and the dialog box will vanish.

O I P

There's a quicker way to insert entries from the Glossary

dialog box. Once you have scrolled to locate the desired en-

try, double-cUck on the entry name, as shown in Figure 16.2.

This will insert the entry and close the dialog box.



INSERTING GLOSSARY ENTRIES IN YOUR DOCUMENTS

FIGURE 16.2

Double-click on an entry

name to place it at your

document's insertion point.

Glossary

•file name mith path
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In Figure 16.2 typing inv would be enough to describe Invoice tab set-

tings while inf would get you tlie informal closing. If you type an ambiguous

abbreviation (in, for instance) Word will beep or bark or bleat at you.

Try again and be more specific.

Assigning keyboard shortcuts

You can assign keyboard shortcuts for frequently used glossary items and

insert glossary entries with a couple of keystrokes. (There's more infor-

mation on assigning keystrokes in Chapter 31.)

1. Open the Glossary dialog box (§€-K).

2. Press 5§-Option- -i- (on the numeric keypad, not the main

keyboard).

3. The pointer will tiun into a large 3€ symbol.

4. Click once on the name of the desired glossary entry (scroll

to display it, if necessary)

.

5. Word will ask you to demonstrate the shortcut-key combina-

tion. Use any previously unassigned key combination, or

confirm the overwriting of an existing one.

6. Close the dialog box.

a I p

If your keyboard doesn't have a numeric keypad (your

PowerBook, for instance), you can also press 3€-Shift-

Option-C to bring up the Conunands dialog box which lets

you assign command keys. See Chapter 31 for further

details.



INSERTING GLOSSARY ENTRIES IN YOUR DOCUMENTS

Adding glossary entries to work menus

Frequently-used glossary entries can be added to your Work menu. See

Chapter 31 for more about Work menus.

1. With the Glossary dialog box displayed, press 36-Option- +

(on the main keyboard, not the numeric keypad).

2. The pointer will turn into a large plus sign.

3. Click on the name of the glossary entry you want added to

the Work menu.

4i Close the Glossary window.

Modifying glossary entries

To modify an entry:

1. Insert the item needing work into your document.

Z Make the necessary changes.

3. Highlight the corrected entry.

4b Open the Glossary dialog box.

5. Highlight the corresponding entry name.

6. Click Define.

7. Your modified entry will replace the old one.

Deleting glossary entries

To delete glossary entries:

1. Open the Glossary dialog box.

7. Highlight the undesirable entry.

3. Click the Delete button.

4. You will be asked to confirm.
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Word s's standard glossary— entries

Word comes equipped with nearly forty standard glossary entries. Word's

Standard Entries all begin with a bullet (•). You cannot delete them, but

you can hide them.

View standard entries by opening the Glossary dialog box and

checking Show Standard Entries, as illustrated in Figure 16.3. You can

hide Standard Entries by unchecking the box or pressing K-S. or hide

your personal entries by unchecking User Entries or pressing 3€-U. This

makes it easier for you to find the type of entries you need. Note that

§€-S won't save here because of its pre-assigned function.

Many standard entries are self-explanatory. You can often see what

will be inserted by highlighting an item in the Glossary dialog box and

looking at the example displayed near the bottom of the box.

Some standard entries are date- or time-dependent. For instance, in

Figure 16.3 the print date entry will cause the current date to print in

your document, using the format shown. The date will change, depend-

ing on the date you print the document. In fact, all standard entries that

begin with the word print instruct Word to check your Mac's internal

clock and calendar each time a document is printed.

FIGURE 16.3

Word's standard glossary

entries all begin with

bullets {•).
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WORD 5S STANDARD GLOSSARY ENTRIES

The current date or time of printing will be inserted in your docu-

ment wherever these glossary entries have been placed. Consider placing

such entries in headers or footers, for instance.

D I P

You can tell changeable print entries from static entries

in documents if you have a gray scale or color monitor.

Changeable print entries are surroimded by light gray lines.

Other standard entries get information from the Summary Informa-

tion box you fill out when you first save a document. This is a handy way

to insert things like the author's name, document-version information

(draft, final, etc.), document title, and so on.

The following sections are a summary of the standard entries, their

functions, and a few tips.

Author
This entry inserts the author information from your Summary informa-

tion—for example: Ron Mansfield.

Date and print date

These entries check your Mac's built-in clock/calendar and insert the

current date. Entries that start with the word print (print date, for in-

stance) will insert a new date whenever you print the document. Other

entries place an unchanging date in your document when you insert

them. Think twice before using print glossary entries in legal documents
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and other projects where a changed date could be a problem in the fu-

ture. Here are samples of the various date glossary entries at work:

Entry



WORD 5'S STANDARD GLOSSARY ENTRIES

Keyword
This entry inserts the keyword information from your Summary informa-

tion, for example: Twain, word, lightning.

Month and print month
Month entries are short versions of date entries. Here too there are static

and Print versions. The static versions don't change after you enter them.

Print versions change when you print. Here are the samples:

Entry
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Subject

This entry inserts the subject information from your Summary informa-

tion, for example: contracts, consulting.

Time and print time

These entries check your Mac's built-in clock/calendar and insert the

current time. Entries that start with the word print (print time, for in-

stance) will insert a new time whenever you print the document. Other

entries place an unchanging time in your document when you insert

them. Think twice before using print glossary entries in time sheets,

medical records, and other documents where a changed time could be a

problem in the future. Here are samples of the various time glossary

entries at work:

Entry Result

time: 10:39 AM

time with seconds: 10:36:42 AM

D I P

Macintosh clocks are notorious time gainers and losers.

If precise times are important to you, check and adjust your

computer's clock regularly. (Use the Alarm Clock on your

Apple menu or the General Controls control panel.) Better

yet, consider getting a Shareware utility like Jim Leitch's Set

Clock 3.3. It uses your modem to dial the time standards

folks and automatically updates your clock.



STORING YOUR GLOSSARY ENTRIES

Title

This entry inserts the title information from your Summary information,

for example: Twain Quote.

Version

This entry inserts the version information from your Summary informa-

tion, for example: DRAFT, FINAL, 24.5.

Year

Year entries are short versions of date entries. There are static and Print

versions. The static versions don't change after you enter them. Print ver-

sions change when you print. There are two formats:

Entry
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m A R N I N G

When you first make glossary changes, they are not

immediately stored to disk. Custom entries reside in your

computer's RAM only, until you save them to disk or

abandon them. Simply closing a document will not save

glossary changes. You must either quit Word or ask Word to

save glossary changes, which we will describe in a moment.

If you've spent a long time creating new glossary entries, it's

a good idea to take a moment to save them to disk. This will

preserve your work in case of a power failure or other

malfunction later in the day.

When you quit Word, it will ask if you want to save the glossary changes,

as illustrated in Figure 16.4. If you answer No, Word discards your

changes. If you answer Yes, Word will propose saving the changes to the

glossary you've been using. If you agree to save your changes there, you

will be asked to confirm the replacement of old glossary information

with the changes.

It is also permissible to specify a different file name and location for

your new glossary. Use standard Macintosh file-saving techniques to ac-

complish this. Here are the general steps:

1. First display the Glossary dialog box.

Z With the Glossary dialog box in view, visit the File menu on

the Word menu bar (the 3€-S shortcut will not work here)

.

FIGURE 16.4
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SPECIAL PURPOSE GLOSSARIES

Z, Choose Save. Instead of saving your Word document, you

will be prompted to save your glossary.

You are not stuck with only one glossary; you can create additional glos-

saries of your own by simply saving them under different names. Open
them using the techniques described next.

Special purpose glossaries

You or your associates can create special-purpose glossaries, as described

above. Your copy of Word may also have been shipped with several spe-

cial-purpose glossaries from Microsoft. One is used to insert desktop

publishing and page-layout entries like PostScript codes for crop marks,

landscape mode page numbers, and more. Another Microsoft glossary is

useful when you create complex mathematical formulas. These special

glossaries can usually be found in the Word 5 Glossaries folder. They are

accompanied by documentation explaining their entries and uses.

Here are the steps for opening special glossaries:

1. Switch to the desired glossary by choosing Glossary... from

the Edit menu or pressing §§-K. This will bring up the Glos-

sary dialog box.

2. Choose New (3€-N) from the File menu.

3. You will be asked if you want to remove all non-standard

glossary entries.

4. Click Yes. This removes the non-standard entries from the

glossary hst, but not from your standard glossary itself.

5. Use the File menu's Open command to locate the desired

special glossary and double-click on its name.

6. The selected special-purpose glossary will be added to the

standard entries and be available for your use.
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ERGING GLOSSARIES

This one's a piece of cake! To merge special entries with an existing glos-

sary, simply open the existing glossary and then open the special glossary

without removing the non-standard choice fust.

If the two glossaries have entries with identical names, Word will use

the entries from the second glossary you open.

Glossary entries and styles

Remember that all glossary entries are available, regardless of what docu-

ment you are working on. Thus, glossary entries you've created in one

document may use styles that do not exist in the document you are cur-

rently working on. WTien this happens. Word will add the necessary style

to the current document's style sheet.

The usual cautions regarding different styles with the same name
apply when you insert glossary entries containing style information. See

Chapter 1 3 for details.

Printing glossary entry lists

It is possible to print glossary items. This is useful when troubleshooting

or documenting your glossaries.

1. Open the Glossary dialog box (§€-K).

2i With the Glossary dialog box in view, pick Print from the

File menu. (3€-P works here.)

3> You will get a useful but not perfectly formatted collection

of glossary entries. (Word prints everything using your

default font.)
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TRACKS

To look up a word 474

select the word or phrase you wish to replace, tlien open the

thesaurus with the Tools menu's Thesaurus... command. Click

replace to accept the replacement word shown in the With box.

Click on synonyms to move them to the With box.

To browse similar words 476

when the Close Words option appears in the Meanings For list

(referred to as Related Words in earlier versions of Word), use

it to select related words.



To find antonyms 478

when the Close Words option appears in the Meanings For list

(referred to as Related Words in earlier versions of Word), pick

Antonyms from the list to display and then select words with op-

posite meanings.

To return to the original word 478

click the Original button.
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LOOKING UP WORDS AND PHRASES

o
If you don't select a word and the insertion point is not

in a word, the thesaurus feature will pick the word closest to

the insertion point.

If you haven't done so aheady, Word will highlight the word in your

document and place it in the Thesaurus dialog box next to the Replace

label. This word (or phrase) is referred to as the original word.

If your original word has more than one meaning, the various mean-

ings and their parts of speech will appear in the Meanings For scrollable

list. Clicking on a meaning in the Meanings For list displays related

synonyms in the Synonyms scrollable list. In Figure 17.1 the thesaurus of-

fers six meanings for awkward. Clicking on bulky displays the synonyms

for bulky.

Clicking on a particular synonym for bulky (unwieldy, for instance)

,

places the synonym in the editable With area of the Thesaurus dialog

FIGURE 17.1
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box. If you don't like any of the choices, chcking Cancel will close the

Thesaurus window and take you back to your unchanged document.

Replacing words and phrases

After exploring the various potential replacement words or phrases sug-

gested by Word:

1. Highlight the word you like best.

2. It will appear in the With box.

3. Click the Replace button in the Thesaurus window.

4. Word will replace the highlighted text in your document

with the contents of the With box; then the Thesaurus win-

dow will disappear. The Undo Thesaurus... command is

available if you act immediately.

If you highlight a phrase, like "at rest," Word may extend the highlighted

area when you open the Thesaurus window. (Try it by highlighting the

words "at rest" in the sentence: The ball was at rest in the driveway. ) Watch

carefully whenever you highlight phrases and replace them using the

thesaurus.

Related words and phrases

Frequendy, Word's thesaurus will not contain an exact match for your

original word. This can happen if you've misspelled a word. In that case,

you will probably see an alphabetical list of words in place of the Mean-

ings For list. Pick the correct word from the list, or return to your docu-

ment and correct the spelling error and then try the Thesaurus...

command again.

You will also have trouble matching certain tenses of words. For in-

stance, if you attempt to replace ambled, W^ord will tell you to seek re-

lated words, as shown in Figure 17.2, since the thesaurus contains the

word amble, but not ambled.



RELATED WORDS AND PHRASES

FIGURE 17.2
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Clicking on a related word in the scrollable Close Word (a.k.a. Re-

lated Word) list will place it in the With dialog box. For instance, clicking

on amble in the Close Words list will replace ambled with amble, as

shown in Figure 17.3. Once you have the related word in the With box,

click on the Look Up button to find synonyms and antonyms.

When you find a related word (saunter, for instance), click on it to

move it to the With box, then edit the word to suit your needs before

clicking Replace. For instance you'd probably want to add "ed" to

saunter in our example.

FIGURE 17.3
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Restoring the original word
C^licking on the Original button in the Thesaurus dialog box will replace

the related word with your original word. Word also keeps track of any

previous replacements made since you last opened the Thesaurus win-

dow, and you can frequently restore earlier words by pulling down the

With drop-down list. Click on the arrow to the right of the With box to

view the list if there is one. You can use Undo to restore your original

word if you act immediately after closing the Thesaurus.

Finding antonyms
Frequently, Word can help you find antonyms. When they are available,

the word Antonyms appears at the bottom of the scrollable Meanings For

list. Click on Antonyms to display a list of them in the right-hand, scroll-

able-list area of the Thesaurus window. As you can see in Figure 1 7.4, the

name of that list changes from Synonyms to Antonyms, and the list con-

tains potential antonyms for the word in the With box.

FIGURE 17.4
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EXPLORING THE THESAURUS

Spelling help from the thesaurus

While Word's thesaurus doesn't actually contain definitions, you can

sometimes use it to help pick the appropriate spelling of confusing

words like which and witch or weather and whether. Look up the words

in question and compare synonyms to help you pick the right spelling.

Exploring the thesaurus

It is possible to really meander around in the Thesaurus!

A single click on any word (either in the Meanings For or

Synonyms list) places it in the With box. Then you can click

on Look Up, and go from there.

Double-clicking on a synonym places that word in both the

With and Meanings For spaces.

Double-clicking on a Meanings For word places just that

word in the With space.
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TRACKS

To spell the<k an entire dowment 484

choose Spelling... from the Tools menu, use the 3€-L shortcut

or click on the Toolbar's Spelling button. Starting at the inser-

tion point, the checker looks for words not in its dictionaries.

It searches the entire document, including headers, footers,

footnotes (and hidden text, but only if it is displayed on your

screen). Unrecognized words are flagged in a dialog box, often

with spelling suggestions. Accept suggestions, type a replace-

ment word, tell Word to ignore the questioned word, or add it

to your dictionary.

To spell <hetk words and phrases 485

select the word or phrase you wish to check then follow the

general procedures previously described.

To treate spedalized dittionaries 489

choose the spelling options from the Preferences... dialog box

reached with the Preferences... command on the Tools menu.

Click the New button and name the new dictionary. Open the

folder containing your main dictionary and save the custom dic-

tionary in it.

To add your own words 490

when the spelling checker displays a properly spelled word that

you want it to recognize in the future, add it to your custom dic-

tionary with the Add button.



To delete words you've added 490
choose the spelhng options from the Preferences dialog box
reached with the Preferences... command on the Tools menu.
Select the dictionary you want to edit and click on the Edit but-

ton. Select the unwanted word and click the Delete button.

Click OK to quit and save changes.

To fount words 492
select a specific portion of your document to be counted, or

count every word in the document by not making a selection.

Use the Tools menu's Word Count... choice or its Option-F15

keyboard shortcut. Click Count to see a count of characters,

words, lines, and paragraphs.

To ihetk grammar and style 493
first correct spelling, then select sentences to be evaluated or

don't select anything to evaluate the entire document. Use the

Tools menu's Grammar... command or the §€-Shift-G keyboard

shortcut. Word evaluates sentences and offers observations

which can be accepted or ignored.

To thange grammar and style preferen<es 497
open the Grammar category of the Preferences dialog box,

reached from the Tools menu (or with the Options button in

the Grammar dialog box). Enable or disable grammar rules

and control their severity with the option buttons. Explanations

are available for most rules.



Word 5*$ much improved spell checker

How to customize the spelling dictionary

Word's Word Count. . . command

The grammar checker

w ORD 5 PROVIDES a powerful spell

^^ checker that lets you check an entire

document, including headers, footers, and hidden text. You can also use

the feature to check a single word. Unlike the printed dictionary on your

desk. Word's checker does not contain definitions. \i does not consider

words in context. While it knows that two, too and to are all proper

spellings, it cannot warn you of their improper use. For instance, Word's

spell checker would not object to the sentence, "She went two the bank

too get a to dollar bill."

Wliat it can do is offer suggested spellings with uncanny accuracy.

Misspellings are usually replaced with just a mouse click or two. You can

add and edit your own custom dictionaries, which might contain proper

noiuis, technical terms, and other specialized words or numbers. You'll

learn how to use all of these features in this chapter.

We'll also explore the Word Count... command. It's a way for

authors to quickly determine the number of characters, words, lines, and

paragraphs in documents and footnotes.

Finally, we'll look at the Grammar checker. It can help you spot

many common writing errors and evaluate your document's readability.

Checking spelling

Start the spell checker with the 3€-L shortcut or by picking Spelling...

from the Tools menu (F15 on extended keyboards). A dialog box ap-

pears like the one in Figure 18.1.



CHECKING SPELLING

FIGURE 18.1
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Typing your own changes

If you want to change a misspelled word only once:

1. Type a replacement in the highlighted Change To box.

2. Press Return or click the Change button.

3. Word will replace the problem text with the new text you

have typed in the Change To box and then continue spell

checking.

To change the word throughout the document that you are checking,

click Change All instead of pressing Return or clicking Change. If the

new word you've typed is something you want Word to recognize in all of

your documents, see Custom Dictionaries later in this chapter.

WORD'S SUGGESTED CHANGES

If you have suggestions enabled (check the Always Suggest choice in the

Spelling category of the Preferences dialog box) , Word will usually list

one or more possible spellings, placing what it thinks is the best guess in

the Change To box. (If the default is not enabled, you can always ask for

suggestions by clicking Suggest.) Other suggestions, if any, will be listed

in the scrollable Suggestions box. This may take a moment. You'll know

Word is finished looking for alternative suggestions when you see either

(End of Suggestions) or (No Suggestions) in the Suggestions list.

If you agree with Word's best gtiess, simply click the Change button

to change this occiurence or use the Change All button to change this

and all succeeding occurrences of the word. The spell checker will

replace the word and continue examining your document.

Word's best guess is usually, bvU not always right, as you can see in

Figure 18.1. If one of the alternative suggestions is correct (the word

"before" in Figure 18.1 ), simply double-click on the desired word to

replace the misspelled word, or click once on the desired word in the list

to move it to the Change To box, then click the Change or Change All

button as necessarv.
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Overruling suggestions

Sometimes Word won't make correct suggestions, or you might want to

correct the problem yourselfwithout retyping the entire word or phrase.

For instance, Word may spot two run-together words like the ones shown
in Figure 18.2.

FIGURE 18.2

Problem text can be

moved to the Cbange To

box for editing without

retyping it.

Not in Dictionary: header$4,footers

Ctiange To:

Suggestions:

headers,footer

(No Suggestions) O

o

Wlien it has no suggestions, Word moves the problem text to the

Change To box where you can edit it yourself. You can force the problem

text to move down sooner by pointing at it with your mouse. The pointer

will turn into the arrow you see in Figure 18.2. Click once, and the text

will move down for editing.

Ignoring flagged words
Sometimes Word will spot a word that is properly spelled, but that isn't in

its open dictionaries. Proper nouns, technicaljargon, and typesetting

codes are examples.

If you want Word to ignore the text only once, click the Ignore but-

ton. Word will leave the word or other text string as you typed it and con-

tinue spell checking. To ignore the word throughout the document you

are checking, click Ignore All. (If the word is something you want to ignore

in all of your documents, you may want to add it to a custom dictionary.)
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m
In version 5.1, the checker's Ignore All button ignores

words for your entire Word session. That is to say, if you tell

Word to ignore a word in the morning, it will ignore the

word all day, in each document you check, unless you quit

Word, or use the Reset "Ignore All" List. . . button in the

spelling preferences as shown in Figure 1 8.3.

Custom or user dictionaries

Most of the words used by the spell checker are located in a dictionary

that comes with your Word program. In the U.S., Word is shipped with a

dictionary called U.S. English Dictionary. It is kept in the Commands
folder. You cannot make changes to this dictionary.

It is possible, however, to maintain one or more of your own dic-

tionaries. In Word 4 these were called User Dictionaries. In Word 5 they

are called Custom Dictionaries.

FIGURE 18.3

Reach the spelling

preferences category

either from the Tools

menu or by clicking the

Options. . . button in the

Spelling dialog box (only

version 5. 1 has the Reset

button).

Preferences

Spsning

Gr^mrfi^r

m
Thesaurus

Hypht-ridtion

(plpla

Toolbar

Main Dictionary:

\^ Hluiays Suggest

Ignore

D Uiords in UPPERCASE

n lilords iDith Numbers

Reset "Ignore HII" List

k^

English (US;
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Word checks only open dictionaries. The more dictionaries you

have open, the slower spell checking will be.

The standard custom dictionary

When you install Word, the installation program places an empty Custom

Dictionary in your Commands folder. The default name for the diction-

ary is Custom Dictionary. It is opened and used whenever you spell

check, unless you instruct Word otherwise. This is where you will want to

keep most proper nouns, trademark names, etc.

Word will place things in the Custom Dictionary whenever you click

the Add button while spell checking. (The first time you add a word, you

will be asked to create a custom dictionary.) You can overrule this default

use of the Custom Dictionary by using the drop-down Add Words To list

to specify a different dictionary.

Custom dictionaries handle capitalization as follows. Ifyou add a

word to a dictionary as all lowercase, it will be recognized later, regardless

of whether it is typed as all lowercase, all uppercase or with a beginning

capital letter. If you enter a word with only the first letter capitalized.

Word will recognize the word when it later appears in all caps or with a

leading cap, but will question the word if it is all lowercase. Unusual

capitalizations like VisiCalc will be questioned unless they are stored in

the dictionary the way they should appear in the text being checked.

Creating additional custom dictionaries

If you work on unusual projects that involve technical jargon, typesetting

codes, etc., you might want to create one or more additional, specially

named custom dictionaries, which you can tiun on or off in the Spelling

category of the Preferences dialog box. (Back in Figure 18.3 a new dic-

tionary called Sybex Typeset Codes has been added.) To create a new cus-

tom dictionary:

1. Visit the Spelling category of the Preferences dialog box

either by choosing Preferences... from the Tools menu or

by clicking the Options... button in the Spelling dialog box.

Figure 18.3 shows the Spelling category.
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7. Click New... to create a new dictionary.

3. Yon will be prompted for a dictionary name.

4 Type a new name containing up to 32 characters.

5. Open the folder where you want to store the dictionary (it

is best to keep custom dictionaries with the main dictionary).

6. Click Save.

Opening and closing custom dictionaries

To make a dictionary available to the spell checker, it must be opened.

The checkmarks next to both custom dictionaries in Figure 18.3 indicate

that both are open and available for the spell checker to use. Click in the

area next to the desired dictionary to open or close it. A checkmark

means it's open.

To open dictionaries that are not in the folder containing the main

dictionary, click the Open... button. Show Word where the desired dic-

tionary is using standard Macintosh folder-navigation techniques.

Editing custom dictionaries

To add items to a custom dictionary, click Add when the spell checker

encounters a word of interest, or type a Word document containing all

of the words you want to add. Spell check the document adding each un-

recognized word.

If you accidentally add a word to a custom dictionary, it is a good

idea to delete it, since extra words mean more searching time during

your spell checks. Removing words from a custom dictionary is slighdy

more involved than adding them.

1. Choose the dictionary you wish to edit from the Spelling

category of the Preferences dialog box.

2. Click the Edit... button.

3. A dialog box will appear, listing all the words in the selected

dictionary, as shown in Figure 18.4.
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4b Click any words you want to delete.

5. Click the Delete button.

6. When you are finished, click OK.

Speeding up the spelling checker

Here are some tips for speeding up your spell checking:

Switch to Word version 5.1 if you haven't already. It is faster.

Place die insertion point at the beginning ofyour document

(3€-Home), and spell check the document in Normal view.

• If you are a good speller with a slow Mac; and are mostly

looking for typos, consider turning off suggestions to speed

checking. (Visit the Spelling category in the Preferences

dialog box reached from the Tools menu.)

Keep custom dictionaries fairly small (a hundred or two

hundred words, perhaps).

Split larger custom dictionaries into smaller ones by

categories that match different kinds of work you do (legal,

technical, etc.). Open just the one(s) you need.

FIGURE 18.4

You remove words from

a custom didionary by

[licking Edil. . . in the

Spelling category of the

Preferences dialog box

and then deleting the

unwanted words.

Edit Custom Dictionary

SybeH Typeset Codes:
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The word count command
The Word Count... command is found in the Tools menu. If you have an

extended keyboard, the keyboard shortcut is Option-F9. Click Count in

the Word Count dialog box to start the process. Figure 18.5 shows typical

results.

The command will scan an entire document or just text you've

selected. It can count characters, lines, paragraphs, and footnote text. It

does not count words in headers and footers. Clicking the Cancel button

closes the dialog box. Click on any of the Count checkboxes to disable

counting of its feature.

1. Select a portion of your document to be counted, or coimt

every word in the document by not selecting anything.

2. Use the Tools menu's Word Count... choice or its Option-

F15 keyboard shortcut.

3. Remove checkmarks from boxes to disable unwanted

counts (paragraphs, for instance).

4 Click Count to see a count of characters, words, lines, and

paragraphs.

FIGURE 18.5

The Word Count feature

also counts characters,

lines, paragraphs, and

words, both in the main

text and in footnotes.

lllord Count
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Checking grammar and style

Word's Grammar checker evaluates style and points out many, but not

all grammatical errors. It can often suggest changes, and even make
some of them for you. Word uses two collections of rules when analyzing

your doctmients. You can turn off specific rules that annoy you or cramp

your style. Word will explain and demonstrate the rules for you.

Statistics and readability indexes are created at the end of a gram-

mar checking session. These help you determine if the writing style is

appropriate for your audience.

Since the grammar checker needs to work with properly spelled

documents, it sometimes activates Word's spell checker when it en-

counters imfamiliar words.

Word is not a complete replacement for a human editor. For

instance, it will not catch things like missing periods at the end of

sentences or double spaces between words.

The fact that Word considers parts of speech when checking gram-

mar might make you believe that it understands what you've written. This

is not the case. For instance, the nonsense phrase "Eye sea sum tins knot

write hear" passes the grammar check successfully.

None the less (oops, Word prefers Nonetheless), the checker will help

you spot many common problems, and can help you polish your style.

The Grammar... command requires as much as 1 Mb ofRAM over

and above the RAM normally used by Word. You may not be able to run

it on a 2 Mb Mac using System 7.

D I P

If you never use the grammar checker, save some disk

space and RAM by reinstalling Word without it. See

Appendix A.
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You may wanl lo save your documentjust prior to grammar check-

ing, or run tiie check on a copy of your masterpiece. Wliile grammar and

style changes are often reversible with Undo, this is not always the case.

To check grammar and style:

1. Save your work and move the insertion point to the begin-

ning of your document.

2. Choose Grammar... from the Tools menu or use the 3€-

Shift-G keyboard shortcut. Unless you select a portion of

yoiu- document, Woi d will attempt to check the whole thing.

3. Working from the insertion point. Word will highlight a

portion of your prose (usually a sentence) and evaluate it.

There maybe a slight delay. If Word spots questionable

spellings, you will be provided the opportiuiity to correct

them or tell Word to ignore them.

4* Once spelling issues have been dealt with, Word will use its

Grammar dialog box to point out questionable style and

grammar issues. The text being considered is listed in the

scrolling Sentence box. Suggestions and observations are

made in the scrolling Suggestions box. For example, in Fig-

ure 18.6 the grammar checker finds the ramblings of a few

old politicians a tad wordy.

5. To get clarification of the rule or style suggestion Word is

offering, click the Explain... button. A new window, called

Grammar Explanations, will open with additional informa-

tion, as shown in Figure 18.6.

Accepting word's suggestions

In Figure 18.6, Word is suggesting "during" as a replacement for the

phrase "in the course of" Here you can rewrite history with a few mouse

clicLs, because, when Word makes specific suggestions like this, you can

double-click on its suggestion or click the Change button to apply the

change.
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FIGURE 18.6

Word finds this

document wordy.

When in the> Course of humac erents, it becomes necessarf for one
people ti:< i:Ussol'?& tte |>o!iti«:al b-ands which Have connected theiqi

wth another, and to assume among the Powers of the earth, the
separate and e«:}ual Lz\ws of Nature and Nature's God <?ntitle tttem,si.

decent respect to the opinions of mankind requires thatj

declare the causi?« which impel tliem to tlie separation fl

Grammar

Sentence:

Vhen in the Course of human events, it becomes

necessary for one people to dissolve the political bands

which have connected them with another, and to

assume among the Powers of the earth, the separate

o

o

Ignore

( Change

fNe«t Sentence

Suggestions Ignore Rule

Grammar E»planatJon

Simplify your writing by eliminating unnecessary phrases. To revise a sentence

like 'They arrived in the course of his speech,' try using 'during' (They arrived

during his speech) or rephrasing (They arrived while he was speaking).

In the example in Figure 18.6, pointing to "during" and double-

clicking would change the first sentence to read: "Wlien during human
events..."

Before making changes like these, it is possible to try them out by

just pointing (not clicking) to the suggestion of interest in the Sugges-

tions box. As you move the mouse into the Suggestions box, the pointer

turns into a hand. Use the hand to point to the suggestion you want to

preview and hold down the mouse button (but don't double-click yet).

The Sentence box above will temporarily change to illustrate the effect

of the suggested change.
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When Word is unable to make changes by itself, the Sentence box

will display the phrase No correction available. In either case, releasing

the mouse button returns the prose in the Sentence box to its original

state, and does not modify your document.

Wlien the grammar checker finishes it will tell you so. Use the Can-

cel button to quit sooner. If you have the statistics option turned on

you'll see a readability report.

Making manual changes

Many of the problems the checker spots need your intervention. To

make manual changes, you'll need to leave the grammar checker tem-

porarilv. To do this, click in vour docimient window to activate it, then

use the usual word-processing techniques to fix your work. Return to the

grammar checker either by clicking on its window or by using the menu
or keyboard shortcuts. The grammar checker will pick up at the sentence

nearest the insertion point.

m A R N I N G

Leaving the Grammar dialog box and making typing

changes this way resets the Undo feature. Suppose you've

made ten or twenty changes based on Word's automatic

suggestions and then left the Grammar dialog box to type a

manual change in the document window. You would no

longer be able to undo the changes you have made from

within the Grammar dialog box, since the Undo menu would

read Undo Typing rather than Undo Grammar. This

dilemma often arises with the Grammar. . . command, since

you frequently need to stop and restart it. That's the reason

it is advisable to save first or work on a copy of important

docimients.
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Ignoring suggestions

The Ignore button in the Grammar dialog box instructs Word to ignore

the current occurrence of a problem, but it will not prevent the gram-

mar checker from pointing out similar problems in the future.

You can skip to the next sentence without making changes to the

current one by clicking on the Next Sentence button. Clicking Ignore

Rule in the Grammar dialog box tells Word to stop using the current

rule with the current document. For example, to stop reminders about

passive voice, click the Ignore Rule button the first time Word points out

a passive construction.

To turn off passive-voice checking for all your projects, turn off the

rule (called Passive Verbs Usage) in the Grammar category of the

Preferences dialog box, as described next.

Changing preferences

You can turn rules on and off from the Preferences dialog box. Reach it

via the Preferences... command in the Tools menu or simply click on the

Options... button in the Grammar dialog box. Your screen will look like

Figure 18.7, although your Grammar Explanations window may not

be open.

Here you can fine-time Word's grammar pickiness. Rules are listed

in two categories—Style and Grammar. Pick a list to scroll by clicking on

the appropriate button. Checkmarks next to a rule mean the rule will be

enforced. Clicking near a checkmark toggles it on and off. For more in-

formation about a rule, highlight it and click on the Explain... button.

The Catch area of the dialog box contains three drop-down menus

that help you specify where Word should draw the line on things like

split infinitives and consecutive nouns.

An X in the Show Document Statistics box enables the document

statistics feature, described next.
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FIGURE 18.7

Reach the Grammar

category of the

Preferences dialog box

from the Tools menu or by

clicking Options ... in the

Grammar window.

Preferences
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FIGURE 18.8

Word can try to quantify

your writing style.

^^ Documen
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The Flesch-Kincaid index assigns a (US public school) grade level.

Gunning Fog assumes that long sentences are hard to understand, as are

multisyllabic words. The higher the index, the tougher the reading. Im-

agine how much better Shakespeare might have been, given tools like

these. To vrnte passively, or not. That is the question.



CHAPTER

Finding and

Replacing



TRACKS

To find text 505

use tlie Find... command on Word's Edit menu or the S6-F

shortcut. Type the character string of interest (which need

not be complete words). Specify the desired direction of

your search and any special formatting or capitalization

requirements.

To limit direttion and stope of sear<hes 505

select a specific portion of your document if you only want to

search a particular area. Use the drop-down menu to specify

Down, Up, or All. (Down and All are usually quickest.)

To find styles and other attributes 505

use the drop-down Format list to take you to Character, Para-

graph or Style dialog boxes. Specify the formats you are looking

for. Remember the difference between clear, checked, and gray

option boxes discussed in this chapter and in Chapter 13.

To find spetial tharatters 507

and items like tab characters, white space, or graphics, pick the

desired item(s) from the drop-down Special list.



To replate found items 509

save your work first just in case. Then use the Replace... com-

mand on Word's Edit menu or the l€-H shortcut. Type the char-

acter string to be found (which need not be complete words) or

just specify formats or special characters of interest. Specify the

desired replacement string and/or formatting options. Choose

the desired direction of your the search and any special format-

ting or capitalization requirements. Use the Find Next and

Replace buttons to selectively replace, or the Replace All button

for global replacement.

To undo replatemenfs 5 14

use Undo immediately after making replacements. If you do

multiple searches and replacements, only the last pass can be

undone. If you've saved immediately before replacing, you can

close the messed up document without saving and reload the

earlier version.



Ways to quicklyfind text andformats

Ways to quickly change and reformat

your work

Tips and techniquesforfinding

and replacing

V ONTEMPORARY WORD-PROCESSING
§ products can quickly locate and replace

specific text strings (collections of words, numbers, and other charac-

ters). Lawyers use replace features like these (sometimes called global

replace features) to do things like finding each occurrence of Thelma in

a contract and replacing it with Louise.

Some typists enter shorthand or acronyms for lengthy items when

they draft. Then, while polishing the document, they replace the short-

hand with the actual text. For instance, you might initially type DRD in

the draft of a government docimient, then have Word find and replace

each occurrence ofDRD with Department of Redundancy Department.

With Word 5 you can search for, and then replace or remove special

characters like paragraph marks, optional hyphens, or footnote-refer-

ence marks.

A form of wild-card searching is permitted, letting you insert ques-

tion marks in search requests to work aroimd minor spelling variations.

Asking Word to find Sm?th, for instance, would find both Smith and

Smyth. You can search for ranges of numbers using a similar technique.

Word's designers refer to this process as searching for unspecified letters

and unspecified digits respectively.

Occasionally, Word's find and replace features can be used to refor-

mat documents. You might, for instance, search for all occurrences of

two consecutive spaces and replace them with a single space. But Word 5

can do much more than that. It will help you find all or selected para-

graphs formatted with a particular style and apply a different style.

It is even possible to use find and replace to remove things. Simply

tell Word to search for the item you wish to delete, and replace it with

nothing.
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Word can search your entire document or selected portions. You

specify the direction of the search (up or down).

Word provides two separate menu items called Find... and

Replace.... Both are located on the Edit menu. The Find... keyboard

shortcut is 8€-F and Replace... is §€-H. Find... is really just an evolution-

ary predecessor to Replace. In fact, if you are careful, you can use

Replace... instead of Find... for everything.

The art of finding

The Find... feature helps you quickly locate text, formats, special charac-

ters, and combinations thereof. It lets you search selected parts of your

document or the whole enchilada. Simple find requests can locate text

regardless of format, or you can ask Word to locate only very specific

things, like occurrences of the word Liberace formatted in bold, blue,

24-point New Century Schoolbook.

You need not limit your searches to text. You can look for section

marks, graphics, paragraph marks, and more. When using the Find. .

.

command (as opposed to Replace...), Word finds what you've requested,

then scrolls to the found item and its surrounding text without modify-

ing anything.

You must click in the document window to work with the found

item. You can leave the Find dialog box out on your screen as you work,

flipping between it and your document window. Figure 19.1 shows the

Find dialog box and its three drop-down menus.

To do a search, follow these general steps:

1. Choose Find... (or Replace...) from the Edit menu.

2. Specify text and special characters (if any) to find.

3. Specify formatung characteristics (if any) to find.

4 Tell Word where to search and in which direction.

5. Click Find Next to start the search.

6. Wlien Word finds what you want, return to the document.

7. To find again, press = (the equals sign) on the numeric pad

(if you're sdll in the document) or Find Next.
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FIGURE 19.1

The Find. . . command

(located under the Edit

menu) lets you specify

search criteria.

Enter text strings here

Start searching

Quit searching

Tab Mark
End of Line Mark
Paragraph Mark
Page Break

Non-breaking Space
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Question Mark
Footnote Mark
Graphic

Ulhite Space

Unspecified Letter

Unspecified Digit

Caret (I
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Rny Character

Clear

Character. .-

Paragraph..,

Style...

Takes you to the

Character dialog box

_Takes you to the

Paragraph dialog box

Lists the styles

in your document

Like any good computer program. Word 5 takes your requests quite

literally, so you will need to understand each Find... option fully to lo-

cate exactly what you want.

For example, if Word searches using the criteria specified in Fig-

ure 19. 1 , it will find B B King, but not B.B. King, BB King, or Burger King.

There are ways to get Word to find each of these text strings, of

course. Just realize that you may need to carefully formulate and test

your search strategy. In some cases, you will need to perform multiple

searches to find similar but subtly different text strings.

Realize also, that Word does not automatically search in headers

and footers. You must open and perform separate searches in them! For

multi-section documents, you may need to open and search headers and
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footers in each section. If your search plans include things like para-

graph marks or hidden text, the hidden text must be visible on the

screen.

Consider proofing your document or at least running the spell-

checker before important, major searches. If you spell banana correctly

six times and incorrectly once. Word will find only six of your seven

bananas...

Finding text

Choose Find... from the Edit menu or use the S§-F shortcut. Move to the

text area of the Find What box and type enough text (a maximum of 255

characters) for an accurate, unambiguous search. For instance, suppose

you wanted to find the word man. Entering "man" in Find What would

cause Word to find the words man, Man, Mansfield, reprimand, manhole, and

man at the end of a sentence (followed by a period, quesfion mark, etc.).

Placing a space after man in your find request would eliminate the

unwanted Mansfield, reprimand, and manhole, but would also prevent

you from finding man at the ends of sentences because periods, question

marks, and such are not spaces.

That's the reason for the Match Wliole Word Only checkbox in the

Find dialog box. If you type man (no space) in the Find What area and

check Match Whole Word Only, Word will locate only man, Man, and

man at the end of sentences.

The Match Case checkbox instructs Word to look for exact

capitalizadon matches. If you type postscript in the Find What area and

check Match Case, Word will not find POSTSCRIPT, PostScript, or even

Postscript at the beginning of sentences.

Extra spaces, non-breaking spaces, and forced page breaks can also

get in the way of searches. See White Space later in this chapter to see

how to work around this.

Finding special characters

The Special drop-down list is a convenient way to enter certain special

characters like tab marks, non-breaking spaces, etc. when construcdng a

search request. Place the insertion point in the Find What box where you
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want the special character to go, and choose the desired character from

the drop-down list.

Find... requests can combine regular text and special characters.

For instance, you could ask Word to search for occurrences of Bob fol-

lowed by two tab marks. Many of the special characters in the drop-down

list are self-explanatory. Let's look more closely at the ones that are not.

Some are extremely useful.

White Space
Here's one to keep you awake nights. Suppose that you are searching for

two words together like Microsoft Corporation. Suppose further that

sometimes you used non-breaking spaces to separate the two words.

Other times you've just typed regular spaces. Occasionally, you typed two

spaces between the words by mistake. And, one time you intentionally

forced a page break between Microsoft and Corporation. Unless you use

Word's White Space feature, you will not find the occurrences of

Microsoft Corporation containing non-breaking spaces or two spaces,

nor will you find the one split by the page break!

So, to do it right, insert Word's White Space special character in

your search string. In our example, you'd start by typing Microsoft in the

Find What box. Then, without touching the Spacebar, choose WTiite

Space from the Special menu. The Wliite Space code (^w) will appear

next to Microsoft. Type Corporation. Your finished search string would

be Microsoft^wCorporation. That should do it.

Unspecified Letter

The Unspecified Letter character lets you overcome some nasty

problems too. Suppose you've used accented characters sometimes but

not always. La Canada and La Canada are not the same thing to Word

when it searches. A search for La Ca'^*ada will find both. Enter the Un-

specified Letter character from the Special drop-down menu the same

way you entered the White Space character.

Unspecified Digit

This special character will sometimes help you find numbers vsithin

ranges. It might be helpful for finding specific groups of part numbers

or zip codes.
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For instance, the search strhig 99^# would find any number be-

tween 990 and 999. The specification 1^# would find the combinations

101 and 11 in 111. It would also find 1000, but not 1 ,000, since Word

treats numbers as text, not ntimeric values, in searches like these. Com-

mas confuse things. Ah, computers...

The art of replacing

To replace, follow these general steps:

1. Save your work.

Z Choose Replace... from the Edit menu or press 3€-H.

3. Create search criteria using the techniques discussed in the

previous section.

4. Specify the desired replacement text, formats, etc.

5. Tell Word where to search and in which direction.

6. Click Find Next or Replace All to start the replacement.

7. Confirm the replacements.

m A R N I N G

It is a good idea to save your work before using the

Replace. . . featiu-e. If you are working on a complex,

important project, you might want to use a copy rather than

the original document since it is much easier to screw up a

document with Replace. . . than it is to repair it.

As you can see from Figure 19.2, the Replace dialog box looks like

the Find dialog box, with additional features. Word lets you confirm each

replacement before it happens, or it will find and replace without your in-

tervention.
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FIGURE 19.2

The Replace dialog box

resembles the Find box,

with added features.

Replace

Find What: Louise

[Format (
[Special [

Replace ILlith:

[Format ]
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Special

n Match Whole lUord Only Match Case
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]

[ Replace All ]

[ Cancel ]

Search:

[
Selection \-w\

Just as you can search for text, formats, styles, and special charac-

ters, you can replace them. For instance, you could replace Thelma with

Louise. Or you could change each occurrence of two consecutive para-

graph marks to a single end-of-line marker, or change the st)'le of certain

paragraphs from chapter-heading style to appendix style. It is even pos-

sible to replace text with graphics. Here are examples of each technique.

Replacing text with text

To simply replace text (like changing Louise to Thelma) without altering

formats or styles, start by entering the text to find and the desired re-

placement text. For instance, you might enter Louise in the Find What

box and Thelma in the Replace With box.

1. Save your work.

2. Choose Replace from the Edit menu (§§-H).

3. Visit the Search drop-down menu to tell Word if you want it

to search the entire document, a selected portion, and so

on. (If you want to replace text in only a portion of the

document, select the text in the document prior to begin-

ning the replace routine and choose Selection in the

Search drop-down menu.)
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m A R N I N G

If there are any formats or styles listed under the Find

What or Replace With boxes, choose Clear from the appro-

priate Format menus. This way, Word will not alter the style

or format of the document.

4. When the replacement instructions are complete, click

Find Next.

5. Word will search the document (or selected portion) for

things matching your Find criteria and propose the next

replacement.

6. Hopefully, the Replace button will undim, and your docu-

ment screen will scroll to reveal the first potential replacement

point.

7. If you want Word to make the change it is proposing, click

Replace. To skip the change, click Find Next. To make the

change and let Word continue uninterrupted, click Replace

All. Word will make the rest of the replacements non-stop,

and probably too quickly for you to even see them. The

status area in the lower-left corner of yoin- document v»dn-

dow will briefly flash the number of replacements made.

8. Check yotn- work. Undo will work here if you use it before

you do anything else.

Replacing formatting

Suppose you have italicized words scattered throughout your text and

decide to change all of them to underlined words. Start by removing any

text from the Find What and Replace With boxes. (This is because you
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want Word to find all italicized text, not just words in the Find What box

that are italicized.)

1. Specify the character attributes you want Word to find

(italics for example). You can do this in one of several ways.

Always start by placing the insertion point in the Find What
entry box. Then specify the Italic format either from

Word's Format menu, or by clicking on the ribbon's Italic

button. The §€-I shortcut works here too. The word Italic

will appear beneath the Find What box. (There is another,

clumsier way to specify italic. Pull down the Format menu
in the Replace dialog box. From there, choose Character,

then click in the Italic option of the Character dialog box.

As you can see, the ribbon or keyboard shortcuts are much
quicker.)

2. Next go to the Replace With box and specify the new for-

mat (Underline in this example). In order to prevent Word
from changing the italic to italic underline, you must also

click the ribbon's italic button until the Replace With

criteria read Underline: Not Italic. Figure 19.3 shows the ap-

pearance of the critical parts of the dialog box when you

are ready to go.

3. Let 'er rip! Either tell Word to Replace All or you can super-

vise as before.

FIGURE 19.3

This combination will

change all italicized text

to underlined text.

Find What:

Format italic

Special ]

Replace With:

Format [ Underline, Not Italic

Special •w\
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Replacing styles

If you want to change the style of certain paragraphs, the Replace...

feature can help. From the Replace dialog box's Format menu, pick

Style... and you will see a list of yoiu" document's styles and descriptions,

as shown in Figure 19.4.

Pick styles for both the find and replace criteria, then proceed as

usual. In this example paragraphs formatted with the Appendix Heading

style will be reformatted using the Chapter Heading style.

Combining replacement tasks

Within reason, it is possible to combine search and replace instructions

to restrict actions. For instance, assuming you had a document with ap-

propriate styles, you could italicize all occurrences of "Gone With The
Wind" in the body text of your report, while leaving the same words

alone when they appear in headings, the table-of-contents, and the index.

You would do this by typing Gone With The Wind in the Find What

box, and restricting the find to the body text style. Then you'd have to

type Gone With The Wind again in the Replace With box and specify

Italic as the format. (If you forget to enter Gone With The Wind in the

FIGURE 19.4

Specify styles to find and

replace with the two

drop-down Format menus.

Replace

Find What:
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Replace With box, Word will replace Gone With The Wind with noth-

ing. ..) Computers are very obedient but not very clever. Undo may
work if you spot the problem immediately. Work on copies of important

documents.

Search

You have several choices as to how Word will search your document
for words you wish to either find or replace. These options are found

imder the Search drop-down menu in the Find and Replace dialog

boxes. Up searches back toward the beginning of the document, while

Down searches toward the end. All searches the entire document, as

you would expect. Selection will appear if you have any text highlighted

when you give the Find... or Replace... command; this option will search

only the selected text.

Using the clipboard with find
~ and replace

The Clipboard can be used for several interesting Find... and Replace...

tasks. For instance, you can copy text from your docimient to the Clip-

board, then paste it into the Find What or Replace With boxes. This is a

great way to paste long passages or obscure characters like umlauted let-

ters or math symbols. It is even possible to overcome the 255 character

limitation this way.

Word also lets you replace text with graphics if you place the

graphics on the Clipboard. Figure 19.5 illustrates how that is done.

Replacing tips

The Replace... command uses con.siderable memory if you

make a lot of changes. It is a good idea to perfomi a normal

save after assuring that your replacements are satisfactory.
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FIGURE 19.5

It is possible fo replace

text with graphics on the

clipboard.
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TRACKS

To <reate quUk outlines 522

use Word's heading styles. (Display heading styles on the ruler's

style drop-down menu by holding down the Shift key when you

point.) Heading styles automatically create outlines when you

switch to Outline view.

To promote and demote headings 523

click on the left-pointing arrow in Outline view to promote

headings. Use the right-pointing arrow to demote headings.

To view outlines 524

switch to Outline view from the View menu or with the

5§-Option-0 shortcut.



To rearrange text in outline view 526

point to a heading. Wlien the pointer becomes a 4-headed

arrow use it to drag the headings and associated text up or

down in the document. Releasing the mouse button moves the

heading and text.

To print outlines 527
display them showing the desired level of heading detail, then

use the Print... command on Word's File menu or the §€-P

shortcut.



How to organize your urriting

How Outline view speeds major renovations

w ORD'S OUTLINE VIEW, located on

^^H the View menu (S€-Option-0), is really

more than a view. It's a collection of tools designed to help you plan,

create, and reorganize long documents. It does this by letting you expand

or contract the amount of detail you see on your screen. Figure 20.1

illustrates this.

The top window in Figure 20.1 shows part of a document in Normal

view. The bottom window shows the same document in Outline view,

with all of the body text collapsed (not revealed). Since only paragraph

FIGURE 20.1

Outline view (bottom)

lets you get o birds-eye

view ofiarge documents

(top).

Outline
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THE OUTLINE VIEW'S ICON BAR

headings are visible in the bottom window, it's easy to see the overall or-

ganization (the outline) of the document. As you will soon see, Outline

view lets you control how much detail you see. For instance, you can view

the first line of text following each heading if you wish.

Notice also that headings in Outline view are indented, giving you a

better idea of the document's organization. Each new level is indented

V4" from the preceding one.

It's a snap to reorganize documents in Outline view. If you want to

move all of the paragraphs having to do with Landing gear up, so that

they appeared before Tail, simply drag the Landing gear heading using

the Oudine views special pointer. This will move all corresponding para-

graphs, called subtext.

Finally, you can quickly promote or demote portions of your docu-

ment using the Outline view tools, found on the Outline bar.

Styles and outlines

In order to use Oudine view, your headings need to be formatted using

Word's standard-heading styles (heading 1 through heading 9). If you

didn't use these styles when you created a document, it is easy to refor-

mat with them. And, as you probably know, you can change the ap-

pearance of standard headings if you don't like Word's standard styles.

(See Chapter 13 for more about styles.)

The outline views icon bar

Outline view provides a number of unique tools. They are found on

the Oudine bar at the top of the screen. There is a new pointer shape

indicating the pointer's ability to move large coUecdons of text. It looks

like a compass.

As you can see in Figure 20.1, on-screen text is often underlined

with an unusual line style. This does not indicate text that will be under-

lined when printed. Rather, it indicates that there is collapsed subtext

beneath it.
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Plus signs, dashes, and boxes

Large plus signs, boxes, and dashes appear next to many headings in Out-

line view. Boxes tell you that you are looking at body text; pluses indicate

headings containing subtext; and minuses denote headings without subtext.

Finally, Outline view includes the Outline bar, with its special head-

ing and body-text symbols.

The outline bar

Figure 20.2 summarizes the Outline bar's unique tools. They promote

and demote heading levels, hide or reveal body text, and turn formatting

on and off.

The best way to understand the effect of these tools is to open a

document containing standard Word headings in Outline view and ex-

periment. If you don't have a document of your own, create one or use

Business Report from the Sample Documents folder. The rest of this

chapter describes the various Outline view tools, offering tips on how to

use them.

Creating and editing outlines

When you start typing a new document in Outline view. Word assumes

the first thing you want to type is a level 1 heading. Each new paragraph

you type will take on the heading level of the previous paragraph.

FIGURE 20.2
Expands or contracts Shov/s/suppresses

Tools on the Outline bar view of subheadings character formatting

promote and demote

headings and reveal and

hide text and formatting.

Moves headings up or dovsrn

I

——

I

Reveals entire document
in outline view (toggle)
-1

> + - I 2 3 4 H Z- ff

I I 4

Turns heading into text Shows either all text

or first line only (toggle)

Promotes or demotes
heading levels Reveals or hides heading levels
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One strategy is to type all of your top-level headings first, and

then go back and insert headings in progressively lower heading levels.

Another approach is to type all your document's headings in sequence,

promoting and demodng as you go. It is even possible to type the endre

document (all headings and text) in Oudine view, without doing a tradi-

tional outline first.

The approach you choose is largely a matter of personal prefer-

ence, hi any scenario, you will need to know how to promote and demote

headings and text.

Promoting and demoting

The two arrows at the left end of the Oudine bar are used to promote

and demote headings. Place the insertion point in the heading you wish

to promote or demote. Click the right arrow to demote. Figure 20.3

shows this at work on a new oudine originally typed with everything at

level 1.

Here, we placed the insertion point in the Parts of the Plane head-

ing and clicked the right arrow once. Then we highlighted the headings

Wings through Tow hook and clicked the right arrow twice, which

demoted them two levels. The results are shown at the bottom of Fig-

ure 20.3. We have left the Theory of Glider Flight heading at the top

level; Parts of the Plane is now the next level down, and Wings through

Tow hook are at heading level 3. (You could confirm this by switching to

Normal or Page Layout view.)

Promoting works as you'd expect. With the insertion point in a

heading, click the left arrow to turn a level 3 heading into a level 2 head-

ing, and so on.

Outlining existing documents

1. Open your document in Oudine view.

2. You will see the first Une of each paragraph.

3. Place the insertion point in each heading and promote or

demote them as desired.

4. Save your work.
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FIGURE 20.3

The right arrow demotes

selected headings ar\d the

left arrow promotes.
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The results

5. Use the viewing techniques described next to view, rearrange

and understand the organization of your document.

Expanding and collapsing outlines

One of the main reasons to use Outline view is to get a collapsed over-

view of a document's contents. Do this by expanding and collapsing
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views with the numbers on the Outhne bars and the buttons to their

right.

For instance, Figure 20.4 shows our Glider book in a bit more detail

than the view in previous figures. The first line of text beneath each head-

ing has been revealed. (The small i's are hidex codes. Read more about

them in Chapter 23.)

This was accomplished by clicking on the all text or first line icon

(just to the left of the ff icon) on the Outline bar. (Clicking the Reveals

Entire Document icon—just to the right of the number 4—reveals all the

document text.)

The document's true heading styles are apparent in Figure 20.4.

The ff button at the end of the Outline bar turns character formatting

on and off.

Clicking on the numbers 1 through 4 in Outline view hides or

reveals the levels of your document. For instance, in our sample docu-

ment, clicking on 1 will reveal only level 1 headings (the Theory of

Glider Flight). Clicking on the 2 would reveal both level 1 and level 2

headings (Parts of the Plane). Clicking the Reveals Entire Document

icon (just to the right of the number 4) shows all text.

Split views

Figure 20.5 illustrates a strategy for working on large documents. You

can split the screen and show your document in Normal view in one half

of the window and Outline view in the other.

FIGURE 20.4

Click the all text or first

line icon (just to the left of

the ff icon) on the Outline

bar to show the first line

of text beneath each

heading.

=0 ^ Outline B^



THE WORD FOR THE MAC HOW-TO BOOK Chapter 20

FIGURE 20.5

Splitling the screen lets

you work in Outline and

Normal views at the

some time.

=- Outline



PRINTING OUTLINES

right arrow will appear along with a dotted line, like the ones shown in

Figure 20.6. Drag the line and the pointer to where you want to move the

text. Release the mouse button and the document will be reorganized.

The up and down pointing arrows on the Outline bar will also

move items up and down. Highlight the headings, then click on the ap-

propriate arrow.

Printing outlines

Printing in Outline view creates a document containing only the levels

you see on the screen. Collapse the document to the desired level then

use the Print command (on the File menu) or 3S-P shortcut. Even ifjust

the first line of text appears, Word will print the whole paragraph.



PART

Desktop

Publishing
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'JJake a look at the examples in this section to get an idea

ofwhat can be accomplished with Word. Learn how to

create multi-column newsletters, resumes, reports, res-

taurant menus—you name it. See how Word can help you

create a table ofcontents and index. Get a better under-

standing ofwhat's involved when working as a team on

really big Word projects. Read about sources oflow cost

art, typefaces, and other attention getters. You 'U even

learn some printing and pre-press terminology in the

pages thatfollow; and you will see how to prepare projects

for professional printing. V
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To spedfy multiple tolumns using the ribbon 535

place the insertion point in the section you wish to cohimnize,

then chck on the double or triple column buttons at the right

edge of the ribbon.

To speafy multiple tolumns using

the Se<tion. . . tommand 536

place the insertion point in the desired section then use the For-

mat menu's Section... command (Option-F14) to specify up to

100 of columns and their width.

To thange the spate between tolumns 536

place the insertion point in the desired section (the one con-

taining the columns whose spacing you need to change) , then

use the Format menu's Section... command (Option-F14) to

specify column spacing. The default measurement is inches.

You can also specify points, picas or centimeters.



To have different tolumn types and sizes on one page 536

insert section marks where yon want to begin different column
specifications. Place the insertion point below the section mark
and specify new column settings.

To view €oiumns before printing 537
use Print Preview or Page Layout view.

To thange tolumn widths 538

while in Page Layout view with the ruler showing (3§-R), place

the insertion point in the column of interest, then click on the

margin scale button ([]) to show the margin markers on the

ruler. Drag margin markers on the ruler.



Creating snaking newspaper-style columns

Changing column widths and spacing

Creating banner heads on columns

OST PEOPLE FIND short lines of text

^tm easier to read than long ones. That's

one reason newspapers and book designers frequently use side-by-side

snaking columns. Text flows from the bottom of one column to the top

of the next until a page is filled, then it fiows onto the next page.

Creating multicolumn documents
Word makes it easy for you to arrange your text in columns like these.

The ribbon buttons let you choose single, double, or triple columns.

(Single is the default.) Moreover, the Columns portion of the Section

dialog box lets you specify up to one hundred colimins. It also provides a

way to adjust the amount of white space between columns.

In a single-section document, all of your pages must have the same

number of columns. But, by breaking a document into multiple sections,

you can have as many different colimin designs as vou have sections.

Word automatically adjusts column widths to accommodate your

chosen page size, orientation, and document margins. You can overrule

these decisions.

It is possible to use indents within columns. You can edit columnar

textjust as you do any other When you work in Page Layout view, you

will see side-by-side columns as they will print. Wlien working in Normal

view, you will see text in the appropriate column width, but you will not

see the columns in position next to each other.

Word's column feature requires all columns in a section to be the

same width. (You can create different column widths with tables. See

Chapter 10 for details.)
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Using the ribbon

Here's an easy way to create columns:

1. If your document contains more than one section, place

the insertion point in the section where you want to create

multiple cohunns.

2. Click either the double- or triple-column button on the

right edge of the ribbon. As you can see in Figme 21.1, they

contain pictures of the column styles they produce. (Click-

ing the biuton to the left of the two column button restores

the text to a single column.)

2. Wlien vou use the ribbon column buttons. Word aiUomat-

ically determines the appropriate width of columns and the

amount of white space between columns based on the page

and document settings.

Changing margins, page size, orientation, indents, and related settings

will cause corresponding changes in column widths and spacing.

The zero point on the ruler is always at the left edge of the column

containing the insertion point. In Figure 21.1, it is at the left edge of the

right column. Clicking in the left column would move the zero point of

the ruler to the left edge of the left column.

FIGURE 21.1

The ribbon puts two- and

three-column text a click

away.
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Indents work as you'd expect within columns. For example, in Fig-

ure 21.1 the two-column ribbon button has been used to create two

column text. Then, the highlighted text has been indented using Word's

indent feature.

Using the section dialog box
You can create more than three columns (up to 100) and specify the

desired amount of white space between columns by using the Columns

portion of the Section dialog box. Reach the Section dialog box by choos-

ing Section... from the Format menu or use the Option-F14 shortcut if

you have an extended keyboard. Figure 21.2 shows the specifications for

twelve columns spaced 1/4" apart. The actual column width vfill be deter-

mined by Word, based on the available text area.

FIGURE 21.2

You can precisely specify

fhe number of columns

and the spacing in the

Section dialog box.

Columns-
Number:

Spacing: 0.25 in

Column breaks and sections

As yoti learned in Chapter 12, each section of your document can have

its own column layout. Since you can break a single page into multiple

sections, it is possible to have different column layouts on the same page.

This is how you create banner heads and similar effects for newsletters

and brochures.

Insert a section break (from the Insert menu) wherever you want to

change the number or spacing of columns, as illustrated in Figure 21.3.



COLUMN BREAKS AND SECTIONS

FIGURE 21.3

Imeil section breaks

to change column

specifications such as

the first section to

single-column and the

second to double-column

(double columns are only

shown side-by-side in

Page Layout view).
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It is easiest to insert and delete section brealcs while in Normal view

(3€-Option-N), but yon will want to use Page Layout view (§€-Option-P)

and Print Preview (9€-Option-I) to fine-tune your work before you print!

m
The Toolbar has Page Layout View and Print Preview

buttons near the right edge of large screens.

For instance, in Figure 21 .4 there is a problem with the spacing be-

tween the single-column and two-column portions of the page. The Spac-

ing Before paragraph feature has been used on the two-column text to

place space between the single- and double-column text. Unfortunately,

the first line of the right-hand column is not the first line of a paragraph.

(It is the continuation of a paragraph.) As a result, the left column has

space before it, but the right column does not. Placing space after the

single column paragraph and no space before the two-column para-

graphs will fix this.
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FIGURE 21.4

Creating different column

layouts with section

breaks can lead to spacing

problems caused by

heedless use of the

Paragraph Before feature.

^

Columns CHample

ja \TT^^ [B[7\U\ Pq^ g [jBH

-4? -+- J3_ Ji- _15_ _16_

I spend lots of tjme looking over people's shoulders It's amazing how
much computer power goes untapped Many users learn the basic

features o( one or two popular programs, then put away tueir

manuals forever When more advanced projects come along these

users (often painfully) apply their basic skills rather than cracking

the books to learn about advanced features that could make them
much more efficient This is particularly true of spreadsheet and
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Controlling column width

As you know, Word 5's column feature requires that all side-by-side

columns within a section be the same width. And, you know that Word in-

itially sets the widths and spacing for you. h's possible, however, to drag

columns to different widths using margin markers. Here's how. Follow

along in Figure 21.5. (If you need to have side-by-side columns of differ-

ing widths, use tables. See Chapter 10 for details.)

1. Place the insertion point in the desired column.

2. From Page Layout view, display the ruler if it isn't already

on screen (3€-R).

3. Click on the Margin Marker button (the closed brackets) in

the ruler to display the margin markers.

4. Drag any marker and the all columns will adjust to the same

width.

FIGURE 21.5

Drag margin markers to

change column widths in

Page Layout view.

Bi^fu :^q^



COLUMN BREAKS AND SECTIONS

Controlling column breaks

Use Word's Keep Lines Together and Keep with Next paragraph features

to prevent unwanted breaks. Sometimes, you will want to force breaks.

For example, the last page of a two column document may end with im-

even columns since Word will completely fill the left column before put-

ting text in the right colimm.

Use Word's Insert Page Break command to force column breaks.

Place the insertion point where you want the column break, then visit

the Insert menu or use the Shift-Enter keyboard shortcut. You remove

breaks by highlighting them and pressing Delete.

An alternate and perhaps more elegant way is to add another sec-

tion after your last real text (this last section will be empty, of course

—

specs are No Break and the number of columns won't matter). Then, if

you add more real text, your columns will automatically adjust and match

up at the bottom and you won't have to redo your Insert Page Break, etc.





Newsletters,

Brochures,

Reports,

and More
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TRACKS

To creofe lists of names in lefterhieads 545

consider using tables. Leave extra rows in anticipation of new

hires.

To treafe logos 547

use Draw to import graphics or draw your own. Add necessary

text then group the results and insert it in an untitled Word

document. Save the results in your scrapbook, add it to letter-

head, stationery, brochures, etc. Create glossary and Work

menu entries for your logo if you like.

To treafe talendars 549

use tables with fixed cell heights. Create stationery then fill in

months, days, and notes as necessary.

To treafe lines and rules 551

use both the border feature and Word's underline capabilities.

To make lists more interesting 552

string them out in one long paragraph, separating items with

white space and Dingbats. Create styles containing borders and

their embellishments to set-off important items in lists.



To rreofe od\a<enf tolumns of different widths 557

use tables. The Make Big Money from Tiny Sea Creatures adver-

tisement in this chapter is an example of the technique.

To treate overhead transparenties 559

modify Word's standard heading styles so that you can make

great looking slides while also creating outlines and handouts.

Stick with simple fonts and sizes between 18 to 24 points (or big-

ger). If you insert charts in your slides, make sure chart text is

big enough. Use hidden text or version B.l's Annotation... com-

mand to make notes to yourself.

To <reate dotvment borders 565

purchase Shareware or commercial border files, frame them

and position them in your Word documents or use preprinted

stock with color borders. There is also a border glossary entry

in Word's optional Page Layout glossary. It can create simple

single line borders aroimd documents.



Samples of Word's desktop publishing

capabilities

Design tips and tricks

Preparing documentsfor seririce bureaus and
printers

Prepress and printing terminology

I OU NOW KNOW enough about Word to

^H put together professional-looking docu-

ments of all kinds. The examples in this chapter are designed to get your

creative juices flowing and show off some of Word's desktop publishing

prowess. You'll see explanations of many of the tricks used to create each

piece. At the end of the chapter read about what's involved in turning

your work over to printers and other graphic artists.

D
All of the Shareware fonts and graphics used in these

illustrations are available at very low cost from Educorp

(1-800-843-9497). When you use Shareware, be sure to pay

the appropriate fees to reward people's hard work, and

keep the supply of fresh stuff coming.

Examples of word at work
All of the examples that follow were created using Word 5. 1 and

commonly available fonts and clip art. In some cases, Word's sample



EXAMPLES OF WORD AT WORK

m

documents and stationery were used as thejumping off point. A few of

the pieces were designed to be printed on specialty papers from com-

panies like Paper Direct in Lyndhurst, NewJersey.

A R N I N G

If you use these tricks, people may not believe you. Be
prepared with a response to questions like "You did that

widi Word?"

Letterheads

Perhaps Word can save you time and money with the most basic of desk-

top publishing tasks: letterhead creation and printing. Design letterhead

stationery that prints your return address, logo and other graphic elements

automatically whenever you compose a letter. Save the stationery and
add it to your Work menu. Check out colored paper and recycled stock

that can add personality and low cost color to your design.

Lavs^ Firm Letterhead
The Yeah, Sure & Really law firm letterhead is pretty straight-forward, ex-

cept that it uses a table (shown in Figure 22.1) for those pesky, ever-

changing partners lists.

Pago Sstup: This example (shown printed in Figure 22.2) uses

Word's defaults (US Letter, Portrait, 100%, etc.).

Dotument Spedfhafions: Margins are 1.25 left and right, 1 inch

bottom and 0.69 top (to accommodate the table). The header has page

numbering and a date which don't print on the first page.

Chara<ter SpetUitations: Palatino is used (9, 10, 12 and

14 point).
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FIGURE 22.1

Use tobies for lists of

names in letlerheods.

]a a
Veah Sure letterhead

\
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EXAMPLES OFWORD AT WORK

in an over-sized center column. Extra rows have been left at the bottom

of the table for the inevitable addition of new partners.

A RE: line has been included as a reminder to insert case numbers,

matter names, etc. It would be useful to replace all those carriage returns

with space before and after paragraphs as described in Chapter 9. This

would make it easier to seek out room for an extra line or two when
necessary.

Logo Letterhead
The letterhead shown in Figiue 22.3 includes graphics and a return

address that have been framed and positioned in a wide left margin to

create a logo.

Notice how in Figiue 22.4, the graphic appears in the top of the

document in Normal view (as opposed to on the left when printed).

Styles have been created for a variety of tasks as you'll see in a moment.

Page Setup: Word's defaults (US Letter, Portrait, 100%, etc.)

.

DOKUment SpedfUafions: Margins have been set at 1-inch except

for the left which is 1.75 inches.

CnOra<ter Spetifhations: Palatino is used here again, and 6 point

Hehetica for the Recycled Paper graphic in the footer shown in Figure 22.3.

Paragraph SpeutUations: A number of different paragraph

specilications have been used here and saved as styles. For instance, the

indented paragraph containing the insertion point is called body. Many
of the paragraphs have between 6 and 24 points before them to elim-

inate the need for extra carriage returns. Examples include the inside

address, salutation, body, and closing paragraphs. Even the room for the

signature was created by specifying 48 points of space before my name.

Other Iritks Both the Butterfly logo with return address and the

recycled paper logo and text consist of encapsulated PostScript graphics
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FIGURE 22.3

A framed logo and return

address print in the left

margin.

Almost Free

123

Sesame St

Big Bird

California

90101

818355.1237

facsimilie

818355.2309

November 13, 1992

Inside

address
placed

here

Dear

Warm Regards,

Ron Mansfield

RCM/mos

€^
Papar

plus text combined in Word's Draw feature. The butterfly and address

elements were framed and moved to the margin. The recycled logo and

text were pasted into the footer and aligned to the right with the footer's

ruler. Things like the butterfly frame and recycle logo can be added to

your glossary.
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FIGURE 22.4

The logo letlerheod in

Normal view.

Butteri

are

Almost Free

123

Sesame St

Big Bird

Caliicnua

90101

818.5551237

far^milie

818 5552309 q

Inside*^

address*^

placed*^

here'!

Dear'i

Warm Regards, ?

Ron Mansfield!
RCM/mosD

December 1, 19921

Page I INormah :eo 12 Q

Calendars

Tables are terrific calendar makers. Check out the example in Fig-

ure 22.5.
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FIGURE 22.5

A calendar created with

Word's table features.

NOVEMBER
Sunday Monday
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FIGURE 22.6

Use different row heights

to separate days of the

week from notes.

Calendar

]a EBm) []

|NH.Ive>K3Narro,7|Fy] l^- \^ [BTTTH] I^"^ M^\^ E |
= |ii|MJ

=) (5B mrinTi [hmt)
1°

. 1 .

.
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NOVEMBER
Sunday Monday Tuesday > Wednesday^ Thursday

1

8

b'anfheeWgyuJ.

4

Table Cells

Rpply To:
|
Selection

Column IDidth:

-Roui

Height: |EKactly \'w\

Space Betiueen Columns:

Indent:

fliignment:

row with black and choosing white as the character color. (This was ac-

complished by highlighting the desired information, selecting Table

Cells from the Format menu, and then clicking on the Border button to

select the desired shading.)

Paragraph SpeiifUations: The day numbers are right-aligned.

November has 6 points of extra space after it, specified in the Paragraph

dialog box.

Other Tritks The rows containing notes are set to exacdy 72 points

with the Table Oils. . . command. A Single border surrounds the entire

calendar with hairlines separating days. The cells in the boiiom right of

the calendar were merged into one to make room for the quotation of the

month which was framed and dragged into position in Print Preview.
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Directories and lists

How many ways are there to make lists? Let's see: 1
)—never mind. Check

out the hst examples that follow, and flip through magazines, books, and

manuals to get some ideas of your own.

Snaking Lists

Here's a novel way to put a lot of information into a small space. Sep-

arate list items with a little white space and some Dingbats like the ex-

ample in Figure 22.7.

FIGURE 22.7
AMERICAN BROADCASTING CORPORATION (ABC) * AMERICAN INDUSTRIAL

Seoarate items in snakina ^^ ESTATE ASSOCIATION 4 ASK MR. FOSTER./FIRSTOURS/CARLSON
,

'^
, ,

" CORPOR.\TION * BE.\R STERNS * BERGER & NORTON * CABLE NEWS
lists Willi space and NETWORK (CNN) A CHILDRENS HOSPITAL OF LOS ANGELES * COLDWELL
DinabatS BANKER * CONSUMER GUIDE COMPUTER BUYING GUIDES 4 EPSON AMERICA

" A FADEM & DOUGLAS A POX TELEVISION ^ QILLETTE/P.\PERMATE S
GRUBB & ELLIS S HORVITZ & LEVY 4 INDUSTRL\L ELECTOONIC ENGINEERS
4 LASER MEDL\ A LOS .\NGELES COUNTY COURTS 4 LOS ANGELES
DODGERS 4 LOS ANGELES OLYMPIC ORGANIZING COMMITTEE 4 LOVE
CONNECTION/ERIC LIEBER PRODUCTIONS ^ NORTHROP A OCCIDENTAL
PETROLEUM CORPORATION A PARTf PLANNERS WEST 4 PETER NORTON
COMPUTING S PRLKENTIAL STEVENSON 4 QUE PUBLISHING .* QUICK
TALLY * ROGERS & COWAN PUBLIC RELATIONS 4 SCIENCE RESEARCH
ASSOCIATESySRA * SYEEX. INC. .*WARNER COMMUNICATIONS ^ XEROX S

Charaiter SpedfUations: A Shareware font called ClassicaRoman

was used for the text, which is all caps and separated with one of Bill's

wonderful Dingbats. There's a space on either side of each Dingbat.

Paragraph SpeuiUations: The whole list is set as one long para-

graph (no returns), isjusiiiied, and has a hairline border at the top and

bottom only. Too easy!

Other Trhks Create glossary entries for your favorite Dingbats, then

you won't need to rummage aroimd to find them.



EXAMPLES OF WORD AT WORK

T>vo Column Lists

Figure 22.8 shows a two-column list that's easy to read and borders on art

deco. It started out life as tab separated data exported from a FileMaker

database.

FIGURE 22.8

An Art deco two-column

list with framed graphics.

A
Aerortiexico Airlines 800-237-6639

Ait Calilornia 800-424-7225

Air Canada 800-422-6232

Air Cargo 800-638-7346

Air France 800-237-2747

Air India 800-223-7776

Air Jamaica 800-523-5585

Air Midwesl 800-835-2953

Air Nevada 800-634-6377

Air-Aid Inlernalional Courier..800-223-1420

AirCal 800-424-7225

Airport Couriers Inc 800-641-4609

Airsyslems Courier 800-223-6795

Alaska Airlines 800-426-0333

Aloha Airlines 800-367-5250

American Airlines Inc 800-433-7300

American Eagle Airlines 800-446-7834

Aspen Ainvays 800-241-6522

Atlantis Airlines 800-845-4365

e
Bar Harbor Airlines - E US„, 800-343-3210

Britisfi Ainways 800-247-9297

Brilisti Caledonian Airways ...800-231-0270

Britt Airways Inc 800-652-7488

c
Canadian Pacific Air Ltd 800-426-7000

Cannonball Air Courier 800-323-6850

Capitol Air 800-221-4468

Continental Airlines 800-525-0280

CP Air (Canadian Pacific) 800-426-7000

D
Data Air Courier Inc 800-323-6808

Delta Air Lines Inc 800-221-1212

E r
Eastern Air Lines Inc 800-327-8376

El Allsrael Airlines 800-223-6700

Emery Ait Freight Corp 800-443-6379

GM
Hawaiian Airlines Inc 800-367-5320

Horizon Air Freight 800-547-7660

Horizon Air 800-547-9308

Iberia Airlines 800-221-6002

Japan Air Lines 800-525-3663

Jet 24 International Ainirays ,800-327-7751

K\.U Royal Dutch Airlines 800-556-7777

Korean Airlines 800-421-8200

>c
LMN

Mexicana Airlines 800-531-7921

Midstate Airtines 800-826-0522

Midway Airlines 800-621-5700

New York Air 800-221-9300

Northwest Airlines Inc 800-225-2525

OP
Olympic Airways 800-223-1226

Pan Am World Airways 800-327-5870

Philippine Airlines 800-435-9725

Piecimont Amines 800-251-5720

Priority Air Courier 800-821-7938

oc
Qantas Airways 800-227-4500

Rocky Mountain Airways 800-525-0280

Royal Air Maroc from NY 800-345-3556

Royal Air lylaroc not NY 800-223-5858

s
SAS Scandinavian Airlines ...800-221-2350

Saudi Arabian Airlines 800-472-8342

Scandinavian Airlines 800-221-2350

Singapore Airlines 800-742-3333

Sonic Air Courier 800-527-9513

South African Airways 800-722-9675

Southwest Airiines 800-442-1616

Summit Airlines 800-932-2636

T
TAP Air Portugal not NY 800-221-7890

Telerad Air Courier 800-621-7774

Thai Airways International ...800-426-5204

Trans World Airiines 800-221-2000

Trans-Global Airiines 800-722-3244

L
United Air Lines 800-241-6522

US Air (USAir) 800-428-4322

V
Varig Brasilian Airlines 800-468-2744

Viasa-Venezuelan IntI Air 800-327-5454

Western Airiines 800-227-6105

(0

u

<
0
N
r
£
3

Please remember to check with the

Transpoilatiort department before

making or changing your otwn

reservations!
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Page Setup: Standard Word defaults were used.

Do<Uinent Spetifuations: Margins were dragged in Print Preview

to get the desired effect with plenty of white space on the left margin.

The two column button was used to create the columns.

ChurUiter SpetifUafions: Narrow Helvetica (12-point) was used

for the names and numbers, while the Shareware font Miami Nights

(18-point) was used for the title and letter separators.

Paragraph SpeufUatloas: A tab stop with dots for leaders was

used to connect the names and numbers. The hidex letters are centered,

and have an extra 3 points of white space before them to separate the

parts of the list visually. The boxed note in the bottom right corner was

enclosed with Word's Border... command.

Other Truks The Insert menu's File command was used to import

the tab-separated ASCII list created by Claris FileMaker Pro. The names

and numbers were originally part of a larger contacts database. The

title—Authorized Air Carriers—was created in the Draw window, and

rotated 90 degrees before it was inserted into the document, where it was

then framed and dragged into position. The EPS airplane graphic (also

Shareware) was imported using the Insert Menu's Picture... command,

framed and dragged into position. Figure 22.9 shows how the list looks in

Normal view.

FIGURE 22.9

The phone lisl in Normal

view. tm
3

RItllne phone list

XT
Aeromexia) Arlines* 800- 237-6639

1

Air Califcmia. 800-424-7225:iI

Air Canada* 80&422-6232T
Air Cargo » 80&6357346 «

Page 1 |taps>...
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Mandarin Menu
When you think about it, menus are nothing but fancy Hsts. Take a look

at Figure 22.10, for instance.

Pogc Setup: Standard Word defaults were used.

Do€Ument Spedfitations: Standard Word defaults were used.

Charader Spe€ifi€ations: Helvetica was used throughout. The

pandas are Dingbats from the Shareware font International. The head-

ing MANDARIN CUISINE was expanded 6 points. The panda Dingbats

were subscripted with the ribbon's subscript button. Category headings

are italicized, small caps, and bold.

FIGURE 22.10

This menu consisfs of

three secfions.

^MANDARIN CUISINE

Specialties

PANDA BEEF 11.50
Made wilh roal pandas (just kidding).

BEEF WITH SCALLOPS 13.75
We couldnl malte up our minds either.

MOO GOO GAI PAN 6.75
Please, no baby or cow jokes when you order this

dish...

* SEAFOOD BASKET 12.79

Looks like seafood, lastes like a basket... Hot.

CRISP DUCK 7.95

That's what happens when we cook it too long I

PORK BeefAND Lamb
SHREDDED BEEF 10.50
Slicer needs sharpening you get a unigue dish.

SWEET AND SOUR PORK 12.75
Famous Long Island pink sticky sauce.

SLICED LAMB FAMILY STYLE 1 6.75
Try not to think about where this came from.

Serves four hungry carnivores.

BEEF WITH BROCCOLI
Mrs. Bush gave us this recipe.

19.92

« MU SHU PORK
Chinese tacos. Roll your own.

SZECHUAN From the Sea
STEAMING HEAP 10.50
Dumpling stuHed with who knows what.

EGG ROLL 6.75

Right. Try to find egg rolls in China.

PO PC PLATE FOR TWO 6.75

Please, no baby jokes when you order this one
either...

TWICE COOKED PORK 14.75
Cooked three or four times if you get here near

the end of the week.

« 4 « BAO HU 7.95

So very hot it will make you say its name.

SHARK'S FIN SOUP
DaPa ... Da Da...

19.50

% % WHOLE FISH
You might even get a hook.

SCALLOPS IN GARLIC SAUCE 16.50
Make everyone take a taste so you don't hear
complaining later.

LOBSTER IN BLACK BEAN SAUCE 12.79
Authentic seafood from the Chinese Province of

New England.

ABALONE 17.50
This is what you'll say when you get the bill.

•ift Pandas indicate hot stuff! Don't say we didn't warn you...
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Paragraph Spetifitations: There's lots going on here. Styles

calkcl category, dish and notes do most of the work. Check out their style

specifications in Figure 22.11.

FIGURE 22.11

Styles make it easy to get

a consistent look.

CATEGORY
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FIGURE 22.12

Fancy menus con be

created by using frames.

Rose of Smoked Salmon
Fresh smoked salmon prepared with herbs and capers.

These beauties lived right near the power plant and were

smoked even before they were caught!

8.50

Baked Bscargot

Ifyou saw Pretty Woman you know hov*' to eat these.

Please don't hit the help.

7.00

Soup Du Jour

Yesterday's vegies are

today's soup

and

tomorrow's yogurt

3.00 /
Othor TfKks The border is an encapsulated Shareware border in-

serted with the hisert menu's Picture... command and dragged to a big-

ger size. Things like this look really elegant when printed on parchment

and other fine papers.

405 AND OTHER COLUMNAR LAYOUTS

Don't just think of tables as places to type long, boring lists. Look at what

can be done with a two-column, two-cell table in Word. That's what was

used to create the want ad in Figure 22.13.

The column on the left is about 2.5 inches wide and the one on the

right is a little over an inch wide. Font and alignment choices give the ad

its interesting visual impact.

Page Setup: Standard Word defaults were used.

Dotument Spetifitations: Standard Word defaults were used.
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FIGURE 22.13

Two column tables can

create interesting

side-by-side visual effects.
Make Big

Money from

Tiny Sea
Creatures

!

Now you can turn a worldwide

labor shortage into a real career

opportunity. Tliere are big bucks to

be made in sardine eye closing. >W

Did you know

that there are

always openings

in the canning

industry? We
need

experienced

eye closers nowl

Day and night

positions are

available.

Benefits include

all the fresh

sardines you can

eat, and a free

oil cloth apron...

Phone

1-800-EYE-SHUT

Charaiter Spe<ifi€ations: Four fonts are used here, Classica-

Roman, Helvetica, hiternational, and (the yesitisalloneword) Davys-

DingbatsOption. The headline is 36 point, the copy beneath is 12 point.

Helvetica is used in the right column—in 9, 10, and 12-point sizes. Those

stick up caps are big and bold. The big fish is one of Davy's Dingbats

set in 36-point type. The litde fish is from the International font and is

14 point. He's been subscripted to make hiin line up better with the text.

Paragraph SpeufUaUons: The headline is all centered, and

has 18 points before it and 9 after The text below is justified and has

9 points of space after. (Fiddle with before and after spacing to get the

desired look.) The screen view in Figure 22.14 reveals some other inter-

esting paragraph tips.
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FIGURE 22.14

It doesn't take too many

paragraphs to create an

interesting ailike this in

a table.

Make Big

Money fronii

Tiny Sea
Creatures ! ^i

No'w you COD iuTO a yfoT]dyf\dc

InboT shoria^ into n renl cotcct

opporluoily. Tbcrc arc big bucks to

bcnndc ia airdiDccycclosing >W*

Did yx)u Know

that there are

aluuays openings

in the canning

industry? We
need

experienced

eye doseis now! -ff

Day and night

positions are

available.

Benefits indude

all the fresh

sardines you can

eat, and a free

oil doth apron./fl

Phone «

1-8C0-EVE-SHUT#

The paragraphs on the right are right-aligned in the column. There

are 5 points of space after each. Since words wrap automatically in table

columns, changing the column width has a big effect on the text layout.

The phone number and word Phone are centered in the column.

Othof Tfl€ks Notice the non-breaking space between the words eye

and closers to keep them together. The line above the phone niunber is a

narrow paragraph containing nothing but a border line. Another border

surrounds the entire ad. No vertical border line was used between the

two table columns, since the white space, text alignment, and different

fonts create a powerful visual separation of their own.

Overhead slides

You don't need to purchase special presentation software to create great

looking slides for your next meeting or lecture. Check out Figure 22.15.

It speaks for itself.
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FIGURE 22.15

wseivodtocreo/e OvGrheacIs
overhead transparencies. Create styles for things like this 24 point subtitle

A Make text easy to read with 18 to 48 point type

A Use dingbats and grapiiics for spice

A Keep your projector's maximum image area in mind

A White space, white space, white space!

Page Setup: The example in Figure 22.15 was created in landscape

mode, but slides are often created in portrait mode also.

DoiUment SpeufUations: This document has margins set so that the

image area is 8 X 10 inches. Adjust your document margins to reflect the size

ofyour overhead projector's maximum safe image area, or the inside dimen-

sion of the slide frames you'll use.

Chara<ter SpeufUafions: Keep characters big and plain. Here

I used 18 through 24 point Helvetica along with International Dingbats

(the cars). The chart labels (created in Microsoft Graph) were selected

and their point sizes increased for better visibility. Charts will almost al-

ways have type that is too small to be read at the back of the room unless

you do something about it. Remember the 18 point minimum rule.

Paragraph Spetifitations: A thick line was created in the top

paragraph with Word's Border feature. Create two or three indented

styles for Heads, subheads, etc.
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Other Tri<ks Consider using modified versions of Word's heading

styles, then you can create an outline of your presentation by switching

to outline view. Outlines often make great handouts if you plan them

carefully.

Make notes to yourself on each slide using hidden text. Turn the

notes off when you make the transparencies, then turn them back on

and print the slides and notes together on paper for yourself. Slick, yes?

Use colored transparency material and/or colored toner cartridges

for impact, but test color combinations on your projector and projection

surface for readability before your presentation!

Newsletters and other multkolumn projects

Use the tricks you know already to create newsletters and other multi-

column projects like the one in Figure 22.16.

Set up stationery and styles. Frame graphics, headlines, and out-

quotes. Use sections for columns or perhaps even tables. Use borders for

rules and to box graphics.

FIGURE 22.16

Nemkners are simply

collections ofparagraph

formats, sections

containing various column

specifications, and framed

graphics.

UFO Neais

]a IF] ri^rui pq^ lag^a m mam

UFO News.
^rarmer'Says
Milking Machine
From Mars!
DivenpoTT. LA. t'espiti? his u/iA**

clkim THit K* dunks i tat. x\as

'—fTtieTini VKingT'^iitTScSaS'iT

me jQixdi jnai^ cpiie monatL' sud
Fiimei Quail, twV) daiins Ms ccrajs

don't seem to mind The odd ftim

>iis milicet Tiou/ tiuJcesI

While all pnzes iwent to the

PI SI l^t^fSvJBodij TcHt M

fWeed VVackeran Alien Too'T
'Comfr to think of it , that gas-

TCTueid weedeTs been a little v/ievi

lately too." Dan told a TV wportet*

gA'heied to intennen; egy "

E
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Resumes

Keep resumes simple, clean and up to date! Use tables for the facts as

shown in Figure 22.17.

FIGURE 22.17

Use tables for the fads in

your resume, and be sure

to run the spelling checker.

la a tthi i:^hi fM5ri;i9i m [tmm
iNornijt nw EfflHi =1=1 l^l^l IUTUIt.|i| \i,\n\B
Jzi- 1-2 -^
William Clinton

i::>rri- 1439

OBJECTIVE -

Position as director of a large state or mid-siied nauon i!

PROFESSIONAL EMPLOVMENT^'

No ..ember "1980"
"" '

to presenu

Page |Normal+

GOVENOR: ARKANSAS CuTOntTy run "a

state wti a budge-i about the size of Tovs R

a

Notice the double line near the top of Bill's resume. It was created

by using Word's double underline, a tab character, and just one tab stop

set at the desired line ending position. Don't forget to run the spelling

checker. .

.

D
If you work on your resume in the office, remember

that its file name will appear on the bottom of your File

menu after you've worked on it. So, name your resume file

something non-descript, and maybe even save it only on a

floppy if you want to keep yourjob search confidential.
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Two AND THREE-FOLD MAILERS

Two (and three) fold mailers are popular because they start out life as a single

sheet of letter-size or legal-size paper. They end up looking like a booklet after

you've printed both sides of tlie sheet in landscape orientation and folded

them. Figure 22.18 is an example of a one side of two-fold brochure.

FIGURE 22.18

Create three fold mailers

in landscape mode with

hve columns.

Here's what important

people are saying:

"Just like being there.''

"Whoa ... Incredible

sounds and colors.

'Reminds me of the

sixties!"

"Billions and billions of

dollars worth of

entertainment."
Cat] Sagsn

"Forgit the

White House. I think

I'm gonna be a damn

astronaut!"

1 Watch PhDs confuse

the daylights out of

weightless frogs.

^BlBBv mhSp^?
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Paragraph Spedfitations: Word's Space Before and After

features were used to separate words and graphics from each other.

Quotations were centered and names right-aligned. Notice the hanging

indents in the paragraphs containing thumbs up bullets.

Other Tri(ks This mailer is just a table with five columns as you can

see in Figure 22.19.

In this example, the text columns are about 3 inches wide and are

separated by two white space columns of about .6 inches each. The art is

from Educorp clipart disks.

Paper Direct and other specialty paper vendors offer preprinted

stock designed to add decorative spot color to mailers like these. Some
designs even come pre-scored to simplify folding.

Reports and proposals

Combine your favorite collections of paragraph styles to create report

stationery, then just fill in the details when a report or proposal is

needed. Store boilerplate as glossary entries or in separate files.

Modify Word's standard Heading styles to create the look you want

while maintaining the ability to generate quick outlines and a table of

contents. Figure 22.20 gives you the idea.

FIGURE 22.19

Five columns provide the

necessary spacing for the

brochure. Here's what important
people are saying:

' "Just like being there."?

I Lmod NOTioy

• "Whoa ... Incredible

PI SI [heading 2'

•Icd| Watch PhDs confuse

the daylights out of

weightless frogs. •

ES
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FIGURE 22.20

Modify Word's standard

heading styles to create

custom stationery, and

maintain outlining and

quick Table of contents

capabilities.

"""' "' ""°°"'
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FIGURE 22.21

Awards are easy,

particularly with border

decoration clipart or

preprinted border stock.

r-^
^IL .iii. Jli. ^ .ili.

r
* * '

^

f , T

4 "
'f^

"77^ 'iv /y\ yf^ 'r^ y^

Prepress and printing
— terminology

Think of prepress activities as all of the work that happens before your

job is actually put on paper. Prepress steps might include design, art,

layout, and typesetting. In the not so distant past, these steps were usually

performed by professionals who have developed industry-specific ter-

minology to describe their work and tools.

Today, despite the fact that personal computers have made it pos-

sible for amateurs to do most or all of their own prepress work, you may

find yourself working with prepress professionals or printers. They'll

want to discuss parts of your project in their own terms. So here's a quick

overview of some of the buzzwords vou mav hear.

BiffD

When an image is designed to bleed, it is meant to print all the way to

the edge of the paper Realize that many laser printers can't print all the
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way to the edges of a sheet, so if you plan to print on most laser printers,

you won't be able to bleed unless you can trim (cut) the final product to

remove the white space around the edges.

Board art, mechanicals, or camera-ready art

If a printer will be reproducing yourjob, he or she will often make

photogiaphic negatives and plates for the printing press. This is often

done by photographing artwork pasted up on stiff cardboard, thus the

terms board art mechanicals, or camera-ready art.

Most printers today accept flimsy pages directly from your laser

printer, and there is often no need to paste it to boards imless you plan

to combine computer output with art from other sources (photos, hand

drawings, etc.). In fact, with the advent of laser drum scanners for plate

making, some printers prefer that you don't mount your copy. Ask first.

If you do find yourself creating camera-ready copy on your laser

printer, consider using special prepress paper like Hammermill's Laser

Plus. It is very white (improving the contrast between your laser printer's

image and the white background). Moreover, the paper stock is specially

designed to help layout ardsts secure it to boards with wax or other ad-

hesives. Purchase Hammermill's Laser Plus and things like it at art stores

or paper specialty mail order firms like Paper Direct.

Body AND DISPLAY TYPE

Lovers of type often purchase special fonts for headlines and others for

the text (or body) of documents. The larger type is often called display

type. When purchasing display type for your Mac, be sure you purchase

fonts containing all of the characters you need. Some display fonts don't

have lowercase letters, punctuation, or special characters for instance.

If you plan to have a service bureau get involved in part of your

prepress work—and parficularly if you'll be playing pass the floppy with

them, be to sure find out if they'll need (and have) the same fonts and

font technology as you'll be using (TrueType or whatever)

.
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Crop marks
Crop marks show printers where to cut finished sheets from oversized

stoci<.. For instance, if you design a postcard and deliver the art on an 8.5

by 1 1 inch piece of paper, the printer will want to know exactly where to

cut the cards. Crop marks specify the finished size of the printed piece

and the position of the image on the piece. Figure 22.22 shows an ex-

ample of two crop marks.

If you don't provide crop marks, the decision is out of your hands,

and you will probably be held financially responsible for printing and cut-

ting results that displease you.

Create crop marks in Word with the dash and vertical stick keys on

the keyboard.

FIGURE 22.22

Crop marks show the

finished size of the sheet

and the position of the

image on it.

f

MnW Rirr
Did you hnour

Ihat there are

D I P

Check out the special purpose, optional Page Layout

Glossary entries that Microsoft has provided for you. You

can install them using the techniques described in Chapter

16. Among other things, the entries include crop marks,

lines between columns, a handy margin notes trick, and

ways to create page borders. Many of these entries add

embedded PostScript. Read about the entries and how to

use them in the Page Layout Glossary Info file in the

Glossaries folder.
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Cropping

Cropping is the process of eliminating part of an image prior to printing

it. As you probably remember, in Word you do this by selecting a graphic

and dragging handles without holding down the shift key.

It is also possible to crop photographs and other items that are not

part ofyour Word document. Do this by covering them with tissue paper

and drawing lines on the tissue to show the printer exactly where to crop.

Keep in mind that the finished art, once cropped, must be the correct

shape to fit the allotted space.

Double PAGE SPREAD

A double page spread is a design that assumes that readers will see two

pages at once. The most appealing double page spreads often use mir-

rored elements like headings, page number positions, and so on. Use

Print Preview's ability to display two pages at once to see how your

spreads will look.

Halftones

Most photos that you see in black and white publications appear to be

printed with a variety of giay inks. If you look closely (with a magnifying

glass, perhaps) you'll see that the photos are actually made up of black

dots in a variety of sizes. From a distance, the small dots provide the il-

lusion of light grays, and the bigger dots look like darker shades.

The final appearance of a photograph depends upon a number of

factors including the number of dots used to represent each inch of a

photo. There isn't room for a complete discussion of your Mac's ability

to simulate shades of gray, but there are some things you should know.

If you have a scanner and a decent laser printer, you may be able to

include acceptable-looking photos in your desktop publications. These

will be fine for low cost newsletters, in-house promotions, etc. But, if you

plan to spend a lot of money for a prestige printed piece (brochures, an-

nual reports, etc.), discuss photo options with your outside printer or a

professional designer when you start the project. They can tell you the

best way to include and reproduce high quality photos.
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Chances are you will be asked to just leave space in your Word
layouts and provide actual photos that the printer will strip into the job

at the plate making stage.

House sheets

Wlien printers and designers talk about house sheets they are referring

to paper stocks (colors, weights, sizes, textures, etc.) that printers always

try to keep in inventory. Because printers often buy this stock in large

quantities, and don't need to place special orders, house sheets often

cost less, and minimize delays.

If you are designing ajob on a tight budget or short schedule, ask

about your printer's house sheets. Try to design the finished size of

printed pieces so that they economically fit on house sheets. And don't

forget to consider the grain direction of the stock if your pieces need

folding. Ask a pro for advice at the design stage when in doubt.

LlNOTRONK PRINTERS

Many printers and prepress service bureaus have invested in expensive

output devices like Linotronic printers that can take PostScript files and

convert them directly to film or photographic paper. These devices have

the advantage of being able to create very fine detail at very high resolu-

tion (typically 1270 to 2450 or more dots per-inch).

Some shops hook gear like this directly up to Macintosh computers,

and in these cases you can often just play pass the floppy or send your

documents via modem. They'll take it from there. Other times you'll be

asked to provide PostScript files on disks.
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Don't wait till the last minute to find a service bureau

or printer. Make arrangements early, run some tests con-

taining samples of the fonts, tables, scanned images, and

other design elements you use regularly. Get advice on how

to make things easier at both ends. Listen carefully. Take

notes. Then, when that inevitable rush job comes, you'll

have most of the kinks already worked out.

Printer spreads and reader spreads

Have you ever thought about what's involved in laying out a newspaper

or other folded document containing more than four pages? Pick up a

newspaper and turn to page 4. Pull out the entire sheet of newsprint and

examine the page numbers on it. Wliat's on the right side of the sheet?

It's not page 5, is it? Look at pages on the other side of the sheet. The

process of deciding which pages go where on a sheet is called imposition.

When designing booklets and other documents that are composed

of more than one sheet of paper, or large, folded sheets, you need to

consider both the reader's needs (called the reader's spread) and the

printer's needs, or printer's spread. High-end desktop publishing pro-

grams do this for you. But, when designing with Word 5, you'll need to

figure these things out for yourself.

For instance, if you are going to create a multipage 8.5 x 5.5-inch

booklet by laying out two pages on each sheet and folding 8.5 x 1 1-inch

paper, you can't use Word's normal page numbering features. Before

creating multipage booklets, brochures, and other complex assemblages,

mock them up with numbered sketches so that you'll understand which

pages need to be printed next to and on the backsides of each other.

Give the mockup to your printer as a guide.
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Proofs
Before printing expensive jobs at a printer, insist upon seeing proofs.

If there is folding, stapling, or other binding involved, have the printer

make a mockup of the finishedjob from the proofs themselves (some-

times called bluelines) to make sure everything will come together cor-

rectly. You'll probably be asked to sign the proofs.

Errors made by professional prepress folks and printers are usually

corrected for free, but if you change your miiid after signing the proofs,

or sign-off on a proof containing errors, expect to be billed for the work

plus the time and materials required for corrections.
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TRACKS

To treate a table of tontents from your outline 577

once the document has been proofed and formatted, simply

choose Table of Contents from the Insert menu. Word will use

the oudine's heading styles to create the table of contents.

To tompile and edit a TOC 578

use the Table of Contents... command on Word's Insert menu.

To treate detailed TOCs 579

with hidden text enabled, select the text for the entry and pick

the TOC Entry command from Word's Insert menu. Word in-

serts the appropriate codes. TOC entries consist of a contents

code, the text of the entry itself, and an end-of-entry code im-

less the selected text is followed by a paragraph mark. Suppress

page numbers by inserting a colon (:) between the last charac-

ter in your text and the end-of-entry or paragraph mark. Assign

levels to entries, by inserting numbers between the hidden C
and the hidden period in TOC-entry markers.



To quUkly index words 58

1

once the document has been proofed and formatted, select a

word or phrase to index and choose the Index Entry choice on

the Insert menu. Word will insert the necessary codes.

To iompile and edit an index 58 1

use the Index... command on Word's Insert menu.

To treate nested index subentries

under a tommon heading 583

you need to retype (or copy and paste) the common heading at

each occurrence of a word or phrase that you want to include

in your index. Up to seven levels are possible.



Quick tables of contents and indexes

Fancy tables ofcontents and indexes

W ORD WILL HELP you create a table of

^^B contents (TOC) for your documents. If

you format your headings using Word's standard heading styles or Out-

line feature, the Table of Contents... command on the Insert menu will

quickly compile (create) a simple but very usable table of contents and
place it in a new section at the beginning of your document.

It is also possible to manually select items to appear in your table of

contents. You do this by identifying words and phrases in your document

using hidden text codes called TOC Entry codes. You can control the

appearance of the table of contents as well. Your TOC can have one or

multiple levels.

Word's Index Entry, Index..., and hidden Index codes work to-

gether to produce equally simple or distinctive indexes at the end of

your document.

D I P

As you will see, for both TOCs and indexes, Word uses

complicated hidden codes to mark entries. You can save a

lot of time by assigning keyboard shortcuts to the commands
that enter the codes.
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Creating a table of contents

Figure 23.1 shows a simple table of contents containing only paragraph

headings created using Word 5's standard heading 1 through heading 3

styles:

FIGURE 23.1

You can produce simple

multilevel TOb using

Word's standard heading

styles.

TOC EHample

103
Itoc I

m g mnm
JO^ -^

3a M^H^ e-^^^ B^i BTT^m^ gir^^
0-

_12_ ±
The Theory of Glider Fhght.

Parts of the Plane*

Wings*
Fuselage*

„ 11

,.5-1

.5-1

Controls and Their Functionst--

Stick*

Rudder Peddles*

Spoiler Lever*.

Your First Flight*.

.6-11

.811

8-1

TTie Theory of Glidef FligM:

'

PI SI toe 3 JKI. l»la

Notice that Word has placed the TOC in its own new section at the

beginning of the document. It has automatically inserted tabs, leading

dots, and page numbers. To format and indent the new table of con-

tents, it has used toe styles corresponding to the standard-heading styles.

Thus, headings in the document formatted with standard heading 3 will

appear in the TOC formatted with a standard style called toe 3.

To create a TOC like this:

1. Begin by formatting your document's headings with Word's

standard-heading styles. (These styles can be added to your

ruler's drop-down style list by visiting the Style dialog box.

Be sure to hold down Shift when clicking on the ruler's

style menu. See Chapter 13 for more about styles.)



THE WORD FOR THE MAC HOW-TO BOOK Chapter 23

2. When you have typed and proofed your document, and are

happy with margins, headers, footers and other design ele-

ments affecting page breaks, pick Table of Contents... from

the Insert menu. You will see a dialog box like the one in

Figure 23.2.

FIGURE 23.2

The Table of Contents

dialog box.

1

—
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Changing a tocs appearance

Yoii can edit the resulting TOC as yon wonld any odier text in your docu-

ment. Feel free to embolden characters, change line spacing, etc. As you'd

expect, changing the st)'le definitions for standard styles toe 1 through toe 9

will change the appearance of your TOC. If you already have a table of con-

tents when you Uy to create a new one. Word will ask if you want to replace

die old one or create an additional one. Sometimes it is a good idea to cre-

ate an additional TOC and then delete the old one once you've formatted

die new one and determined it is sadsfactory.

Elegant tocs

While the simple preceding steps are fine for most documents, there may
be times when you will want to create more complex TOCs. For instance,

you might want to include items in the TOC that are not paragraph head-

ings, or to suppress page numbers for a particular heading. You do these

things by using TOC-entry codes instead of heading styles to define TOC
entries.

Contents codes are hidden-text markers placed before and after the

text you want to have appear in your TOC. A complete TOC entry con-

sists of three parts: the contents code, the text of the entry itself, and the

end-of-entry code.

Suppose you need the Theory of Glider Flight heading to appear in

the TOC without a page number and you want the next two entries to ap-

pear as they did in our first example, but you want to add another level

containing entries gleaned from the text of the document.

Figure 23.3 shows a portion of a new TOC and the coded text that

created it. Examine the figure, then read on to see how to easily add

codes like these.

Adding Hidden Codes

1. Start by making sure that the Show Hidden Text preference

has been enabled using the View category of the Preferences

dialog box. (See Chapter 31 for help with preferences.)
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FIGURE 23.3

Here's a pohion of a TOC

shown with the text and

hidden codes that created

the TOC entries.

Marks this as a TOC entry Colon suppresses page numbers in TOC

JThe Theory of Glider Flight^/

Parts of the Plane* / Ifl

Wings* / 1<1I

leading edge* 1^

trailing edge* l<ff

c TTie TTieofy of Glider Fliqrt:^

This chapter deals witii the theory of soaring flight, as exacting and

unforgiving art as you will ever study.1
.c2,Parts of the Plane?

T^ere are hundreds of important plane parts Let's examine a ie'W<9

c3 Wingsl
Ea'tofwing has a c.4,leading edge ,and ,c.4,trailing edge;. The leading

Specifies TOC level End-of-entry codes

Z Select (highlight) the text you want to use as a TOC entry

(The Theory of Flight, for instance)

.

X Pick TOC Entry from the Insert menu.

4 Word will insert a TOC code at the beginning of the entry

and, if necessary, an end-of-entry code at the end of the

selected text. (There is no need for the end code if your

selection ends with a paragraph mark.)

5. To suppress page numbers insert a colon (:) between the

last character in your text and the end-of-entry or para-

graph mark. You can see an example of this in the first

entry in Figure 23.3.

6. To assign levels to entries, insert numbers between the hid-

den C and the hidden period in TOC-entry markers, as

shown in the rest of the entries in Figure 23.3. As you can

see from the example, a 1 is optional.

7. To compile a coded TOC, use the Table of Contents...

choice on the Insert menu, but click the .C. Paragraphs but-

ton in the Collect box. Alas, you cannot combine Outline

and .C. coding to create a single TOC.
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Restricting TOC Levels

Ifyou want to suppress the printing of one or more TOC levels, specify the

From and To levels you wish to print in the Table of Contents dialog box

(see Figure 23.2). For example, you could create a TOC showing only sec-

tion and chapter headings. This is a great way to create a second contenls-at-

a-glance TOC for big documents. You could create a second, more in-depth

TOC down to the paragraph level and print them both in your document.

Answer No to the Replace existing table of contents? prompt when
compiling multiple TOCs like this. Word will place the most recently

compiled TOC first.

Printing Colons and Semicolons
If you use coded TOC entries and want to print colons or semicolons in

your TOC text (Chapter 10: Annie Feels Her Oats, for instance), sur-

round the text with single, hidden quotes. Thus, our Chapter 10 ex-

ample would read .c.'Chapter 10: Annie Feels Her Oats', vrith the

single-quote marks coded as hidden.

Creating an index

Automatic indexes are created using hidden codes much like the ones

used to code TOC entries. There are more codes, however, since indexes

can be more complex than TOCs. Word compiles indexes on demand
and places them at the end of your document in new sections which it

creates for this purpose.

Quick indexes

Quick indexes might be an oxymoron. Simple indexes can be created by

using the Index Entry choice on the Insert menu to code selected (high-

lighted) words and phrases you want to appear in your index. Word can

then compile an unembellished index.
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Here's how to do that.

1. As with coded TOC entries, start by making sure that you

are done proofing, fiddling witli margins, page endings,

and the like.

2i Be certain that the Show Hidden Text preference has been

enabled in the View category of the Preferences dialog box.

(See Chapter 31 for details on preferences.)

3. Select (highlight) a word or phrase you want to use as an

index entry (wing, for instance).

4i Pick Index Entry from the hisert menu.

5. Word will insert an index code (.i.) at the beginning of the

entry and, if necessary, an end-of-entry code (;) at the end

of the selected text. (There is no need for the end code if

your selection ends with a paragjraph mark.)

6h When you have coded all (yes all) occurrences of each word

you want to see in your index, choose Index... from the In-

sert menu.

7. You'll be rewarded with a dialog box like the one in Fig-

ure 23.4.

& Click on Start or press Return.

FIGURE 23.4

The Index dialog box

starts the compilation of

an index.

IndeK

Format: (]i) Nested

O Run-in

IndeK Characters:

(•) fill

O From: \\ I
To:

I
Cancel I
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Index Coding Shortcuts
Place coded words and phrases in yonr Glossary. Insert them rather than

typing and coding each time (copy and paste works here too). In existing

documents, rather than visiting each occurrence of every indexable word

in your docimient, consider coding every first occurrence, then using

Word's Replace... command to replace identical uncoded words and

phrases with coded ones. You'll not want to use the Replace All button,

however. Supervise each replacement yourself.

Fancy indexes

Word offers quite a bit of control over the appearance of indexes. You

can create multilevel indexes, italicize parts of entries, and more. Here

are the tricks you need to know.

Index Subentries (Nesting)

To create sub-entries under a common heading, you need to retype (or copy

and paste) the common heading at each occurrence of a word or phrase that

you want to include in your index. Up to seven levels are possible. Note that

levels are separated by colons. Figure 23.5 illustiates the technique for a three-

level subindex. The top part of tlie example is the coded document text. The

resulting index is shown at the bottom of the figure.

Notice that the first occurrence ofpUme parts is coded as an index entry,

but the words plane parts are not coded as hidden text That's because we want

them to print at that point in the document. Subsequently, the words pkirw

parts are coded as hidden text, since they are part of a nested index entry

and you don't want them to print in these otlier places in the document.
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FIGURE 23.5

Nesting under common

terms entails repeating

the common term at each

occurrence of a sub-entry.

IndeK EKample lai

ja si^a mzjsi imh H mnm
ja -MM B=l= l Bf^ BTTIETj guj]-

J^ -+- -+- -42 -|5-
3:

This chapter deals with the theory of i.soaring. fhght, as exacting and
unforgiving art as you will ever study 51

Parts of the Plane

There are hundreds of important 1 plane parts.- Lets examine a few f

Wings i

Each 1 plane parts wing, has a i plaiie parts wing leading edge, and

iplane parts wing trailing edge, The leading edge is the part that

meets the vnnti The trailing edge contains tilings called flaps
'

Fuselage f

The iplane partsFuselage, is the main body of the ship This is

where you sit- *

plane parts lli

Fuselage lii

wing 1

;

leading edge 1'4

trailing edge 1-i

soaring 1
•

PI S2 INormal ESE Q
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If you do a lot of this kind of indexing, make friends

with the keyboard shortcut that toggles hidden text (l€-Shift-

X). Plan to visit the View category of the Preferences dialog

box to turn hidden text on and off, since it can be pretty

hard to read a document full of nested index codes Uke

these.

Look carefully at the semicolons at the end of each coded index entry.

See how they are not curly? That's how you tell that they are hidden text. If

your indexed document contains unexpected semicolons or other charac-

ters, check to be sure you'xe defined all the codes as hidden text.

Text in Index Entries

You can type text in index entries. This has a number of benefits. Two

are shown in Figure 23.6.
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FIGURE 23.6

Typing text in index

entries lets you capitalize

index entries and refer

readers elsewhere.

iNorm.l IR ^* 1^1= 1 BEm BP] H"f]T( t
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I
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Ther- nr^ hundreds of important plane parts tBBSBSSSSSSSi
tetSfeaiSasaliMJEal Lets examine a few *

Wings
Each iPlane parts wing, has a i plane parts wingleading edge, and
iplane parts wing traiUng edge. The leading edge is the part that

meets the wind The trailing edge contains things called flaps.g

Fuselage ^

The 1 plane.par.tSiFuselage, is the main body of the ship This is

where you sit -1

Plane parts (see also whatchamacallums)1I
Fuselage 15

wing Vf

leading edge m
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Earlier, we had defined the words plane parts in text as the common
heading for Fuselage, wing, etc. Because we selected (highlighted) the

lowercase words plane parts to define them as index entries, Word used ex-

acdy what we highlighted, lowercase and all. To place a capitalized Plane

parts in the index, we could have defined a hidden capitalized version of

plane parts and defined it as the index instead of the actual body text.

Understand here that ...hundreds of important plane parts is not the entry

now. This technique is illustrated in Figure 23.6.

Typing hidden text within an index mark is also a way to place

notes (like see also) with your entries. Nodce the change in the index it-

self resvilting from the new entry technique. Notice in the figure that you

must use the number symbol (#).

Cross Indexing
You can do a form of cross referencing by typing several related hidden

index words (like .i.Plane parts;, .i.Parts, plane;, and .i.Air Frame;) and

have a separate entry appear at the appropriate place in your index. Fig-

ure 23.7 shows this at work.
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FIGURE 23.7

Type several index

entries in the same place

to create a form of cross

referencing.

IndeH EHample
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There are hundreds of important plan© parts iX^m:^ti0±fST^
HHHHHIl L^t^ examine a few •

Wings i

Each ! Plane parts wing, has a vpj.ane partswing.leading edge, and
1 plane parts wing. trailing edge, The leading edge is the part that

meets the wind The trailing edge contains things called flaps 5

Fuselage l

The rplane partsfuselage, is the main body of the ship This is

where you situ

Air Frame 1<S

Parts, plane H
Plane parts If,

Fuselage 1^
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Type carefully when you do this. Remember, each index item in

your collection must start with .i. and end with a semicolon. Notice the

use of a comma in the Parts, plane entry. It prints just fine here. Remem-

ber that index entries must be formatted as hidden text. Compare the

resulting index in Figure 23.7 with the one in Figiue 23.6. Indexing is

hard work, but often worth it.

Formatting Index Entries

Word provides ways to italicize or make bold an index's page numbers.

To make a page number bold, place the letter b between the i in the

index code and the period (.ib.Planes, for instance). Use an i in place of

the b for italics (.ii.Planes), or both (.ibi.Planes) if you want to really em-

phasize an entry.

Printing Colons and Semicolons
If you want to print colons or semicolons in your index text (Glider

Materials: metal, wood, fiberglass, for instance), surround the text with

single, hidden quotes. Otherwise Word treats colons as indications of sub-

entries. Thus, the Materials example above would read ./. 'Glider Materials:

metal, wood, fiberglass 'with the single quote marks coded as hidden.
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CREATING AN INDEX

Printing Page Ranges
It is possible to index selected portions of your index (A-M, for in-

stance). Use the Index Characters choice in the Index dialog box

(revealed when you choose Index... from the Insert menu). Place the

first and last letters in the From and To boxes respectively.

If you work with index and table of contents

commands frequently, consider adding them to your

Toolbar. See Chapter 31 to learn how.
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TRACKS

To plan for large projetts 593

create stationary, glossary entries, and possibly a Work menu

first. Use the same styles throughout and be consistent to

produce a uniform appearance.

To print multiple files as a single dowment 593

prool, format, and save all of the files. Connect the first two by

opening the first and using the File Series tool to specify the

next file in the series and necessary page numbering or other

options. Open the second file and connect the third, and so on.

Printing the first file will cause the others to print in succession.

To number pages atross multiple files 595

click Continue under the Page Numbers label each dme yotx

call up the File Series box.

To number lines atross multiple files 596

you must check each document to see the last line number it

contains, then type the next number in the Number Lines

From box in the next file's File Series box.



To number paragraphs a<ross multiple files 596

use the open and look technique just described to determine

starting numbers for paragraphs.

To number footnotes atross multiple files 596

use the open and look technique just described to determine

starting numbers for footnotes.

To treate an index and TOC atross multiple files 597

open the first document in a series and issue the Table of Con-

tents... or Index... commands. Word will create a TOC or index

across all members of the series.



Working ivith large documents

Connecting and printing a series

ofdocuments

Page, paragraph, andfootnote numbering
in a series

II NE PERSON'S LARGE document is

another's small one. Word has the ability

to create documents of virtually any length. At some point, however, you

will find that Word's performance degrades as yoiu- document size in-

creases. This is particularly true of older, slower Macs with limited RAM.
When performance (scrolling speed, spell checking, etc.) becomes

disappointing, you might want to split a single document into multiple

documents. Microsoft's published rule-of-thumb is to split a document

every twenty pages. This seems conservative, given the speed and capa-

city of today's machines.

Many people routinely work with documents containing hundreds

of pages. At one point the entire text of this book was in one Word 5.1

document, and edited on a Macintosh Ilex and PowerBook 140. While

not lightning fast, performance was quite acceptable. And, it was very

convenient to make global changes without opening new files for each

chapter. So where acceptable speed is concerned, the choice is yours.

Another reason to split documents is to have different people work

on different parts of the project. After everyone is done, you'll probably

want to print the whole body of work as if it were one document.

After you've split a docinnent (regardless of the reason), there are

three ways to print the completed work. You can recombine all the parts

and treat the resulting large document as a single entity. Or, you can

keep the document broken into multiple sections and print the pieces

separately. Finally, you can leave the work in pieces and have Word print

them as a series. There are two things to watch, regardless of which ap-

proach you choose: consistency of appearance and correct page number-

ing across document parts.



CONNECTING MULTIPLE PARTS IN A SERIES

Planning for large documents
If you know you are going to create a large document, create stationary,

glossary entries, and possibly a Work menu first. Then use these tools to

create the multiple parts.

If other people will be working on parts of the document, provide

them with copies of your stationary and possibly copies of your custom

glossaries, spelling dictionaries, settings files, and special fonts. You will

definitely want to provide them with your various styles. The more alike

your machines are, the fewer problems you will have during the crunch.

Develop a strategy. Consider making logical breaks at the beginning

of chapters or sections. Publish a brief author's guide to ensure that

everyone uses the same abbreviations and typing techniques.

Connecting multiple parts
- in a series

Word can treat pages from different files as a continuous series of pages

for purposes of page numbering, indexing, TOC creation, and so on.

To create a series, you need to show Word which documents to use and

what order to use them in. The first document in a series remembers the

name of the next in the series. Document two remembers the file name
of document three, and so on.

You can connect a series of documents using the general technique

described below. But modify the steps based on your page- and line-num-

bering needs. (Since page and line numbering are affected by the way

you connect files, read about numbering issties before actually connect-

ing your documents. See Chapter II.)
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Carpenters have a saying: Measure twice. Cut once. In a

strange way, that saying applies when creating a series. It is

very important to proofread yoiu- work before connecting a

series of documents. Anything that changes pagination after

dociunents are connected can have a major ripple effect in a

series. Measure twice. Cut once.

General steps for creating a series

1. Create, proof, and format all files.

2. Once you have finished working on all of the separate docu-

ments (finished spell checking, paginating, footnoting,

etc.), open the first document in your series.

3. Use the Document... command in the Format menvi to

bring up the Docinnent dialog box.

4b Click on the File Series. . . button in the lower-right corner

of the dialog box.

5. You will be visited by the File Series dialog box, shown in

Figure 24.1.

FIGURE 24.1

Use the File Series dialog

box to conned separate

documents.

File Series

Page Numbers

O Continue

(•) Number From:

Number Lines From:

( NeKtFile... ]

[Cancel
J
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6i Click Next File.... You will see an Open dialog box.

7. Locate the next document in your series and open it. The

name of the file you've picked will appear near the bottom

of File Series dialog box.

8. Click OK to close the dialog box, then click OK in the Docu-

ment dialog box.

9. Save the first document you opened. You have created a

series consisting of the first and second documents.

10. To add a third document to your series, open the second docu-

ment and use the steps above to point to the third document.

11. Save the second document, thereby instructing it to remem-

ber the name and location of the third.

12. Continue to connect as many documents as you desire.

Numbering issues

When you connect a series this way, Word will let you restart page num-

bers at the beginning of each separate document or let you create con-

tinuous numbers from beginning to end. Word can generate an index

and TOC using information gleaned from all the documents in your

series.

Line and paragraph numbering can be continuous or restart at

the beginning of each document in the series. These techniques are

described next.

Page Numbering
Assuming that you want page numbers to run continuously from the first

page in the first document to the final page of the last, click Continue

under the Page Numbers label each time you call up the File Series box.

If instead you want to define a specific starting number for the first

page in each new document, specify the new starting number in the

Number From box each time you call up the File Series dialog box. See

Figure 24. L Remember to do this for each document.
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Line Numbering
If you want line numbers to run continuously from the first page in the

first document in your series to the last page of the last document in

your series, you must check each document to see the last line number it

contains, then type the next number in the Number Lines From box in

the next file's File Series box. See Figure 24.1. There is no way to effect

continuous line numbering automatically.

Footnote Numbering
If you want footnote numbers to run continuously, you must check each

document and note its last footnote number; then you type the next

number in the Footnote section's Number From box in the next file's

Document dialog box. See Figure 24.2. If you want more detail, see Chap)-

terll.

Paragraph Numbering
Use the same open and look technique to determine starting numbers

for paragraphs. Open the next document and manually number its first

paragraph. Use the Renumber... command on the Tools menu to renum-

ber the rest of the paragraphs. Then note the last paragraph number
and visit the next document in the series, if necessary.

FIGURE 24.2

Open the preceding

document to determine

the last footnote number,

then enter the next

number in the following

document's Footnotes

Number From box

(located in the Doc-

ument dialog box).

rFootnotes
1



PRINTING MULTIPART DOCUMENTS

TOC and Indexes
Once you have all of your documents connected in a series (and all index

items marked in all documents). Word will create a TOC and index across

all members of the series. Be sure to give the command from the first docu-

ment in your series. Create them as usual with the Table of Contents... and
Index... commands on Word's Insert menu (see Chapter 23). Be patient.

Printing multipart documents
To print all of the documents in a series:

1. Open the first document in the series.

Z Be sure the Print Next File box is X'd in the Print dialog

box (Print... from the File menu).

3. Print as usual with the File Menu's Print command or §€-P

shortcut.

4b All of the documents will print in succession.

O I P

You can print individual documents in a series

separately by removing the X from their Print Next File

boxes.
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l^p^f/e nof strictly word processing tools, Word offers a

number of tools designedfor "power users, " the corporate

and small business environment. There are E-Mailfea-

tures, for instance, and ways to play QuickTime movies

from within Word documents. You can change the look

andfeel of Word ifyou like-change menu choices, add key-

board shortcuts and so on. Then there's Print Mergefor

creating personalized "junk mail" and similar projects.

System 7 users will want to read about Word's supportfor

their Macs' Publish and Subscribe capabilities.

Jjearn how, when, why, and why not to be a Word

power user here—in Part V.
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TRACKS

To use hidden text as annotations 604

select the desired text, dien define it as hidden with the 5€-Shift-X

shortcut, or open the Character dialog box (choose Character...

from the Format menu or use the ribbon hotspot and define it

as hidden). When printing, check the Print Hidden Text choice

in the Print dialog box (Print... on the File menu) if you want

the annotations to print. To hide hidden text, use the View

category in the Preferences dialog box reached from the Tools

menu. Consider adding the Show Hidden Text command to

your menu or Toolbar.

To retard voi<e annotations 607

on a microphone-equipped Mac, place the insertion point and

pick Voice Annotation from Word's Insert menu. Click on the

resulting Record button to begin recording. Speak so that the

Level meter stays in the left three-quarters of its range. The cir-

cular time meter will show you how much time you have left as

you record. Black means you are out of time.

To playba<k voi<e annotations 608

double-click on the voice annotation marker (a speaker). Use

the buttons to play, pause, and rewind.



To topY ond distribute voi<e annotations 610

copy annotation markers (speakers) just as you would any Word
character. Pasting a marker inserts its voice annotation at the

insertion point in the new document.

To <reate version 5. 1 annotations 611

position the insertion point, then use Word's Annotation...

command on the Insert menu. Pick a different marker if you so

desire. Type the note and click Insert.

To view version 5. 1 annotations 612

double-click on annotation marker of interest. Use the forward

and back arrows in the Annotations window to view other an-

notations. Use the Close box in the upper-left corner to close

the window.

To remove version 5. 1 annotations 614

select its marker and delete it as you would any other Word
character.
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USING HIDDEN TEXT FOR ANNOTATIONS

FIGURE 25.1

Hidden text has dotted

lines under it (top) and is

otherwise truly hidden

Ibottom) unless you check

the Show Hidden Text box

in the View category

of the Preferences

dialog box.

I Haue to Go I

Mustang's radials dropped off of 165th street onto the private dvct and

gravel vashboard leading to the airport I had a pretty good idea of vhat to

expect Thermals were cooking I was ready to /!y
'

Too much description here , Trim it •"

I like to park in the shade near the office but I didn't today Instead,

I stopped eight-hundred feet north, near the concrete block outhouse that

Geoff lokmpiv refers to a-: the m/oi! lounpfor
Num. Lock [Body* Kfi

'mt pik>te 'm'mis..,.

IQI

o
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I Haue to Go I

Mustang's radials dropped off of 165th street onto the private dust and

gravel vashboard leading to the airport I had a pretty good idea of what to

expect Thermals were cooking I was ready to rfy '

|1 like to park in the shade near the office but I didn't today Instead,

I stopped eight-hundred feet north, near the concrete block outhouse that

Geoff jokingly refers to as the piJo/s Joiirtgeor the studentpilots'nervous

room~t
, ^^____________„

101 gw:Num. Lock IBodij* 'Q

To define text as hideable:

1. Select the desired text.

2. Visit the Character dialog box (choose Character... from

the Format menu or use the ribbon hotspot).

3. Check Hidden in the Style area.

4 Click on Apply to view, or OK to set.

5. WTien printing, check the Print Hidden Text choice in the

Print dialog box (Print... on the File menu) if you want

the annotations to print.

O I P

The keyboard shortcut to define text as hideable is 9€-

Shift-X. This command toggles hidden text. If you use it with

hideable text, the text will revert to non-hideable text.
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Showing and hiding text

1. Use the View category in the Preferences dialog box
reached from the Tools menu.

2. Enable or disable the Hidden Text feature by clicking to

add or remove an X.

3. Click Close.

O I P

If you find yourself toggling hidden text frequendy,

add the Show Hidden Text command to a menu or the

Toolbar. You may wish to define a keyboard shortcut as well.

See Chapter 31 to learn how.

Voice-annotation—scoTTY
— WASN'T MISTAKEN

Have you ever seen that old Star Trek photo of Scotty trying to talk to a

Mac? Now it's possible. New Macs like the Ilsi, LC, and the high-end of

the PowerBook portable line come with microphones. They let you

record sounds to disk, then play them back. Owners of earlier Macs can

purchase sound recording accessories like Voice Impact, MacRecorder,

or Voice Impact Pro, available from computer dealers and mail order

firms. All Macs can play sounds recorded by any of these new devices.

Word 5 pro\ides a built-in software feature to control the recording

of voice annotations. It saves voice annotations with your Word docu-

ments. But before you toss out your pocket dictating machine, there are

some things you should know. Sound files are pretty big. One second of

speech requires nearly 30K of disk space when recorded in the Best

Quality mode. That means a minute of soimd might require as much as

2 Mb of disk space. There are RAM considerations as well.



VOICE-ANNOTATION—SCOTTY WASN'T MISTAKEN

If you use a Mac with 8 Mb of RAM and a huge hard disk, you will

be able to record reasonably long, wonderful sounding voice annota-

tions. Smaller machines and hard disks will necessitate shorter notes and

slightly degraded sound quality.

Once the appropriate soimd-recording hardware is installed and

configured (check your manuals for these things) , Word makes it easy to

record.

Recording voice annotations

Here are the steps for recording voice annotations on a microphone-

equipped Mac:

1. Place the insertion point where you want to attach a voice

annotation.

2. From the Insert menu, pick Voice Annotation.

3. If all goes well, you will see a dialog box like the one in Fig-

ure 25.2. It looks like the controls on a cassette recorder.

4 Click on the Record button to begin recording.

5. Speak so that the Level meter stays in the left three-quarters

of its range, as shown in the illustration. This makes sounds

easy to hear without distorting them.

b. Word decides how much time you will be permitted to speak

based on available memory and sound-quality decisions you

make in the Voice Annotation preference settings.

7. Based on these factors, the circular time meter will show

you how much time you have left as you record. It starts out

all white and turns progressively blacker as time rims out.

In Figure 25.2 about one-quarter of the permitted time has

elapsed. Stop slightly before the circle turns completely

black, or you risk being cut off abruptly.

& To pause while recording, click on either the Record or

Pause buttons. A second click resumes recording.
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9. You can play an annotation immediately after you've

recorded it by clicking the Play button in the Vcjice Rectjrd

dialog box, which will not be dim after you have recorded

something.

10. If you are satisfied, click OK to save the annotation in your

document at the insertion point. If you want to re-record

your note instead, either click Record again or pick New
from the Voice Record's File menu, then click Record again.

FIGURE 25.2

IfyoufMacis

sound-sawy, you will see

fhis dialog box when you

pick Voice Annotations

from the Insert menu.

Uoice Record

lie imt DuiiliUj i}\itmu:i

H0 1

Record Stop Pause Play

Level

:

Total:

( A 0:00:163 61 K

[ Cancel
|

Sound quality

Word provides three sound quality levels—Good, Better, and Best. The
better the sound the bigger your files. Experiment, keeping in mind mv
grandfather's favorite saying: There's good and there's good enough.

Playing voice annotations

You can play soimd annotations through Word 5.0 on virtually any

Macintosh.

1. First, using Word versions 5.0 or 5.1, open the Word 5 docu-

ment containing voice annotations.

2. Each annotation is flagged with a tinv speaker like the two

shown in Figure 25.3. The little varmints are only \isible if

you have the Show Hidden Text preference selected in the

View category of your Preferences dialog box.



VOICE-ANNOTATION—SCOTTY WASN'T MISTAKEN

FIGURE 25.3

Voice annotations are

flagged witli little

speakers, visible only with

Show Hidden Text enabled

Uoice samples

|N?« York ja [ii:ja rsuwi hi] e BiJH

^
3a ^mJH BFT^ B^ HEI KTil-^ -

41 -I? -13-

Hey, Bob, I can't figure out which of these guys to use in our new
radio spots Listen to both of these voice annotations and tell me
what you think I

it

Jimmy Stewart as Jimmy Stewart.^%

Rich LitUe 35 Jimmy Stewart f^;'1I



THE WORD FOR THE MAC HOW-TO BOOK Chapter 25

Sound annotation shortcuts

Shortcut fanatics will be pleased to know that the Voice feature is riddled

with key combinations:

" With the Voice Record dialog box in \iew, the §€-R combina-

tion records.

Tab pauses.

I6-. (period) stops.

To play, press 36-Y.

Bypass the Voice Record dialog box altogether by holding

down the Option key while picking Voice Annotation from

the Insert menu. Start speaking immediately. The status area

will give you a running description of what's happening.

m
Word S.l's text annotation feature may be reason

enough for you to throw away those Post-it notes and

upgrade from 5.0. Read about text annotations next.

Version s.rs text annotation
— FEATURE

This new feature lets you add reminders to yourself and notes to others

collaborating on your document. The notes can be completeh hidden,

flagged, or displayed and printed. When you are done with them they

can be deleted or incorporated into your final document.
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Inserting annotations

Creating annotations with version 5.1 couldn't be easier. Figure 25.4

illustrates the process.

1. Place the insertion point at the place in your document

where you want to insert the annotation.

Z Pick Annotation. . . from the Insert menu (not Annotations. .

.

on the View menu)

.

3> You'll see an annotation window like the one in Figure 25.4.

4. Either pick a new annotation mark from the drop-down list

shown in Figure 25.5 or use the proposed one.

FIGURE 25.4

Use the Annotation...

command on Word 5. 1 's

Insert menu to create

annotations.

Netiiiork manual

D® ]Q tjTWi mg imais b
iBodkj mrriii r^ic:]
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nnnotatjon

Typically, fouipl ex jacks are used The top two jacks are used for

telephones ar^d/ormodems (voice Imes) and the bottom two pcks are

Ircm]
used for network connections (data lines) *_ _ 'A few Iccahons Oike the

library) have two sets of duplex jacks one fcr voice lines and another for

data lines K

The data jacks are

while blue denotes Elhet

jacks IS t(^ticalirui eithi

sigpals i'^^^The cobr c

and troubleshooting ^

The data jacks (bu

panel in the server room
that corresponds to its fx

Insert I [
Cancel

Mention the jack map in the serverroon^, 0-
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5. Several of the marks can include your initials.

6> If you don't see your initials in the box to the left of the In-

sert button, and if you want them included in marks, click

in the box and type them.

7. To insert the note, click Insert.

FIGURE 25.5

Pick an annotation mafi(

from the drop-down list if

you don't like tlie one

Word proposes.

Viewing annotations

You view annotations with the Annotations... command from the View

menu. (Notice that this command is plural and the insert command is

singular since you insert one annotation at a time but can view more

than one at a time.)

1. Double-click on the annotation mark of interest in your

document, or use the Annotations. . . command on the View

menu.

2. To view the next or previous annotations, click on the for-

ward and backward buttons in the upper-right corner of the

Annotations window.

3b When you are done you can close the Annotations window

with the Close box in its upper-left corner.
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Editing annotations

If you open then change an existing annotation, you will be asked if you

want to save the changes when you close the window or move on to a dif-

ferent annotation. Answering Yes will save the changes.

Printing and incorporating annotations

Word creates a new untitled document when you want to print annota-

tions. The docimient will either contain a complete copy of the text and

notes from the original document, orjust the notes and some surround-

ing text. In order to print annotations, do the following:

1. Choose Annotations. . . from Word's View menu.

2. Click on the button to the right of the date in the annota-

tion window to convert annotations to text.

3. Wlien you see the dialog box illustrated in Figure 25.6

specify All Annotations to collect just the annotations and a

small amount of surroimding text, or Whole Document
with All Annotations To get the whole enchilada.

4k Word will open a new untitled document (shown in Fig-

ure 25.7) containing what you have requested.

5. Print, edit, save, or discard this new document as you would

any other.

FIGURE 25.6

This dialog box lets you

specify a document with

all your annotations and

only some surrounding

text, or a document with

all your text including its

annotations.

^^
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FIGURE 25.7

The new document

created to display

annotations and

surrounding text.

Untitled3

Da M [B_l^lul r^T^ PHi]^ B
["•'"""•'^ - ]Q Baaii B =T=i iHi^ m^nRTm nmn

-42 -45

L_»^ C

Typically, foutplex jacks are used The top two jacks are used for

telephories arid/ormodems (voice Imes ) and the bottom two pcksare used for

Ircm)
network connechons (data lines) *- 'A few lorations Qike the hbrary) have
twosets of duplev jacks one for icic e lines and another for data lines ^

IrcmI
i ' RCM

Maybe we should mention the differences at the receptionists desk too.>^

The data jacks are colorcoded Red normallydenotes PhoneNFT, while

blue denotes Ethernet The actual luinngoi the red arid blue data jacks is id£jdi cal

Jam)
and either can be used to cany Ethernet or PhoneNET signals a;^—'The color

coding IS simply and aid to network organisation and troub'leshioting

fAMl
i—''AM^

This vould be a good place to explain the differences between PhoneNET
and Ethernet. ^

The data jacks (but not the voice jacks) are all connected to a patch panel
in the serverraonn Each data jack has a handwritten 7?umier on it tl^t

/am)
corresponds to its postion on the patdi parisl .*C!Z.'^

fAMl
I—'*AM«-

Mention the jack map in the server room'

7

P3 S2 jheading 2 m:

Showing and hiding annotations

1. Use the View category in tiie Preferences dialog box

reached from the Tools menu.

2. Enable or disable the Hidden Text feature by clicking to

add or remove an X.

3. Click on the Close box.

lEa

Moving and removing annotations

Move and delete annotations by treating their annotation marks as you

would any other character in a document. Select them, drag-and-drop,

delete, copy, etc.
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TRACKS

To design and treate a data dotumeni 623

open an t-nipty, untitled Word dotinnent (New from the File

menu or5€-N). With the insertion point at the very beginning

of the empty document, choose Print Merge Helper. . . from the

View menu. You will see a modified Open dialog box. Click

the New button to bring up an empty Data Document Builder

dialog box, then type the name for your first field (title for ex-

ample), and press Return or click the Add button. Type the

next field name (first name for instance), and continue adding

field names until you are finished. The order of field names is

unimportant. Click OK in the Data Document Builder dialog

box to name and save the data document (a Word table) and

open an untitled main document. The untitled document will

contain a DATA statement pointing to your new data document.

To design and <reafe a main doKument 627

let Print Merge Helper insert the DATA statement at the very

beginning of your main document when you save your data

document. Type the body of the document normally, using the

helper's hisert Field Name menu, insert field names, keywords

and other data instructions as necessary.

To test and preview merge designs 631

run Print Merge Helper's error checking program by clicking

on the checkmark icon in the print merge help bar.



To print merged dowments 63

1

make your main document active, then either print all documents

direcdy to your printer by clicking on the merge to printer button

(the right-most icon in the print merge help bar that looks like

two sheets of paper and a printer); or visit the Print Merge dialog

box (Print Merge. . . from the File menu) , which gives you more

control over how many records are merged and printed.

To merge dotvmenfs to a new file 633

make your main document active, then either merge all docu-

ments directly to an untitled document by clicking on the

merge to file button in the print merge help bar (it looks like

two blank sheets of paper and a third sheet with lines) ; or visit

the Print Merge dialog box (Print Merge... from the File

menu), which gives you more control over how many records

are merged and printed.

To Itave Word asit operators for information 634

insert ASK instructions at appropriate points in the main docu-

ment. Read more about ASK in this chapter.

To liave Word perform tonditional printing 637

insert calculation, IF and other statements at appropriate places

in your main document. Read more about them in this chapter.

To show the print merge helper bar 64 1

with your main document active, choose Print Merge... from

Word's File menu, then click the Show Helper button.
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CREATING CUSTOM DOCUMENTS WITH PRINT MERGE

FrCURE 26.1

Print merge projects

require a data document

(top) and a main

document (bottom) to

produce new documents

that contain information

from botli.

Field
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Print merge can make simple decisions as it encounters certain con-

ditions. For instance, you can tell it to print a company name in the in-

side address of a letter IF the data for a customer in the data file contains

one, or ELSE close-up what would otherwise be blank space in the letter

when there is no company name. The devices that make this possible are

referred to as merge instructions.

Reality check

Before we dive into the details of Piint Merge... and its helper, it is worth

mentioning that, while most people use print merge for personalized cor-

respondence, it can be just as easily used to create custom forms, print

name tags, assemble legal documents, or crank out mailing labels. Keep

this in mind as you explore the wealth of print merge features offered by

Word 5. Once you imderstand these powerful tools you'll probably think

of many new uses for them.

By the same token, a few people try to use Word's print merge fea-

tures when they should switch to a more powerful database program like

FileMaker with its robust data entry, management and selection features.

Moreover, some Word print merge features require the use of simple

programming statements and techniques. WTiile anyone can learn these

things, it will take time and experimentation.

Unfortunately, a book this size cannot cover all of the problems or

contain recipes for every merge application you are likely to encounter.

Sometimes it will be quicker to cut and paste than to set up a new merge

design. Remember the old expression: When you get a new hammer,

everything looks like a nail. If you are starting a big, data-intensive

project, be sure you are using the right hammer.

About data documents
Data documents are organized collections of information (they're

databases, actually). As you will soon see. Word 5"s Print Merge Helper

can quickly lead you through the creation of a new data document. It

automatically stores data document designs as Word tables.
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Word can also use data stored as paragraphs or data from other

programs like Excel or FileMaker as data documents. Regardless of their

origin, data documents contain records and fields. For instance, in an

employee data document there is usually one record for each employee.

Each record contains multiple fields. There might be one field for the

employee's name, another for her home phone number, a third for a

work phone extension, etc.

About main documents
As you should recall bv now, main docimients contain a DATA statement

that refers them to a data docviment. They also contain the text of your

project (the body of a letter, for instance), and merge instructions.

Creating your first print merge
- PROJECT

The best way to learn how to create a print merge document is to try

one. Consider working along as you read the rest of this chapter.

Project overview

For each new project you'll need to:

Create a new data document

Enter information into the data document

Type and proof the text of your main document

Insert Data Instructions into your main document

Check for design and data-entry errors

Merge and print multiple documents

You need not follow this order exactly. For instance, you can create the

main document first and then create a data document, or vise versa.

Since data documents are simply Word documents containing tables, you
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can add information and edit them at any time prior to doing the actual

merge. Once yon feel comfortable with print merge concepts, feel free to

do things in any workable order that pleases you.

You need not type your main document first, but it is often helpful

to sketch one out or type a draft to get a sense of which information you

will need from data documents and where to insert it.

Planning your data document
Perhaps the most important part of a new project is the thoughtful

design of a useful, easy-to-maintain data docimient. If you are clever, you

can use the same data document for more than one project. For in-

stance, you might use a single, properly designed employee data docu-

ment with different main documents to print mailing labels, phone lists,

personalized memos, and name tags for the company picnic. The trick is

to think ahead when creating new data documents.

For instance, if you plan to use an employee data document to send

employees letters or memos, you might want one field for the employee's

full legal name, and another for an informal salutation. That way you

could address mailing envelopes to Dr. Norman Tirebiter and have the

salutation of your letters or memos read Dear Norm or Dear Doc.

On the surface, there doesn't appear to be anything wrong with

creating a single field for all the address information needed for letters

and labels. Many people do this. Then they type everything—the recip-

ient's name, company name, street address, city, state, and zip—in that

single field.

You should at least consider breaking an addressee's data up into

multiple fields. For instance, create separate fields for recipients' first

and last names. This will come in handy if you ever plan to use Word's

sort feature to produce alphabetized lists or labels sorted by last name.

Putting ZIP codes in their own field might let you to save money by sort-

ing bulk mailings by ZIP code, and so on.

Space limitations preclude a thorough exploration of the science of

database design—and that's what you are really doing here.



CREATING A DATA DOCUMENT
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It is always a good idea to test your new design with

small data documents containing a dozen or so representa-

tive records. Try your sample data dociunent with a number

of different main documents, or have an experienced print

merge user look over your new design before spending

hours entering data into your first data document.

Creating a data document
For your first few projects, start with data documents. You might want to

create a sample data document like the one back in Figure 26.1 at this

point. Here are the general steps:

1. Open an empty, untitled Word document (New from the

File menu or 36-N).

2. Make sure the insertion point is at the very beginning of

the empty document. You'll see why later.

3. Choose Print Merge Helper. . . from the View menu.

4. You will see a modified Open dialog box something like the

one at the top of Figure 26.2. It is asking if you want to lo-

cate an existing data document or create a new one.

5. Click the New button to bring up an empty Data Document

Builder dialog box, similar to the one shown in the bottom

of Figure 26.2.

6. Type the name for your first field (tide for example), then

press Return or click the Add button.

7. Type the next field name, and continue adding field names

unul you are finished. The order of field names is unimpor-

tant. For the tutorial, enter: tide, first name, last name, com-

pany, street, city, state, post code.
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FIGURE 26.2

To create a new data

document with Print

Merge Helper, start by

telling it which field

names to use.
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Some data document rules

Field names can be up to 253 characters long, but shorter is

usually better.

Don't use commas in field names if you are using the U.S.

version of Word.

Don't use colons in non-U. S. versions.

Do not use identical field names in the same data document.

When using Print Merge Helper, you can define a maxi-

mum of 31 fields.

To delete fields, highlight the unwanted field name in the

Data Document Builder's scrollable list, then click the

Delete button.

To edit names, delete the undesirable name and add the

correct one.

Saving data document designs

To save your new data-document design just after you've created it:

1. Click OK in the Data Document Builder dialog box.

Z When you click OK a new untitled document will appear

This will be your new data document. At the same time, a

standard Save dialog box will ask you for a name and

storage location for the new data document.

3. Name the document and specify a storage location if you

don't like the one Word has proposed. (Be sure you notice

where it will be stored.) Click Save.

4, Here's where things get a litde confusing. In the blink of an

eye. Word will open another new untitled document and

use it to create your data document (a table) using the field

names you've provided. The new table will flash on your

screen momentarily, then disappear This can be rather

alarming, so be prepared.
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5L Your earlier, untitled document (soon to be your main

document) will reappear and Word will insert the name
and location of your new data document at the top of this

main document.

6. At this point you will have at least two documents listed in

your Window menu—the data document and this new un-

titled main document. If you view them together at this

point, they might look something like the ones in Fig-

ure 26.3, sans names and addresses.

Word has created a table in the data document with field names at the

top (called the header record) and one empt\' row, ready for you to

enter the data for your first data record.

In addition, it has placed the name and location of the data docu-

ment (the path) in the untitled document that will become your main

FIGURE 26.3

A typical data and main

document (when you

create a data document

first) with the data

document's name and

path in the main

document.
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document. Notice the new bar below the Ruler in your main document.

It is called the print merge help bar. You'll use it later to create main

documents.

Entering and editing data

Enter, edit, and navigate in data documents as you would in any other

Word table. Save early and often. Place the insertion point in the first empty

cell of the data document (imder title in Figure 26.3) and type the data.

Tab to the next field needing information (first name in our example).

When you reach the end of a record, tabbing again will create a new row

for your next record.

D I P

If you are using a single field to capture multiple lines

of data (we are not in the sample exercise) type the first line

then press Shift-Return to enter a new line in the same field.

When all of the lines have been entered in a field, tab to

the next.

Creating a main document
Main documents contain the following things:

The name and location of the associated data document.

Text and pimctuation (the body of your document).

Merge instructions and field names used by Word to

merge data.

Figure 26.4 shows a main document for your practice form letter. We'll

discuss the various elements in detail.
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FIGURE 26.4

Your Main document will

look like this one if you

follow along.

Print Merge Sample Main Doc

ICoun^i

:l^l^l^l

bTTTuI i:^^ IbST^ E l
= isgM

IT III fT^Tn
-4* -45

Insert Field Name [Insert Key w a a El offl
"DATA Ron's IIcx:Desktop Folder:Print I-Ierge Sample Data»^

Ajr Heads Inc -^

124lnciustriaJ Wayfl
BayDn. m 12345^

NdveTn&er 11, 1992'!
1
«title» «£ijrst name* "last naiiie»'fl

ocompany »'^^

«stjreet» V:

«city», «state» «post code»-lf

Dear «title» "last naTne»:^

Thank you for your interest in our coin operated tire pumps
for gas stations. It is true. You can make big bucks selling
nothing but airlf?

Page 1 INormal jKi:

The data statement

Each main document must begin with the (non-printing) name and loca-

tion of the associated data document. This needs to be the very first

thing in a main document. It is called the DATA statement. You must

place it before even your letterhead or other design elements.

As you saw earlier, Print Merge Helper can place this information at

the beginning of the document for you if you properly position the inser-

tion point in your main document before using Print Merge Helper to

create a data document.

In Figure 26.4, Word will merge data from a data document called

Print Merge Sample Data located in the Desktop Folder folder on the

hard disk Ron's Ilex.

Text in main documents

Use Word 5's word-processing and graphics arsenal to create text and

design elements in your main documents. In our exercise, an industrial-

strength letterhead has been created by typing the return address in

Helvetica and centering it.
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The body of the letter was typed (in Courier) using regular Word

techniques, with data instructions containing field names and other

merge devices inserted as needed.

Inserting data instructions

Print Merge Helper makes it easy to insert field names and other data in-

structions in your main documents. Place the insertion point where you

want to insert a data instruction, then pull down the appropriate list

from the help bar and pick the item to insert.

For example, to insert the title field name in Figure 26.4, you would

place the inserdon point on a new line after the date. A quick trip to the

Insert Field Name menu (shown in Figure 26.5) on the print merge help

bar, would insert the field name dtle and the required print merge char-

acters (« and ») on either side of the field name.

FIGURE 26.5

Typical Inserl Field Name

and Insen Keyword

menus, located on the

print merge help bar.

company

street

city

state

post code

SequenceNumber

RecordNumber

Define New Field

Deal" o<title»

Insert Keyword

esktop Foldejr: Print
Pir Heads Inc.

124 Industrial Way
Bavcn, NJ 12345

e» "last name"
.ny»

)st code»

Insert Keg word

IF... END IF...

IF...

ELSE

END IF

ASK...

SET...

INCLUDE...

NEXT
DATA
CateulaWons... i^W
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Wlien preparing the text of a main document, don't forget to in-

clude things hke the space before a field name and any required punctua-

tion following it.

As you'll see in a moment, you can use combinations of keywords

from the Insert Keyword list, and fields from the Insert Field Name
list, and text typed from your keyboard to construct powerful merge

instructions.

Try IT

Take a moment now to recreate the sample pitch letter and some sample

names and addresses. Refer to Figure 26.4 as you work.

1. Use I2-point Helvetica to create a centered return address

after the DATA line in your main document.

2. Switch to Courier.

3. Use the Date command on the Insert menu (or a Print date

glossary entry if you prefer)

.

4k Press Return to start a new line.

5. Insert the dde field with the insertion point on the new line

by choosing title from the drop-down Insert Field Name list

on the helper bar. Do not press Return.

6i. Type a space to separate the title and first name fields.

7. Use the Insert Field Name list on the helper bar again to in-

sert the first name field. Do not press Return yet.

8. Add a space and insert the last name field.

9. Now, press Return to start a new line.

lOl Add company, street, city, state, post code, and their neces-

sary punctuation and spacing.

11. Type a salutation (Dear ), then add title and last name
fields followed by a colon.

12. Type the body of your letter.

IX Save your main document.
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14. If you haven't already done so, switch to your data docu-

ment and add two or three names and addresses. Leave the

company field blank in at least one. (Jane's in our example

shown back in Figure 26.3.)

15. Save the data document.

Testing and proofing

Before cranking out a hundred or even a dozen letters, it is a good idea

to proofread your work. Use Word's spell checker and grammar tools.

Make any necessary corrections. Then, run Print Merge Helper's error

checking program by clicking on the checkmark icon in the print merge

help bar. It will inspect your data and main documents looking for

problems like missing data fields in the data document and misspelled

field names in your main documents. (Try it on your sample main docu-

ment if you are following along.)

As a final check, you may want to merge some or all of your docu-

ments to a file and inspect them rather than printing out the whole

batch. You'll learn how to do this next.

Printing merged documents

Records are always merged and printed in the order they occur in yoiu"

data document. If necessary, sort your data document before merging. It

is possible to restrict printing to only records containing certain data by

using IF commands, explained later in this chapter in the section Merge

Instructions.

With your data in the desired order:

1. Start the merge process by making your main document the

active document (click in it if necessary).

2 You can either print directly to your printer by clicking on

the right icon in the print merge help bar, or you can ask

Word to create a new, untitled document containing all of
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your merged documents. Click the middle merge button in

the helper bar to do this. (If you merge to a new untitled

document, you can inspect everything on screen and print

later.)

3. All three of the print merge help buttons merge every

record in your data document.

4b Visiting the Print Merge dialog box (Print Merge... from

the File menu) gives you a little more control over how
many records get merged. You will see a dialog box like the

one in Figure 26.6. Here you have the same choice of test-

ing for errors, printing to the printer, or creating a new, un-

titled document, but you also have some say in how many
records are merged.

5. Specify a range using the From and To boxes. For instance,

you could specify from 1 to 10 or from 25 to 50. Each new

record begins on a new page.

6. Merging begins. To stop merging press S€-. (period) or the

Escape key.

If you haven't already, try it. Notice the unsightly blank line in inside

addresses without company names. As, you'll see in a moment, there are

ways to eliminate these.

FIGURE 26.6

To merge, click on the

appropriate print merge

help bar icon or visit the

Print Merge dialog box,

shown here.

Print Merge

Records-
(«)RII
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Using word's merge instructions

Word provides a number of ways to change its behavior based on the con-

tents of individual records in your data document. For instance, it can

eliminate unwanted blank lines like the ones in your exercise. It can in-

sert special text if certain conditions are met, or stop during each merge

to let you enter unique text from the keyboard. Be prepared to spend

some time experimenting and troubleshooting if you decide to use these

features. Figure 26.7 shows several examples of merge instructions.

FIGURE 26.7

This form letter uses

merge instructions to

eliminate possible blank

lines in addresses,

perform math

calculations, and ask the

operator for information

from the keyboard.

Eagles' Hauen student melcome ^

iR fTF-iR ibtttui r^q;^

pa ^ggW B^^ Bf^ BEITTTTTl BUT - -
B mnm o

J?- 4i -1- -P -14 -45-

I

Insert Field Name w\ [insert Ketjword zi a Dai Dffl
DATA 210MB E ict « i na 1 ; % Wo r d 5 examples for

I ookiStu dent Welcome d a I a > -

Eagles' Haven Soaring School
122 Cactus Road + Las Vegas. N' -1134 "

January 4, 1992?
«name»i
«address 1»'*

«IF address 2>K<address 2»<-"

«ENDIF»«csz»'<i

Dear «salutation», I

Welcome to the Eagles' Haven soaring school i We hope you will

enjoy the thrill of silent glider flight as much as we do -1

«instructor» will be your primary instructor As you know, the

total fee for the course is $«fee» We have received your deposit of

$«dep» and would appreciate it if you would bring the remaining

$«fee-dep» vnth you when you come for your first lesson , you will

also need to complete the medical and liability release forms before

your first flight Bring sunglasses, sunscreen and a v^de-brimmed hat

We'll supply your first log book, the glider and the smiles -i

•J

Sincerely,'!

H

<«

W. Wright I Is!

WWII/mosJ
-1

PS Here's the phone number we have on file for you: «phone» is it

correct '?Tl ^
|Normal*... |<^[Page Q
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Calculations.

Calculation instructions let you insert numbers in merge documents

based on the contents of records. When creating a main document, use

the Print Merge Helper to insert the Calculaticjn instruction at the inser-

tion point in your document. Choose Calculations... from the Insert

Keyword menu. You will see a dialog box like the one in Figure 26.8.

FIGURE 26.8

Use the Insert Calculation

feature to compute and

insert numbers in merged

documents.

Insert Calculation

Field or Ualue:

la

/

Field or Ual

dep ^^^]a
[Cancel

J

Use the drop-down menus in the Insert Calculation dialog box to

specify fields or values and the type of calculation you wish to perform.

In Figure 26.8 Word will subtract the deposit found in the dep field from

the fee found in the fee field. You can use calculations with other instruc-

tions as you will see in a moment. For instance, it is possible to print text

if the results of a calculation warrant it.

Ask.

The ASK feature will cause Word to stop during the merge process to ask

you for keyboard input to be printed. It will stop each time a new record

is merged and prompt you for a keyboard entry.

This feature is normally used to include data in main documents

that has not been stored in the data document. Suppose, for example, that

you were creating ten new-student welcome letters like the one in Fig-

ure 26.7, and that you wanted to enter a date and time for each student's

first lesso!!. Suppose further that your data document does not contain a

field for first lesson dates and times.
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Setting Up an Ask Entry

Wlien designing your main document, move the insertion point to the

beginning of a line near the top of your document (following the DATA

statement). Then pick ASK... from the Insert Keyword menu on the

print merge help bar. Word displays a dialog box like the top one in

Figure 26.9.

You would use this dialog box to create a new field unique to the

main document (not the data document). Click on Define New Field,

then type a new, legal merge field name (first lesson in our example).

You can also enter a message that you want to see whenever you are ex-

pected to type from the keyboard. In Figure 26.9 the prompt would be

Start day and time.

Next, insert the corresponding field name («first lesson» in Fig-

ure 26.9) in your main document wherever you want the contents of the

ASK entry to print. The ASK instruction goes beneath DATA near the

beginning of the document, while the field names themselves are em-

bedded. (Look ahead to Figure 26.1 1 to see where this should go.)

FIGURE 26.9

The Insert ASK feature

(top) creates prompts for

keyboard entries wlien

you merge (bottom).

Field Name:

first lesson

Insert flSK

B
Prompt:

[ Define Nem Field...
]

Start day and time
(cancel

]

Print Merge

First lesson day and time

Tuesday, January 21 at 10:30 Rl^

eg Jj
[stop Merge]
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Using ASK
When you actually merge your documents (ten letters, for instance)

Word will ask you for ten lesson dates and times—one for each student's

letter. You'll see a dialog box like the one at the bottom of Figure 26.9

for each student. Here, you enter the day and time then click OK or

press Return. (In a moment you will see a finished document including

this feature and the results it produces. First let's look at SET...)

Set.

SET... works like ASK..., except that you are prompted once at the begin-

ning of a merge print, and your keyboard entry is used for all documents

being created. For instance, you could use it to insert Winter in the

semester field in winter, Summer in summer, and so on.

Inserting a SET... Field Name
When designing your main document, move the insertion point to a line

near the top of your document (following the DATA statement). Choose

the SET... choice from the Insert Keyword menu on the print merge
help bar. Word displays a dialog box like the one in Figure 26.10.

Use this dialog box to create a new field unique to the main docu-

ment (not the data document). Click on Define New Field, then type a

new, legal merge-field name (semester in our example). If you check the

equals sign in the drop-down menu, and type a value in the value box

(Winter, for example) Word will print that value in each document imtil

you change the Insert SET statement. If you choose the =? choice on the

drop-down menu. Word will ask for a SET value each time you use the

Print Merge... command on the File menu.

FIGURE 26.10

The Insert SET dialog box.

=====^============ Insert SET
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You can also enter a message that you want to see whenever you are

expected to type from the keyboard.

Using SET
Wlien you actually merge your documents (ten letters, for instance),

Word automatically prints the defined SET value in each student's letter

at the points where you've inserted the field names.

Examples of set and ask at work
Figure 26.1 1 shows a main document containing a SET and ASK instruc-

tion near the top of the document, below the DATA line. The body of

the letter contains the field names semester and first lesson where you

want the SET and ASK information to print. The bottom part of Fig-

ure 26.11 shows the results.

Eliminating blank lines

Notice the three blank lines (paragraph marks) at the top of the sample

merged document in Figure 26.1 1. They're caused by the DATA, SET,

and ASK lines in the top of the main document. To prevent this, high-

light all three paragraph marks in the main document and use the Char-

acter dialog box to define the marks as hidden text. Or use the hidden

text keyboard shortcut, 3€-Shift-X. You must also make certain that Show

Hidden Text is not checked in the View category of the Preferences

dialog box.

IF...,ENDIF..,ANDELSE

You use IF..., its required companion ENDIF..., and frequently ELSE to

cause Word to do different things, based on conditions it finds in fields

in your data documents. For instance, you could have Word check the

data document to see IF the deposit the student paid was equal to the

total fee for the course. If the student had paid the total amount due you
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FIGURE 26.11

SEI and ASK place

variable information in

your merged documents.

Eagles' Hauen student luelcome

J0_
ja mM lB sm or^m^m mw-

-+- -4? -4- -+- -+-

••DATA 210MB E xt e r n a 1 : % Wo r d 5 examples for
book:Student Welcome data'-'J
••SET s e me St ei= "Wint ei ".• t

•ASK first 1 e s 5 o n = ?S t a It day and time- r

Eagles' Haven Soaring School
122 Cactus Road + Las Vegas, NV 7112 * <7 3 )5 5 5 - 1 1 3 4

-J

January 4, 199211

«name»<B
«address 1»<1I

«IF address 2»«address 2»-^

«ENDIF»«csz»n

Dear «salutation», I

Welcome to the «semester» semester of Eagles' Haven soaring

school! We hope you will enjoy the thrill of silent glider flight as much
as we do 3

«mstructor» will be your primary instructor Your first lesson will

be on «first lesson» As vou know, the total fee for the course is

Page 1 INormal* :m:

o

li

-1

Eagles' Haven Soaring School
122 Cactus Road •> Lf NV 7 112 * (70 3)555 -I 134>fl

January 4, 19921
Mr Ira Flato'I

555 Apple Orchard Road'i

Newton, NV 700231

Dear Ira,<il

Welcome to the Winter semester of Eagles' Haven soaring school!

We hope you will en)oy the thrill of silent glider flight as much as we
do.-i

Hal Bonney will be your primary instructor Your first lesson -will

be on Monday, January20, at 10:30 AM As you know, the total fee for

the course is $2,000 We have received your deposit of $200 and

might have Word insert a sentence in her letter thanking her for the

total payment; otherwise, ELSE would calculate the amount due and

print a sentence requesting the balance.

IF statements can be used to prevent the printing of blank lines if a

field is empty in a record. Figure 26.1 1 contains an example. In this case,

Word checks to see if the «address2» field is empty.
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IF statements can also compare numbers or text. IF uses the follow-

ing standard comparison operators;

= (equals)

< (less than)

<= (less than or equal to)

> (greater than)

>= (greater than or equal to)

<> (not equal to a number or non-matching text)

Field Not Empty (checks for non-empt)' fields)

AND (a record must meet multiple conditions)

OR (a record must meet at least one condition)

NOT (the specified field must not meet the condition)

You can construct IF-ELSE statements in a number of ways. For instance,

Figure 26.12 illustrates an IF-ELSE combination that does a math com-

parison on numbers in two fields and prints different sentences based on

what IF finds. Notice that the ELSE sentence contains more math.

Place IF statements where you want them to work. Do this by

moving the insertion point to the appropriate place in your main docu-

ment. For instance in Figure 26.12 the inserdon point was placed after

the period and space following fee».

Use the Insert Keyword drop-down menu choices to speed the con-

struction of IF-ELSE, and ENDIF combinations. For instance, when you

choose IF... ENDIF... or related choices you will see a dialog box Uke the

one in Figure 26.13. It is asking for the name of a field to compare in

your data record, and a value to compare.

FIGURE 26.12

A typical IF-ELSE
«mstructor» will be V'Mjr primary iiiitruit-r Yovr iiiit l-^aori v.nll

b" -r^n f ir?t lesson 'Mjon know, the total fee for the com-se is

combination prints l^feew «IF d©p=f«'«»Tbanks for your payment in full. «ELSE»W«" have

different sentences based received your deposit of $«dep» and vrouid appreciate it If you would,

bring the remaining $«fee-dep» with you when you come for your

first lesson. «ENDIF»«You will alsv ii<?ed to complete ai>r ineciical andon numbers found in the

data document
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FIGURE 26.13

The Insert Keyword menu

contains choices that bring

up this dialog box to

speed construction of IF

statements.

A drop-down menu in this dialog box lists all of the available field

names. When you click OK, the statement and merge marks will be in-

serted in your document. While these shortcuts can help you construct

IF statements, you may still need to edit them from the keyboard.

Include.

Like an automated version of the Insert File. . . command, INCLUDE will

place the entire contents of a specified external file in your Word main

document when you run a print merge. For instance, if you created a stu-

dent phone-list document, and wanted to include that list in the body of

each student letter, you could place an INCLUDE command at the ap-

propriate spot in the main document.

Wlien you insert the INCLUDE command using Word's Print

Merge Helper, Word will present a File dialog box and ask you to locate

the desired file. Documents you include can also contain INCLUDE state-

ments, making it possible to nest them.

Nfxr
NEXT is useful when you want Word to move on to the next record in a

data document without starting a new page. You might want to use this



IFYOU DON'T USE PRINT MERGE HELPER

to print different labels on a page or to create a list. Place the insertion

point at the location in your document where you want Word to switch to

the next record and choose NEXT from the drop-down Insert Keyword

menu on the print merge help bar.

Data

The DATA... choice on the Insert Keyword menu lets you replace the

DATA statement at the top of your main document, thereby changing

the data document used with the main document. You can have only one

DATA statement in a main document.

This command will highlight your old DATA statement, then

present a File dialog box, which you use to select the desired data docu-

ment. Word will insert the replacement DATA statement, including the

word DATA, the path, and the required merge marks.

Try IT

Try to apply some of the tricks you've just learned. See if you can get the

blank line to stop printing in your pitch letter. (If you get stuck, peek at

Figure 26.11. It contains the necessary IF... and ENDIF... entries.

Also experiment with ASK and SET. Try some calculations.

If you DON'T USE PRINT MERGE
- HELPER

It is possible to construct everything you need for a merge project

without using the new Print Merge Helper. Just be sure you follow the

merge rules. Data statements must be at the very top ofyour main docu-

ment, merge marks must appear where required and so on.
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m A R N I N G

To manually insert merge marks « and », do not use

greater than and less than characters! They won't work. Use
the keyboard combinations OptionA and Shift-OptionA to

insert « and >>.

Restarting stopped merges
If you are running a merge project and must stop before all documents

have been printed due to a printer error or other problem, it is often pos-

sible to pick up where you have left off. The best way is to count the num-
ber of successful documents printed then enter the next number in the

From area of the Print Merge dialog box (shown back in Figure 26.6).

For instance, if you tried to print ten letters and had a printer problem

after the sixth letter printed, place 7 in the From box.

WORD'S PREDESIGNED LABELS— AND ENVELOPES

Word is shipped with stationery for various kinds of blank labels and en-

velopes. Look for them in the Mailing Labels and Envelopes folders in

the Sample Documents folder. You can use this stationery to create main
documents for your mailing projects. Figure 26.14 shows you which

stationery documents Microsoft recommends for popular styles of Avery

brand labels.

Printing labels on laser printers

To print labels on a laser printer, you start by creating a main document
containing a table with fixed-size cells and cell spacing that match the

size and position of your blank label stock. Then you insert merge
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FIGURE 26.14

Miffosoh's recom-

mended stationery

documents for

popuhr styles of

Avery brand labels.

Laserprinters
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With appropriate DATA and merge instructions in place, Word can

properly merge addresses with your main document (label table) and

voila! You are in the mail order business.

Here are the general steps. Try them with the sample data you

created earlier, and print on inexpensive plain paper, not costly labels

until you get the bugs out.

1. Open the appropriate label stationery. (We've used LW 1 X
4, 2 up (20) for this exercise.) Look for it in the Laser

Labels folder in the Mailing Labels Folder in the Sample

Documents folder in your Word folder. Phew!

2. You'll see an untitled main document like the one in

Figure 26.15.

3. Choose Print Merge Helper from Word's View menu.

4. You will be asked to find your data document. Locate and

open the sample data file you created earlier.

5. Word will highlight the DATA instruction in the untided

main document and ask ifyou want to replace it with a DATA
statement pointing to your data document. Answer Yes.

6. Cut all five lines from the top of your main document (the

DATA and merge instructions) and paste them into the top

left cell of the table.

FIGURE 26.15

Start label projects

with pre-defined label

stationery like this from

Word's Sample Docu-

ments folder.

-di^TA Hard Dsh Sample Doci/nents Nteiling Labels ^Wdress File»

•titleoafiret name- "last name»
«IF 03mpany"<ompany*l
-ENDIF"Street»?
«:jtyo, «tate» tjjost gpde»5 _ __

Page 1 s: lEa
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7. Copy the second through, and including, the last line to

your Clipboard.

& Move the insertion point to the top right cell in the main

document.

9. Use the helper's Insert Keyword list to insert the NEXT
keyword.

10. Press Return.

11. Paste the merge instructions below the NEXT keyword.

12. Copy all five lines from the top-right cell in your main docu-

ment and paste them into all of the remaining cells. Your

screen should look something like Figure 26.16.

13. Save your main document with a meaningful name!

14b Take the plunge, try a merge.

Microsoft has provided a Mailing Labels ReadMe file that explains the

procedures for different printers and situations. It is worth reading.

Look for it in the Mailing Labels folder (you know where).

FIGURE 26.16

The main document

ready to go.

-CWTAHaidDsh SEmcte CDonerns Nte*Tgl£fcelsAtire» Fte"'

title •first rame» "last name »-

IF company••company* +

«ENDIF"Street» M

•city*, «st3te» -post code* -

• _ _„
""iiiiExt-'"

«(title» "first name* "last name*fl
«lf company-<company»*l!
«ENOIF"Street. H

'City. "State* <post code»*^

"NEXT."
title* "fifst name* "last name»5
«1F company»<ompany« 11

«ENDIF..street*'ll

•city*, "State- <fiost cocie»'^

iNEXT*-
«title* "first name* "last name»"?
«IF company*<ompany»'li
«ENDIF«stfeet->'«

<;ity», -state* iaosicocte*^

""«NEXfi*
-

title* "first name* "last name fl
«IF a)mpany»<ompany*4i
.ENDIF*"Street»ii

"City*. "«tate* -^jost code* *

:mcvt-t
Page 1 :sn

otitic. «fifst name- -last name»^
«IF cooiparvcompany^^f
.ENDIF»«street-1!

city, Mstate-^ -^ostoDde-*

liUPYT.r ,MilIWU«il,|MUlW [SB
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Printing addresses on imagewriter labels

Use the appropriate Microsoft label stationery for your labels or create a

main document from scratch. Here are the steps for creating a single

colimin continuous label main docimient for ImageWriters and other

tractor-fed printers:

1. Open a new document (§€-N).

2. Use the View menu's Print Merge Helper... command.

3. Show Word the location of your data document.

A. Use the helper's Insert Field Name list. Insert Keyword list,

and your keyboard to set up the mailing address.

5. Save the main document.

6. Choose Preferences from the Tools menu.

7. Enter the label width in the Custom Paper Size Width box

and the appropriate height in the height box.

& Click OK.

9. Open the Page Setup dialog box and select the Custom

Paper Size and No Gaps Between Pages options.

10. Choose Document. Enter zeros in all but the left box. Enter

a small measurement like 0.2 there.

11. Load labels into your printer.

1Z Choose Print Merge... from Word's File menu.

13. Print a test label (place 1 in the From and To boxes).

14 Adjust the position of the label stock repeatedly until yoti

get it right.

15. Merge ho.
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Printing addresses on envelopes

Ifyou plan to use print merge instead of version S.l's envelope feature,

start with Microsoft's handy envelope stationery. Insert a data statement

before your return address, and replace the name and address lines in

the stationery with appropriate merge instructions.

Tips, techniques, and
- troubleshooting

To change the appearance of merged characters (change

fonts, underline, etc.), format their merge instructions in

the main document. Merged characters take on the ap>-

pearance of their merge instructions.

• Ifyou move your data files, Word will ask you to relocate

them before you can merge.

Don't use greater than and less than signs to enter merge

characters. They look a lot like merge characters but are

not substitutes.

To print selected items from a longer data file, sort them

and just print the range containing the desired records

(from 10 to 30, for instance).
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TRACKS

To treate a graph in version 5.

1

653

place the insertion point where you want the graph to appear

in your Word document. Click on the Graph button in version

5.rs ribbon (it looks like a bar graph), or choose the Microsoft

Graph Object type in the Insert Object dialog box reached

from version 5.rs Insert menu. T)pe numbers and labels into

the datasheet window, select the desired graph type and other

opdons. Quit the Graph program (3€-Q) to embed the chart in

your Word document.

To position embedded graphs 672

use normal paragraph positioning techniques (margins, Center

paragraph formatting, etc.), or frame them and use frame tech-

niques for positioning.

To resize or <rop embedded graphs 673

select them and hold down the Shift key while you drag the

handle in the chart's lower-right corner to change its size. Drag-

ging without liolding down the Shift key crops the graph.



1/
s

To edif embedded graphs 673

double-click on them in your Word document to open

Microsoft Graph.

To delete graphs 673

select them and delete as you would any other selection.
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GETTING STARTED IN VERSION 5.1

What you need

You must be running System 7.0 or greater to use Microsoft Graph. If

you've installed Word using the Easy Install option, Microsoft Graph

should be ready to go. If the program was not installed, run Word's in-

staller to add it.

Getting started in version 5.1

The general steps for creating a giaph are so simple that you can be off

and running in a flash.

1. Open a Word document and place the insertion point

where you want the new graph to appear.

2. With the ribbon in view (S8-Option-R), click on the ribbon

button that looks like a column graph or skyscrapers.

3. In a moment you'll see a datasheet window that looks like a

small spreadsheet and a chart window (also called a graph

window).

4k Enter data and labels into the datasheet window.

5. Notice that Microsoft Graph's menu bar (shown in Fig-

ure 27.1) is very different from Word's. Pick a new graph

type from the Gallery menu if you wish.

6. Using Microsoft Graph's menu commands, embellish the

graph with text, arrows, different type styles, etc. Resize the

actual graph by dragging the size box in the lower-right

corner of its window.

FIGURE 27.1

Because Microsoh Graph

is a separate program, it

has its own menu bar.

^t File Edit DstaSeries Gallery Chart Format tUmdout _m
Hide Microsoft Graph

Hide Others

Vhuiu Hli

Q Finder

I

I^MHrosottLUord "
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7. When you are ready to insert the finished graph into your

Word document, choose Microsoft Graph's File menu's

Quit and Return choice or use the 3€-Q keyboard shortcut.

& Click on Yes to update the graph.

9. You'll see your Word document again, this time containing

the new chart.

10. Caption, resize, reposition, frame, apply a border, and

otherwise embellish the chart and its surrounding area as

you would when dealing with any other graphic object.

11. If you want to make changes to the content and appearance

of the chart itself, double-click on it in your Word docu-

ment to launch Microsoft Graph and make the necessary

changes.

Parts of a graph project

There are three parts to any Graph project—the datasheet window, the

chart window, and the Graph object that gets embedded in your Word
document. Let's look at each separately. Figure 27.2 shows the first two

elements—the Datasheet window and Chart window.

Datasheet window
The datasheet window is where you enter all of the numbers and much
of the text that will be presented graphically. It will remind you of a

spreadsheet. When you start Microsoft Graph, you'll see a datasheet like

the one in Figure 27.2, complete with sample data. The parts of the win-

dow are described next.

Cells

The individual rectangles containing numbers and text are called cells,

just as they are in a spreadsheet. You can type and edit in cells just as

you'd expect.
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FIGURE 27.2

Graph's Datasheet and

Chart windows.

Only cells witti black headings

ore included in your graph

Tick-mark labels

Data series names -

The active cell

Each shade represents

a different series

Datasheet window A series (1 of 3)

lines

.

The plot area

Y or Value axis
Chart window

X or Category axis

The Active Cell

To work in a cell you must first make it active by clicking in it. The active

cell is surrounded by a dark border. In Figure 27.2 the active cell con-

tains the number 20.4.

Ro>vs and Columns
Cells are arranged in horizontal rows and vertical columns. A datasheet

can contain a maximum of 1,024,000 cells (4,000 rows X 256 columns).
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Ro>v and Column Headings
Those black boxes at the top and along the left of the datasheet in Fig-

ure 27.2 are row and column headings. When they are solid black their

corresponding data will be included in a chart. When they are gray

(dim) their corresponding data will not appear in your graph. Double-

click on headings to toggle them.

Data Points

Each cell containing a value is a data point.

Data Series and Double Lines

A collection of related cells is called a data series, hi Figure 27.2 there

are three series—one for East, West, and North. Each series contains

four data points. Double lines in a datasheet window separate each data

series.

Series Names
Series names are in the left-most cells when a data series is plotted in

horizontal rows. Series names are at the top of vertical columns when

your graph will be plotted in columns.

Tick-Mark Labels
Tick-mark labels are the names that appear along the horizontal axes of

area, coluinn, and line charts, or along a bar chart's vertical axis. In Fig-

ure 27.2 the tick-marks are 1st Qtr, 2nd Qtr, and so on.

Chart window
The chart window has its own terminology to understand. Here are the

ba.sics.

The Chart
Everything inside the chart window is considered to be part of the chart.

This includes the bars, pie wedges, labels, arrows, and so on.
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Data Markers
Data markers come in various shapes depending upon the graph type.

They are bars in bar charts, lines in hne charts, and pie wedges in pie

charts for example. Each marker represents the value of a single data

point or value.

Data Series

Just as a data series in the datasheet represents a group of data points, so

does a data series in the chart windows. Figure 27.2 has three data series

represented by three different shades of data markers.

Axis
An axis is a line along which data are plotted. Two dimensional graphs

like line and bar graphs usually have a horizontal (or X-axis), and a verti-

cal (or Y-axis). 3-D charts have a third axis, called the Z-axis.

Tick Marks
Tick marks are the intersections ofX and Y axes. They are usually

labeled with tick-mark labels.

Gridlines

The gridlines are those optional vertical and horizontal lines that make it

easier tojudge values on a graph.

Chart Text
Microsoft Chart text comes in two flavors—attached text used for things

like data and axes markers, and unattached text which you can add by

typing it. Use unattached text to point things out.

Legends
Legends are little reference boxes that tell you which shades (or colors)

are used to represent each data series. You can hide legends if they are

unnecessary or get in the way.
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Graph objects in word documents

Wlien you quit Microsoft Graph it embeds a graph object in your Word
document. Objects can be resized, cropped, surrounded with borders,

and so on. Treat graph objects as you would any other embedded object.

See Chapter 28 for more information. Figure 27.3 shows a typical graph

object in a Word document.

FIGURE 27.3

A graph object in a Word

document.

MS Graph In Mpmo
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InterOffice JHemo;
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Froni-^ ': Nem^oik R8!?%tc>i«

Date« : NovembeiU, IMl*

W
Our research shows that the naton is facing a record shortage of

humor Please keep this in mind when you write If there's a car chase, be

sure the bad guys hit a vegetable cart Be creative there must be things we

can do with stuff like septic system pumping trucks, jokes about crepitating

and so on Make us laugh, damniti Bring back Gum^ if that's what it takes!

This chart says it all'l

Hum or Sh ortage

-fmWmM I Irrl J:

Vtel

DNotlh

IstQlT fndQir Jrd Qd 4lhQt[

Page 1 |Normal+... :m: Q

Getting on line help

On line help (or "hep" as some folks call it) can be reached from the

System 7 balloon menu, or with the 3€-/ keyboard shortcut. Microsoft

documentation not withstanding, the Fl extended keyboard shortcut will
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probably not work in the Macintosh version of Graph. In any case, you'll

see a help window like the one in the top of Figure 27.4.

Point to a topic of interest to read about it. Use the Previous, Next,

and Back buttons to navigate.

FIGURE 27.4

Get help from the

Balloon Help menu or

withGraph'sX-/

keyboard shortcut.
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D
Some key words and phrases like the one highlighted in

the bottom of Figure 27.4 can also be expanded by pointing

to them. They are underlined and easy to spot. Point and

click to read more about underlined words and phrases in

help windows.

Working in the datasheet— WINDOW
Use the datasheet window to enter data. It behaves so much like a Word
table that a quick review is all that should be necessary. Here are some tips:

Entering and editing cell data

Click in the datasheet window to activate it, then click in a

cell to edit its contents.

Always type data series labels in the first column of a

datasheet, and category names in the first row.

Changes to cell formatting (fonts, sizes, bold, etc.) are not

reflected in the graph. (See Formatting Chart Text later in

this chapter.)

When using the Clear command in datasheets, you'll be

able to clear the data, cell formatting, or both.

You can import data from other places with the Import

Data command on Graph's File menu. The Clipboard can

also be used. Incoming data must be comma-separated or

tab-separated text, and must not exceed the maximum
4,000 row by 256 column restrictions.



WORKING IN THE DATASHEET WINDOW

To include data in a graph, be sure the data heading above

or to the left of the data is black (not gray). Click to toggle

these headings.

Navigating in datasheets

The usual navigational tricks work in a datasheet. Tabbing

and Shift-tabbing moves you from cell-to-cell and back. This

is a quick way to change the active cell location.

Dragging or shift-clicking selects multiple cells.

Clicking at the left edge of a row or the top of a column will

select the entire row or column.

To speed entry, select multiple cells before entering data,

then tab from one to the next. The active cell will never

leave the selected area.

Use the datasheet window's zoom box (or drag the size

box) to fill your screen with the datasheet, click it or drag

again to reduce the size of the window.

Scrolling works as you'd expect, as do the keyboard

shortcuts for navigation (page up, home, end, etc.).

Number formats in the datasheet

" Numbers that are too long to be displayed in cells will be

stored as you typed them but displayed in scientific notation.

You can apply predefined number formats with the Num-
ber... command on the format menu, where you can also

define your own special number formats.

" Inspect the sample formats or read on line help for assis-

tance. Excel users will find the process and formats familiar.

For instance, use dollar signs ($), pound signs (#), commas,
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decimal points (.), percent signs, parentheses, and colors to

specify custom formats. Thus, $#,###.;[Red]($#,###.) would

display and print dollars with commas and no pennies.

Negative dollar amounts would be shown in parentheses

and red. The custom format 0.0% would display percent-

ages to one decimal place.

Column widths

Change column widths by dragging the right edge of

columns.

Columns can be up to 255 characters wide.

" The Column Width... command on Graph's Format menu
can be used to specify column widths in characters.

9 characters is the standard width.

Inserting and deleting rows and columns

Inserting rows works the way it does in Word tables. Select

the row beneath the point where you want to see a new one

and choose Insert Row/Col from the Edit menu. If you first

select multiple rows, you'll insert a like number of new ones.

" To insert a column, select the column to the right of the

place where you want to see a new one, and choose Insert

Row/Col from the Edit menu. If you first select multiple

columns, you'll insert a like niuiiber of new ones.

" Delete rows and columns by selecting them and using

the Delete Row/Col command on Graph's Edit menu.
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Working in the chart window
Use the Chart window to specify the appearance and size of the chart ob-

ject you want to insert into your Word document. Click in it to activate it.

Here are some tips:

Pick the right chart type

Use the Gallery menu to pick the desired chart type for each project.

Descriptions of the available types and their uses follow.

Area
Use area charts to show changes in relative values of multiple series over

time. Area charts emphasize the differences and the amount of change

(changes in various Presidential candidates' approval ratings over time,

for instance). Figure 27.5 shows some of the available area formats.

FIGURE 27.5

Some area formats.

Rrea

4

Bar
Bar charts organize categories vertically and show comparisons between

items (speeds of various disk drives, for instance). Figure 27.6 shows

some of the available bar formats.
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FIGURE 27.6

Some bar formats.

Bar
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FIGURE 27.8

Some line hrmats.

Line
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Pie

Pie charts show the relationships of parts to the whole—each

department's contribution to the firm's total expense budget, for in-

stance. You can only include one data series in a pie chart. Figure 27.9

shows some of the available pie formats.

FIGURE 27.9

Some pie formats.

Pie

42% 25%

Scatter

Scatter charts are useful for demonstrating trends and patterns.

They can show if variables are dependent upon or affect each other.

Figure 27.10 shows some of the available scatter formats.
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FIGURE 27.10

Some scatler formats.

KV (Scatter)
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Combination
Microsoft Ciraph's combination charts can contain up to four axes

representing data in different formats (lines and columns for instance).

It's a great way to overlay actual versus projected data, or loosely related

items like temperature and humidity. Figure 27.11 shows some of the

available combination formats.

FIGURE 27.11

Some combinafion

formats.

Combination

4-\

--/X-::
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3-D
Microsoft's 3-D variations give perspective to data representations. 3-D

graphs can be rotated to change the bird's eye view (which can some-

times emphasize or even distort relationships of related data). Fig-

ure 27.12 shows ajust a few of the many, many possible 3-D variations.

FIGURE 27.12

Some 3-D formats.

3-D Column

1

y
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Viewing graphs in different sizes

If you wish to change the size of a chart in the chart window without af-

fecting the size of the chart in your Word document, use the view per-

centage choices on Graph's Window menu (33%, 50%, 200%, etc.). This

changes the screen view but not the actual chart size, and is useful for

working on small chart elements or stepping back to get the big picture.

Editing parts of a chart

You can select various chart parts, then edit, move, and embellish. Click

to select, Shift-click to select multiple items. Selected items are sur-

rounded by handles. Solid black handles indicate that the selected item

can be formatted with commands and moved or resized with your

mouse. White handles mean you must use commands to make changes.

For example, you can select the legend box or chart title and drag

them to new locations. Selected text can be formatted (fonts changed,

italics applied, etc.). If you select axes, however, you can't move them

with a mouse, but you can modify them with many of Graph's menu
commands. The following things can be selected and altered:

- 3-D floor

- 3-D walls

Arrows

Axes

" Charts

Data series (any)

" Drop lines

Gridlines

Hi-lo lines

" Legends
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Plot areas

Series lines

Text

Up/Down bars

a I p

Here's a hot tip. Frequently, double-clicking on an

object in the chart window brings up a dialog box containing

the available formatting options. For instance, double-

clicking on an axis brings up the axis Patterns dialog box.

Double-clicking on a data marker brings up the Line and

Markers dialog box. Double-clicking a pie wedge brings up

pattern choices and so on. Explore!

Dragging to change data

You can drag data points and thereby change the appearance of a chart

and the underlying numbers in the datasheet! Yep. Read it again. For ex-

ample, you can drag a column up or down and see the changes visually

in the chart and numerically in the datasheet. Try it. Hold down the Of>-

tion key then point to the ends of bars and columns, the selection boxes

on lines, etc.

Typing attached title chart text

To type or edit attached text (titles):

1. Choose Titles... from Graph's Chart menu.

2. Choose the destination for the attached text (the chart, an

axis, etc.).

X Click OK.
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4k Chart opens a tiny text object surrounded by white selec-

tion squares.

5. Begin typing. Press the enter key to force new lines without

ending the entry.

6. Press Return when you've entered all the desired text.

7. Press Esc and the object will expand to reveal your typing.

8. Pick a new font, style, and so on, but forget about moving at-

tached text. For text you can move, see the next topic.

Typing unattached chart text

If you want to add unattached text notes to your chart that you can

easily move:

1. Simply start typing in the active chart window.

2. The text first appears in the center of your chart window.

3i Press the enter key to force new lines without ending the

entry.

4 Press Return to complete the entry.

5. Press Esc and the object will expand to reveal your typing.

6. Pick a new font, style, and so on.

7. Position the text by pointing to an edge, and when the

mouse pointer becomes a large arrow, dragging the text to

its new location.

Editing chart text

Point to chart text. WTien your mouse pointer looks like an I-bar, use it to

select and edit the desired text. (Insert and delete the Macintosh way.)
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Formatting chart text

Select text (click on it to surround with handles) then use the Format

menu's Font..., Text..., and Patterns... commands to change the ap-

pearance of the text.

Gridlines on charts

Use the Gridlines... command on the Chart menu to specify gridlines.

Double-click on gridlines to pick different line patterns.

Rotating 3-d charts

The 3-D View... command is available on Chart's format menu when
you are working with a 3-D chart. It reveals a dialog box like the one in

Figure 27.13.

You can control elevation, perspective, rotation, axes orientation,

and height by clicking on boxes that demonstrate their functions. The
Right Angle Axes option forces right angles. Auto Scaling sometimes

helps with the conversion of 2-D charts to 3-D charts. Use caution when

FIGURE 27.13

Control the orientation of

3D charts with this dialog

box reached from the 3-D

View... command on the

Format menu.

Format 3-D View

1>
^

Eleuation:
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changing a 3-D graph's orientation, particularly perspective. You can give

misleading impressions of the relative size or importance of data this way.

Saving charts and their data

The only way to save charts and chart data is to embed them into a Word
document by answering Yes to the Update Graph question when you quit

the Chart program. You must then save the Word document to preserve

the chart and data.

Positioning graphs in word
— documents

You can use normal paragraph formatting techniques to position em-

bedded graphs. For instance, to center a graph:

1. Select the embedded graph in your Word document by

clicking on it.

2. Remove first line indenting from the paragraph containing

the graph if there is any.

3. Use the ruler's Center button or the Paragraph... com-

mand on Word's Format menu.

D I P

Instead, you can frame graphs then use the Frame. .

.

command so Word's Insert and Format menus can position

them. See Chapters 4 and 5 for more information.
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Resizing and cropping

1. Select the embedded graph in your Word document by

clicking on it.

2. Small handles appear around the edges and in the bottom-

left corner.

X Hold down the Shift key and drag the corner handle to resize

the graph. Use the handles sans Shift key to crop (cover up)

portions of the graph.

Editing and updating

To update a graph:

1. Save your Word document if you have made any recent

changes. (You'll see why in a moment.)

2. Double-click on the graph in your Word document.

3. The graph will open in a Microsoft Graph window.

A. Make the desired changes.

5. Choose Quit from Microsoft Graph's File menu or use the

9€-Q shortcut.

6. Answer Yes to the Update question.

7. You will be returned to Word.

8. The updated graph will be in position.

9. Save your Word document to save the changes.
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If you accidentally answer Yes to the Update Graph

question, and insert a graph containing unwanted changes

into your Word document, Word's Undo command will not

restore the older version of the graph! Instead, close the

Word document without saving changes, then reopen it.

For this reason it is a very good idea to save your Word
document just before you edit graphs.

Other ways to incorporate graphs
You can create graphs with other programs (Excel, for instance) and

either copy and paste them via your clipboard; or link them to your

Word document with tools like Publish and Subscribe. Read more about

these techniques in the next chapter.



CHAPTER

Publish and

Subscribe, Link,

and Embed



TRACKS

To publish 681

create a document and save it normally. Select the part of the

document you wish to publish and use the application's publish-

ing command (Create Publisher... in Word and Excel). Name
the resulting edition file.

To substrlbe 683

open the subscribing Word document and place the insertion

point at the desired spot. Pick Subscribe To... from the Edit

menu, and locate and open the desired edition file. Save

your work.

To iontrol when Word updates 684

use the Subscriber Options. . . command on Word's Edit menu
(visible only with subscribing documents) to specify manual

or automatic updates. Cancel Subscriber breaks the link.

To tontel publitatlon and subsulptlon 684

use the Subscriber Options... command on Word's Edit menu
(visible only with subscribing documents) to cancel subscriber

links.



To embed ob/ecfs 686

with both applications running, place the insertion point in the

Word document that will receive the embedded information.

Switch to the other document, select the information to embed,

and copy it to your Clipboard. Switch back to Word, hold down

the Shift key, and choose Paste Object from the Word Edit

menu. (The choice will only appear when you hold down the

Shift key.)

To update embedded ob/ecfs 687

double-click on the object which launches the creating program.

To link 690

with both documents open, place the insertion point in the

Word document that will receive the linked information. Switch

to the other document, select the information to link, and copy

it to your Clipboard. Switch back to Word, hold down the Shift

key, and choose Paste Link from the Word Edit menu. (The

choice will only appear when you hold down the Shift key.)

To update or €an<el links 692

choose Link Options. . . from the Edit menu.
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WHICH, WHEN, AND WHY?

A minimum of three files are created when people publish and sub-

scribe. (You'll learn about them in a moment.) Since, in simple situa-

tions, you may only need to run Word to publish or subscribe, RAM
requirements are minimal (if you consider 2 Mb minimal. ..) . As you'll

see in a moment, embedding and linking are more RAM hungry.

If you work alone, you can still use Publish and Subscribe by being

both a publisher and subscriber.

Embedding is another way to keep your Word document current. It

lets you paste objects into your Word documents containing not only the

results of work done elsewhere, but also the file information needed to

create the work. Thus, you can double-click on an embedded object in

your Word document and Word will launch the program that created the

object (Excel or the Equation Editor, for instance), and let you work in

it. When you've finished, and quit the program, your Word document is

automatically updated.

If you save the resulting Word document to a diskette and give it to

someone else with both Word and the other program on their machine,

they can open the Word document and double-click on the embedded

object. This will launch their copy of the other program (Excel, for in-

stance) and let them make changes to the spreadsheet. If they don't have

the program, they may even be able to use a compatible product. This is

a great way to take work back and forth between home and office, since

you can keep all related documents together as one file.

Computer dealers rejoice: when you embed, everyone involved

needs enough RAM to simultaneously run both Word and the other

programs that created the embedded objects if they plan to modify the

objects.

Linking is a lot like embedding, but you use multiple, separate files.

Typically, your Word document is the destination file and external infor-

mation conies from source files. You must have all of the programs used

to create document parts on your machine. Moreover, you must have

enough memory to run both Word and the other program simulta-

neously. Linking is a good way to update part of a document when

another part of that same document changes. Linking creates two files

—

a Word file and a file from the other program.
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Any technique that changes things without human
intervention can cause problems. Suppose for instance you

own a law firm with a letterhead which includes the names

of partners in a table. As partners come and go, you change

the table to update the letterhead. This seems like a natural

application for the automatic updating tasks described in

this chapter. You could keep a master copy of the table on

your network server and make the changes only once. You

could then link everyone's letterheads to the master table on

the server. Thereafter, whenever anyone opens a letter it will

display the ciu'rent partners list. But that is not always what

you want. Unless you are very careful about how and when

updating takes place, it is possible for someone to open an

old letter, then see, print, and possibly even resave the old

letter with the latest partner list. You can have similar

problems with budgets, contracts, and other important

documents. Widespread use of automatic updating needs a

firm imderstanding of the potential consequences and close

supervision.

Publish and subscribe

Let's start with the most powerful and confusing of the trio. To publish

and subscribe you use three files:

A subscriber docvmient (a Word file in our example)

• A publisher document (an Excel spreadsheet for example)

A third intermediate document (called the edition)
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Suppose that someone else in your organization regularly updates rain

statistics in an Excel spreadsheet. She creates and saves this spreadsheet

file on her machine. In the process, she publishes a portion of that

spreadsheet, creating a second file called the edition file.

Suppose further that you write a monthly memo containing some
of those ever-changing statistics. You save your memo as a regular Word
document that knows it is a subscriber to your friend's spreadsheet (be-

cause you tell it as much) . You and your partner-in-clime are on the same

network (though you need not be). Whenever you get ready to write the

latest version of your monthly memo. Word will obtain your co-worker's

current spreadsheet data contained in the edition file (and sent over the

network, in this scenario). Word automatically inserts the latest data at

the appropriate location in your Word document. You don't even need

to have a copy of Excel on your computer for this to work.

Incidentally, you are not limited to subscribing to Microsoft Excel

spreadsheets; you can subscribe to any document created by any pro-

gram that can publish (including Word 5). Not all programs can publish

yet, so check your manuals or contact software manufacturers for details

regarding publish-and-subscribe-sawy software. Here are the steps for

publishing and subscribing.

Publishing

To make a document a publisher:

1. Create a document and save it normally.

2. With the document on-screen, select the pertinent informa-

tion and publish it. In the case of Word or Excel, that

means a trip to the Edit menu for the Create Publisher...

command. This will bring up a dialog box similar to the

one in Figure 28.1. An Excel Publish dialog box is il-

lustrated here, in keeping with our spreadsheet example.

Word's Publish dialog box is reached the same way and is

virtually identical to Excel's.

3. Name the edition file (the third file required for publishing

and subscribing). This file will contain just the selected in-

formation being published.
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FIGURE 28.1

To publish, select the

pertinent Hems, choose

Create Publisher. . . to

bring up this dialog box,

name the edition file, and

click the Publish button.
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Isi Rain In Spain Project
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Subscribing

To subscribe to an edition:

1. Open the Word document where you want to insert the pub-

hshed information.

2. Place the insertion point at the desired spot. Then pick Sub-

scribe To. . . from the Edit menu. You will see a dialog box
like the one in Figure 28.2.

3. Using standard Mac folder-navigating techniques, locate the

edition file of interest. They have unusual, fuzzy, brick-like

icons, as you can see in Figure 28.2. If you are searching

over a network, be sure the publisher has granted ap-

propriate access privileges. Contact your network ad-

ministrator for assistance, if necessary.

4. Once you've located the desired edition file, double-click

on its name or highlight the name and click Subscribe.

5. Soon, a copy of the published information will be placed in

your Word document at the insertion point. This may take a

moment if you are subscribing to a large file over a busy

network. Remain calm. Figure 28.3 shows the rewards of

patience and technology—copies of Excel spreadsheet cells

automatically inserted into a Word 5 table. What a country!

6. After you've first subscribed, save your Word document.

FIGURE 28.2

Use Word's Subscribe

dialog box fo locate

edition files (distinguished

by an unusual icon) and

subscribe to them.
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FIGURE 28.3

When you subscribe,

the published [xcel

spreadsheet cells will

appear in your Word

document.
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Inasmuch as Publish and Subscribe is a new science

(make that art), you will need to experiment with published

information to see what happens regarding character embel-

lishments, margins, styles, font incompatibihties, and the

Uke. Experiment on copies of important documents! If you

make changes to the resulting Word table (apply table borders,

adjust the table's indents and so on), these changes may all

disappear the next time you update your subscription.

In our example, the font information came from Excel without dif-

ficulty. Moreover, centered spreadsheet cells became centered table cells.

Try to make the most of your style decisions on the publishing end.

When necessary, create styles on the subscriber's end to speed the in-

evitable manual reformatting process. (Even if Word is both the pub-

lisher and subscriber, it does not send new styles with edition files.)

Updating or canceling your subscription

If you are a subscriber, you do have control over when your document

gets updated. But, unless you tell Word otherwise, it will attempt to up-

date each time you open a subscriber document. Undo will not undo an
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automatic update. (Close the subscriber document without saving

changes instead.)

When you open a document that subscribes, the command Sub-

scriber Options... appears near the bottom of your Edit menu when you

select a subscribed element. Choosing it brings up a dialog box like the

one in Figure 28.4.

If you click the Manually button and save the file, automatic up-

dates no longer occur. Thereafter, it becomes your personal respon-

sibility to update your document. Any time you want an update, select

the subscribed element, visit this dialog box, and click Get Edition Now,

which updates your document immediately. This dialog box also tells you

when an edition was last modified—right down to the second...

Clicking Cancel Subscriber breaks your document's association with

the publisher entirely. You are asked to confirm this. You must do this to

delete information placed in your document from a publisher. Canceling

a subscription does not remove the last version of the edition placed in

your Word document.

Publishers have choices similar to those shown in Figure 28.4.

Reach them by choosing Publishers Options... on the bottom of pub-

lisher's Edit menus.

If a subscriber can't find an edition, an abrupt dialog box an-

nounces that the edidon can not be located because it is missing. Check

with the publisher to see if the document has been moved, renamed,

deleted, or had its access privileges changed.

You may need to turn off automatic subscribing to edit certain

kinds of objects. For example. Excel spreadsheet tables can be edited

only when auto subscribe is off.

FIGURE 28.4

Use the Subscriber

Options. . . command on

the [dit menu to control

updates and cancel

subscriptions.

Subscriber to: a Spain Rain Stats

[ Cancel Subscriber
:Get Editions: -

(S) Hutomatically

O Manually ( Get Edition Nou)~)
;

[ Open Publisher

i Latest Edition Wednesday , January 8, 1992 3 20 5S PM

( Cancel ] [(
OK ]]
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Embedding
To embed existing information in a Word document (embedding a

spreadsheet in a Word document, for instance) you must have both

applications running.

1. Witli both applications running, place the insertion point

in the Word document that will receive the embedded
information.

2. In oiu" example, you would then switch to the spreadsheet

and select the information to embed.

3. Copy it to your Clipboard.

4 Switch back to Word.

5. Hold down the Shift key and choose Paste Object from the

Word Edit menu. (The choice will only appear when you

hold down the Shift key.)

6. The object from your Clipboard will be pasted into your

Word document.

7. Save your Word file.

Figure 28.5 shows an example of embedding at work. Notice that this

time the spreadsheet looks like a spreadsheet rather than a table. That's

because this time it is a spreadsheet.

FIGURE 28.5

Embedding can save

fhings like spreadsheef

files in your Word

documents.

p|3 ----- , Embedded memo/ss : „ ^ --,- ^13^
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Updating embedded objects

Since the spreadsheet is saved as part of your Word document file, you

update it by opening the Word document and double-clicking on the ob-

ject. This laimches the spreadsheet program (or other program that

created the object). Your screen would look something like Figure 28.6.

You then edit the data in the originating program (Excel in our

example) and use the Update command (3€-S) on the originating

program's menu bar or paste a revised object, depending on the type of

changes that you've made.

For example, if you simply changed the number of regular post of-

fices in Figtue 28.6, you could choose Update (3€-S) on the Excel File

menu. Excel would move the revised spreadsheet numbers to your Word
document and quit.

FIGURE 28.6

Double-clicking on an

embedded object in Word

huncbei tbe pcogram that

created the object.

1

i File Edit
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But suppose you made changes like those shown in Figure 28.7.

Here you've added three extra lines and highlighted them.

FIGURE 28.7

Changes to objects

sometimes require an

additional trip to the Paste

Object command (on the

Edit menu).
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FIGURE 28.8

Choosing Objecf. . . from

the Inseh menu lists the

available object types.
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with the t-lusive Object Options... command, sometimes found on

Word 5's Edit menu. You must first select an object before visiting the

Edit menu. Figure 28.9 is from a recent sighting.

FIGURE 28.9

Freezing permanently

converts objects to

pictures, so use it with

caution.
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FIGURE 28.10

Changing the name in

the memo updates the

phone list, thanks to

linking, but notice what

happens to character

formatting.
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Notice that the document receiving the text gets font, size, and style

information from the originating document (12-point Courier, in the ex-

ample). There is no easy way to force the incoming information to the

receiving document's special format or style (14-point Helvetica here).

You can paste unformatted text, in which case the receiving document

will display and print incoming text in Word's default form (typically, but

not necessarily 12-Point New York).

Paste special links

The way to paste unformatted text is to use the Paste Special choice on

your Edit menu instead of the Paste Link command. You will see a dialog

box like the one in Figure 28. 1 1 . Choosing Unformatted Text will cause

the receiving document to apply the Normal style to incoming text.

Picture pastes incoming information as a picture, and picking

choices like Word Document will embed objects.

FIGURE 28.11

Paste Special gives you a

little more control over

the format of incoming

information.

Paste Special

Paste From: lUord Document
Confidential New hire ... t-

Paste:

Formatted TeKt (RTF!

Unformatted TeKt

Picture

Ulord Document O

[ Paste

)

[(Paste Llnk
|

( Cancel j

Link options

The Link Options dialog box, shown in Figure 28.12, lets you control

how often links are updated and lets you cancel a link or quickly reach

the original document.

To reach this dialog box, you must open a document containing a

link. Place the insertion point at the link of interest (the linked info will

become highlighted, as shown in Figure 28.12). Then choose Link

Options... from the Edit menu.
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FIGURE 28.12

Highlight linked items

and choose Link

Options. . . from the

Edit menu to get this

dialog box.
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The Update area lets you specify when links are updated. The

Forrnat menu provides the available format choices (typically RTF,

Unformatted Text, and Picture). Open Source takes you to the originat-

ing document. If the Source is other than Word, the button will attempt

to laimch the source program (Excel, for instance). You must have the

source program on your machine and enough RAM to run both the Source

program and Word in this case. Edit Link lets you tie the receiving link to

a different source link.
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TRACKS

To send mail from wifhin Word 698

use the Microsoft Mail command on your Apple menu unless

you also want to enclose a Word document, in which case, use

the Send Mail... command on Word's File menu.

To intlude Word dotuments with messages you send 698

make the document you want to send the current document

then choose Send Mail... from Word's File menu. Type a note

to accompany the enclosure if you wish. Specify the names of

recipients and send.



To read mail from within Word 700

use the Microsoft Mail command on your Apple menu unless

you only want to see messages with enclosed Word documents,

in which case, use the Open Mail... command on Word's

File menu.

To use do€uments sent to you via MS-Mail 700

use the Open Mail... command on Word's File menu. Click to

select a message or shift-click to select multiple messages, then

click Open. Word will open one or more new document win-

dows containing the enclosures and close the Mail window.

Treat the enclosures like any other Word documents (Edit,

save, etc.).



Sending e-mail (electronic mail) from
unthin Word

Enclosing Word documents with e-mail

Receiving notes and enclosuresfrom
within Word

w HEN YOU ARE on a network and your

^^H organization uses Microsoft Mail for

in-house electronic communications, you can use the Open Mail... and

Send Mail... commands on yoiu' Word File menu to access mail and send

copies of your Word documents to others.

Word 5 is compatible with most Microsoft Mail versions, incltiding

2.0 and 3.0. You must have Microsoft Mail installed on your Mac and be

connected to a network with a mail server to use these commands. Read

the Users booklet that came with your copy of Microsoft Mail. Contact

your system administrator or mail manager for assistance.

O I P

Generally, you will want to use the Microsoft Mail

command on your Apple menu rather than Word's mail

commands for most e-mail (electronic mail) tasks. The

primary advantage of using the Word 5's Send Mail. . . and

Open Mail . . . commands instead of using the Apple menu
choice is that the Word commands eliminate a couple of

steps when you exchange Word documents with other Word
users.



SENDING WORD DOCUMENTS VIA E-MAIL

Sending word documents
- via e-mail

1. With your Word document saved to disk and displayed on

screen, choose Send Mail... from Words File menu.

2i Ifyour mail server is up and running, and ifyou are properly

attached to your network, you will see a Send Document
dialog box. The exact appearance of the dialog box will

vary, depending upon which version of Microsoft Mail is in-

stalled on your machine. The Mail options you've chosen

also affect the appearance of this screen. Figure 29.1 shows

FIGURE 29.1

A typical Send Document

window (yours may be

different) readied from

Word's Send Mail...

command.

Twain Quote

ja si^a \-Bmu\ ^^m m B BiJH
aaea^iB^^sp gn^- -

-42

1 he difference between the right

word and the almost right word is

the difference between lightning

and the lightning bug.
Mark Twain

I

Normal" :m:

^=|==-*| Send Document
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a typical but very simple mail window, running imder

Microsoft Mail version 2.0.

3. Somewhere on your screen there will be a list of potential

addressees, a place for you to type the subject of your mes-

sage, and a message area. There may be other checkboxes

for return receipts, urgent handling, and so on.

A. Pick the intended recipients and type a message in the mes-

sage area.

5. (Hick send to transmit both the message and the Word docu-

ment to the recipients.

m A R N I N G
T

If you are typing a list of ten things you hate about

your boss and decide to send her a happy birthday e-mail

message, don't use Word's Send Mail. . . command. Your note

will arrive with a copy of your typing project! If you don't

want to send a Word document with an e-mail message, use

the regular Microsoft Mail features on the Apple menu
instead.

Reading mail comments and
— enclosures in word

1. From within Word and connected to a network, use the

Open Mail... command on Word's File menu.

2. \ou may be asked for your name or password.



READING MAIL COMMENTS AND ENCLOSURES IN WORD

3. You will see a list of messages (shown in Figine 29.2) sent to

you by others using Word's Send Mail... command. This list

will only show mail sent using Microsoft Word enclosures. If

you want to see all your mail, use the Microsoft Mail com-

mand on yoiu" Apple menu.

4. Click on the message you want to read and use the Com-

ments button to read the comments.

5. If you want to open any enclosures which may be contained

in a message, click on the message and you'll see a list of

possibilities.

6. Click to select an enclosure, or shift-click to select multiple

choices.

7. Click Open.

8. Word will open one or more new document windows con-

taining the enclosures and close the Mail window. Treat the

enclosures like any other Word doctxments (edit, save, etc.).

FIGURE 29.2

A typical message list

displayed through the

Open Mail. . . command

on Word's File menu.

"^^|= = '| Mail Documents

From Subject Received

£315 Ron Mansfield Budget Sun Nov 8 2 38 PM O

0-

n p 1 p t p [ CanceT
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n I p

Holding down the Shift key when you use Word's Open

MaU. . . and Send Mail. . . commands wUl often let you open

and save documents in non-Word formats (text, RTF, etc.).

For additional help with mail

Mail and network connections can be confusing, particularly on complex

networks. Read your Microsoft Mail user's guide and ask your mail

manager for assistance.
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TRACKS

To show QuitkTime movies 707

you need system version 6.07 or later with the FS6Patch system

extension properly installed, or System version 7.0 or later. Your

computer must be 32-bit color QuickDraw compatible. Word's

Movie commands must be installed. (They are normally unless

you choose a Custom or PowerBook installation configuration

that eliminates them.)

To insert a QuitkTime movie into a Word dotument 708

position the insertion point and choose Movie... from Word's

Insert menu. Use the resulting Open dialog box to locate and

open the movie.

To sliare Word dotuments tontaining movies 708

you must copy two files—the Word document and the Quick-

Time movie.



To play movies 709

double-click on the movie poster (a still frame from the movie

containing a badge)

.

To stop start, adyame, and rewind movies 709

use the Play/Pause button at the bottom of the movie window

to alternately play and pause. The Forward and Rewind buttons

work as you'd expect. Drag the slider to make bigjumps.

To tapture stills from movies 71 1

play the movie and pause on the desired frame. Select the still

picture (if it's not already selected) by clicking on it once, and

then copy it to the Clipboard (SS-C). Paste the resulting PICT

image to your scrapbook, or other Word document etc.



Ways to include QuickTime movies in your
documents

Ways to share QuickTime movies with others

Ways to turn QuickTime images

into drawings

w HILEYOU CANNOT record QuickTime

^^H movies with Word, you can play tliem

from witiiin Word documents. This give the illusion of adding sound and

animation to memos and otlier documents. You do this by inserting movie

posters (graphic objects) which can be used to launch a QuickTime player

and the movie you specify. Figure 30. 1 illustrates the concept.

FIGURE 30.1

Word's Movie commands

let you insert movie

posters in your Word

documents which play

QuickTime movies when

you double-click on them.

QuickTime memo
rffTTTu] r^T^ mmm m [wum

l-l-l li=il^l t-1TT711
-44

InteiOfCice Memo
To Bob K

From Ron M
Date;

;
Novembei 10. 199Z

Sutgect QmckTlmie is a siles tool

Bob

Double click on the "movie poster" at the end of this memo and see what

you think of QuickTime as a sales tool We'll obviously need to hammer out

the technical details How about a tnal run in the Chicago office'

Movie badge

Page t

• Movie poster



OF MOVIES, DISK SPACE, SPEED, AND QUALITY

What you need

Here are the requirements for playing QuickTime movies:

System version 6.07 or later with the FS6Patch system exten-

sion in your System folder, or System version 7.0 or later.

(Get the System 6 FS6Patch from your Apple dealer if you

need it.)

A 68020 or greater machine. Macintosh Plus, Classic, SE,

Portable, and PowerBook 100 systems are not compatible.

32-bit color QuickDraw compatibility. Other PowerBooks

(140, 170, etc.), Macintosh II series. Quadras, and SE/30s

running System 7 are compatible.

Word's Movie commands must be installed. (They normally

are, except if you eliminate them during a Custom or Power-

Book installation. Run Word's installer again to add the

necessary QuickTime features.)

A hard disk with lots of disk space.

4 Mb of RAM on System 7 machines, and 2 Mb with Sys-

tem 6.07.

A source of QuickTime Movies.

Popcorn.

Of movies, disk space, speed,
— and quality

It's time for a reality check. A fifteen-second QuickTime movie can easily

take more than 1.3 megabytes of disk space. You're gonna need a big

disk drive for Gone With The Wind; or even a decent sales presentation.

Which brings up another point. QuickTime movies won't fill your

screen, even a small one. And, while the picture and sound quality are

pretty amazing under the circumstances, makers of broadcast video gear

and IMAX theater equipment have nothing to fearjust yet.



THE WORD FOR THE MAC HOW-TO BOOK Chapter 30

Disk drive speed and overall computer performance can be an

issue. QuickTime movies run best on your local hard drive. It's a good

idea to copy movies from CD-ROMs to your hard disk. While you might

be able to play a movie over your network (from a Server for instance) , it

would be ill-advised.

Some background tasks that hog a lot of your computer resources

(like background printing and certain SCSI tasks) can make movies

pretty herkey-jerky. Give your Mac a break. Don't try to print and scan

and watch movies simultaneously. Enjoy the show. QuickTime movies can

be entertaining, informative, and great attention getters, as long as you

can live with the limitations of this emerging technology.

Inserting a movie

Microsoft's claims to the contrary, you don't actually insert a QuickTime

movie into a Word document. What you do is insert a graphic object

used to launch the movie player and play a specific movie. Still, it's con-

venient to think of the process as inserting a movie, as long as you

remember that you'll need to deal with two files when it comes time to

back up or share Word-resident movies.

To insert a movie:

1. Create a QuickTime movie with some other software, or

copy a movie to your hard disk.

Z Open or create a Word document and position the inser-

tion point where you want the movie poster to appear.

3. Use the Movie... command on Word's Insert menu.

4 You'll see an Open dialog box that will remind you of

Word's regular Open dialog box.

5. Use it to locate and open the movie.

6. Word will open a movie window and play the movie you've

selected.



PLA\1NG MOMES

7. Using techniques you'll learn in a moment, pick a frame in

the movie you want to use as a poster in your Word docu-

ment, then close the movie window.

8. Word will insert the poster at the insertion point along with

a little movie badge in the lower left corner of the poster.

(The badge tells you this is a movie, notjust an everyday

graphic image.)

Playing movies

To play a movie, just double-click on its poster. A movie window will open

with VCR-like controls at the bottom. The movie will run from beginning

to end unless you stop it first. Figure 30.2 shows the controls and their

functions.

As you'd expect, the Play/Pause button will start and stop your

movie. The Forward and Rewind buttons move you ahead and back

when you click. Hold them down to fast forward or rewind. The slider in

the middle of the control panel lets you scoot to various places in the

movie (the middle or beginning, for instance). Drag the handle.

FIGURE 30.2

If you've ever played a

tape, you know how to

control a QuickTime movie.

Volume

Pause/Play button Advance one frame

Mck one frame

Drag to see desired movie frame
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Movie options

When you select a movie or pause it during playback, the Edit Movie...

command on your Edit menu will take you to a dialog box like the one

shown in Figure 30.3. You can also reach this dialog box from the Object

Options command on the Edit menu.

Alvs^ays Shovs^ Badge
This option toggles the little film-like thing at the lower left of posters. It

is on by default and so darn cute you'll want to leave it on.

Play Continuously
An X here plays the movie over and over and over and over.

Loop Back and Forth

This option plays the movie from beginning to end; then it plays the

whole show backwards. If Play continuously is checked the Energizer

btmny appears (just kidding). Actually the movie plays forward, then

backwards; over and over. It's a litde like CSPAN.

FIGURE 30.3

The Movie Options dialog

box (reached via the Edit

Movie. . . command or the

Object Options command

on the Edit menu).

Mouie Options

Mouie Playback Options

^ Rluiays Shom Badge

n Play Continuously

n Loop Back and Forth

H Oouble-Click Shoujs Controller

n Keep this Display Picture

n fllu.pays Play from First Frame

jj I

Cancel ]c OK



TURNING QUICKTIME FRAMES INTO PICT STILLS

Double-Click Sho>vs Controller

Renio\ing the default X here deprives you of the VCR-style controls and

turns your mouse pointer into a pause control. I say, let it be. People will

be impressed by all the buttons.

Keep This Display Picture

This option lets you pick a new frame to use as the poster. Play the

movie. Pause on the desired frame. Visit the Movie Options box. Choose

this option.

Al>vays Ploy from First Frame
This option forces the movie to start from the beginning except after you

pause.

Movie sound
Ifyour movie has sound (and some movies don't), the litde speaker icon

in the lower-left of the mo\ie window will not be dim. Click on the

speaker icon to reveal a sliding volume control. I'd show you what it

looks like, but screen capture technology has not caught up with Quick-

Time technologyjust yet.

Turning QuickTime frames
- into pict stills

It's easy to copy single frames and use them as PICT stills.

1. Play the movie.

2. Pause when you see the frame you like.

3l Copy (3?-C).

4. Paste to your scrapbook, a Word document or any

other document that accepts PICT graphics (Paint

programs, etc.).
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Editing movies

Attention budding Spielbergs! You can cut, copy, and paste single Quick-

Time Frames or ranges of frames, and the sounds that accompany them.

It is even possible to copy frames from one movie to another. Experi-

ment on copies of your favorite QuickTime flicks.

To copy multiple frames (and sounds):

1. Play the movie.

2i Pause wheti you see the first frame you like.

2. Hold down the Shift key.

4. Shift key depressed, move forward a frame-at-a-time with

the Forward button or drag the slider SLOWLY.

5. Copy (3€-C) or cut (96-X).

6i Move to the point where you want to paste.

7. Paste (§€-V).

8. Show off.

Copying documents containing
- MOVIES

Remember to copy both the Word document and movie (s) associated

with it. If you forget a QuickTime file (or move it), you'll still see the

poster in your Word document, biu you'll get a message like the one in

Figure 30.4.

If the Movie is on your disk(s), but not in the same place as before,

the Search button will usually find it. fYou could also use Word's Find

File command.)



SOURCES OF QUICKTIME MOVIES

FIGURE 30.4

Word can't find the

movie file.

(!)
The mouie file "Cable Car Moule"
cannot be found. lUithout this

file, the mouie cannot play

properly.

[(
Cancel

jj
[ Searc h

]

m A R N I N G

Microsoft warns that if you store movies on floppies,

you should not use untitled floppies. This shouldn't be a

common prohlem, given the size of QuickTime files and

today's floppy capacities. .

.

Sources of quicktime movies

Your local Macintosh users group is probably a great source of Quick-

Time movies. (Just be sure you use current virus protection software if

you swap flies.) You can also find movies in Shareware catalogs like

Educorp's (request one by dialing 800-843-9497), through bulletin board

services, on-line services (such as America Online), and Apple's Quick-

Time startup kit has a CD full of movies.
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TRACKS

To thange preferentes

use the lools menu's Preferences... command to open the

Preferences dialog box. Scroll if necessary and click on the

desired preferences category (General, Grammar, Toolbar,

etc.). Choose options when they appear and use the close box

to return to your work. Quitting Word saves the changes.

Jo modify menus

open the Gommands dialog box pick commands from the

scrollable list and add or delete them. Add, change, or delete

keyboard shortcuts here if you wish.

To save settings thanges

ciuit Word.

722

736

747



To revert fo Word's standard settings 748

open the Commands dialog box and click on the Reset... but-

ton in the bottom left corner.

To add and remove keyboard shorttuts 749

use the Commands dialog box (§€-Shift-Option-C) or, if you

have a numeric keypad, hold down §€-Option- + (on the nu-

meric pad). Your cursor will change to a large l§ symbol. Pick

the menu item you want to add a shortcut to. Demonstrate the

key combination when Word asks you to. To remove shortcuts

without visiting the Commands dialog box, hold down 3€- Op-

tion- - (on the numeric pad). Word will ask you to type and

confirm the key combination you wish to remove.



Featuring «



STANDARD SETTINGS

hires can be slowed by undocumented, department-wide changes to

menus as well.

And, if you are using third-party macro programs like QuicKeys or

Apple's now discontinued MacroMaker, changes in menus can some-

times cause your old macros to malfunction.

If you work in a large organization, your systems manager may have

strong feelings about changing Word's menus and shortcuts. Check first.

With that out of the way, let's look at ways to personalize Word.

Standard settings

Word's original (factory) settings are referred to as Microsoft Standard

Settings. The designers ofWord 5 have chosen settings they feel will work

for the majority of people doing general typing and correspondence. For

instance, they assume you will use standard letter size (8'/2xH") paper.

They have specified generous right, left, top, and bottom margins that

should accommodate most binding, header, and footer needs. They have

turned on popular Word features and turned off more esoteric ones that

annoy some people. They have organized the menus for you and held

back many potential menu choices.

But even the research-laden folks in the Microsoft Useability labs

couldn't come to a consensus on the best font default, so Word lets you

pick your favorite at installation. Table 31.1 lists some (but not all) of

Microsoft Word's standard settings for the American version. Most can

be found in various categories of the Preferences dialog box.

As you can see from the table, some settings, like Fractional

Widths and Most Recently Used List (MRU List), change based on your

machine's configuration. Things like the dictionaries and thesaurus

change in international versions.

Defaults are stored in the Word Setdngs (5) file in your System

Folder. If you are using System 7, the file is stored in the Preferences

folder within the System Folder.
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TABLE 31.1 Word 5's Factory Defaults (American Version)

FEATURE DEFAULT SETTINGS

Allow Fast Saves



STANDARD SETTINGS

TABLE 31.1 WordS's Factory Defaults (American Version) (continued)

FEATURE DEFAULT SETTINGS

Page margins in
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Changing word's preferences

Word 5 gives you considerable control over its various features. For ex-

ample, you can dictate default view settings, menu appearance, default

font settings, and much more. Many of these choices are made using

preference categories (collections of options) in the Preferences dialog

box. Preferences are saved in Word Settings files, so it is possible to have

more than one set of preferences.

There are eight preferences categories in version 5.0 and nine in

version 5.1. Here are the steps for changing preferences:

1. Begin by selecting Preferences... from the Tools menu.

Z You'll see a dialog box like the one shown in Figtire 31.1.

Notice the icons and scroll bar on the left side of this

dialog box.

X Click on an icon to move from one Preferences category to

another. You'll always see the General category first.

4b Change preferences by clicking on options, typing in the

text boxes, and so on.

FIGURE 31.1

The Preferences dialog

box allows you to

customize settings.

Preferences

CJeneral

7^

Open And Save

E
Default Font
¥

Spelling

Vour Name: nsfieiil

Vour Initials: RCM

Custom Paper Size

Measurement Unit:

Uiidth:



CHANGING WORD'S PREFERENCES

5. When finished, click in the close box to return to your

document.

Let's look at all nine categories (General, View, Open and Save, Default

Font, Spelling, Grammar, Thesaurus, Hyphenation, and Toolbar).

The general category

The General Preferences category lets you enter or edit your name
and initials, define custom paper sizes, toggle smart quotes, control

automatic Repagination, and control clipboard formatting.

Name
The name is used by the Summary Information dialog box and the Glos-

sary for the author glossary item. If you insert your name here, you will

not need to retype it each time you create Simimary Information or use

the author glossary item. If necessary, edit your name using normal

Macintosh editing and navigation techniques.

Initials

The initials you type here will be displayed when you record a voice an-

notation. See Chapter 25 for more information about voice annotation.

Custom Paper Size

Notice the custom paper size boxes below the name and initial boxes. They

will be dimmed unless your chosen printer supports custom paper sizes.

Most laserprinters do not. ImageWriters and the ImageWriter LQ do.

If your printer supports custom sizes and you wish to define them,

but the choices are dim, close the Preferences dialog box and visit the

Chooser to select the appropriate printer icon. Then return to the

General Preferences category to continue.
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Measurement Unit

Beneath the tiislom paper size boxes you'll find a drop-down menu used

to define the units of measure used by the ruler, text boxes, and for mar-

gins and tab settings, as shown in Figure 31.1. Spacing measurements

such as super- and subscripts, line spacing, and inter-character spacing

are not controlled here.

Smart Quotes
An X in this box tells Word to replace simple quotes with curly type-

setter's quotes as you type. This option does not affect previously typed

quote marks. To turn off smart quotes, remove the X from the checkbox

by clicking on it.

Background Repagination
With this option checked, Word will automadcally repaginate your

document (compute new line and page endings) whenever you are not

typing. On some slower Macs you may find that automatic Repagination

slows certain operadons. If this is an annoyance, remove the checkmark

and Word will only repaginate when you tell it to (through the Tools

menu) or before you print or do other tasks requiring Repagination.

Include Formatted Text in Clipboard
Normally you will want this box checked. It carries text attributes (bold,

italic, etc.) with the text on the Clipboard. Paragraph formatting carries

over as well if you copy the appropriate paragraph markers to the Clip-

board. Removing the checkmark from this box copies plain text to the

Clipboard.

Drag-and-Drop Text Editing

This box determines whether the Drag-and-Drop feature defaults to off

or on when you start Word. Some people turn Drag-and-Drop off here

and install a menu choice and/or keyboard shortcut to control it.
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The view category

Figure 31.2 illustrates the View category. It determines how hidden text,

grid lines, text boundaries, and picture placeholders appear. It gives you

control over the appearance or absence of the ruler and ribbon in new

documents. This category also controls several items relating to menu
appearance. With most choices in this category, regardless of what you

set here, you can control the option from the menu bar.

Shov/ Hidden Text
This choice determines whether hidden text will be displayed by default.

It does not affect the default printing of hidden text which is controlled

by the Print dialog box.

Show Table Gridlines

An X here means that you will see dotted lines between rows and

columns in tables. These lines will not print.

Show Text Boundaries in Page Layout View
An X here means that when you are in the Page Layout view, you will see

dotted lines around document elements like text areas, headers, footers,

FIGURE 31.2

The View Preference

choices range from

non-prinfing character

display to menu

appearance.

Preferences

Show
^ Hidden Tent

^ Table Gridlines

GTeHt Boundaries in Page Layout UieiD

n Picture Placeholders

|-Open Documents
G In Page Layout Uieu>

I^Ulith Ruler On

lEIUJith Ribbon On

Menus
^ Shooi Function Keys on Menus

^ List Recently Opened Documents

n Use Short Menu Names

M^Show 3-D Ribbon and Ruler
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and framed objects. These lines will not print. Note that even though the

choice contains the word text, it affects non-text elements as well (like

graphics).

Show Picture Placeholders
On slower Macs, Word can slow to a crawl if your document contains

large graphics. It is possible to speed work in drafts by displaying gray

rectangles instead of the graphics themselves while editing. The picture

placeholders choice determines whether or not these placeholders are

used by default.

Open Documents in Page Layout Vie^
With this box checked. Word 5 will always open your documents in Page

Layout view (called Page View in Word 4). In Page Layout view, you will

see headers, footers, page numbers, and so on. There is a performance

penalty. Scrolling and other tasks can be noticeably slower in this view.

That's why you have a choice of default views.

Open Documents v^ith Ruler On
With this box checked. Word 5 will always open yom^ documents with the

ruler in view. The ruler shows tabs, indent markers, the Style list, etc., but

takes up room, particularly on small screens.

Open Documents vs^ith Ribbon On
With this box checked. Word 5 will always open your documents with the

ribbon in view. The ribbon shows font choices, lets you show paragraph

markers, lets you quickly apply bold, underscore, and other embellish-

ments. Like the ruler, the ribbon takes up room, particularly on small

screens.

Show Function Keys on Menus
Notice the difference between the left and right menus in Figure 31.3.

The Save As... choice on the left lists Shift-F7 as a keyboard shortcut.
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FIGURE 31.3

The Save As. . . choice

shown with the function

keys option on (left) and

off (right).

Edit Uieuj Insert

NeiJj

Open...

Close

Saue

3gO

ses

Saue fis...
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FIGURE 31.4
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FIGURE 31.5

The Open and Save

category.

General

»'

Preferences

O-

Spelling yr

Hniiiiays Interpret RTF

n Hluiays Make Backup

^ fllloui Fast Saues

E3 Prompt for Summary Info

H Saue Reminder Euery |l5 I Minutes

Al>vays Make a Backup
With this box checked, Word 5 will always make a backup copy of the pre-

vious version of your document whenever you save your current work. It

does not make a backup when you first save a document, but makes back-

ups on second and subsequent saves. Keep file names short if you plan to

use this feature, and note that automatic backup disables Fast Saves (see

the next topic). As you probably read earlier, the backup file created by

Word is a copy of your document before your last save, and does not con-

tain your most recent changes. In other words, the backup feature lets

you go back in time one generation.

For instance, suppose you created a new document containing only

the word Test, and saved it as a file called Example 1. There would be no

backup created at this point. Suppose that you then modify the text to

read Test two. Now when you save. Word creates two files in your folder

—

one called Example 1 and another called Backup of Example 1. If you

were to open Backup of Example 1, you would find that it contained only

the word Test. Example 1 would contain the words Test two and would

be the most recent version of your work.
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m A R N I N G

m

Don't use this feature as your primary or only backup

method.

Allo>v Fast Saves
This feature speeds the saving process. Rather than writing the entire

document to the disk each time you save, Word writes and keeps track of

just the changes. Eventually, Word performs a slower, full save to clean

up the document file and reclaim some memory. Quick saves are par-

ticularly useful if you work with floppies, save over a network, and so on.

The always backup feature disables fast saves.

A R N I N G

Some applications and conversion utilities may be

incompatible with Word created with Fast Save.

Prompt for Summary Information
This box turns on and off Word 5's new Summary Information feature.

See Chapter 6.

Save Reminder Every n Minutes
With this box checked. Word asks you how often you wish to be

reminded to save your work. Enter the number of minutes between

saves. Whenever the specified number of minutes passes without your

saving your work, you'll see a dialog box like the one in Figure 31.6.
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FIGURE 31.6
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The Save reminder dialog box lets you save by simply clicking

OK (or by pressing Return). If you want to postpone the save and be

reminded again, you can specify a length of time to be left alone. The
cancel box postpones the reminder for the default period. That is to say,

if you have entered 15 minutes in the save reminder box, then you would

be interrupted again in 15 minutes. To stop the interruptions entirely,

go back to the Open and Save Preferences category and remove the X
from the save reminder box.

The default font category

The Default Font category shown in Figure 31 .7 lets you pick a font and

size for new documents. It defines the font and size used by the Normal

style. Press on the appropriate triangle to reveal the font or size menu.

Slide the mouse pointer down the menu and release the mouse button

on the desired item. Your choice will be highlighted and a checkmark

will appear next to it, as shown in Figure 31.7.

The spelling category

This category lets you pick dictionaries and instruct Word's spell

checker to ignore certain words or combinations of words and numbers,

as shown in Figure 31.8.

Main Dictionary

A drop-down list shows all main dictionaries in your Word Com-

mands folder. The one you check will be used when you run the

spelling checker. Contact Microsoft for information about additional

dictionaries.
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FIGURE 31.7
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Custom Dictionaries

This is where you specify which custom dictionaries Words spelling

checker will automatically use. Custom dictionaries might include

FIGURE 31.8
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technical phrases, client names, etc. It is best to keep custom dictionaries

in the Word Commands folder, since Word looks for them there first. See

Chapter 18 for more information about dictionaries and spelling checks.

Always Suggest
An X in this box causes Word's spelling checker to always suggest

replacement words when it detects a possible misspelling. If you turn

off this option, you can still ask Word to suggest when the spelling

checker is running. Start with this feature turned on, even if you were

disappointed with earlier Word versions. Word 5's suggestions are much
better and appear more quickly than prior versions'.

Ignore
A checkmark in the Words in UPPERCASE box will cause word to ignore

acronyms like ASAP, RAM, etc. Word will still check text that has been

given the appearance of being capitalized by the All Caps and Small

Caps style features. Words with Numbers tells the spelling checker to

skip techno-babble like 800K and words containing numbers, such

as 10cm.

The grammar category

You will probably need to scroll down using the scroll bar to bring the

Grammar and remaining category icons into view. The Grammar cate-

gory (shown in Figure 31.9) lets you specify which writing style and

grammar rules will be used by the Grammar checker. An Explain...

button offers brief explanations of each option. See Chapter 18 for

more information about grammar checking.

Rule Groups: Style

Clicking on the St)'le button reveals a scrollable list of style tests that can

be turned on or off Click to the left of choices you wish to toggle. A
checkmark indicates that the grammar checker will watch for the indi-

cated problem.
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Rule Groups: Grammar
Clicking on the Grammar button replaces the list of style issues with a

scrollable list of grammar rules. Those with checkmarks are enabled.

Catch
The Grammar Preferences dialog box provides a way to fine-tune the flag-

ging of split infinitives, consecutive nouns, and prepositional phrases, as

shown in Figure 31.9. Choose the appropriate menu and scroll down the

list of choices. Release the mouse button to highlight your choice.

The thesaurus category

You will probably need to scroll down using the scroll bar to bring the

Thesaurus and remaining category icons into view, as illustrated in Fig-

ure 31.10.

The Thesaurus category lets you pick a default thesaurus language

if more than one language is installed. Thesaurus files should be located

in the Word Commands folder, since that is where Word looks for them.

FIGURE 31.9

You can turn off

unwanted grammar and

style rules.

Preferences

Hyphenation

rKul
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FIGURE 31.10

The Thesaurus category.
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See Chapter 1 7 for more information about the thesaurus. Contact

Microsoft regarding additional languages.

The hyphenation category

This dialog box lets you pick a default hyphenation language and is

almost identical to the Thesaurus category. Hyphenation files should be

located in the Word Commands folder, since that is where Word looks

for them.

m
Version 5. 1 has an additional category—Toolbar. Read

about it next.
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The toolbar category

The version 5.1 Toolbar category lets you turn the Toolbar off as the

default, and it lets you specify the Toolbar position. There are also but-

tons in this category that take you to the Customize and Addresses dialog

boxes. All of these choices are also available on the Toolbar and menu.

Modifying word's menus
Word lets you control the appearance and arrangement of its menus.

You can add, delete, and reposition menu items. It is possible to change

the keyboard shortcut assignments for most menu items. There are two

ways to modify menus. You can use the Commands dialog box or some

menu changing keyboard shortcuts. Let's look at the dialog box method

first.

Reach the Commands dialog box by choosing Commands... from

the Tools menu or using the l€-Shift-Option-C keyboard shortcut.

Using the commands dialog box

Take a moment to study your screen's Commands dialog box, shown in

Figure 31.1 1. It is one of the most crowded you will find in Word. There

is a .scrollable list of commands in the upper-left corner. You select com-

mands by scrolling them into view and clicking on them once or by

typing the first few unique characters in their names. You will see a

description box to the right of the command list that tells about each

command as you select it. Beneath the list and the description box you

will find two more boxes—one tided Menu, the other Keys. The Menu

box lets you tell Word where you want to place or remove items. The

Keys box is used to assign keyboard shortcuts.

At the bottom of the Commands dialog box you will see the Set-

tings File section. It contains four buttons. These are used to manage

multiple settings files and to restore Word's default settings.

The upper-right corner of the Commands dialog box contains two

buttons and an information area. We'll learn about the tools here by

using them to add the Screen Test menu item.
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FIGURE 31.11
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FIGURE 31.12
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FIGURE 31.13
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2. Scroll the command list if necessary and select the menu
item yon want to remove.

3. Click the Remove button and close the dialog box.

Some menu choices like About Microsoft Word cannot be removed. The

Remove button will remain dim in these instances. Obviously, if a com-

mand has not been added to a menu it cannot be removed; therefore,

the Remove button will be dim in these cases as well. Removing com-

mands from menus does not remove them from Word. You can still use

their keyboard shortcuts or open the Commands dialog box and use

them from there. That is the purpose of the Do It button in the Com-

mands dialog box.

Restoring the commands... menu choice

At first you might think that removing the Commands... menu choice

would prevent you and others from reaching the Commands dialog box

and modifying Word's menus. In fact, soine system managers use this

trick to secure the menu layout.

If someone has accidentally or intentionally removed your Com-

mands... menu choice, you can get it back.

1. Use the keyboard shortcut (3€-Shift-Option-C) to bring up

the Commands dialog box.

2. Re-add Commands... to the Tools menu.

3. Click in the close box to return to vour document.

Moving menu items

To move a menu item, first remove it, then reinstall it at the desired new

location using the Menu and Add Below features discussed previously
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Adding and removing separator lines

Most menus contain separator lines that help you spot groups of related

choices. For instance, there are three separator lines on the standard

Word File menu. You have some (but not total) control over their quan-

tity and location.

You add, remove, and position separator lines just like any other

menu item. Suppose, for instance, you wanted to add a separator below

the Open... command in the File menu.

1. Bring up the Commands dialog box as before.

2. Scroll down and select the Separator choice in the com-

mands list.

X Specify the desired menu (File for example) in the

Menu box.

4. Pull down the Add Below menu to specify the posidon of

the new separator, as shown in Figure 31.15.

5. When you click on Add and close the Commands dialog

box, the new separator will be placed in the appropriate

position, under the Open... command in the File menu.

It is not possible to remove Word's default separator lines. Custom lines

can be removed, though. To do so, press 9€- Option— (the cursor will

turn into a large minus sign), click the menu, and drag down to the

separator you want to delete. The separator will flash and disappear.

The work menu
The Work menu is a powerful but sometimes overused and often mis-

used tool. The addition ofWord 5's new ribbon and ruler features

further reduce the need for Work menus, but they are still worth under-

standing. The Work menu is a place for you to display the names of fre-

quently used documents, glossary entries, and styles. A typical Work

menu is shown in Figure 31.16.
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FIGURE 31.15

Specifying the location

of a new separator line

is easy.
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FIGURE 31.16

A typical Work menu
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Once you've created a Work menu, you can open documents, paste

glossary entries, or apply styles by visiting the Work menu. Sometimes,

this technique is quicker than using other methods of doing the same

thing.

For instance, suppose that you have been working on a new agree-

ment and want to write an accompanying cover letter. If you did not have

a Work menu, you would have to go to Word's File menu and use the

Open... command to sift through the various folders on your disk until

you found the appropriate boilerplate cover letter.

But if you've set up a Work menu containing the name of the

boilerplate document, you can simply pick Agreement Cover Letter from

the Work menu. Based on things you tell it when you set up the Work

menu. Word will remember, quickly locate, and open the document.

This may be the best way to use the Work menu—as a shortcut for load-

ing frequently used documents.

Remember, however, if you rename files or move them to different

folders. Word will not be able to find them. If you select such a file from

the Work menu, you will see a dialog box asking you to help find the files.

The Work menu can do other things. Suppose you are designing a

new brochure using Word and you want to paste in a copy ofyour logo. If

you have stored a copy of the logo in your glossary and ifyou have added

the Logo glossary item to your Work menu, you could go to tlie Work menu

rather than the glossary to paste the logo. Similarly, you could list glossary

items like address lines, signature lines, and so on in your Work menu. But

you may prefer to add keyboard shortcuts for your favorite glossary entries

instead. See Chapter 1 6 for more about glossaries.
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Finally, suppose you've created a very involved paragraph style for

in\()i( ing or some other puipose. You might be able to place its name on

the Work menu, then visit the Work menu rather than the ruler's Style

menu when you want to apply the style. However, this technique works

only if the document you are editing contains the style listed on the

Work menu. See Chapter 13 for more about styles.

Creating a work menu
With that background, let's see what is involved in creating a W^ork

menu. In most cases, you start by opening a dialog box. For instance, to

add a file name to the Work menu:

1. Start by opening the Open dialog box (from Word's File

menu, S€-0), as shown in Figure 31.17.

2. Locate the file you wi.sh to add to the Work menu using the

usual Macintosh navigation tricks; then highlight the file

name by clicking on it.

3. Next, while holding down the Option and 3€ keys, press the

plus (+) key on the top row of your keyboard (not on the 10-

key pad).

4 Your mouse pointer will tiun into a large, bold plus sign, as

shown in Figure 31.17 next to the file name.

FIGURE 31.17

Highlight the name of

the file you want to add to

the Work menu.
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5. Click on the Open button in the dialog box. Your menu bar

will flash.

6. A Work menu will appear on the menu bar, if there wasn't

one there already, with the file name you selected added to

the menu.

Use the same basic techniques to add glossary entries to your work menu

—

open the Glossary dialog box (on the Edit menu, 16-K), select an entry

of interest, press Option-§€-+, and proceed as above. Styles are added the

same way.

D I P

Before getting carried away with adding glossary and

style entries to your Work menu, consider creating keyboard

shortcuts for these items instead. If you have multiple

glossaries, you can list them in the Work menu and flip

between them quickly. See Chapter 16 for more information

about multiple glossaries.

Removing work menu items

To remove a Work menu item:

1. Hold down the Option and §€ keys and press the minus key

on the upper row of your keyboard (not on the key pad).

2. The mouse pointer becomes a bold, black minus sign.

X Go to the Work menu and pick the doomed item.

4 Your display will flash and the item will disappear. Undo will

not make it reappear.
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Listing commands
As you can imagine, it is important to document the commands you are

using with Word, particularly if you have made changes to the standard

setup. Word 5 has a feature that lets you do this quickly. It is the List...

button located near the bottom of the C.onunands dialog box.

Clicking it will create a new Word document containing a table

listing either just the commands on your menus or all possible Word

commands. You decide by clicking the appropriate button, as shown in

Figure 31.18.

FIGURE 31.18
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FIGURE 31.19
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Resetting word's standard menus
There are several ways to restore Word's standard menus. The brute

force method is to use tlie Reset function found in the Commands dialog

box. After clicking on the Reset... button you will be given three choices,

as shown in Figure 31.20.

Besides restoring the factory menus, Reset can restore other things,

such as default preferences. This may or may not be desirable. If you've

just spent the afternoon getdng margins, type styles, grammar rules, and

other preferences the way you like them, avoid the temptation to use the

Reset to Microsoft Standard Settings choice. There are better ways to re-

store menus, as you will see in a moment.

The top choice restores all ofWords standard settings, not just

menus. The second choice returns you to your last group of saved set-

tings. The third choice leaves your non-menu preferences as is, and adds

all of Word's commands (one hundred plus) to their default menus. It

does not remove non-default menu items (like Screen Test) if you've

added them.

FIGURE 31.20
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Keyboard shortcuts

EE3

Appendix B lists Word's standard keyboard shortcuts next to the com-

mands they evoke. A shortcut can be a combination of up to four keys.

There are several ways to have Word show you which keyboard shortcuts

do what. You can also edit and enter your own shortcuts.

ARMING

If you work only on one Mac, keyboard differences are

probably a trivial matter to you. But if you work in a large

office with new and old Macs, and a variety of keyboard

styles, you need to make certain you don't assign combin-

ations that are unavailable to some users. Similarly, if you

assign numeric keypad keys to shortcuts, realize that users

without numeric pads won't be able to use your new short-

cuts. Test new combos and review user documentation on

each keyboard type in your organization.

Printing a shortcuts list

One way to learn about shortcuts in general is to print and study a com-

mand list using the List... feature in the Commands dialog box.

Browsing shortcuts key combinations

Here's a quick way to see what a specific key combination does:

1. Start by opening the Commands dialog box, found under

the Tools menu.

2. With the Commands dialog box in \iew, type the key com-

bination of interest.
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3L The associated command (if there is one) will scroll into

view in the commands list.

4b A description of the command will appear in the Descrip-

tion portion of the dialog box. Since any Word command
can have many different keyboard shortcuts, they will all be

listed in the Keys area of the dialog box. Scroll if necessary.

Assigning and changing keyboard shortcuts

You can assign a new shortcut from the Commands dialog box. There is

also a quicker way. Let's start with the dialog-box technique.

Assigning shortcuts
from the commands dialog box

To assign or change shortcuts from the Commands dialog box:

1. Open the Commands dialog box with the Tools menu's

Commands... choice.

2. Scroll and select the command you wish to modify. In Fig-

ure 31.21 Screen Test is selected. Notice the Keys area of

the dialog box. This command does not yet have a shortcut.

3. Click on the Add... button in the Keys area (be careful, the

Commands dialog box has two different Add buttons).

4b You will be asked to demonstrate the key combination you

want to use for the command.

5. To assign Control-S as the shortcut, press that combination.

6. Word will add it to the Keys area of the dialog box. Hence-

forth, Control-S will activate the Screen Test.
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FIGURE 31.21
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FIGURE 31.22
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Command reference

Now that you know how to add, move, and delete commands, take a few

moments to browse Table B. 1 in Appendix B. It lists all available Word 5

commands and offers some tips on their use. If yon find some commands
that interest you, add them to your menus and experiment.

Using multiple command sets

As yoti know, menu configurations (and much more) are stored in Word
settings files. Normally, Word 5 uses the settings file called Word Settings

(5), located in your System Folder. But suppose you want to have dif-

ferent Word 5 configmations for specific tasks like script writing? Or suf)-

pose you share your computer with someone who wants to have more or

different menu choices? It is possible to create multiple settings files,

then switch to the one that best suits your needs. Microsoft has even

provided some alternative settings files you may find useful.

The bottom of the Commands dialog box contains controls that let

you save and load different settings files. Clicking on the Open button in

the Settings File area of the Commands dialog box brings up an Open
dialog box, as shown in Figiue 31.23.

Use the dialog box to locate and load alternate Word settings files

of interest. (The alternate files provided by Microsoft are normally in a

folder called Settings Files, which will probably be in your Word 5

FIGURE 31.23
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setlings files for different

applications or user skill

levels.
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folder.) Once yon locate the settings file yon desire, either double-click

on its name or click on the Open button in the dialog box.

For instance, Word 5 comes with a settings file that provides ab-

breviated menus, much like the old Short Menus feature in Word 4. Some
casual users may find these simplified menus less confusing. Another set-

tings choice emulates MacWrite II settings. Notice that the file list in Figure

31.23 includes a settings file called Word Setdngs (5). This is not the one

Word normally uses. This is normally an unmodified version of the standard

factory settings. Your settings file is in your System Folder.

Reverting to standard defaults

Be aware that reverting will change other things besides the Microsoft

standard settings you hope to regain. For instance, if you have a list of

most recently used files, they will not be on the file menu after you revert

to Microsoft's standard settings. If you have reassigned some keyboard

shortcuts, those changes will also be lost. Your default-font choice will

need to be made again as well.

That said, there are several ways to revert to Microsoft's standard

defaults. The brute force method is to reinstall Word, but you needn't go

to that extreme.

WTienever Word starts, it looks in your System Folder for a Word Set-

tings (5) file. If it can't find one, it makes a new one. Thus, dragging the

Word Settings (5) file from the System folder into the trash (or renam-

ing the settings file) before you start Word will cause Word to create a

new standard Word Settings (5) file. There is one potential gotcha, how-

ever. You must do this when Word is not running, otherwise Word will

write the unwanted settings to a replacement settings file.

Last but not least. Word's Commands dialog box has a button for

resetting.

1. Open the Commands dialog box with the Commands...

choice on the Tools menu (or the 3€- Shift-Option-C

shortcut).

2. Click the Reset... button.

3. You will see a dialog box like the one back in Figure 31.20.
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4b Choose Reset to Microsoft Standard Settings and things

should be back to Microsoft's suggested defaults!

5. Quit Word to save these changes.

Changing the default style sheet

To add your own styles to Word's standard style sheet:

1. Open the Style dialog box with the Format menu's Style...

command or the 3€-T shortcut.

2. Select the style you wish to add.

3. Click Use As Default.

4b Confirm the addition to your default style sheet.

5. Add others if you wish.

6. Click OK to return to your document.

7. The changes are saved to disk when you quit Word.

To remove styles from the Default style sheet:

1. Open the Style dialog box with the Format menu's Style...

command or the 9€-T shortcut.

2. Select the style you wish to delete (it should be one that's

on your default style sheet)

.

X Click Delete.

4b Confirm the deletion from your default style sheet.

5. Delete others if you wish.

6. Click OK to return to your document.

7. The changes are saved to disk when you quit Word.
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Changing the default document
- formatting options

1. Open a document.

2i Visit the Document dialog box from Word's Format menu
or with the 3€-F14 keyboard shortcut.

3i Choose all the desired document-wide options (margins,

tab settings, Even/Odd settings, etc.).

4 Click Use As Default button in the Document dialog box.

Changing the default page setup
- OPTIONS

1. Open a document.

2. Visit the Page Setup dialog box from the File menu or with

the Shift-F8 keyboard shortcut.

X Choose all the desired page setup options (Fractional

widths, page orientation. Larger Print Area, etc.).

4. Choose Use As Default in the Page Setup dialog box.

Changing the amount of ram
- available to word

It is sometimes useful to increase the amount of RAM reserved for

running Word, particularly if you work with large documents. Changes

are made in Word's Get Info box. You must quit Word to make these

changes. When specifying RAM for Word, be sure you leave enough for

your System software and other applications that you might want to run

simultaneously (Excel or a drawing program, for instance).

1. Quit Word if it is running (§€-Q)

.

2. From the Finder, click once on the Microsoft Word pro-

gram icon.

3. Choose Get Info from the Finder's File menu (§€-I).
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CHANGING THE AMOUNT OF RAM AVAILABLE TO WORD

4» Type a new number in the Current size box as shown in Fig-

ure 31.24. Normally you'll want to assign at least the mini-

mum suggested RAM, or additional RAM in increments of

1204 K (2,048 K, 3072 K, etc.).

You can customize the appearance, position, and

functionality of version S.l's Toolbar. Read how next.

FIGURE 31.24

Increasing the amount of

memory reserved for

Word can sometimes

improve the program's

performance.

IMMmA^imi^l sD^^ Microsoft IDord Info |
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Changing version s.rs toolbar
It is possible to position the Toolbar on the Top, left or right of your

screen. Moreover, if you find that there are Toolbar buttons you never

use, it is easy to replace them with different, more useful ones. Word

provides about 150 command choices, and a variety of button icons you

can associate with those commands.

Controlling the toolbar's position

Use the Toolbar menu at the extreme right of your toolbar to specify' the

desired Toolbar position (Top, Right or Left). The current Toolbar posi-

tion will be dimmed. Figure 31.25 illustrates this.

Adding and removing toolbar buttons

Suppose you never use the Change Case button, but use the Thesaurus

regularly. It is easy to remove one button and replace it with the other.

Here are the steps (refer to Figure 31.26 as you read them).

1. Display the Toolbar if it is not already in view. (Use the Tool-

bar choice on Word's View menu.)

2. Choose Customize... from the drop-down list reached with

the Toolbar button at the right end of the Toolbar (the tri-

angle button).

FIGURE 31.25

Use the Toolbar menu to

specify a location for tlie

Toolbar and to open a

dialog box for customizing

the button collection.
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3. You'll see the Customize dialog box.

4b Decide which button you wish to remove.

5. Select that button in the drop<lown button Position list in

the Customize dialog box (Change Case... in our example).

6. From the scrolling command list, choose the command you

wish add (Thesaurus... in our example).

7. Choose a button icon from the scrollable Button list. Pick

something meaningful looking that's not already on your

Toolbar (a book, in our example).

& Click Change.

9. Change other buttons if you like, than click Close when

done.

Resetting the toolbar

To restore the Toolbar's factory settings:

1. Display the Toolbar if it is not already in view. (Use the Tool-

bar choice on Word's View menu.)

FIGURE 31.26

Select the position you

wish to change, choose a

new command and button

icon, then click Change

and Close.

Customize

Button Position:

|BBt| Change Case.

Button: Command:

;;? «s
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7. Choose Customize... from the drop-down list reached with

the Toolbar button at the right end of the Toolbar (the tri-

angle button).

X You'll see the Ctistomize dialog box.

4b Click the Reset... button.

5. A dialog box will ask if you prefer the original Toolbar but-

ton or the last saved Toolbar.

6. The Toolbar will return to normal.

7. Click Close when done.
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I HIS APPENDIX EXPLAINS how to install

^M Word. It covers what yoii need as far as

disk space for full or partial installation and how to prepare your Mac-

intosh and run the Installer.

What you need

You can install Word on any Macintosh that has a hard drive and at

least an 800 K disk drive. System 6 users will need a minimum of 1 Mb
of RAM or 2 Mb if they want to run Word's grammar checker. If you have

only 1 Mb of RAM, the Installer will not install the grammar feature.

System 7 users need at least 4 Mb of RAM to rim Word with the

grammar checker. Your hard drive will need to have a minimum of be-

tween 5 and 7 Mb free at the time of installation, although Word will not

need all of that disk space after the installation. (The Installer program

will inform you if you need to free up additional hard-disk space.)

Word is shipped on six 800 K diskettes:

Install

Program

Converters
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Proofing Tools

Commands

More Commands

The files are compressed, thus they cannot simply be dragged onto your

hard disk. You need to run the Installer program, which will walk you

through the simple installation steps.

Preparing your mac
1. Start by turning off any virus-protection software you are

running, and disable GateKeeper if you are using it.

2i If you have a Radius Rocket board installed, turn it

off before running the Installer, as the two may not be

compatible. You can turn it back on after a successful

installation.

3b Ifyou are running System 7 or MultiFinder, quit any other

programs you are running before starting the installation.

Running the installer

1. Insert the Install disk and double-click to open it.

2. Start by reading any ReadMe files on the disk, then return

to the Install disk window and double-click on the Installer

icon, shown in Figure A. I.

FIGURE A.I

Double-click on the

Installer icon found on the

Initall disk to launch the

installation program.

IDB Install ^Hi
7 items 77tKindisk

Installer 3 3

o

^
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3. If this is the first time you've used the Install disk, you will

be asked to personalize it.

4. Enter the necessary information.

5. You will be reminded to send in your registration card. Ac-

knowledge the reminder.

6. You will be reminded about turning off virus protection

and GateKeeper. If you have done that already, continue.

Otherwise quit. Then rerun the Installer after turning

things off. Soon you will see a dialog box like the one in

Figure A. 2.

7. The lower-left corner of the gray, dotted box shows which

hard disk the Installer plans to use. If you have more than

one hard disk, pick the one you want to install Word on by

clicking the Switch Disk button. If you try to install on the

disk used to start your Mac, Word will order you to quit

other programs before continuing. It will assist with orderly

shut-downs of your various programs.

8. Unless you have very limited hard-disk space, it is advised

that you use the Easy Install option.

FIGURE A.2

Choose Easy Install for

most sHuotions.

Easy Install

Click "Install" to install

• Microsoft Ulord Uersion 5.0

• Plug-In Modules
• File Conuerters
• System Resources for Ulord 5.0

on the hard disk named

<=^ Ron's IICK

Help

f[
Install™])

( tied Disk ]

( Smitch Disk
]

( Customize
]

(
Quit ]
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9. Clicking the Install button will determine which Microsoft

installation disks are required and ask you to pick a folder

to hold your new Word 5 files. Normally, you will want to

create a new one.

10. Click on the New Folder button and you will be prompted
for a folder name as shown in Figure A.3.

11. Type a folder name, click Create, and then click Install.

1Z If all goes well. Word will ask you for the necessary disks to

complete the first part of the installation. Feed them to

your Mac in the order requested. Because the files are com-

pressed they need to be imstuffed. The Installer does this

for you, but be prepared to wait fifteen minutes or more for

the process to end. You will see a series of boxes like the

one in Figure A.4 as unstuffing progresses.

13. Near the end of the process you will get an opportunity to

pick a default font. Word proposes New York. If you plan to

use a laserprinter, consider choosing a laser font (such as

Times or Palatine) . You can change this later if you wish.

FIGURE A.3

Create o new folder for

Word 5 Willi the Iristaller's

help.

s
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FIGURE A.4

The Installer will keep

you posted as it unstufh

your files.

IPi
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Mail

Symbol

Picture

Equation Editor

Equation Editor Help

Grammar

U.S. English Grammar

Spelling

U.S. English Dictionary

Custom Dictionary

Thesaurus

U.S. English Thesaurus

U.S. English Hyphenation

EPS/TIFF/PICT

MacWrite II Converter

Windows Metafile Converter

Word for DOS 5.x

Word for Windows 1

Word for Windows 2

WordPerfect for DOS 5.x

MS Word Conversion Options

Microsoft Graph (folder)

Microsoft Graph

Microsoft Graph Help

Glossaries (folder)

Date and Time Glossary

Formula Glossary

Formula Glossary Information

Page Layout Glossary

Page Layout Glossary Info
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Settings Files (folder)

MacWrite II Settings

Short Menu Settings

Word 4.0 Settings (5)

Word for Windows (2) Settings

Word Settings (5)

Sample Documents (folder)

Brochure

Business Letter

Business Report

Employment Form

Memo

Newsletter

Resume

Envelopes (folder—see disk for folder contents)

Practice Documents (folder—see disk for folder

contents)

Mailing Labels (folder—see disk for folder

contents)

The following files are not installed with the Easy Install option:

Works for Macintosh 2.x

RFT-DCA Converter

If you need them, use the custom Installer to add them later.
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Running Word after Installation

You will need to restart your Mac to use Word 5. The Installer will pro-

vide congratulations and a Restart button.

Custom installation

If you choose not to do an easv installation, vou can tell the Installer

which items you want to install. This is helpful if you have limited disk

space or if one of your non-essential disks is damaged. For instance, you

could live without the converters disk until Microsoft sends a replace-

ment. Click on Customize when starting the installation (see Figure A. 2).

Optional installation items include:

Spell checker (U. S.)

Grammar checker

Thesaurus

Hyphenation

Mail

Equation Editor

Picture (the drawing feature)

Find File

Text Annotation (5.1 only)

Voice annotation

Symbol

Drop Caps (5.1 only)

Toolbar (5.1 only)

Microsoft Graph (5.1 only)
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It's a good idea to install the sample documents and glossaries, as they

contain helpful files and examples. If you choose not to install certain

features (like the wonderful new spell checker), they will either not ap-

pear on your Word menus or will always be dimmed. You can always

return to the Installer later and install just the items you left off when
you last did a custom installation.

Using old dictionary and glossary files

If you have old custom dictionaries and settings files from Word 3 or 4

scattered around your hard disk, you may be able to use them with

Word 5. To round them up, use Word 5's new Find File, Preferences,

and Settings features.

The discussion and handy tip that follow assume you know about

Word 5's new Preferences dialog box. Dictionary features. Find File...,

and the Commands dialog box. (You may want to read about them first,

then come back here.)

To find dictionaries, visit the Preferences dialog box and open the

Spelling category. Click Open... then Find File... on the resulting Open
dialog box, similar to the one shown in Figure A.5.

FIGURE A.5

A special Find File

feature will help you

locale old custom Word

dictionaries and settings

files for possible use with

Words.

MS Ulord 4.0 D f

U Added Words

U Custom Dictionary

D Main Dictionary

D Sijbex Typeset Codes

H

Find File

Uiem: Contents

Canada

PrintMonitor

Ron

Sybex

Unbilled

nnos

Search Tent

B

IQi

[f Open
]] I

Search...
] [ Sort...

) [
Pfin?... ]
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To find settings files, visit the Commands dialog box and follow the

same basic steps. The Find File dialog box will list all of the dictionaries

(or Settings files) it finds. Opening them from Find File makes them
available to you in Word 5.

m
Version 5. 1 lets you install a limited version of Word on

your PowerBook that takes less disk space but offers fewer

features. It also installs a battery indicator on your Toolbar

that shows an estimate of the approximate amount of

remaining battery charge.
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Commands
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w ORD 5 HAS a bewildering number of

IB commands, many of which have similar

names or similar functions. To help you find commands quickly, we have

listed most of the Word 5 commands in this appendix in two formats.

First, you will find each command in a function-specific table

(Tables B.1—B.7).

Second, we have listed the commands in an alphabetized glossary.

In this glossary we have noted a keyboard shortcut if there is one. Com-

mands that are only available in version 5.1 are so noted. Happy himting!

TABLE B.I Choosing Commands wilb Key Combinations



GLOSSARY OF WORD 5 COMMANDS

TABLE B.I Choosing Commands v/ilh Key Combinations (continued)

TO CHOOSE... PRESS. OR

FUe

Edit

New
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TABLE B.I Choosing Commands with Key Combinations (continued)
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TABLE B.I Choosing Commands with Key Combinations (continued)
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TABLE B.2 Outliner Keyboard Shortcuts

TO... PRESS THIS IN OUTLINE VIEW

Switch to Outline view

Switch from Outline to

Normal view

Promote heading (<—

)

Demote heading (—>)

Move heading up (T)

Move heading down (4-)

Demote to body text (^)

Show/Hide text below

all headings

Show/Hide text below

selected heading

Display or hide character

formatting

3€-Option-0

9€-Option-N

Option- <—

Option

—

>

Option- T

Option- J-

Option-Shift- -^

Option-Shift- «- or - sign (numeric

keypad)

Option-Shift- T or / (numeric keypad)

TABLE B.3 Choosing Options in Dialog Boxes

TO DO THIS... PRESS.

Select next text or scrolling box

Select previous text box

Move right or left within a text box

Tab

Shift-Tab

-^ or <—
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TABLE B.3 Choosing Options in Dialog Boxes (continued)

TO DO THIS.. PRESS...

Select next option (list, check, or
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TABLE B.4 Mouse Shortcuts

TO... DOUBLE-CLICK ON..

Open the Tabs dialog box in the

Paragraph dialog box

Open the Paragraph dialog box

Open the Go To dialog box

Open the Style dialog box

Open the Section dialog box

Open the footnote window at a

desired foonote

Open the Document dialog box

Open the Character dialog box

Split the current window in half,

unsplit windows

Zoom into or out from a window

Return to an embedded object's

application

A tab stop marker on the ruler

or one of the tab buttons

An indent marker on the ruler

The page number in the status

area (lower-left screen corner)

The style name in the status area

(left of the scroll bar)

Any section mark

An automatically numbered

reference mark

Outside the margins in the page

corners in Page Layout view

The ribbon between boxes or

buttons

The split box

The window's title bar

The embedded object in the

Word
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tfUUTI-^^B Characler Formatting
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TABLE B.5 Character Formatting (continued)

FOR THIS

FORMAT.. PRESS.

Subscript

Superscript

Copy formatting

'Acts as a toggle (will turn feature on or off).

3€-Shift- - (minus

sign)

3€-Shift-+

9€-Option-V

TABLE B.6 Paragraph Formatting

OR

Shift-F4

FOR THIS FORMAT.. PRESS.

Normal paragraph

Apply new style*

Left-aligned

Right-aligned

Centered

Justified

First-line indent

Nest paragraph

Unnest paragraph

Hanging indent

Double space

3€-Shift-P

i€-Shift-S

§€-Shift-L

i€-Shift-R

8€-Shift-C

3€-Shift-J

3€-Shift-F

i€-Shift-N

3€-Shift-M

§€-Shift-T

S€-Shift-Y



GLOSSARY OF WORD 5 COMMANDS

TABLE B.6 Paragraph Formafting (continued)

FOR THIS FORMAT. PRESS...

Open spacing** J§-Shift-0

Copy formatting 3€-Option-V or Shift-F4

* You still then need to type a style name.

" Toggles Space Before between and 12 points.

TABLE B.7 Keyboard Shortcuts: Scrolling, Moving, and Editing

SCROLLING TO MOVE TO. PRESS...

Up

Down

Left

Right

Previous Word

Next Word

Beginning of line

End of line

Previous sentence

Next sentence

Next page

Previous page

T or 8 (keypad)

i or 2 (keypad)

<— or 4 (keypad)

—> or 6 (keypad)

3§-<— or3§-4 (keypad)

3€-^ or 3€-6 (keypad)

7 (keypad)

1 (keypad)

J§-7 (keypad)

16- 1 (keypad)

3€-Page Down

3€-Page Up
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TABLE B.7 Keyboard Shortcuts: Scrolling, Moving, and Editing (continued)

SCROLLING TO MOVE TO... PRESS.

Beginning of current

paragraph

Beginning of next

paragraph

Top of window

Bottom of window

Start of document

End of document

Scroll up one screen

Scroll down one screen

Scroll up one line

Scroll down one line

§€-t or3€-8 (keypad)

X-i or3€-2 (keypad)

Home or3€-5 (keypad)

End

5§-Home or 3€-9

(keypad)

3€-End or 3€-3 (keypad)

Page Up or 9 (keypad)

Page Down or 3

(keypad)

or * (asterisk on

keypad)

+ (plus sign on keypad)

MOVING IN A

TABLE OR IN

PAGE LAYOUT

VIEW TO MOVE TO. PRESS.

First table cell or page

element

End of table or last

page element

Next cell in table

§€-Option-7 (on

keypad)

3§-Option-l (on

keypad)

Tab or 3i-Option-3 (on

keypad)
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TABLE B.7 Keyboard Shorlcuts: Scrolling, Moving, and Editing (continued)

SCROLLING TO MOVE TO.. PRESS.

Previous cell in table

Next page element

Previous page element

Cell or page element

above

Cell or page element

below

Cell or page element to

the left

Cell or page element to

the right

Shift-Tab or 9€-Option-

9 (on keypad)

9€-Option-3 (on

keypad)

S€-Option-9 (on

keypad)

3€-Option-8 (on

keypad)

3€-Option-2 (on

keypad)

§€-Option-4 (on

keypad)

3i-Option-6 (on

keypad)

EDITING TO... PRESS.

Select the entire

document

Delete character before

cursor or selected text

Delete character after

cursor or selected text

Delete previous word

Delete next word

Insert formula character

§€-A

Delete (Backspace)

3€-Option-F or Del

3€- Option-Delete

(Backspace)

9€-Option-G

l€-Option-\ (backslash)
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TABLE B.7 Keyboard Shorlcuts: Scrolling, Moving, and Editing (continued)

SCROLLING TO MOVE TO... PRESS..

(.()|jv text

Move text

Insert glossary entry

Copy formats

Insert special character

(symbol)

Copy as picture

9€-Option-(;

3€-Option-X

3€-Delete

9€-Option-V

8S-Option-Q

§€-Option-D

Glossary of word 5 commands
About Murosoff Word Shows Word version and serial number.

Gives access to on-line help.

A<tivate Keyboard Menus (§€-Tab or keypad-, (period)) Lets

you use keystrokes to pull down menus and make choices. When Menu
bar blackens, type first character of menu name (f for File, etc.). When
menu appears, type letters or use arrow keys to highlight desired func-

tion, press Return or Enter to execute. Feature self<ancels if not used

soon after activated.

Add to Menu (i€-Option-= or 9€-Shift-Option-=) Adds selected

command to the default or "home" menu.

Address Entry (5. 1) Takes you to the Address dialog box.

Addresses. . . (5, 1} Takes you to the Address dialog box.
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All Caps (§€-Shift-K or Shift-FlO) Toggles appearance of

selected text to all caps or not. Underlying characters retain original

capitalization.

Allow Fast Saves Lets you turn the Fast Save feature on and off

from the menu bar.

Always Inferpret RTF Toggles automatic conversion of Rich Text

Format documents when opened by Word.

Always Make BaKkup Files Toggles automatic backup copy

feature.

Annotation... (5.1) OpensAnnotationwindowin version 5.1 only.

Annotations... (5,1) Displays annotations entered with version

5.rs Annotation command (if any).

Apply Style Name:
( Work menu) Applies indicated style to

selected paragraph (s).

Assign to Key (3€- Option-keypad + or 3€-Shift-Option-left arrow)

Used to assign a key combination to a command.

Ba<kgi'OUnd Repagination Toggles automatic repagination,

which activates during typing pauses. Turn off if repagination causes

bothersome delays or "keyboard stuttering."

Batkspate {Delete on the Edit menu) The Backspace key.

Bold (3€-B or 36-Shift-B or FIO, on the Format menu) This toggle

command makes text appear and print darker and thicker by applying

Word's bold character format. There is also a ribbon button for this fea-

ture. Note that the key combination has changed from Word 4.
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Border. . . (Format menu) Used to apply and remove selected cell

and paragraph borders. Provides different dialog boxes for tables or para-

graphs. Brings up Border dialog box.

Bullet (5. 1) Inserts bullets or converts paragraphs to bulleted lists

in version 5.1 only.

Coltulofe (§€-= on the Toolsmenu) Computes numerical expres-

sion (s) in selection and places results in Clipboard. Use the Show Clip-

board command or Paste to see results.

Cantel (9€-. (period)) Stops current command actions like Print,

Sort, etc. Can't be added to menus.

Centered (§€-Shift-C) Centers text or graphics between left and

right indents (not margins!). There is a ruler button for this feature.

Change Case... (Format menu) Changes selected text to UPPER-

CASE, lowercase. Title Case, Sentence case, or tOGGLE cASE.

Change Font (li-Shift-E) Changes font of selected text when you

type a valid iont name and press Retiun.

Change Style (§€-Shift-S) Changes style of selected paragraph (s)

when you type a valid style name and press Return.

Charatter. . . (9€-D or F14, on the Format menu) Brings up Charac-

ter Formatting dialog box.

Clear (Fdit menu) Deletes selected text or graphics without moring

them to the Clipboard.

Close (§6-W, on the Filemenu) Closes the active document window.

Will ask to save new changes, if any.

Collapse Selettion in Oudine view collapses selection lo hide

selected headings or text regardless of their le\el.
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Collapse Subtext in Outline view hides subordinate levels or next

highest level if entire heading is selected.

Columns 1 Reverts multicolumn text to a single column. There is a

ribbon button for this command.

Columns 2 Converts text to two columns. Use Page Layout view or

Print Preview to see results. There is a ribbon button for this command.

Columns 3 Converts text to three columns. Use Page Layout view or

Print Pre\iew to see results. There is a ribbon button for this command.

Columns 4 Converts text to four columns. Use Page Layout view

or Print Preview to see results. There is not a ribbon button for this

command.

Command from Key Assignment Great on-line help for learn-

ing keyboard shortcuts. You t}'pe key combinations; this feature tells you

what they do.

Commands. . . (3€-Shift-Option-C, on the Tools menu) Displays Com-

mands dialog box. Lets you add, delete, and move menu items. Don't

remove this choice from your menu bar! If you do, use its keyboard short-

cut to bring up the Commands dialog box, then reinstate the Commands

menu choice.

Condensed 1.5 pt Reduces intercharacter spacing by an amount

you specify when adding this item to the menu. Must be between 0.5

and 1.75 points and will be rounded to the nearest .25 points. Default is

1.5 pt.

Copy (3€-C or F3, on the Edit menu) Copies selected text giaphics or

sounds to Clipboard, replacing previous Clipboard contents. Undo will

revert if done immediately.

Copy as Pitture (9€-Option-D) Places selecdon in the Clipboard in

MacDraw-compatible format.
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Copy Formats (9€-Option-V or Shift-F4) Copies character format-

ting or fiuire paragraph fornialting if paragiaph is selected. Applies for-

matting to subsequently selected text.

Copy Text (9€-Option-C or Shift-F3) Either copies selected text to a

new location or copies text you select after choosing this command to

the current insertion pointer location. Watch status area at lower-left of

screen. Cancel with §€-. (period).

Create Publisher. . . (Edit menu) System 7 feature lets you share a

document or portion thereof with others on your network.

Create Envelope. . . (5. 1) Opens Envelope dialog box in version

5.1 only.

Cut (l§-X or F2, on the Edit menu) Removes selected text graphics

or sounds and places on Clipboard, replacing previous Clipboard con-

tents. Undo will revert if done immediately.

Default Font. . . Lets you quickly set default font.

Delete Cells, Shift Left in tables, deletes selected cell(s), then

moves remaining cells to the left. Deletions do no^ go to Clipboard.

Delete Cells, Shift Up in tables, deletes selected cell(s), then

moves remaining cells up. Deletions do not go to Clipboard.

Delete Columns In tables: deletes column containing inserdon

pointer or selected column (s). DeleUons do not go to Clipboard.

Delete Forward (§€-Option-F or Del) Removes one character to

the right of the insertion point. Some keyboards have both a Delete and

Del key. This is the Del key. Deledons do not go to Clipboard.

Delete Next Word (3€-Oplion-G) Removes word or pardal word to

right of inserdon point. Deletions do not go to Clipboard.
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Delete Previous Word (9€- Option-Delete) Removes word or par-

tial word to left of insertion point. Deletions do not go to Clipboard.

Delete Rows (l€-Control-X) in tables: deletes row containing inser-

tion pointer or selected row(s). Deletions do not go to Clipboard.

Delete. . . Deletes unopened documents from disk.

Demote Heading In Outline view lowers selected paragraph (s) to

next outline level.

Different First Page Lets you turn off page number of first page

of section and create special first page headers and footers.

DO€Ument. . . (36-F14, on the Format menu) Displays Document for-

matting dialog box.

Dotted Underline (3€-Shift-\or Option-F12) Applies/removes the

dotted underline character format to selected text.

Double Underline (3€-Shift-[ or Shift-F12) Applies/removes the

double-underline character format to selected text.

Down (9€- [ or §€-Shift<, on the Font menu) Decreases font size by

one point. Works with selected text or text typed at insertion point after

you issue the command.

Drag-and-Drop Text Editing
(
Tools menu) New Word 5 feature

lets you select items, then drag them to desired location and insert by

releasing mouse button at desired insertion point. Will wo/ work between

Word windows, between split window segments, or between different

programs.

Drop Cap. . . (5, 1) Creates drop caps in version 5.1 only.

Edit Link (QuitkSwit<h) (3€-, (comma) orOption-F2) Automat-

ically switches you to another (the source) application.
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Edit Objeit... {Edit menu) Runs application that created the

selected object.

Even footer Opens footer for even-numbered pages in the current

section. Lets you \iew and edit.

Even Header Opens header for even-numbered pages in the cur-

rent section. Lets you view and edit.

Expand Subtext in Outline view shows either all lower levels or

next lower level if entire heading is not selected.

Expanded 3 pt Expands intercharacter spacing by an amount you

specify when adding this item to the menu. Must be between 0.5 and

14 points and will be rounded to the nearest 0.25 points. Default is 3 pt.

Extend to Chara<ter (9€-Opdon-H or keypad -) This selecdon

shortcut will extend an existing selecdon area up to and including the

first occurrence of the next letter that you type. Watch lower-left of

screen for prompts. Cancel with §€-. (period).

File. . . (Insert menu) Brings up the Word File dialog box and inserts

the entire selected file at the insertion point.

Find. . . (9€-F, on the Edit menu) Brings up Find dialog box. Lets you

search for text, special characters, formats, and styles.

Find Again (3€-Option-A or keypad =) Repeats searches for text or

formats performed with Find or Replace commands.

Find File. . . (Eile menu) Helps locate lost files by searching on sum-

mary info, filename dates, and text content.

Find Formats Searches for matching character or paragraph for-

mats, based on selection.
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First Footer Opens footer for first page in current section. Lets you

view and edit.

First Header Opens header for first page in current section. Lets

you view and edit.

First Line Indent {9€-Shift-F) Sets indent of selected paragraph (s)

to first tab stop.

Footer ( Vino menu) Opens a standard footer window in the current

section. If you are in Page Layout view, footers are shown with regular

text; in Normal view, they're displayed in a separate window.

Footnote. . . (9€-E, on the hisert menu) Inserts a footnote reference

marker at the insertion point and opens a footnote window. Moves inser-

tion point to footnote text area when in Page Layout view.

Footnote Cent. Hotite. . . Lets you type a footnote continuation

notice.

Footnote Cent.: Hotite Default (§€-H, on the Edit menu)

Returns footnote continuation notice to Word 5's default (no continua-

tion notice).

Footnote Cent. Separator. . . Lets you change characters used to

separate footnotes continued from preceding page and body text.

Footnote Cent. Sep.: Default Returns footnote continuation

separator to Word 5's default (6", 1 pt. line).

Footnote Separator. . . Lets you change characters used to

separate footnotes from body text.

Footnote Separator: Default Returns footnote separator to

Word 5's default (2", 1 pt. line).
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footnotes (S€-Shift-Option-S, on the View menu) Displays all foot-

notes related to any "visible" footnote reference markers.

Fra<tional Widths Toggles LaserWriter fractional-width feature

document-wide.

frame. . . (format) (Format menu) New Word 5 feature. Opens

dialog box used to position selected paragraphs on current page. Do not

confuse this with its cousin, who lives on the Insert menu.

frame. . . (Insert) (insert menu) New Word 5 feature. Inserts a posi-

tioned paragraph, called a frame, at the current selection or insertion

point. Opens Print Preview to let you drag the frame into position. Don't

confuse this with its cousin, who lives on the Format menu.

full Repaginate Now Forces a repagination even if there were no

edits since last pagination.

Glossary. . . (3€-K, on the Edit menu) Improved Word 5 feature.

Opens Glossary dialog box. Lets you insert existing Glossary entries,

create new entries, or switch Glossary files.

Go Ba<k (S€-Option-Z or keypad 0) Powerful navigation aid. Quickly

moves you to previous selection or to the insertion point (last three edit-

ing places in the document)

.

Go To. . . (§€-G, on the Edit menu) A dialog box that lets you specify a

page and/or section number, then takes you there quickly.

Grammar. . . (9€-Shift-G, on the Tools menu) New Word 5 feature.

Checks grammar and document readability, offers suggestions, aids edit-

ing. File called "Grammar" must be installed in the Word Commands
folder.

Hanging Indent (l€-Shift-T) indents lines after first line in para-

graph (s) to first tab stop.
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Heoder ( Vieiu menu) Opens a standard header window in the cur-

rent section. If you are in Page Layout view, the insertion point will move

to the header window as well.

Help. . . ( Window menu) A scrollable list of on-line help topics and

related help info.

Help (Context Sensitive) (3€-/) Displays help information for

open dialog boxes and commands. This command cannot be added to

the menu bar.

Hidden Text (3€-Shift-V or 3g-Shift-X or Option-F9) This toggle for-

mats text as hidden or not hidden.

Hyphenation .. . (Shift-F15, on the Toolsmenu) Presents hyphena-

tion dialog box and offers suggestions for soft hyphen placement.

Intlude Endnotes in Settion Forces footnotes to end of section

when enabled.

Intlude formatted Text in Clipboard Toggles Rich Text For-

mat (RTF) for Clipboard contents. Determines if style (bold, italic, etc.)

will be retained by Clipboard.

Index. . . (Insert menu) Causes Word to generate an index ofyour

document.

Index Entry {insert menu) Inserts index entry code either at inser-

tion point or before and after selected text.

Insert Cells Down in a table, inserts equal number of empty cells

above selected cells. Selected cells are pushed down.

Insert Cells Right In a table, inserts equal number of empty cells

to the left of selected cells. Selected cells are pushed right.
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Insert Columns In a table, inserts empty column (s) to the left of

the column containing the insertion point or to the left of selected

columns.

Insert Formulo (3€-Option-\) Inserts the special formula character

rccjuired when using math formula codes.

Insert Glossary Entry (3€-Delete) Asks you for name of an exist-

ing Glossary entry, then inserts the contents of that Glossary item at the

insertion point.

Insert Non-breaking Hyphen (§€- ' ) Creates a required hyphen

that will prevent line breaks at the hyphen. (Keeps items on same line.)

Insert Non-breaking Spate (Option-Spacebar or §€-Spacebar)

Creates a required space that will prevent line breaks at the space.

(Keeps items on same line.)

Insert Optional Hyphen (9€— ) Creates a hyphen that is printed

only if a word is broken at the hyphen.

Insert Rows (§€-Control-V) in a table, inserts empty row(s) above

the row containing the insertion point or above selected row(s).

Insert Tab (Tab or Option-Tab) Inserts a tab character. (This is the

Tab key.)

Insert ff Above Row (§€-Option-Spacebar) In a table, inserts a

paragraph marker (Normal style) above the row containing the insertion

point or above selected row(s).

Italu (3€-l or §€-Shift-I or Fl I, on the Format menu) Makes text

appear italicized by applying Word's italic character format. There is

also a ribbon button for this feature. Note that the key combination

has changed from Word 4.
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ffff/fC Cursor Toggles slanted insertion pointer in italic text, which

some find hard to use.

Justified (3€-Shift-J) Justifies text on both right and left edges be-

tween indents by adjusting spaces.

Keep Lines Together Prevents page breaks within a selected para-

graph and its successor.

Keep with Next ff Prevents page breaks between the selected para-

graph and its successor.

i Thicll Paragraph Border (3€-Option-2) Applies heavy left bor-

der to selected paragraphs.

Larger Font Siie (§€-Shift-> or §€-Shift-. (period)) increases

selected character(s) to next larger point size.

Line Break (Shift-Return) hiserts a nonprinting line-ending marker

and moves insertion point to beginning of next line. Often better than

pressing Return to separate paragraphs. Used in conjunction with para-

graph spacing features.

iffie Numbers By Page {Format menu) Turns on line numbering
for current section and restarts line numbers at 1 on each new page.

Line Numbers By 5e<tl0n Turns on line numbering for current

section and restarts line numbers at 1.

Line Numbers Continuous Turns on line numbering for current

section and continues line numbers from preceding section.

Iffie Numbers Otf Turns offline numbering for selected text.

iffie Spacing: 1 and '/2 Creates l V2line spacing (18 pts. between

lines) for selected paragraphs. May not work with type sizes greater than

24 pts. In this case use character spacing instead.
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Line Spadng: Double (§€-Shift-Y) Double-spaces selected lines

(24-p()int line spacing). There is also a ruler button for this feature.

Line Spa€ing: Single Applies single-line (12 pt.) spacing to

selected text.

Link Options. . . (Edit menu) Opens a dialog box with linking

choices under System 7 or MultiFinder.

List All Fonts Displays all fonts on Word Font menu.

List Re<ently Opened DoiumentS New Word 5 feature. Appends

names of last four Word documents you've used to bottom of File menu
for easy relaunching.

Lowertase Changes current selection to all lowercase.

Make Ba<kup Files Toggles automatic backup of saved docu-

ments. Wlien on, backup is made when document is saved. Limit the

length of file names when using this feature.

Make Body Text in Oudine view converts selected text to body text.

Margin Page Numbers Toggles auto page numbering for current

section.

Measurement Unit: Cm Changes default unit of measurement to

centimeters.

Measurement Unit: Inthes Changes default unit of measure-

ment to inches.

Measurement Unit: Pi<as Changes default unit of measurement

to picas.

Measurement Unit: Points Changes default unit of measure-

ment to poults.
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Merge Cells in tables, combines selected cells in a row into a

single cell. .

More Keyboard Prefix (l€-Option-') Used with original (small)

keyboards. Amplifies extent of subsequent key action.

Move Down One Text Area (§€- Option-keypad 2) In text, moves

insertion point down to next text line. In tables, moves insertion point

down 1 cell (Page Layout view.)

Move Heading Down In Outline view, moves selected heading or

text below next paragraph in the outline.

Move Heading Up in Outline view, moves selected heading or text

above preceding paragraph in the oudine.

Move Left One Text Area (3€- Option-keypad 4) Moves insertion

point to the text area to the left or to next cell to left in tables. (Page

Layout view.)

Move Right One Text Area (3€- Option-keypad 6) Moves inser-

tion point to the text area to the right or to next cell to right in tables

visible in the window (Page Layout view).

Move Text (3€-Option-X or Shift-F2) Moves text, graphics, or sound

without disturbing Clipboard contents.

Move to Bottom of Window (End) Places insertion point after

last character visible in window.

Move to End of Dotument (§€- keypad 3 or §€-End) Places inser-

tion point after last character visible in document.

Move to End of Line (keypad l) Places insertion point at end of

current line.
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Move to First Text Area (5€- Option-keypad 7) Moves insertion

point to first text area or to first cell in tables.

Move to Last Text Area (3€- Option-keypad 1) Moves insertion

point to last text area in Page Layout view or to last cell in tables visible

in the window.

Move to Next Cell in tables, moves insertion point to next cell to

right. Wraps left and down at end of row.

Move to Next Chara<ter (right arrow or S€-Option-L or key-

pad 6) Moves insertion point right one character.

Move to Next Line (down arrow or 3€- Option-, or keypad 2)

Moves insertion point down one line.

Move to Next Page (3€-Page Down) Moves insertion point to

beginning of next page.

Move to Next Paragraph (§€-down arrow or §€-Option-B or

§€- keypad 2) Moves insertion point to beginning of next paragraph.

Move to Next Sentente dS-ke^pad l) Moves insertion point to

beginning of next sentence.

Move to Next Text Area (9€- Option-keypad 3) Moves inserdon

point to beginning of next text area in Page Layout view or next cell in

table.

Move to Next Window (3€-Option-W) Moves insertion point to

the next document window.

Move to Next Word (^- right arrow or 3i-Opdon-; or 3€-key-

pad 6) Moves insertion point after current or next word.

Move to Previous Cell (Shift-Tab) in tables moves insertion point

lo preceding c ell.
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Move to Previous Chara<ter (left arrow or 3€-Option-K or key-

pad 4) Moves insertion point back one character.

Move to Previous Line (up arrow or keypad 8) Moves insertion

point up one line.

Move to Previous Page (9€-Page Up) Moves insertion point to

beginning of previous page.

Move to Previous Paragraph (3€-up arrow or S€-Option-Y or

3€-keypad 8) Moves insertion point to beginning of current or previous

paragraph.

Move to Previous Sentente (9€-keypad 7) Moves insertion point

to beginning of current or previous sentence.

Move to Previous Text Area (3€- Option-keypad 9) Moves inser-

tion point to beginning of previous text area in Page Layout view or a

cell in a table.

Move to Previous Word (S€-left arrow or 3€-Option-J or 9€-key-

pad 4) Moves insertion point to beginning of current or previous word.

Move to Start of Dotument (9€-keypad 9 or §€-Home) Places in-

sertion point before first character in document.

Move to Start of Line (keypad 7) Moves insertion point to begin-

ning of current line.

Move to Top of Window (S€- keypad 5 or Home) Places insertion

point before first character in active vdndow.

Move Up One Text Area (§€- Option-keypad 8) Moves inserdon

point to beginning of previous text area in Page Layout view or up one

cell in tables.

Movie. . . (5. 1) Inserts QuickTime movies in version 5.1 only.
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Nest Paragraph (3€-Shift-N) Shifts indent of selected para-

graph (s) I ight one tab stop.

New (§€-N or F5, on the File menu) Opens a new untitled document.

New Paragraph (Return or Enter) hiserts a nonprinting para-

graph marker and moves insertion point to beginning of next line.

New Pitture inserts an empty graphics frame and opens the Picture

window.

WeiV Window (Shift-F5, on the Window menu) Opens an additional

window for the active document.

New Tl After Ins. Point (§€-Option-Return) inserts a new para-

graph marker (after the insertion point) without moving the insertion

point.

New 11 with Same Style (§€-Return) Overrides "Next Style" fea-

ture and opens a new paragraph with the same style as the current one.

No Paragraph Border (3€-Option-l) Turns off paragraph border

for selected paragraph (s).

Normal (3€-Option-N, on the View menu) Switches to Normal view,

which is quick, but does not easily show headers, footers, or footnotes.

Normal Charatter Position Applies normal text baseline posi-

tion to selected text or text typed at insertion point.

Normal Charatter Spadng Applies normal character spacing to

selected text or text t\ped at insertion point.

Normal Paragraph (§€-Shift-P) Applies Normal style to selected

paragraphs or paragraph containing insertion pointer.
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Numerit Lo<k (keypad Clear) Toggles Num Lock to permit dual use

as number entry or navigation tool.

Obje€t. . . {Insert menu) New Word 5 feature. Brings up dialog box

listing objects that Word can embed (Excel spreadsheets, etc.). Lets you

insert these objects in Word documents.

Odd footBT Opens footer for odd-numbered pages in current sec-

tion. Lets you view and edit.

Odd Header Opens header for odd-numbered pages in current sec-

tion. Lets you view and edit.

Open. . . (3€-0 or F6, on the File menu) Presents the Open dialog

box containing a list of files from which you choose. Also lets you change

folders or launch Find File to locate lost documents. You can use this

command in conjunction with the Glossary or Style dialog boxes.

Open Any file. . . (Shift-F6) Lists all available files even if they are

not Word-compatible. Lets you attempt to open them.

Open Do€UmentS in Page View Lets you control whether Word
opens all documents in Page Layout view or Normal view.

Open DO€UmentS Wifll Ribbon Lets you control whether Word
opens all documents with or without a ribbon.

Open DotumentS Wifh Ruler Lets you control whether Word
opens all documenis with or without a ruler

Open Mail. . . {File menu) Opens messages in your Microsoft Mail-

box if they contain Word-readable enclosures.

Other. . . {Font menu) Takes you directly to the Character dialog box

from the Font menu. Lets you specify color, character spacing, etc.
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Outline (format) (§€-Shif t-D or Shift-Fl l , on the Formal menu)

This toggle shows the letters of text as thin outlines, like stencils.

Outline (View) (§€-Option-0 or Shift-F13, on the View menu)

Changes display to Outline view. Helps organize and rearrange complex

documents.

Outline Command Prefix (3€-Option-T) Lets you use the key-

board to create actions in outlines (such as demodng headings).

Outline View On/Off Toggles Oudine view on and off.

Page # Alphabeti< Lower<ase Formats page numbers a-z,

aa-zz, etc.

Page # Alphabeti< Uppertase Numbers pages A-Z, AA-ZZ, and

so on. All caps.

Page # Arabii Numbers pages 1, 2, 3 and so on.

Page # Roman Lowertase Formats page numbers as lowercase

Roman numerals (i, ii, etc.).

Page # Roman Uppertase Selects uppercase Roman numerals

for current section.

Page Break (Shift-Enter, on the Insert menu) hiserts a hard

(manual) page break.

Page Break Before Inserts a hard page breakjust before selected

paragraph.

Page layout (3€-Option-P or F13, on the Vieio menu) Changes to

Page Layout view, which shows how the page will look when it is printed.

Page layout View On/Off Toggles Page Layout viview.
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Poge NunbCF Inserts automatic page numbers based on Glossary.

Page Setup. . . (Shift-F8, on the File menu) Brings up Page Setup

dialog box where you enter paper size, orientation, and printer effects

based on chosen printer.

Paragraph . . . (§€-M or Shift-F14, on the Format menu) Brings up
standard Paragraph dialog box, where you define Spacing before and

after paragraphs, line numbers, and more.

Paragraph Aligned Left (3€-Shift-L) Aligns selected text with left

indent. There is also a ruler button for this feature.

Paragraph Aligned Right (§€-Shift-R) Aligns selected text with

right indent. There is also a ruler button for this feature.

Paragraph Border. . . Brings up Paragraph Border dialog box,

used to place borders around paragraphs. Choose standard borders or

design your own.

Paste (36-V or F4, on the Edit menu) Inserts Clipboard contents at

insertion point or replaces selected items with Clipboard contents.

Paste Cells Only available when table cells are on the Clipboard.

Pastes cells.

Paste Link (Option-F4) Lets you paste items from other documents

(Excel spreadsheets, for example) into Word documents and have the

Word document updated when the external items change.

Paste Oble<t (3€-F4) Pastes items (usually from spreadsheets, draw-

ing programs, etc.). Pasted objects cannot be modified by Word.

Paste Speual. . . (Edit menu) Brings up a dialog box that lets you

specify' whether Clipboard contents should be pasted in Rich Text For-

mat (RTF), as unformatted text, or as a picture.
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Paste Spetial Chara<ter (3€-Option-Q) You type the decimal

value ot a character and Word pastes the corresponding character in the

current font.

PufUfB. . . {Insert menu) Brings up a dialog box that lets you use

Word's Pictiue window to either draw your own graphics or import them

from other sources. Closing the Picture window pastes the graphic into

your document.

Plain Text (§€-Shift-Z or Shift-F9, on the Format n^enu) Removes op-

tional character formatting, including bold, underscore, italic, and so

on, from selected text.

Play Uovie.. . (5. 1) Plays QuickTime movies in version 5.1 only.

Preferen<es. . . ( Tools menu) Brings up a dialog box that lets you

change your name and initials for the Summary Info fields; define cus-

tom paper sizes; change units of measiue; toggle smart quotes, back-

ground pagination. Clipboard features, the Drag-and-Drop feature, etc.;

specify default views. Open. . . and Save options, default fonts, spelling,

grammar, thesaurus, and hyphenation settings; and more!

Print. . . (3€-P or F8, on the Fik menu) Brings up the Print dialog

box to let you print entire documents, selected portions of documents,

outlines, open glossaries, and style sheets.

Print Date Inserts current date using Glossary format Month

date, year.

Print Merge Helper. . . ( View menu) Toggles print merge help bar.

Helper also assists in the creation and editing of data for print merge

projects (name and address lists, etc.).

Print Merge. . . {File menu) Combines documents and data to

create personalized form letters and such.
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Print Preview. . . (S€-Option-I or Option-F13, on the File menu)

Powerful tool that shows one or two pages as an on-screen repre-

sentation of how your document will print. Shows margins, line num-

bers, etc. Lets you change margins, manage page numbers, and so on.

Promote Heading in Outline view, this command moves selected

paragraphs up one outline level.

Prompt for Summary Info Toggles the Summary Info dialog

box. When enabled, you will see a new Summary dialog box whenever

you create a new document.

Qui<k Retard Voite Annotation (Control-3€-R) Shortcut

for recording voice annotations (dialog box must be showing). Press

§€-. (period) to stop recording.

Quit (3€-Q, on the File menu) Ends your Word session and removes

Word from RAM. Prompts you to save unsaved changes to documents,

glossaries, and dictionaries.

Redefine Style from Selettion Use to change a style. Based on

the style of a selected paragraph.

Remove From Menu (§€-Opdon- -) Removes a selected command
from the menu.

Renumber. . . (3€-F15, on the Tools menu) Brings up a dialog box

that lets you specify renumbering opdons, then renumbers automatically.

Repaginate Now ( Tools menu) In Normal view, repaginates your

entire document. In Page Layout view, repaginates from beginning of

document to current page.

Repeat Repeats your last command or text you've typed since the

command was executed.
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ReplOKe. . . (3€-H, on the Edit menu) Brings up a "search and

replace" dialog box that lets you find and replace text, formats, and

styles. Much improved over Word 4 version!

Restart Page Numbering at 1 Toggles feature that restarts page

numbering at 1 for current section only.

Revert To Style (3€- Shift-Spacebar or F9, on the Format menu)

Retiuns selected text to the style for the paragraph (removes manual

changes to font, styles, indents, etc.).

Ribbon (9i-Opdon-R, on the View menu) Toggles display of ribbon

in document, header, and footer windows.

Ruler (3€-R, on the Viau menu) Toggles display of ruler in docu-

ment, header, and footer windows.

Same As Previous Copies contents of previous section's header or

footer into current header and footer windows.

Save (3€-S or F7, on the Fil-e menu) Saves the acdve document

using the most recent Save As dialog-box settings (quick save, file

locations, etc.).

Save As... (Shift-F7, on the File menu) Brings up a dialog box that

lets you specifv a new document name, format for saxing the document,

new location, etc.

Save Copy As. . . Saves a copy of the active document under a

new name, then lets you continue to work on the original document,

not the copy.

Streen Test A built-in "screensaver" that displays changing

geometric shapes to prevent screen burn-in while you are not taping. Has

user-definable patterns and colors. Starts as soon as you choose the Screen

Test menu item. Click the mouse button to change the setdngs or cancel.
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Stroll Line Down (3S- Option-/ or keypad +) Scrolls up one line. If

out of view, it brings next line into view at bottom of screen.

Stfoll Line Up (3€-Option-[ or keypad *) Scrolls down one line. If

out of view, it brings next line into view at top of screen.

Siroll Street! Down (§€-Option-. (period) or keypad 3 or Page

Down) Scrolls down one full window. If out of view, it brings next window

into view.

Stroll Streen Up (keypad 9 or Page Up) Scrolls up one full window.

If out of view, it brings next window into view.

SettlOn. . . (Option-F14, on the Format menu) Brings up the

Section dialog box, where you can specify breaks, column numbers,

header/footer positions, page numbering, and more.

Settion Breok (§€-Enter, on the Insert menu) Inserts section break

at insertion point.

SetflOn StorfS on Even Page Forces sections to start on even-

numbered pages.

Settion Starts on New Column Forces sections to start in next

column on same page, unless current and preceding sections have a dif-

ferent number of columns, in which case text starts on next page.

Settion Starts on New Page Forces current section to start on

new page.

Settion Starts on Odd Page Forces sections to start on odd-num-

bered pages.

Settion Starts with No Break Does not force a new page for cur-

rent (new) section.
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Sele<t All (i€-A or 3€-Option-M, on the Edit menu) Selects contents

oi entire document.

Send Mail. . . {File menu) Lets you send the current Word document

via Microsoft Mail if your computer is so equipped. Brings up the MS-

Mail Send window.

Sentente Case Capitalizes the first word in the selected text using

periods as its guide. Does not change existing capital letters.

Separator inserts dashed line at bottom of selected menu. Used to

group related menu choices.

Set Indent Ruler Siale Switches ruler tools to those used to

manipulate paragiaphs. There is also a ruler button for this menu choice.

Set Margin Ruler S<ale Switches ruler tools to those used to

manipulate the entire document. There is also a ruler button for this

menu choice.

Set Table Ruler Stale Switches ruler tools to those used to manipu-

late tables. There is also a ruler button for this menu choice.

Shadow (§€-Shift-W or Option-Fl 1 ) Character format changes let-

ters to white with black, shadowed outline.

Show All Headings in Outline view, this displays all levels of head-

ings and text (the entire doctmient).

Show Body Text in Outline view, this displays body text (the entire

document).

Show Clipboard ( Window menu) Displays the contents of the Clip-

board in a movable, sizable window.

Show formatting in Outline view, toggles bold, type sizes, etc.

When off, all headings and body text appear plain and the same size.
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Show Fumtion Keys on Menus Toggles listing of extended-

keyboard function keys (Fl, F2, and so on) in menus.

Show Heading 1-9 in Oudine view, lets you decide which levels of

outline to display. Show Heading 1 shows only level 1. Show Heading 3

shows levels 1 , 2, and 3.

Show Hidden Text Toggles display of hidden text on screen. This

command does not affect the printing of hidden text.

Show Pitfure PlateholderS Displays rectangles in place of

graphics to speed scrolling.

Show Styles on Ruler Drops down a style list, but only if the ruler

is displayed. An alternative to clicking on the style list triangle.

Show Table Gridlines In tables, toggles display of nonprinting

gridlines. Does not affect display of printing cell borders.

Show Text Boundaries in Page Layout view, toggles display of

nonprinting rectangles that outline text, footers, frames, etc.

ShowXHide Tl (3€-J, on the View menu) Toggles display of nonprint-

ing characters (paragraph marks, tab marks, etc.).

Side by Side One of several ways to specify position-related para-

graphs. Largely obsolete with tables and paragraph-positioning features.

Small Caps (3€-Shift-H or Option-FlO) Toggles small caps for

selected text when the current font supports this feature.

Smaller font Size (§€-Shift-< or §€-Shift-,) Decreases font size to

next smaller standard size.

Smart Quotes Toggles use of standard quote marks (" ") with

typesetting curly quotes (" ") while typing. Does not replace previously

typed quotes.
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Sort (TooLs menu) Sorts selected text in ascending (ASCII) order,

based on left-most selected character. Sorts A-Z, 0-9.

Sort DeS€ending Sorts selected text in descending (ASCII) order,

based on left-most selected character. Sorts Z-A, 9-0.

Spate Before V: 12 points (3€-Shift-0) This toggle adds 12

points of vertical white space before each selected paragraph.

Spate Before ff; None Narrows vertical interparagraph spacing in

selected paragraph(s).

Spelling. . . (3€-L or F15, on the Tools menu) Spell-checks your docu-

ment if the spell checker has been installed in the Word 5 commands

folder.

Split Cell In a table, returns a merged cell to two single cells.

Split Window (3€-Option-S) This toggle lets you have two views of

the same document. Good for flipping between distant sections of a

large document.

Strikethru (l€-Shift-/ ) Toggles strikethru text formatting in the

selected text.

Style. . . (§€-T, on the Format menu) Brings up the Style dialog box,

where you define and modify paragraph styles.

Substribe To. . . {Edit menu) System 7 feature that lets you link your

Word document with "editions" (from Excel spreadsheets, for instance).

Contents of edition appear at the Word document's insertion point.

Substript 2 pt (3€-Shift- -) Applies the subscript style to selected text

using a point measurement you specify when installing the command.

Summary Info. . . (File menu) Brings up a Summary Informa-

tion dialog box, where you enter document-identification information
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(title, author, subject, etc.). Facilitates future searches for lost documents

for documents meeting specific criteria.

Superstript 3 pt (§€-Shift-=) New Word 5 feature. Applies the

superscript stvle to selected text, using a point measurement you specify

when installing the command.

Suppress Line # in Paragraph Turns offline numbers for

selected text. (Onl\ a\ailable if numbering option is on for section.)

Symbol. . . {insert menu) Displays a palette of font-specific symbol

characters. Click on the desired character to place it at the insertion

point.

Symbol font (§€-Shift-Q) Applies the Apple LaserWriter symbol

font to selected text.

Table. . . {Insn-I menu) Brings up a dialog box that lets you define

and insert a new table.

Table Cells. . . {Formal menu) In tables, brings up a dialog box that

lets you define cell sizes, alignment, spacing, borders, etc.

Table Cells Borders. . . Brings up Borders dialog box.

Table Layout. . . {Format menu) In tables, brings up a dialog box

that lets you add and delete rows, merge split cells, and more.

Table of Contents. . . {Insert menu) Generates a TOC and places

it at the beginning of the active document. You can use either a docu-

ment's outline or TOC entries (hidden-text codes) to create the TOC.

Table to Text. .. in a table, converts the table to text, separated

either by paragraph marks, tabs, or commas.

Tabs. . . Brings up a dialog box that lets you define and position tabs

for the selected paragraphs.
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Text to Table. . . Converts the selected text into a table using tabs

and paragraph markers as indicators of columns and rows.

Thesaurus. . . ( Tools menu) Brings up a thesaurus offering alternative

words for tlie selected word. Only works if the thesaurus has been installed

in the Word 5 commands folder and the selected word is properly spelled.

Time Inserts the current time using the Glossary's time format. (Up-

dates the time when you print.)

Title Case Capitalizes eiiery selected word.

TLBR Single Paragraph Border (Format menu) Used with tables

to modify border of specified cell(s).

TLBR Single Shadow Paragraph Border (Format menu) Shades

selected cells in tables.

TOC Entry (insert menu) Inserts a TOC (hidden-text) code before

and after the selected text.

Toggle Case Reverses the case of each highlighted letter. Caps be-

come lowercase, and \ice versa.

Toggle Looping (5. 1) Turns QuickTime Movie looping on and off

in version 5.1 only.

Toolbar Opens Toolbar Option dialog box in version 5.1 only.

Unassign Keystroke (3€- Option-keypad -) Asks you to type a key

combination (§€-P for instance). Removes that key combination from its

related command (Print... in our example) so the combination can be

used elsewhere.

Underline (§€-U or 3€-Shift-U or F12, on the Format menu) Applies

or removes the continuous imderline format from selected text. There is

also a ribbon button for this feature.
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Undo (36-Z or Fl, on the Edit menu) Watches you work and attempts

to undo your most recent action (typing, formatting, deleting, etc.)-

Works best if used immediately after action needing reversal.

Unnest Paragraph (9€-Shift-M) Shifts selected paragraphs left one

indent.

Up (l€- ] or 3€-Shift- <, on the Font menu) Increases font size by 1

point. Works for selected text or text typed after the command is issued.

Update Link (Option-F3) MultiFinder feature that updates selected

linked information to match source. Source application (Excel, for in-

stance) must be available and have enough R.\M to rim.

Upponaso Changes all selected text to uppercase.

Use Short Menu Names Shortens length of Word menu names to

permit use of additions (clocks, etc.) on smaller Mac screens. For in-

stance. Format becomes Fmt.

Voite Annotation (on the insert menu) Brings up the Voice Record

dialog box.

Voite Annotations (on the \7<wmenu) Brings up the Voice An-

notations dialog box, where you can play back voice annotations.

Word Count. . . (Option-F15, on the Took menu) Counts and dis-

plays word, character, paragraph, and line counts for selected section or

entire docimient. Does not coimt text in headers or footers.

Vtord Underline (§€-Shift-] or l€-F12) Applies and removes single-

word underline (does not underline spaces).

Zoom to Fill Streen Resizes active window to fill entire screen.





Boldface page numbers refer to main topics; Italic page numbers refer to

figures or tables.

Symbols and Numbers
* (asterisk) , as footnote reference

mark, 386

i€ key

to copy with drag and drop, 47

and sentence selection, 15

J, as line end marker, 291

... (ellipses), commands with, 9

: (colon)

printing in index, 586

printing in table of contents, 581

to suppress page numbers in table

of contents, 580

;
(semicolon)

printing in index, 586

printing in table of contents, 581

? (question mark), as mouse pointer,

57

11/2 line spacing, 303, 304

3-D charts, 667

rotating, 671-672

3-D ribbon, 728

3-D ruler, 728

8-bit window, for Picture Window, 147

24-bit graphics, 147

32-bit graphics, 147

32-bit QuickDraw compatibility, 707

50% Reduction, from ImageWriter

and StyleWriter, 1 1

1

A button (Toolbar), 240

.\A (Array) command. 274-275, 275

aborting, printing, 99

About Microsoft Word, 786

accented characters, 50, 253, 256

Find command for, 508

in sorts, 354

AccessPC, 181

Activate Keyboard Menus, 786

active cell, in datasheet window, 655

active window, 39, 67

Add button (Spell checker), and

custom dictionary, 489

Add Matches to List (Search Options

menu), 188

Add to Menu command, 786

adding, with Calculate command,

357-358

addresses

adding to list for printing, 434

changing, 435^36

deleting, 436

inserting in documents, 435

printing labels with ImageWriter,

646

Addresses command (Insert menu),

434, 786

Addresses dialog box, 430

Adobe Illustrator, 1 48
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Adobe TN-pe Manager (ATM), 282

ads, 557-559

Again feature. See Repeat command
(Edit menu)

Aldus FreeHand, 148

Alias feature (System 7), 33-35

aliases, for stationery, 446

alignment of graphics, 155-156

alignment of tables, 344

alignment of text, 302-303

in Picture Window, 138-139

ruler and, 1 1 , 26, 293

All Caps feature (Character dialog

box), 248, 787

All Styles button (Style dialog box)

,

409

Allow Fast Saves feature, 730, 787

Always Interpret RTF option, 728, 787

Always Make a Backup option, 729,

787

Always Suggest option, for spelling

checker, 733

Annotation (Insert menu), 611, 787

annotadons, 610-614

editing, 613

hidden text for, 604-606

moving and deleting, 614

printing and incorporating, 613

showing and hiding, 614

voice, 606-610

Annotations (View menu), 612, 613

Ann-Stone font, 261

antonyms in Thesaurus, 474, 478

Apple, QuickTime startup kit, 713

Apple File Exchange, 180

Apple LaserWriter printers, 107, 437

options, 108-111

two-sided printing on, 118

Apple menu

Chooser, 100-101

Key Caps, 253

Microsoft Mail, 698, 700

Scrapbook command, 151

Apply button (Character dialog box),

237

Apply button (Paragraph dialog box),

298

Apply Style Name (Work menu), 787

Arc tool (Picture Window), 132, 141

area charts, 663

Array (.\A) command, 274-275, 275

arrow keys, 48

Arrowhead tool (Picture Window),

132, 142-143

arrows, as tab markers, 323

ascenders, 231

ascending sort order, 353

ASCII codes. Find or Replace for, 515

ASK feature, 618, 634-636, 638

Assign to Key command, 787

asterisk (*), as footnote reference

mark, 386

ATM (Adobe Type Manager), 282

attached text in chart window, 657

editing, 669-670

author, 723

Author standard glossary entry, 463

Auto Scaling, of 3-D charts, 671

automatic backup feature, 198

automatic hyphenation feature,

269-273

removing hyphens, 272-273

automatic page breaks, controlling

position of, 21^220
automatic repagination, 216, 724

aiuomatic save reminder, 189

Aver\ brand labels, stationery

docimients for, 643
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awards, 565-566

axes, 657

orientation in 3-D charts, 671

.\B (Bracket) command, 275, 276

background printing, 121-125

canceling, 124

checking print job status, 122-123

postponing, 124-125

and print cancellation, 99

background repagination, 87, 724, 787

background tasks, and movie

performance, 708

Backspace, 787

backups, of files, 198

badge for movie, 709

displaying or hiding, 710

balloon help (System 7), 58-59

banter, 406

bar charts, 663-664

bar tab stops, 322

Based On menu (Style dialog box),

408

baseline, 230, 244

battery indicator (Toolbar), 771

beginning of docimient, moving to, 79

bibliographies, hanging indents for,

300

binding, gutters for, 206, 213-214

bitmap alignment, precision, 109

bitmap fonts, 279-280

jaggy, 107, 108

bitmap giaphics, 146, 147

eliminating stretched-out look. 111

faster printing option, 108

black and white printing, vs.

color/giayscale, 114—115

blank lines

adding between paragraphs, 292

eliminating in merge documents,

633, 637

bleed, 566-567

bluelines, 572

board art, 567

body type, 567

boilerplate text

as glossary entries, 456, 564

sharing on network, 450-451

in Work menu, 743

Bold option (Format menu), 232, 787

bold text, 228

creating, 241

in index, 586

in pictures, 138

Bold text button (ribbon), 11, 22, 25,

235, 241

Border command (Format menu),

554, 788

lines from, 308, 560

border guides, 310

border sample, 310

borders, 307-312

custom, 310-312

deleting, 313

in tables, 336

white space and, 312

bottom margin, footer in, 215

Box (.\X) command, 275-276

box size, for graphic images, 149

boxes, in Oudine view, 522

Bracket (.\B) command, 275, 276

brackets, for linked text, 691

bullet character, 254

for standard glossary entries, 462
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Bullet command (Insert menu),

257-258, 788

Bulleted list button (Toolbar), 235,

257-258, 294

bulleted lists, hanging indents for, 300

buttons, 10

Calculate command, 356-359, 788

adding with, 357-358

parentheses to control, 359

calculation instructions, in merge

documents, 634

calendars, 549-551

camera-ready art, 567

Cancel Subscriber button, 685

canceling, 788

background printing, 124

embedding, 689-690

searches, 186

capitalization

in custom dictionaries, 489

in Find command, 507

in style names, 404

case sensitivity, in style names, 416

Catch area (Grammar Preferences),

497

Category axis, in chart window, 655

CD-ROMs, for QuickTime movies, 708

Cell selection bar, 334

cells in datasheet window, 654

entering and editing data, 660-661

cells in tables, 329

merging, 345

moving contents, 350

paragiaphs in, 333

selecting adjacent, 335

splitting, 345

center-alignment button (ruler), 7

Center button (ruler), 302

for chart positioning, 672

center tab stops, 322

Centered command, 788

Change All (Spelling Checker), 486

Change button (Spelling Checker),

486

Change case button (Toolbar) , 235

Change Case command (Format

menu), 246-249, 788

Change Font command, 788

Change Style command, 788

Change To box (Spelling Checker),

486

changeable print entries, 463

chapter elements, sections as, 393

Character command (Format menu),

233, 236-238, 788

Character dialog box, 236-238

All Caps, 248

Apply button, 237

Bold option, 241

Color menu, 245

and drop caps, 263

font selection, 240

gray boxes in, 238

Hidden style, 605

hotspot for, 54, 236

Italic option, 241

Small Caps option, 248-249

Strikethru, 242-243

Style section, 236

character formatting, 228-229,

231-238

color choices, 245-246

copying, 252-253

deleting, 249-252



INDEX

kerning, 25, 244

keyboard shortcuts for, 781-782

with menus, 232-233

with ribbon, 233-235

spacing changes, 243-244

and styles, 410

with Toolbar, 235, 235

vs. paragraph formatting, 417

characters, 227

frame for, 1 62

spacing of, 25

chart labels, 560

Chart menu (Graph)

Gridlines command, 671

Titles, 669

chart window, 653, 655, 656-657

changing chart size, 667

double-clicking object in, 669

viewing graphs in different sizes,

668

working in, 663-672

charts

default setting for type, 667

editing parts of, 668-669

editing text, 670

frame for, 162-163

saving, 672

types of, 663-667

Chooser (Apple menu), 100-101

to enable background printing,

121-122

circles, improving appearance, 111

Clear All button (Tabs dialog box)

,

328

Clear command (Edit menu), 788

clearing tab stops, 328

clip art, 146, 565

Clipboard, 37, 41-42

Calculate feature and, 357-358

copying QuickTime image to, 154

and embedding, 686

with Find and Replace, 514

graphic image in, 146

importing graphics with, 150

including formatted text in, 724

for linking, 690

saving contents in Scrapbook,

150-151

clocks on Macs, 466

Close box, 9, 67

Close command (File menu), 788

closing

custom dictionaries, 490

document window, 71

collapsed text, 520

collapsing outlines, 524-525, 788

colon (:)

printing in index, 586

printing in table of contents, 581

to suppress page numbers in table

of contents, 580

color, in Pictvire Window, 141

Color menu (Character dialog box),

245

color printing, vs. black and white

printing, 114-115

column breaks, 539

and sections, 536-539

column charts, 664

column graph button, on ribbon, 653

column headings, in datasheet, 656

Column selection bar, 334

columns, 7, 534-539, 789

creating with ribbon, 535-536

creating with Section dialog box,

536

layouts for, 557-559

for lists, 553-554
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new for sections, 395

in normal view, 81, 82-84

ribbon buttons for, 1 1 , 22

sections and, 393-394

white space between, 535

width, 538

columns in datasheet, 655

inserting and deleting, 662

width, 662

columns in tables, 330

deleting, 341

inserting, 340-341

selecting, 334-335

white space between, 346

width of, 331,341-344

combination charts, 666

combined searches, 188

combining documents, 449-450

comma-delimited text, for table

conversion, 347-348

Command from Key Assignment, 789

command key, 48. See also 36 key

(Apple key)

command list, in Commands dialog

box, 737

command sets, multiple, 753-754

commands, 774-815

adding to menus, 718

executing when not on menus, 740

glossary of, 786-815

and menu bar, 9-10

placing on menu, 737-378

commands buttons, in Save As dialog

box, 192

Commands command (Tools menu),

49, 189, 196, 789

restoring to menu, 740

Commands dialog box, 736-741

assigning keyboard shortcuts from,

750-751

Command list, 737

Do It button, 740

List button, 746

Menu section, 737-378

to remove keyboard shortcuts, 751

Reset button, 748, 754

Save As button, 747

Commands folder

file converters in, 180

standard Custom dictionary, 489

U.S. English Dictionary, 488

commas, to separate multiple style

names, 404

comparison operators, in IF merge

instructions, 639

compass shape, for mouse pointer, 522

complex formulas, 278

compressed files, 763

CompuServe, Microsoft forums, 61

computer lockup, recovery after,

198-199

Condensed character formatting, 243,

789

conditional printing, of merge

documents, 637-640

connected documents, printing, 115

continuation line, for footnotes, 384

continuation message, for footnotes,

384

(Control Panel

keyboard features, 52

monitor portion, gray shade, 246

Sound portion, 609

copies, printing multiple, 113

copying, 150,789-790

character formatting, 252-253, 790
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documents containing movies,

712-713

with drag and drop, 47

footnotes, 383

keyboard shortcuts for, 75-76

for movies, 712

section breaks, 395-396

text between documents, 39

corner guides, for borders, 311

Courier font, 230

cover pages, printing, 1 14

Create Envelope command (Tools

menu), 434, 790

Addresses biuton, 430

Create Publisher command (Edit

menu), 681, 790

crop marks, 568

cropping, 569

cross indexing, 585-586

cursor. Se^ insertion point

Curve tool (Picture Window), 141

custom dictionaries, 487, 488-491,

732-733

creating, 489-490

deleting words from, 490

editing, 490^91

opening and closing, 490

using old after install, 770

custom installation, 769-770

custom paper size, 723

Cut button (toolbar), 39

Cut command (Edit menu), 38

cut, copy and paste, 37^7, 790

.\D (Displace) command, 275,

276-277

damaged files, recovering, 198-199

dashes, 267-269

Data Document Builder dialog box,

623, 624

data documents, 618, 619, 620-621

creating, 623-625

entering and editing data, 627

planning, 622-623

saving designs, 625-627

sorting, 631

data instructions, inserting in main

document, 629-630

data markers, 657

DATA merge instruction, 641

replacing, 644

data points, 656

data series, 656, 657

names in datasheet window, 655

DATA statement, 619, 621, 63S

in main document, 628

database programs, vs. Print merge

feature, 620

datasheet

column widths in, 662

number formats in, 661-662

Datasheet window, 655

for graph projects, 654—655

working in, 660-662

Date command (Insert menu), 630

Date glossary entry, 463-464, 679

dates

in headers or footers, 87, 368

sorting, 355

Day glossary entry, 464

decimal tab stops, 322

Decrease font size button (Toolbar),

235

Default command (Font menu), 232,

253, 790
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default font, selecting during install,

765

Default Font category (Preferences),

731

default settings, 8, 103, 719-721

changing, 722-736

for chart type, 667

for expanded and condensed

character spacing, 243

for font and point size, 253

for formatting, 756

for line spacing, 304

for measurement units, 295

for Num Loc, 5

1

for Page Setup options, 756

for paragraphs, 289

for style sheet, 755

for super and subscripts, 245

for tab stops, 327-328

for views, 92

Delete Cells command, 790

Delete Columns command, 790

Delete Forward command, 790

Delete Next Word command, 790

Delete Previous Word command, 791

Delete Rows command, 791

deleting

addresses, 436

annotations, 614

automatic hyphens, 272-273

borders, 313

character formatting, 249-252

columns in tables, 341

drop caps, 267

fields, 625

files, 189, 196, 791

footnotes, 383

framed objects, 171

glossary entries, 461

keyboard shortcuts for, 75-76

menu items, 718

page breaks, 218

page numbers, 379-380

paragraphs, 291

rows and columns in datasheet, 662

rows in tables, 338

section breaks, 396

shading, 313

stationery documents, 447

styles, 412-413

styles but retaining formatting,

420^21

text, 17

words from custom dictionary, 490

demoting outline headings, 523, 791

descenders, 231

descending sort, 353, 812

Design Sciences, Inc., 362

Desktop ColorFoil, 565

desktop publishing, 544-572

ads, 557-559

awards, 565-566

calendars, 549-551

column layouts, 557-559

directories and lists, 552-557

glossary for, 469

letterheads, 545-549

mailers, 563-564

menus, 555-556

newsletters, 561

overhead slides, 559-561

prepress activities, 556-572

reports and proposals, 564

resumes, 562

desdnation file, for linking, 679

dialog boxes. See also specific types

for character formatting, 231

choosing options in, 778-779
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keyboard access to, 54

on-line help for, 58

dictionaries

custom, 487, 488-491, 732-733

finding, 770

selecting main for Spelling

checker, 731

using old after install, 770

Different First Page (Section dialog

box), 372, 791

dimmed commands, on menus, 20

dimmed page nimiber, in status

area, 79

dingbats, 248, 257, 552, 555

directories, 552-557

disk files. See files

disk space.Se« hard disk

diskettes, reading DOS on Mac, 181

disks, file search of multiple, 188

Displace (.\D) command, 215,

Displace formula typesetting

command, for kerning, 244

display type, 567

division, 358

Do It button (Commands dialog

box), 740

Document button (Page Setup dialog

box), 103

Document command (Format

menu), 221, 327, 379, 594, 791

Document dialog box

adjusting gutter in, 213

changing default tab settings,

327-328

Even/Odd Headers, 371

File Series button, 594

Footnote choices, 384

hotspot for, 54

margin settings in, 209

Mirror Even/Odd margin feature,

207,211,212-213

Widow Control option, 221

document list, in Save As dialog box,

191

document setup, 6-7

document size, and speed, 592

document statistics, from Grammar

checker, 498-500

document windows, 66-71, 67

closing, 71

pointing to activate, 68-69

documents. See also large documents;

stationery documents

adding emphasis to, 228

combining, 449-450

copying text between, 39

copying those containing movies,

712-713

creating, 36-37

graph objects in, 658

inserting addresses in, 435

inserfing glossary entries in,

458^60

listing open on Window menu, 40

maximum open, 66

moving to beginning, 79

multicolumn, 534-536

names for, 29

opening non-Word, 179-181

outlining existing, 523-524

placing equations in, 362

positioning charts in, 672-674

reasons for splitting, 592

recently opened listed on File

menu, 35, 727

samples, 438

saving first time, 27-31
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saving styles with, 407

searching inside, 185-186

selecting entire with mouse, 15, 23

selecting portion for search and

replace, 510

sending via E-mail, 699-700

size and speed, 94

style collection for, 401

transferring styles between,

415-416

viewing separate portions

simultaneously, 88

Work menu for frequently used,

741-746

DOS computers, saving files for, 195

DOS diskettes, reading on Mac, 181

dot matrix printers, quality from. 111

Dotted Underline command, 791

double-clicking, 8

document icon to launch Word, 33

to launch application for

embedded object, 687

object in chart window, 669

double line spacing, 303, 304

double lines, in datasheet window, 656

double page spread, 569

Double Underline command, 791

Down command (Font menu), 791

downloadable laser fonts, 107

imlimited, 110

downloaded fonts, printer memory

for, 110

downloading, technical notes, 61

Draft option, from dot matrix

printers, 1 1

1

Drag and drop feature (Tools menu),

791

copying with, 47

enabling, 724

to move text, 45-47

dragging

margin brackets on ruler, 21 1-212

margin handles, 120

margins in Print Preview, 210-211

to position page numbers, 374

to select text, 16

for sizing windows, 70

title bar to move window, 70

Draw button (ribbon), 22

drawing, 131. S<'? a/io Picture Window
in Picture Window, 132-136

drives

in Save As dialog box, 191, 192

saving files to other, 194—195

drop caps, 1 60, 259

deleting, 267

Drop Caps command (Insert menu),

260-262, 791

drop-down menus, 10

Dropped Position option, for drop

caps, 262

dropped words, 259, 261

duplicating objects, in Picture

Window, 135

Duplication tool (Picture Window),

132

Easy Install option, 764

Edit menu, 19

Clear command, 788

commands and shortcuts, 775

Create Publisher command, 681

Edit Movie command, 710

Find command, 80, 507

Glossary command, 153, 457, 458
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Go To command, 77-79

LinkOptions, 692, 791

Object Options, 690, 710, 792

Paste command, 38

Paste Object, 686

Paste Special, 692

Redo command, 20

Repeat command, 20

Replace command, 414, 509-515

Select All, 139

Subscribe To, 683

Subscriber Options, 685

Undo command, 17-20

Edit Movie command (Edit menu),

710

editing

annotations, 613

automatic subscribing and, 685

equations, 362

graphics, 153-154

keyboard shortcuts for, 73-76,

785-786

movies, 712

in Normal view, 81-84

in Page layout view, 85-87

in Picture Window, 138-139

returning to previous point of,

79-80

stationery documents, 447-448

editions, 680-681

subscribing to, 683-684

Educorp, 544

elevation, in 3-D charts, 671

Ellipse tool (Picture Window), 132,

141

ellipses (...). commands with, 9

ELSE merge instruction, 637-640

em dashes, 268

E-mail, sending Word documents via,

699-700

embedded objects, 679, 686-690

canceling, 689-690

graph object as, 658

updating, 687-688

embedded PostScript (EPS) images,

printing over text. 111, 112

en dashes, 268

Encapsulated PostScript (EPS) file

format, 146, 148

enclosures, with E-mail, 701

end mark, 9

ENDIF merge instruction,

637-640, 638

enlarging printed image, 104—105

Enter key, and dialog box

commands, 29

Envelope button (Toolbar), 429-430

envelope printing, 429^39, 642-645

adding addresses to list for, 434

merge for, 647

with new address, 431-433

return address for, 431

with stored addresses, 434-435

envelope stationery, 436-439

Envelopes folder, 642

EPS (Encapsulated PostScript) file

format, 146, 148

Equation Editor, 360-362

help in, 361

upgrading, 362

equations, 362

error checking, by Print Merge

Helper, 631

error messages, from PrintMonitor,

124

errors, undoing, 17-20

Escape key, 48
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even pages

headers and footers for, 371-372,

792

after section break, 395

Excel, data documents from, 621

Expanded character formatting, 243,

792

expanding outlines, 524-525, 792

Explain button (Grammar checker),

494

exporting documents

retaining formatting for, 420-421

Smart Quotes feature and, 259

tab stops for, 329

Extend to Character command, 792

extended keyboards, 48, 51-52

.\F (Fraction) command, 275, 277

Fast Save option (Save As dialog box),

192-193

auto backup and, 729

Fast Tips, 60

Faster Bitmap Printing option, 108

fax-based support service, 60

FAX modems, 282

Field names, 61 9, 625

fields, 621,622, 623

deleting, 625

multiple lines in, 627

File command (Insert menu), 444,

449-450, 554, 792

file compression, by TIFF format, 147

file conversion programs, 180

file management, 176-199

File menu, 32, 36

adding command to, 196

Close command, 788

commands and shortcuts, 775

Find command, 8

Find File command, 182

Make Alias command, 34

New command, 36

Open command, 177-182

Open Mail, 700

Page Setup dialog box, 756

Paste command, 150

Print command, 98-99

Print Merge, 632

Print Preview, 90, 119

Quit, 31-32

recent documents on, 35, 727

Save command, 27, 190

Send Mail, 699

Summary Info command, 30

File menu (Graph), Import Data, 660

File Name glossary entry, 464

file names

for glossary, 468-469

policies and procedures on, 187

in Save As dialog box, 192

searching by, 183-184

file searches

of multiple disks, 188

multiple searches to restrict lists,

188

File Series button (Document dialog

box), 379, 594

FileMaker, data documents from, 621

files, 176-177. .S^^'a^osave process

backups of 198

ccjmpressed, 763

deleting, 189

from Installer, 766-768

locating for saving, 28-29

multiple searches for, 187-188
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printing to, 115

files names, saving under different,

193-194

Fill color tool (Picture Window), 132

Fill pattern tool (Picture Window),

132

fill patterns, in Picture Window, 141

Find Again command, 792

Find command (Edit menu),

505-509, 506, 792

Clipboard and, 514

for navigating, 80

for special characters, 507-508

unspecified digits in, 508-509

Unspecified letters in, 508

white space in, 508

Find command (File menu), 8

Find dialog box

Match Case box, 507

Match Whole Word Only option,

507

Find File accessory (System 6), 8

Find File feature (Word 5), 182-188,

792

large lists in, 184-185

and summary information, 187

Find Formats command, 792

Find Next button (Replace dialog

box), 511

Find and Replace

for footnotes, 387

for index codes, 583

for styles, 414

Finder, Balloon Help, 58, 59

First Footer command, 793

First Header command, 793

first line indents, 297, 299-300, 793

and centering, 302

first page of document, special

headers and footers for, 372

fixed-size fonts. S<'<' bitmap fonts

Flesch index, 498, 499

Flesch-Kincaid index, 498, 500

Flip tool (Picture Window), 132,

144-145

flips, when prindng, 109

floppy disks

backups on, 198

movies on, 713

saving files to, 194-195

folders, 176-177

backups of, 198

Commands, 488

creating, 195

Envelopes, 642

Glossaries, 467, 469

for help file, 59

from Installer, 766-768

Mailing Labels, 642

name in Save As dialog box, 191

Sample Documents, 94, 429

for saving documents, 27, 29

selecting for Word install, 765

font families, 228

font ID conflict, 283

Font menu, 232, 239

commands and shortcuts, 777

Default Font command, 253

Down command, 791

Other command, 232, 236

on ribbon, 10-11, 22

fonts, 227, 279-283, 719

bitmap, 279-280

for body text or headlines, 567

choosing, 239-240

default setting for, 253

for drop caps, 260
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monospaced vs. proportionally

spaced, 229-230

in Picture Window, 138

point sizes, 230-231

PostScript, 281-282

serif or sans serif, 231

specialty, 261

substituting, 107, 282-283

TrueType, 280

vendors for, 228-229

footers, 793. See also headers and

footers

Footnote (Insert menu), 380, 384, 793

Footnote Cont. Notice command, 793

Footnote dialog box, 384

footnote window, 381

hotspot for, 55

resizing, 382

footnotes, 380-387

continuation, 387, 793

copying, moving, deleting, 383

editing text in, 383

inserting, 382

numbering, 385

numbering for document series,

596

position for, 385

reference marks, 381, 384, 386

separators for, 385-386, 793

spell checker for, 387

text style for, 385

viewing, 381-382

Footnotes command (View menu),

794

forcing

new lines, 291

page breaks, 217,220

foreign accented characters, 50, 253,

256

format layers, and Replace command,
420

Format menu, 7, 232-233, 234

Bold, 787

Border command, 308, 788

Change Case command, 246-249

Character command, 233,

236-238, 240

commands and shortcuts, 776-777

Document command, 221, 327,

379, 594

Frame command, 163-164, 165,

261,266

Paragraph command, 219, 220

Plain Text command, 250, 420

Revert To Style command,

251-252,267,313,315,412

Section dialog box, 372, 376, 394

Style command, 404, 755

Table Cells command, 338

Table Layout command, 340, 813

Underline command, 242

formatting. See also character

formatting; paragraph

formatting

basics, 22-26

changing default options, 756

character vs. paragraph, 417

for footnote text, 385

index entries, 586

layers for, 419

for linked text, 692

in merge documents, 647

object in chart window, 669

replacing, 511-512

retaining when removing styles,

420-421

sections and, 393-394

and styles, 417^20
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subscribed documents, 684

tools for characters, 231-238

formulas

complex, 278

printing, 279

typesetting commands, 273-279

Fraction (.\F) command, 215, 211

fractional widths printing, 110-111,

794

Frame command (Format menu),

163-164, 165,261,266,794

for drop caps, 261

for graphs, 672

for paragraphs of selected text, 168

Frame command (Insert menu),

162-163, 164,263,794

for selected text, 168

Frame dialog box, 165-166

framed elements, 548

deleting or unframing, 171

frames, 160-171, 161

changing widths, 163-164

for fixed-width items, 164-165

in headers or footers, 767

for lists, 556

positions as styles, 170

for text, 168

text flow around, 166

Freeze Picture (Object Options dialog

box), 689

Front/back tool (Picture Window),

132, 144-145

Full Repaginate Now command, 794

function keys, 48, 51-52

showing on menus, 726-727

Galley view. See Normal view

GateKeeper, 763, 764

General category (Preferences),

723-724

Get Edition Now button, 685

Get Info (Finder, File menu), 183, 756

glossaries

formula, 278

for index codes, 583

merging, 470

multiple in Work menu, 745

special puipose, 469

Glossaries folder, 467, 469

Glossary command (Edit menu), 153,

456-470, 794

Glossary dialog box, 153, 457

glossary entries, 548

adding to Work menu, 461, 743

assigning keyboard shortcuts to,

460

boilerplate text as, 564

borders as, 31

1

defining, 457^58

deleting, 461

for footnotes, 387

graphics as, 152-153

inserting in documents, 458-460

inserting files and, 450

inserting with keyboard, 459^60

for large documents, 593

modifying, 461

Page layout, 568

printing lists, 470

save process for, 467-469

for styles, 415

and styles, 416, 470
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Work menu for frequently used,

741-746

glossary files, 456

Go Back feature, 79-80, 794

Go To command (Edit menu), 77-79,

794

and section numbers, 78

Go To dialog box, hotspot for, 55

Grammar category (Preferences),

733-734

Grammar checker, 493-500, 794

accepting suggestions, 494-496

docuinent statistics from, 498-500

Ignore Rule, 497

ignoring suggestions, 497

making manual changes, 496

grammar rules, 497

enabling or disabling, 734

graph objects, 658

parts of, 654-658

graph window, 653. See also chart

window

graphic images, box size for, 149

graphic objects, for QuickTime

movies, 708-709

graphics. See also Picture Window

as drop caps, 259, 267, 262

editing, 153-154

eliminadng stretched-out look, 1 1

1

finding, 505

iormats for, 146

frame for, 162-163

as glossary entries, 152-153

imported, 146, 150

inserting from Scrapbook, 151-152

keeping with related text, 219

in letterhead, 547

linking, 154

in margins, 214

moving, 45

and paragraph numbering, 314

positioning, 155-156. See also

frames

printing selected, 115

QuickTime movies as, 154

replacing text with, 514

in return addresses, 439

in Scrapbook, 150-152

selecting with mouse, 15

smoothing, 108

types of 146-148

graphs, 652-674

creating, 653-654

positioning in documents, 672-674

resizing, 673

restoring previous version, 674

updating, 673

gray lines, for changeable print

entries, 463

grayscale printing, vs. black and white

printing, 114-115

gridlines, 657

in chart window, 655

in tables, 330

Group tool (Picture Window), 132,

139-141

groups of objects, in Picture Window,

139

Gimning Fog index, 498, 500

gutters, 206, 213-214

halftones, 569-570

Hammermill's Laser Plus paper, 567

hanging indents, 296, 300-301, 795

and bullets, 257
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hard disk, 762

for fonts, 280

for QuickTime movies, 707

for sound file, 606

hardware requirements, 762

QuickTime movies, 707

Header command (View menu), 795

header record, 626

header window, 367

headers and footers, 366-372

dates, times, and page numbers in,

368

deleting page numbers from, 380

entering, 367-368

even and odd, 371-372

for first page, 372

frames in, 767

and margins, 215

non-printing areas and, 370

in Normal view, 81-82

in Page Layout view, 86, 87, 369

page numbers in, 375

PostScript code in, 372

in Print Preview, 369-371

searching in, 506-507

sections and, 393

heading styles, for table of contents,

511

headings

for datasheet rows and columns,

656

repeating for multipage tables, 351

headlines, 558

fonts for, 567

hearing impaired, TTD support for, 61

Height box, for drop caps, 260

help, 20, 55-59, 795

in Equation Editor, 361

quitting on-line, 59

Help file, location of, 59

Help menu. Topics button, 57

Helvetica font, 230

hidden text, 795

for annotations, 604-606

default for displaying, 725

index entries as, 586

merge instructions as, 637

in Page Layout view, 87

printing, 115

Hide (Show) \ command (View

menu),94, 290, 323, 811

and formulas, 274

hiding

non-printing characters, 93-94

paragraph marks, 1

1

Standard glossary entries, 462

hinnng, 282

horizontal flips, 109

hotspots, 54-55, 180

for Character dialog box, 236

house sheets, 570

Hyphenation category (Preferences),

735

Hyphenation (Tools menu), 271, 795

hyphens, 267-269

optional, 269

and white space in justified text,

303

I-beam. ,S>c also mouse pointer

vs. insertion point, 21

.\I (Integral) command, 215. 277

icon bar, in Outline view, 521-522
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icons

double-clicking document to

launch Word, 33

page-numbering, 374

in Preferences dialog box, 722

Print Preview actions, 119-120

printer driver, 101

for stationery, 445

Word 5, 8

IF merge instruction, 637-640, 638

Ignore option (Spelling Checker),

487, 733

Imagewriter, 111

printing addresses on labels, 646

importing

ASCII list, 554

data to datasheet window, 660

graphics, 146

graphics with Clipboard, 150

with Picture command, 148-149

imposition, 571

In Margin option, for drop caps, 262

Include Endnotes in Section

command, 795

Include Formatted Text in Clipboard

command, 795

INCLUDE merge instruction, 640

Increase font size button (Toolbar),

235

indent markers, 214, 297

indents

and border width, 312

and column widths, 535

within columns, 536

for framed text, 168

headings in Oudine view, 521

with keyboard shortcuts, 298-299

in margins, 299

with Paragraph dialog box, 298

paragraphs, 7, 296-301

ruler and, 11, 293. 297-298

with Toolbar, 294, 299

vs. margins, 208

index codes (.i), 525, 582

Find and Replace for adding, 583

Index command (Insert menu), 795

Index dialog box, 582

index entries

and footnotes, 387

formatting, 586

text in, 584-585

Index Entry (Insert menu), 581, 582,

795

indexes

creating, 581-587

for large documents, 597

for selected portions, 587

subentries, 583-584

initial caps, 259

initials, for voice annotation, 723

Inkjet printing, 282

Insert 1[ Above Row command, 796

Insert Cells Down command, 795

Insert Cells Right command, 795

Insert Field Name menu (print merge

help bar), 629

Insert Formula command, 796

Insert Keyword menu (print merge

help bar), 629

ASK, 635

Calculations, 634

DATA, 641

IF-ELSE. 639

SET, 636-637

Insert menu
Addresses command, 434

Annotation command, 611

Bullet connnand, 257-258
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Date command, 630

Drop Caps command, 260-262

File command, 444, 449^50, 554

Footnote command, 380, 384

Frame command, 162-163, 164,

263

Index Entry command, 581, 582

Movie command, 708

Object command, 361, 688

Picture command, 131, 148-149

Section Break command, 392

Symbol command, 50, 254

Table command, 331

Table of Contents command, 576

Table to Text command, 349

TOC Entry command, 580

Voice Annotation command, 607

Insert Non-breaking Hyphen

command, 796

Insert Non-breaking Space command,

796

Insert Object dialog box, to start

Equation Editor, 361

Insert Optional Hyphen command,

796

Insert Page Break command, 8

for column breaks, 539

Insert Rows command, 796

Insert symbols biuton, (Toolbar), 235

Insert Tab command, 796

Insert Table dialog box, 331

Comma Delimited button, 347

Paragraphs button, 348

Tab Delimited button, 347

inserting

addresses in documents, 435

columns in tables, 340-341, 796

footnotes, 382

glossary entries in documents,

458-460, 796

graphics from Scrapbook, 151-152

manual page break, 217

movies, 708

rows and columns in datasheet, 662

text, 21

text annotations, 611-612

insertion point, 9, 10

scrolling and, 73

vs. I-beam, 21

inside margins, 212

Installer, files for, 766-768

installing

custom, 769-770

Picture command, 131

Word, 762-771

insufficient disk space message, and

saving files, 195-196

Integral (.\I) command, 275, 277

inter-character spacing, 110

international characters, 50, 253, 256

international telephone support, 60

Invert Image feature, 109

Italic Cursor command, 797

Italic option (Format menu), 232, 796

italic text, 228, 241

in pictures, 138

italic text button (ribbon), 11, 22, 25,

235, 241

jaggy bitmap characters, 107, 108

joining paragraphs, 290-291

justification, 303, 797
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Keep Lines Together option, 219, 797

and column breaks, 539

Keep with Next Paragraph option,

219, 797

and cohimn breaks, 539

kerning, 25, 244

Key Caps (Apple menu), 253

Key Repeat Rate, 52

keyboard, 48-54

accessing dialog boxes with, 54

applying styles from, 403

extended, 51-52

hotspots, 54-55

for input to merge documents,

634-636

for inserting glossary entries,

459-460

navigation with, 73-77

repeating keys, 52

typing symbols from, 254

Keyboard Menus feature, 53

keyboard shortcuts, 48-49, 749-752

assigning, 736

assigning from Commands dialog

box, 750-751

assigning to glossary entries, 460

for bold character formatting, 241

for character formatting, 231

for choosing commands, 774-777

to define hideable text, 605

displaying fimction keys on menus,

726-727

for Find and Replace, 505

for glossary definidon, 457

for Grammar checker, 494

for hanging indents, 301

for hiding ruler, 10

indenting with, 298-299

for inserting table rows, 337

for Move Text command, 45

moving, scrolling and editing,

73-76, 783-784

numeric keypad to add or remove,

752

in Outline view, 778

for paragraph formatting, 296

for Plain Text, 250-251

printing list, 749

Repeat, and styles, 403

for Revert to Style, 412

for special characters, 255

for super and subscripts, 245

for switching views, 84

for Symbol command, 254

symbols for, 49

KeyFinder (Norton utility), 254

keystrokes, for special characters, 50

Keyword glossary entry, 465

.\L (List) command, 275, 277

L Thick Paragraph Border command,

797

labels, 642-645

printing addresses with

ImageWriter, 646

landscape printing, 104, 563

for calendar, 550-551

large documents, 592-597

connecting multiple parts in series,

593-597

indexes for, 597

numbering within, 595—596

planning for, 593
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printing, 592, 597

table of contents for, 597

Larger Font Size command, 797

laser printers, 98, 566-567. See also

Apple LaserWriter printers

feeding envelopes to, 433

minimum margin from, 110

PostScript compatibilit)', 281

printing labels on, 642-645

last page, moving to, 79

laimching Word, 33

law firm letterhead, 545-547

layers, in Picture Window, 144

leading, 25, 231

leading charactei^s, for tabs, 326-327

left alignment, 302

left tab stops, 321

legends, 657

letterheads, 545-549

letters, as page numbers, 377

ligatures, 253

line breaks. 797

line charts, 664-665

Line color tool (Picture Window), 132

line heights, specifying exact, 304-305

line numbers, 295, 797

within document series, 596

in page layout view, 87

viewing, 82

Line pattern tool (Picture Window),

132

line spacing, 295, 797-798

adjusting, 303-305

default measurement unit for, 295

negative, 266

line spacing buttons (ruler), 293

Line tool (Picture Window) , 132, 136,

141, 143

Line width tool (Picture Window), 132

lines, 556

changing length in Picture

Window, 144

creating with Border command,

308

custom, 310-312

as footnote separators, 385-386

width in Picture Window, 142-144

lines of text

eliminating blank in merge

documents, 633, 637

forcing new, 291

preventing page break between,

218-219

selecting with mouse, 14-15

Link Options dialog box, 692-693,

798

linking, 679, 690-693

graphics, 154

and styles, 416

Linotronic printers, 570-571

List (.\L) command, 275, 277

List All Fonts command, 798

List button (Commands dialog box),

746

List Recently Opened Documents

command, 798

lists, 552-557

logo letterhead, 547-549

Lowercase command, 798

Mac

clocks on, 466

power off vs. quitting Word, 32

preparing for Word install, 763

MacPaint, 147
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MacRecorder, 606

macro programs, and menu changes,

719

MacWrite II, 180

mail, reading in Word, 700-702

mailers, 563-564

Mailing Labels folder, 642

Main dictionary, selecting for Spelling

checker, 731

main documents for merge, 618, 67 9,

621,626

creating, 627-631

DATA statement in, 628

including external file contents in,

640

inserting data instructions in,

629-630

testing and proofing, 631

text in. 628-629

Make Alias command (File menu), 34

Make Backup option box, in Save As

dialog box, 192,798

Make Body Text command, 798

Make graphs button (ribbon). 22

Make tables button (ribbon). 22

manual formatting, 418

appl)ing styles to, 419-420

inserting page break. 217

Margin Marker button (ruler), 330,

538

margin markers, vs. colimin width, 538

Margin Page Numbers command, 798

margins. 206-208

changing. 208-212

changing in Print Preview, 90, 120,

370

and column width. 535

defining measurement imit for, 724

headers and footers and, 215

and indents, 296. 299

for mailers, 563

printers and, 208

printing in, 214

ruler and, 11

table alignment with, 344

vs. indents, 208

Match Case box (Find dialog box),

507

Match Whole Word Only option

(Find dialog box), 507

math, 356-359

mathematical formulas, glossary for,

469

measurement units, 798

defauk settings for, 295

defining, 724

in Tab dialog box, 326

mechanicals, 567

memory
for Grammar command, 493

in laser printers, 110

for QuickTime movies, 707

and sound annotations, 607

for tables, 351

for Word, 756-757, 762

menu bar, 9

and commands, 9-10

keyboard access to, 53

Microsoft Graph, 653

menu commands, 9, 12

avoiding execution. 10

Menu section (Commands dialog

box). 737-738

menus

adding commands to. 718

adding Show Hidden Text

command to. 606

adding table layout choices to, 351
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for character formatting, 231,

232-233

deleting items from, 718, 739-740

dimmed commands on, 20

documenting changes in, 746-747

executing commands not on, 740

keyboard for accessing, 786

keyboard symbols in, 49, 726-727

modifying, 736-741

moving items on, 718, 740

resetting standard, 748

saving changes to, 747

separator lines in, 741

short names for, 727-728

shortcuts for changing, 714

without mouse, 53

menus (restaurants), 555-558

Merge cells command, 799

merge documents. Se? also Print

merge feature

calculation instructions in, 634

condidonal prindng of, 637-640

eliminating blank lines in, 633, 637

formatung in, 647

keyboard input to, 634-636

preventing page breaks for each

record, 640-641

printing, 631-632

restarting merge process, 642

Merge instructions, 619, 620, 633-641

as hidden text, 637

merge marks, manually inserting, 642

Merge to file button (Main merge

document), 679

Merge to printer button (Main merge

document), 619

merging

glossaries, 470

style sheets, 415—416

table cells, 345

microphones, 606

Microsoft, product support services,

60-61

Microsoft Graph, 652

on-line help from, 658-660

Microsoft Mail, 698, 699

minus signs, in Oudine view, 522

Mirror Even/Odd margin feature

(Document dialog box) , 207,

211,212-213

misspelled words, correcting, 486

mistakes, undoing, 17-20

monospaced fonts, 229-230

Month glossary entry, 465

More Keyboard Prefix command, 799

mouse

menu use without, 53

selecting text with, 14—16

shortcuts with, 780

mouse pointer, 9, 10

compass shape for, 522

question mark as, 57

Move Down One Text Area

command, 799

Move Heading Down command, 799

Move Heading Up command, 799

Move Left One Text Area command,

799

Move Right One Text Area

command, 799

Move Text command, 42-45, 799

Move to Bottom ofWindow

command, 799

Move to End of Document command,

799

Move to End of Line command, 799

Movie command (Insert menu), 708,

801
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movie sound, 711

movies. See QuickTime movies

moving, 799-801

annotations, 614

cell contents, 350

data Files and merge process, 647

to document beginning, 79

footnotes, 383

keyboard shortcuts for, 73-76,

783-784

margins in Print Preview, 120

to next page, 79

page breaks, 218

paragraphs in outline view, 526-527

tab stops on ruler, 324

between table cells, 333

text in Picture Window, 137-138

vs. resizing drawing objects, 135

windows, 70—71

moving objects

with drag and drop, 45—47

in Picture Window, 135

moving text, in outline view, 90

multicolumn documents, 534-536

MultiFinder, Clipboard use in, 42

multilevel sorts, 355

multipage tables, repeating headings

for, 351

multiple objects, selecting in Draw

Window, 134

multiple searches, for files, 187-188

multiplication, 358

names. See also file names

for documents, 29

sorting, 355

navigaung

in datasheets, 661

with keyboard, 73-77

navigation keys, 48

negative line spacing, 266

negative margin settings, 299

negative numbers, parentheses for,

358

Nest button (Toolbar), 294, 299

nested index entries, 583-584

nested paragraphs, 298, 802

networks

choosing printers on, 102

edition files accessed on, 682

sharing files on, 450-451

New f After Ins. Point command, 802

New \ with Same Style command, 802

New command (File menu), 36

new documents, creating, 36-37

New Folder button (Save dialog box),

195

new lines, forcing, 291

new pages

forcing, 220

for section breaks, 395

New Paragraph command, 802

New Picture command, 802

New Window command, 802

newsletters, 561

NEXT merge instruction, 640-641

Next Style (Style dialog box), 408-^09

No Break option, for section printing,

395

No Paragraph Border command, 802

No Space Before button (ruler), 306

non-breaking hyphens, 268

non-breaking spaces, 267, 559

non-printing characters

displaying, 1

1
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hiding, 93-94

non-printing characters button

(ribbon), 22

non-Word file formats

for E-mail, 702

opening, 179-181

save process, 195

specifying when saving files, 193

Normal Character Position

command, 802

Normal Character Spacing command,

802

Normal Paragraph command, 802

Normalstyle, 289, 412

font and point size for, 253

for linked text, 692

and standard styles, 409

Normal view, 81-84, 802

columns in, 534

as default, 92

editing in, 81-84

footnotes in, 381-382

framed items in, 162, 168

keyboard shortcut for, 84

page breaks in, 216

and speed, 94

Norton Utilities, 254

Num Loc key, 50, 803

number formats, in datasheet,

661-662

numbered paragraphs, 313-315

hanging indents for, 300

numbering footnotes, 385

numbers, in Find command, 508—509

numeric keypad, 48, 50-51

to add or delete keyboard

shortcuts, 752

to navigate, 77

.\0 (Overstrike) command, 275,

277-278

Object command (Insert menu), 361,

688, 803

Object Options command (Edit

menu), 690, 710

Freeze Picture, 689

objects

creating, 688-689

deselecting in Draw Window, 134

double-clicking in chart window,

669

duplicating in Picture Window, 135

groups in Picture Window, 139-141

selecting with mouse, 15

selecting multiple in Draw

Window, 134

odd pages

after section break, 395

headers and footers for, 371-372,

803

printing, 117-118

on-line help, 56-58

in Equation Editor, 361

from Microsoft Graph, 658-660

pointing for, 57-58

quitting, 59

Open command (File menu),

177-182, 803

open documents, listing on Window

menu, 40, 803

Open Mail (File menu), 698, 700, 803

Open and Save category

(Preferences), 31, 728-731

opening

custom dictionaries, 490

non-Word documents, 179-181
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Picture Window, 131-132

read only documents, 181-182

opening documents, in Page Layout

view, 726

option key, 48

optional hyphens, 269, 271-272

orientation of printing, 104

Original button (Thesaurus dialog

box), 478

orphans, 221

Other command (Font menu), 232,

236, 803

outdents, 296. See also hanging indents

Outline bar, 522

Outline Command Prefix command,

804

Outline view, 90, 92, 93, 520-527, 804

footnotes in, 381-382

icon bar, 521-522

keyboard shortcuts, 84, 778

moving paragraphs in, 526-527

page breaks in, 216

plus signs in, 522

for rearranging table rows, 349

split screen and, 525-526

styles and, 521

underlined text in, 522

outlines

creating and editing, 522-527

for existing documents, 523-524

expanding and collapsing,

524-525, 788, 789

for presentations, 561

printing, 527

promoting and demoting

headings, 523

table of contents from, 578

outquotes, 160

outside margins, 212

overhead slides, 559-561

Overstrike (.\0) command, 275,

277-278

Page Break Before option (Paragraph

command), 220, 804

page breaks, 215-216, 804

controlling position of, 218-220

forcing, 217

hiding, 93-94

moving and deleting, 218

in Normal view, 81

in Page Layout view, 86

reduce/enlarge box and, 106

removing formatting restrictions

on, 220

repaginalion, 216-217

and table of contents, 578

page counts, relative, in Go to

command, 78

page design, 6-7

Page Layout glossary entries, 568

Page Layout view, 85-87, 804

columns in, 534

for drop caps, 263

framed items in, 162, 168

headers and footers in, 369

keyboard shortcut for, 84

opening documerits in, 726

for position of framed items, 162

scrolling in, 75, 784-785

show text boundaiies in, 725-726

Page Layout View button (Toolbar),

537

Page number glossary entr\, 465

page numbers, 373-378, 804, 805
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beginning with second page as

one, 378-379

changing starting number, 379

deleting, 379-380

dimmed, in status area, 79

for document series, 595

formats and styles for, 377-380

in headers or footers, 87, 368, 375

in margins, 214

Print Preview for, 373-374

restarting in each section, 378

Section dialog box for, 376

sections and, 393

starting, 377-379

suppressing, 378

suppressing in table of contents,

580

page orientation, 7, 104

and colimin widths, 535

for envelope printing, 432, 435

page setup

changing default options, 756

for letterhead, 545

options for printing, 102-1 1

1

Page Setup dialog box, 102-1 1 1, 805

vs. Print dialog box, 1 12-1 13

page size

and column width, 535

planning for, 7

page tops, paragraph spacing and, 307

pages

moving between, 79

new, 8, 220

preventing new in merge

documents, 640-641

printing frame on all, 167-168

printing odd/even, 117-118

printing range, 113

pagination. See Repagination

paint programs, 147

Paper Direct, 565

paper size, 106

custom, 723

paper source, 1 14

paper stocks, 570

Paragraph Aligned Left command,

805

Paragraph Aligned Right command,

805

paragraph alignment tools, for

graphics, 155

Paragraph Border feature, 166, 805

Paragraph command (Format menu),

805

for chart positioning, 672

Keep Lines Together, 219

Paragraph dialog box

Apply button, 298

Border button, 309

exact line height in, 305

first line indenting with, 300

formatting with, 294-295

hotspot for, 55

indenting with, 298

Spacing, 305

paragraph formatting, 288-316. See

also styles

keyboard shortcuts for, 782-783

with Paragraph dialog box, 294-295

restoring, 315

with ruler, 293

with Toolbar, 294

vs. character formatting, 417

paragraph marks (\), 9, 288

finding, 505

hiding or showing, 11, 93-94, 209,

323,811

vs. section breaks, 396
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paragraplis, 288-291

adding blank lines between, 292

borders, 307-312

bullets for, 257-258

converting to tables, 348

creating, 289

default measurement unit for

spacing, 295

deledng, 291

first line indents, 297. 299-300

frame for, 1 62

indenting, 7, 296-301

joining, 290-291

moving in Oudine view, 526-527

niunbering, 313-315

numbering for document series,

596

preventing page breaks between,

219

removing white space before, 306

selecting with mouse, 15

shading for, 312

sorting, 315-316

splitting text into multiple, 289-290

in table cells, 333

white space between, 8, 292, 295,

305-307

Paragraphs button (Insert Table

dialog box), 348

parentheses

to control Calculate feature, 359

including in formulas, 276

for negative numbers, 358

part numbers, sorting, 355

Paste button (toolbar), 39

Paste Cells command, 805

Paste command (Edit menu), 38, 805

for movies, 712

Paste command (File menu), 150

Paste Link command, 805

Paste Object (Edit menu), 686, 805

Paste Special Character command,
806

Paste Special (Edit menu), 692, 805

and styles, 416

path, 177

percentages, calculating, 358

perspective, in 3-D charts, 671

photos, in desktop publishing, 569

PICT graphic format, 146, 147

Picture command (Insert menu), 131,

148-149, 806

picture placeholders, displaying in

place of graphics, 726

Picture Window, 130

8-bit window for, 147

changing line length in, 144

drawing in, 132-136

drawing placement in, 133

duplicating objects in, 135

editing graphics in, 153-154

editing text in, 138-139

fill patterns and color in, 141

groups of objects in, 139-141

layers in, 144

line width in, 142-143

moving objects in, 135

moving text in, 137-138

opening, 131-132

polygons in, 141-142

Tool palette, 132

typing text in, 137

ungrouping elements, 140-141

pictures, grouping all elements, 140

pie charts, 665

Plain Text command (Format menu),

233, 250, 420, 806

playing, QuickTime movies, 709, 806
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plus signs, in Outline view, 522

point size menu (ribbon), 22

point size of type, 230-231

changing, 23-25, 240

choosing, 239-240

default setting for, 253

pointing

to activate window, 39, 68-69

for on-line help, 57-58

Polygon tool (Picture Window), 132

polygons, in Picture Window, 141-142

port, for printer, 102

portrait printing, 104

Position command. See Frame

command (Insert menu)

positioning graphics, 155-156

post code, 624

poster

for movie, 709

selecting picture frame for, 71

1

postponing, background printing,

124-125

PostScript code, in headers, 372

PostScript (EPS) images, printing

over text, 111, 112

PostScript File Printing, 115

PostScript fonts, 281-282

power failure

document loss from, 27

and file loss, 189

and new glossary entries, 468

recovery after, 198-199

PowerBook, limited Word version for,

771

precision bitmap alignment, 109

preferences

changing, 722-736

resetting, 748

Preferences command (Tools menu),

806

Open and Save, 31, 197

Preferences dialog box

Always Suggest for Spelling, 486

default view, 85

Grammar, 497, 498

icons in, 722

Show Hidden Text (View

category),87, 579, 582, 605,

606,614

Spelling category, 489

Preferences folder, 719

prepress activities, terminology,

556-572

presentations, outlines for, 561

preview, of formatting changes, 298

print area, size of, 1 10

Print command (File menu), 98-99,

806

Print Date glossary entry, 462-463,

463-464, 806

Print Day glossary entry, 464

Print dialog box, 112-115

Print Hidden Text box, 87

printjob

canceling, 124

checking status of, 122-123

Print merge feature, 618-647

creating data document, 623-625

creating main documents, 627-631

creating project, 621-627

planning data document, 622-623

restarting, 642

stopping, 632

Print Merge (File menu), 632, 806

Print merge glossary entry, 465

print merge help bar, 619, 627
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Print Merge Helper (View menu),

623, 624, 806

error checking, 631

merge documents without, 641-642

Print Month glossary entry, 465

Print Next File option, 115

Print Preview, 90, 91, 119-120, 807

crosshair for mouse pointer in, 162

deleting page numbers in, 379

dragging margins in, 210-21

1

framed items in, 162, 168

headers and footers in, 369-371

keyboard shortcut for, 84

moving margins in, 120

for page numbering, 373-374

for position of framed items, 162

printing from, 120

Print Preview (Toolbar), 537

Print Time glossary entry, 466

printer driver icons, 101

printer effects, 107

printer fonts, 281

printer-resident fonts, 107

printer spreads, 571

printers. See also laser printers

choosing, 100-102

dot-matrix, 1 1

1

Linotronic, 570-571

margins settings and, 208, 209

minimum margins for, 370

planning for, 7

selecting at project beginning, 100

printing, 98-125

aborting, 99

addresses on envelopes with

merge, 647

annotations, 613

background, 121-125

black and white vs. color/grayscale,

114-115

conditional, of merge documents,

637-640

connected documents, 115

cover pages, 114

documents in series, 597

envelopes, 429-439

formulas, 279

fractional widths, 110-111

glossary entry lists, 470

hidden text, 115

as interactive process, 99-100

keyboard shortcuts list, 749

in margins, 214

merged documents, 631-632

multiple copies, 1 13

odd/even pages, 117-118

outlines, 527

page orientation, 7, 104

page setup options, 102-111

PostScript over text. 111, 112

from Print Preview, 120

range of pages, 113

reducing and enlarging, 104-105

saving before, 189

section ranges, 114

selected text or graphics, 115

split documents, 592

style sheets, 406

suppressing table of contents

levels, 581

two-sided, 116-119

PrintMonitor, 99, 121

error messages from, 124

postponing printjob, 124-125

window for, 122-123

programs, switching between, 69

promodng oudine headings, 523, 807
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Prompt for Summary Info command,

807

proofreading, 594

proofs, 572

proportionally spaced fonts, 229-230

proposals, 564

Publish and Subscribe feature, 146,

678-679, 680-685

publisher document, 680

creating, 681-682

quotation marks, typographer's,

258-259

quality, from dot matrix printers. 111

question mark (?), as mouse

pointer, 57

Quick Record Voice Annotation

command, 807

QuickTime movies, 130, 706-713

changing frames to PICT graphic,

711

controls for running, 109, 711

copying documents containing,

712-713

editing, 712

frames as graphics, 154

hardware requirements, 707

inserting, 708

looping back and forth, 710

playing, 709

playing continuously, 710

selecting with mouse, 15

sources of, 713

Quit (File menu), 31-32, 807

quitting

on-line help, 59

Word, 31-32

.\R (Radical) command, 275, 278

Radical (.\R) command, 215, 278

Radius Rocket board, 763

RAM. See memory
range of pages, printing, 113

read only documents, opening,

181-182

readability statistics, 498

reader spreads, 571

reapplying styles, 410

recording

sounds to disk, 606

voice annotations, 607-608

records, 621

recovering damaged files, 198-199

Rectangle tool (Picture Window),

132, 133

rectangular areas, selecting, 16

redefining, styles, 411, 807

Redo command (Edit menu), 20

reducing printed image, 104—105

reference marks, for footnotes, 381,

384, 386

relative page counts, in Go To

command, 78

Remove from Menu command, 807

renaming styles, 413

Renumber command (Tools menu),

596, 807

Repaginate Now command (Tools

menu),79, 87, 807

repagination, 216-217

background, 87, 724
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in Page Layout view, 87

Repeat command (Edit menu), 20,

807

Repeat keyboard shortcut, and styles,

403

repeating keys, 52

Replace All button (Replace dialog

box), 511

Replace command (Edit menu), 22,

504-515,808

and Clipboard, 514

combining tasks in, 513-514

for deleting strikethru text, 243

and format layers, 420

for formatting, 511-512

interaction with styles, 515

for manual page breaks, 218

for styles, 513, 515

reports, 564

Reset to Microsoft Standard Settings,

748

resizing

vs. moving drawing objects, 135

windows, 67

Restart Page Numbering at 1

command, 808

resumes, 562

return addresses

for envelope printing, 431

graphics in, 439

Return key, 8, 13, 288

and dialog box commands, 29

Revert To Style command (Format

menu), 233, 251-252, 267, 313,

315,412,808

ribbon, 9, 10-11, 22-25, 22, 234

3-D, 94, 728

character formatting with, 231,

233-235

column graph button, 653

to create columns, 535-536

default for displaying, 726

font and size lists on, 239-240

for headers and footers, 369

hiding, 10

making visible, 235

paragraph alignment buttons, 55

paragraph mark button, 94

picture icon, 131

Table button, 332, 341

Ribbon command (View menu), 235,

808

Rich Text Format, 180, 728

right alignment, 302-303, 559

right tab stops, 322

Roman numerals, for page numbers,

377

Rotation tool (Picture Window), 132,

144-145

Rounded rectangle tool (Picture

Window), 132, 141

row headings, in datasheet, 656

Row selection bar, 334

rows in datasheet, 655

inserting and deleting, 662

rows in tables, 330

adding, 336-337

creating, 333

deleting, 338

height of, 338

rearranging, 349

selecting, 335

white space between, 339

ruler, 9, 11,25-26

3-D, 94, 728

applying styles from, 403

Center button, 7, 302
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changing table column width with,

342-343

default for displaying, 726

defining measurement imit for, 724

dragging margin brackets on,

211-212

first line indenting widi, 299-300

hanging indents with, 300-301

for headers and footers, 369

hiding, 11

indenting with. 297-298

Justify button, 303

line spacing buttons, 293

margin indicators as hotspot, 54

Margin Marker button, 538

margin markers, reduce/enlarge

and, 106

No Space Before button, 306

for paragraph formatting, 293

Right alignment button, 302

Space Before Paragraph button,

292, 306

styles definition with, 402

tab stops on, 323-324

zero point on, 535

Ruler command (View menu), 212,

808

.\S (Super/Subscript) command, 215,

278

Same As Previous command, 808

sample documents, 438

Sample Documents folder, 94

stationery files, 429, 448

sans serif fonts, 231

Save As button (Commands dialog

box), 747

Save As command (File menu), 181,

190-193, 808

to save to other drives, 194-195

to save under different file name,

193-194

System 6 vs. System 7, 190

Save button (Toolbar), 190

Save command (File menu), 27, 190,

808

Save Copy As command, 808

Save Current Document As box (Save

As dialog box), 192

Save dialog box, 27-29, 27

New Folder button, 195

Save File As Type menu (Save

command), 193, 447

save process

auto backup in, 729

before printing, 98

charts, 672

data document designs, 625-627

during work, 31

Fast Saves, 730

first time, 27-31, 189-190

for glossary entries, 467^69

importance of, 19

and insufficient disk space

message, 195-196

non-Word formats, 195

styles, 407

Save reminder, 197

enabling, 730-731

scaleable fonts, 280

scanner, 569

bitmap images from, 147

scatter charts, 665-666

scientific notation, 661



THE WORD FOR THE MAC HOW-TO BOOK Index

Scrapbook, 41

for Word graphics, 150-152

screen-capture programs, TIFF files

from, 147

screen display, speeding up, 94

screen fonts, 281. See also bitmap fonts

Screen Test command, 808

scroll arrow, 71

scroll bars, 9, 72

Scroll boxes, 67,72

scrolling, 809

keyboard shortcuts for, 73-76,

783-784

windows, 71-73

Search dialog box, for finding files,

182

Search menu (Find dialog box), 514

Search menu (Replace dialog box),

514

Search Only hi List option (Search

Options menu), 188

search text criteria, 186

searching

canceling, 186

combined, 188

by file names, 183-184

inside docimienis, 185-186

multiple disks, 188

multiple, for files, 187-188

wildcards in, 186

Section Break (Insert menu), 392, 809

section breaks

for column changes, 536-537

copying, 395-396

deleting, 396

vs. paragraph marks (f ), 396

Section dialog box, 394-395, 809

to create columns, 534, 536

Different First Page, 372

hotspot for, 55

for inserting page numbers, 376

Section glossary entry, 465

section marks, finding, 505

section numbers, and Go To

command, 78

section ranges, printing, 114

sections, 392-396

and column breaks, 536-539

column width in, 534

creating breaks, 392-393

deleting page numbers from, 380

and formatting, 393-394

page number formats for, 377

restarting page numbers with one,

378

Select All command (Edit menu),

139,810

and tables, 335

selected graphics, printing, 115

selected objects, grouping in picture,

140

selected pages, printing range, 113

selected paragraphs, formatting

changes to, 292

selected records, print merge for, 631

selecting text, 13-16

canceling, 14

dragging for, 1

6

entire table, 335

for index entry, 582

with mouse, 14—16

for printing, 115

scrolling and, 73

for search and replace feature, 510

for sorting, 354

for spell check, 485

selection markers, for borders, 310
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Selection tool (Picture Window), 132,

134

semicolon (;)

printing in index, 586

printing in table of contents, 581

Send Mail (File menu), 698, 699, 810

Sentence Case command, 810

sentences, selecting with mouse, 15

separator lines, in menus, 741, 810

serial number, for Word, 786

series

connecting multiple document

parts in, 593-597

creating, 594-595

numbering within, 595-596

printing documents in, 597

table of contents and indexes for,

597

series names, in datasheet window, 656

serifs, 231

Set button (Tab dialog box), 324

SET feature, 636-637, 638

Set Indent Ruler Scale command, 810

Set Margin Ruler Scale command, 810

Set Print Time biUton

(PrintMonitor), 125

Set Table Ruler Scale command, 810

Settings files

finding, 771

keyboard shortcuts in, 751

setup, of documents, 6-7

shading

deleting, 313

for paragraphs, 312

Shadow command, 810

shareware

bitmap graphics, 147

dingbat fonts, 257

Shareware fonts, 544

sharing information. See embedding;

linking; Publish and Subscribe

shift-clicking, for text selection, 16

Shift-Return key combination, 291

Show (Hide) f command (View

menu),94, 290, 323, 811

and formulas, 274

Show All Headings command, 810

Show Balloons (Word menu), 58, 59

Show Body Text command, 810

Show Clipboard command (Window

menu), 41, 810

Show Document Statistics (Grammar

preferences), 497

Show Formatting command, 810

Show Function Keys on Menus

command, 811

Show Heading 1-9 command, 81

1

Show Hidden Text (Preferences

dialog box), 579, 582, 605, 606,

614,811

and voice annotation speakers, 608

Show Picture Placeholders command,

811

Show PrintMonitor Window when

Printing option (PrintMonitor

Preferences dialog box), 123

Show Styles on Ruler command, 811

Show Table Gridlines command, 811

Show Text Boundaries command, 811

side-by-side text, 811

converting to table, 348

single line spacing, 303, 304

size box, in document window, 9

sizing windows, 67

dragging for, 70

Zoom box for, 70

slides, 559-561
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Small Caps option (Character dialog

box), 248-249, 811

for dropped text, 262

Smaller Font Size command, 811

Smart Quotes, 258, 724, 811

snaking columns, 534—539. See also

columns

snaking lists, 552

Sort command (Tools menu), 316,

812

sorting, 352-355

data docimient, 631

dates, names, part numbers, 355

in Find File feature, 185

multilevel, 355

order for, 353-354

paragraphs, 315-316

selected text, 354

sounds

movie with, 711

moving, 45

recording to disk, 606

quality, 608

volume of, 609

source files, for linking, 679

Space Before Paragraph button

(ruler), 292, 306, 812

Spacebar, 7

spaces

hiding, 93-94

non-breaking, 267

spacing. See also white space

of characters, 25, 110. 243-244

ruler and, 11

speaker icon, 71

1

special characters, 253-257

finding. 507-508

for formula commands, 273

keyboard shortcuts for, 50, 255

specialty fonts, in drop caps, 261

speed

document size and, 592

of repeating keys, 52

of screen display, 94

of tables, memory and, 351

Spell checker, 484-491, 812

dictionaries, 488-491

and Find command, 507

for footnotes, 387

Grammar checker and, 493

ignoring flagged words, 487

overruling suggestions by, 487

selecting main dictionary for, 731

speeding up, 491

suggested changes by, 486

spelling, help from Thesaurus, 479

Spelling button (Toolbar) , 485

Spelling category (Preferences),

731-733

Split bar, 67

split box, for footnote window, 381

Split screen view, 88-89, 812

and Outline view, 525-526

splitting

cells in tables, 345, 812

documents, reasons for, 592

text into multiple paragraphs,

289-290

square brackets, for linked text, 691

squares, improving appearance. 111

standard Custom dictionary, 489

Standard glossary entries, 462^67
hiding, 462

standard settings, 719-721. See also

default settings

reverting to, 754-755

standard styles, 409

starting page number, changing, 379
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stationery documents, 182, 444-^49

creating, 445

deleting, 447

editing, 447^48

envelope, 436-439

for labels and envelopes, 642

for large documents, 593

for reports, 564

in Sample Documents folder, 429

sharing on network, 450-451

styles in, 415

using, 445-447

in Work menu, 446, 448^149

statistics, about document, 498

status area, 9, 12

dimmed page nimiber on, 79

fonts in, 240

page or section number in, 55

straight lines, in Picture Window. 136

Strikethru (Character dialog box),

242-243

Style command (Format menu), 404,

755

Style dialog box, 404-406, 405

Based On menu, 408

hotspot for, 55

Next Style, 40&-409

st)'le names, case sensitivity in, 416

Style rules, 497, 733

Style section (Character dialog box),

236

style sheets, 401

changing default, 755

merging, 415-416

printing, 406

style of text, in Picture W^indow, 138

styles, 400^21, 556

applying from keyboard, 403

applying from ruler, 403

applying to manual formatting,

419^20

basing one on another, 407^12
borders in, 311

and character formatting, 410

defining from dialog box, 405-406

defining from ruler, 402

deleting. 412^13

and edition files, 684

Find and Replace for, 414

frame positions as, 170

and glossary entries, 470

for headers arid footers, 375

inserting files and, 450

names for, 404

and oudines, 90, 521

for page numbers, 374, 377-380

reapplying, 410^11

redefining, 411

remo\ing biu retaining formats,

420^21

and removing character

formatting, 250

renaming, 413

Replace command and, 515

replacing, 513, 515

saving, 407

standard, 409

and tables. 350-351

transferring to other documents,

415^16

Work menu for frequently used,

741-746

StyleWriter, 111

Subject glossary entry, 466

Subscribe feature, and styles, 416

Subscribe To (Edit menu), 683

subscriber documents, 678, 680

editions for, 683-684
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formatting, 684

updating or canceling, 684-685

Subscriber Options (Edit menu), 685

subscript text button (ribbon), 11, 22,

25, 235

for drop caps, 265-266

subscripts, 244-245, 813

graphics as, 555

substituting fonts, 107, 282-283

subtext, 526

Summary Info command (File

menu), 30, 812

Summary Info dialog box, 30-31, 190

author, 463, 723

and Find File feature (Word 5), 187

prompt for, 730

subject information, 466

tide, 467

version, 467

Super/Subscript (.\S) command, 275,

278

superscript text button (ribbon), 11,

22, 25, 235

superscripts, 244-245

switching views, 84-85

Symbol command (Insert menu), 50,

254,813

Symbol font, 813

symbols, typing from keyboard, 254

synonyms, 474

System 6

Find File accessory, 8

FSePatch, 707

System 7

Alias feature, 33-35

balloon help, 58-59

Clipboard use in, 42

for Microsoft Graph, 653

System folder

background printing software

installed in, 122

Word Settings file, 719

tab characters

entering in table cells, 333

hiding, 93-94

Tab Delimited button (Insert Table

dialog box), 347

Tab dialog box

hotspot for, 55

measurement units in, 326

Tab key, 7

first line indenting widi, 300

tab stops, 7, 320-329

clearing, 328

data entry using, 328-329

defining measurement unit for, 724

deleting custom, 328

leading characters for, 326-327

ruler and, 11, 295

setUng custom, 323-326

vs. tables, 322-323

Table button (ribbon), 330, 332, 341

Table Cells Borders command, 813

Table Cells command (Format

menu), 338, 813

to change column width, 343-344

Table Cells dialog box, 339

Alignment menu, 344

Space Between Columns box, 346

Table command (Insert menu), 331,

813

table of contents

appearance of, 579

creating, 577-581
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and footnotes, 387

for large documents, 597

from Outline feature, 578

suppressing page numbers in, 580

suppressing printing of levels, 581

Table of Contents command (Insert

menu), 576, 813

Table of Contents dialog box, 578

Table dialog box, Border button, 309

Table Layout command (Format

menu), 813

Table Layout dialog box

Column button, 340

Insert Row, 337

Merge Cells, 345

Table scale button, 330

Table to Text (Insert menu), 349, 813

tables, 7, 329-351, 330. See also

columns in tables; rows in tables

alignment of, 344

borders in, 336

converting paragraphs to, 348

converting text to, 347-348

converting to text, 349

correcting alignment problems

with, 344

creating, 331-332

default for displaying gridlines, 725

frame for, 162-163

for letterhead, 546

memory and speed in, 351

modifying designs, 335-346

moving throvigh, 784-785

preventing page break in, 220

repeating headings for multipage,

351

scrolling in, 75

selecting entire, 335

selecting items in, 334-335

styles and, 350-351

tab characters in, 333

text entry in, 332-333

vs. frames, 171

vs. tab stops, 322-323

Tabs dialog box, 324-325, 813

Clear button, 328

Tall Adjusted option, from

ImageWriter and StyleWriter,

111

technical notes, downloading, 61

technical support, from Microsoft, 60

temporary files, and disk space, 195

text. See also selecting text

in chart window, 657

converting tables to, 349

converting to tables, 347-348

deleting, 17

entry in Picture Window, 137

framing, 168

inserting, 21

in main documents, 628-629

placement. Sf? frames

replacing, 22, 510-511

showing and hiding, 606

Text alignment tool (Picture

Window), 132

text annotations, 610-614

inserting, 611-612

text block, in Picture Window, 137

text boxes, defining measurement

unit for, 724

text entry, 12-13

in tables, 332-333

using tab stops, 328-329

text smoothing, 107, 108

Text to Table command, 814

Text tool (Picture Window), 132, 137

Thesaurus, 474-479, 814
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looking up words and phrases,

474-476

related words and phrases, 476^77
replacing words and phrases, 476

spelling help from, 479

Thesaurus category (Preferences), 734

Thesaurus dialog box. Original

button, 478

three-fold mailers, 563-564

tick marks, 657

labels in datasheet window, 655, 656

TIFF file format, 146, 147

Time glossary entry, 466, 814

time meter, for voice recording, 607

times, in headers or footers, 87, 368

Times font, 230

title bar, 67

dragging to move window, 70

Title Case command, 24fr-248, 814

Title glossary entry, 467

TOC Entry codes, 576, 579-581, 814

Toggle Case command, 814

Toggle Looping command, 814

toggling, 250-251

Tool palette (Picture Window), 132

Toolbar, 9, 12, 814

A button, 240

adding and removing buttons,

758-759

adding Show Hidden Text

command to, 606

battery indicator, 771

Bulleted list button, 235, 257

buttons for views, 85

changing, 758-760

character formatting with, 235, 235

Cut button, 39

Envelope button, 429-430

indenting buttons, 299

Open file button, 179

Page Break tool, 218

Page Layout View button, 537

paragraph formatting with, 294

Paste button, 39

pencil eraser button, 18

position of, 758

print icon, 99

restoring factory settings, 759-760

Save button, 28, 190

and speed, 94

Spelling button, 485

Toolbar category, displaying, 736

Tools menu
Calculate, 357

Commands, restoring to menu, 740

Commands command, 49, 189,

196, 736

commands and shortcuts, 777

Create Envelope command, 434

Grammar command, 494

Hyphenation, 271

Preferences command, 722

Preferences command,

Background Repagination,

216

Preferences command. Save and

Open Disk icon, 197

Preferences command. Smart

quotes, 258

Renimiber command, 596

Repaginate Now command, 79, 87,

216, 379

Sort command, 316, 352-355

Spelling, 484-485

Thesaurus, 474

Word Count command. 492

top margin, header in, 215

tractor-fed printers, 646
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transparencies, 559-561

TrueType fonts, 107, 280

turnover lines, 300

two-fold mailers, 563-564

two-sided documents

and margins, 207

printing, 116-119

typefaces, 227-228

typesetter's quotes, 258, 724

typing habits, changing, 7-8

typography, 226-283

automatic hyphenation feature,

269-273

bold characters, 241

bulleted list command, 257-258

case, 246-249

character formatting tools, 231-238

choosing fonts and sizes, 239-240

color choices, 245-246

curly quotes, 258-259

default font and size, 253

font technology, 279-283

formula typesetting commands,

273-279

initial caps, drop caps, and

dropped words, 259-267

non-breaking spaces, 267

removing character formatting,

249-252

special characters, 253-257

Strikethru, 242-243

super and subscripts, 244-245

terminology, 227-231

underlining, 242

unattached text in chart window, 657,

670

Underline option (Format menu),

232,242,814

underlined text

in Outline view, 522

in pictures, 138

underscore text button (ribbon), 11,

22, 25, 235

Undo command (Edit menu), 17-20,

815

and Clipboard contents, 41

for deleted paragraph marks, 291

for drag and drop, 47

and Grammar checker, 494, 496

for Picture object size and shape,

135

to remove borders, 311

and Replace feature, 515

to undo character formatting, 250

undoing, 20

Undo Thesaurus command (Edit

menu), 476

unframing, framed objects, 171

U.S. English Dictionary, 488

unlimited downloadable laser fonts,

110

Unnest button (Toolbar), 294, 299

Unnest Paragraph command, 815

Unspecified letters, in Find

command, 508

Up command (Font menu) , 815

Update Link command, 815

uppercase characters, changing text

to, 246, 815

Use Short Menu Names command,

815

user dictionaries, 488-491

Unassign Keystroke command, 51, 814
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Value axis, in chart window, 655

vendors, for fonts, 228-229

Version glossary entry, 467

version of Word, 786

vertical flips, 109

Vertical scroll arrow, 67

Vertical scroll bar, 67

View category (Preferences), 725-728

View menu, 183

Annotations, 612, 613

commands and shortcuts, 776

Footer command, 368

Footnotes command, 794

Header command, 367

Outline view, 520

Print Merge Helper, 623

Ribbon command, 235

Ruler command, 10, 11,212

Show f command, 94

for switching views, 84-85

Toolbar, 12

views, 81—90. See also Normal view;

Oiidine view; Page Layout view;

Print Preview; Split Screen view

default settings for, 92, 726

switching, 84-85

virus-protection software, and

installing Word, 763. 764

voice annotations, 606-610, 815

initials for, 723

playing, 608-609

recording, 607-608

volume of, 609

Voice Annotations dialog box, 609

Voice Impact, 606

Voice Impact Pro, 606

voice support service, 60

white space. See also indents; line

spacing; margins

around drawings, 133

around drop caps, 263-264

between borders and text, 312

between columns, 535

creating, 417

in Find command, 508

in lists, 552

page breaks, 215-216

between paragraphs, 8, 292, 295,

305-307

between paragraphs, page tops

and, 307

removing before paragraphs, 306

rivers of, 303

searching for, 186

between table columns, 346

between table rows, 339

white text with black background, 109

widows, 221

width

in datasheet, 662

of table cokmins, 331, 341-344

of text cokmins, 538

wildcards, in file search, 186

Window menu, 40-41, 69

to activate windows, 69-70

commands and shortcuts, 777

Help command, 56

Show Clipboard command, 41

windows. Sir also document windows

activating, 67-70

active, 39

fooUiote, 381

header, 367

hotspoLs in. 54-55
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moving, 70-71

multiple open to copy between

documents, 39

parts for Word, 8-12

for PrintMonitor, 122-123

scrolling, 71-73

sizing, 67, 70

Windows computers, saving files for,

195

Word

changing amount of memory for,

756-757

glossary with, 456

installing, 762-771

laimching, 33

quitting, 31-32

reading mail in, 700-702

sample documents with, 438

standard glossary entries in,

462-467

Standard settings, 719-721

version and serial number of, 786

Word 5 icon, 8

Word Count command (Tools

menu), 492, 815

Word document icon, double-clicking

to launch Word, 33

Word menu, Show Balloons, 58, 59

Word Settings file, 753, 754

Word Underline command, 815

Word window, parts of, 8-12

Word for Word, 180

word wrap, 13

WordPerfect, 180

words

correcting misspelled, 486

dropped, 259, 261

frame for, 1 62

looking up in Thesaurus, 474-476

preventing line break between, 267

selecting with mouse, 14

usage, spell checker and, 484

Work menu, 741-746, 743

adding glossary entries to, 461

Apply Style Name, 787

creating, 744-745

for large documents, 593

removing item from, 745

stationery in, 446, 448-449

X axis, 657

in chart window, 655

.\X (Box) command, 275-276, 275

Y axis, in chart window, 655, 657

Year glossary entry, 467

Z axis, 657

Zapf Chancery fonts, 257

ZapfDingbats, 228, 257

zero point, on ruler, 535

Zoom box, 9, 67

for sizing window, 70

Zoom to Fill Screen command, 815
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